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About This Guide

This Novell GroupWise 8 Installation Guide helps you install a new GroupWise system or update an 
existing GroupWise 5.x/6.x/7 system. The guide is divided into the following sections:

 Part I, “GroupWise Product Overview,” on page 11
 Chapter 1, “What Is GroupWise?,” on page 13
 Chapter 2, “GroupWise System Requirements,” on page 17

 Part II, “Installation,” on page 23
 Chapter 3, “Installing a Basic GroupWise System,” on page 25
 Chapter 4, “Installing the GroupWise Internet Agent,” on page 73
 Chapter 5, “Installing GroupWise WebAccess,” on page 101
 Chapter 6, “Installing the GroupWise Calendar Publishing Host,” on page 135
 Chapter 7, “Installing GroupWise Monitor,” on page 159
 Chapter 8, “Installing GroupWise Agents,” on page 181
 Chapter 9, “Installing the GroupWise Clients,” on page 229
 Chapter 10, “Installing Novell Messenger,” on page 239
 Chapter 11, “Installing the Novell Data Synchronizer Mobility Pack,” on page 241
 Chapter 12, “Installing Novell Vibe,” on page 243

 Part III, “Update,” on page 247
 Chapter 14, “What’s New in GroupWise 8,” on page 249
 Chapter 15, “Understanding the Update Process,” on page 255
 Chapter 16, “Preparing Your GroupWise System for Update,” on page 261
 Chapter 17, “Updating Your GroupWise 7 System to Version 8,” on page 263
 Chapter 18, “Updating Your GroupWise 5.x or 6.x System to Version 8,” on page 277

 Part IV, “Appendixes,” on page 279
 Appendix A, “GroupWise Version Compatibility,” on page 281
 Appendix B, “GroupWise Linux Executables,” on page 293
 Appendix C, “Third-Party Materials,” on page 323

For troubleshooting assistance, see:

 GroupWise 8 Troubleshooting 1: Error Messages
 GroupWise 8 Troubleshooting 2: Solutions to Common Problems
 GroupWise 8 Troubleshooting 3: Message Flow and Directory Structure
 Novell Support and Knowledgebase (http://www.novell.com/support)

To search the GroupWise documentation from the Novell Support Web site, click Advanced 
Search, select Documentation in the Search In drop-down list, select GroupWise in the Products 
drop-down list, type the search string, then click Search.

 GroupWise Support Forums (http://forums.novell.com/forumdisplay.php?&f=356) 
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 GroupWise Support Community (http://www.novell.com/support/products/groupwise)
 GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)

Audience

This guide is intended for network administrators who install and administer GroupWise. 

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation, or go to Novell Documentation Feedback (http://www.novell.com/
documentation/feedback.html) and enter your comments there.

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 8 
Documentation Web site (http://www.novell.com/documentation/gw8):

 Administration Guide
 Multi-System Administration Guide 
 Interoperability Guide
 Troubleshooting Guides
 GroupWise Client User Guides
 GroupWise Client Frequently Asked Questions (FAQ)
10 GroupWise 8 Installation Guide
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I IGroupWise Product Overview

 Chapter 1, “What Is GroupWise?,” on page 13
 Chapter 2, “GroupWise System Requirements,” on page 17
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1 1What Is GroupWise?

Novell GroupWise is an enterprise collaboration system that provides secure e-mail, calendaring, 
scheduling, and secure instant messaging. GroupWise also includes task management, contact 
management, document management, and other productivity tools. Companion products provide 
synchronization with mobile devices, teaming, and telephone and soft phone conferencing for 
complete enterprise connectivity and collaboration.

GroupWise can be used on your desktop on Windows, Macintosh, or Linux; in a Web browser 
anywhere you have an Internet connection; and on mobile devices. Your GroupWise system can be 
set up on NetWare, Linux, Windows, or any combination of these operating systems.

The following sections include more details about what GroupWise provides and what you need to 
do to set up GroupWise to best meet your needs.

 Section 1.1, “What GroupWise Provides,” on page 13
 Section 1.2, “What You Need to Install,” on page 15

1.1 What GroupWise Provides
GroupWise provides communication and collaboration services that are secure, highly available, and 
easily accessible:

 Section 1.1.1, “Essential Communication and Collaboration Services,” on page 13
 Section 1.1.2, “Available Anytime,” on page 14
 Section 1.1.3, “Accessible Anywhere,” on page 14
 Section 1.1.4, “Always Secure,” on page 15

1.1.1 Essential Communication and Collaboration Services

GroupWise provides a variety of tools to enable users to work together and work smarter.

 Messaging: Send and receive mail messages, phone messages, and reminder notes. A mail 
message is for general correspondence. A phone message is designed for those who take phone 
messages for others. A reminder note includes a start date and, when accepted by the recipient, 
is posted to the recipient’s Calendar.

 Scheduling: Schedule both appointments and tasks. When you schedule an appointment, you 
can search other users’ Calendars to find free times for the appointment. When you schedule a 
task, you can assign a priority and due date to the task. If the recipient accepts an appointment 
or task, it is automatically added to his or her Calendar. 

 Calendaring: View and manage your appointments, tasks, and reminder notes in a Calendar 
view. You can create multiple calendars. You can also publish personal calendars and free/busy 
status so that non-GroupWise users can conveniently schedule meetings with you.
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 Task Management: Accept or decline the tasks you are sent, and track accepted tasks through to 
completion. You can turn any message into a task. You can also organize, schedule, and monitor 
tasks in your Tasklist folder.

 Contact Management: Manage information for your contacts, groups, resources, and 
organizations, including being able to view, update, delete, and add information to the contacts 
in your address books and Contacts folders. In addition, you can view a history of messages sent 
to and received from individual contacts and compile notes on interactions with contacts.

 Document Management: Store documents in GroupWise libraries. In a library, documents are 
compressed to save disk space and encrypted to maintain security. With document 
management, you can check in, check out, share, and version documents.

 Instant Messaging: Using Novell Messenger, communicate in real time with other GroupWise 
users. Novell Messenger lets you know when other users are online, busy, or away from their 
desks. It also allows you to save conversations.

 Teaming: Using Novell Vibe, collaborate on a teaming Web site where personal, team, and 
global workspaces can include discussion folders, shared calendars, shared documents, blogs, 
wikis, surveys, and more. Powerful search capabilities make finding information quick and easy. 

 Conferencing: Using Novell Conferencing, conduct telephone conferences with the convenience 
of communities, contacts, and buddies for conference calls; phone presence and participation 
indicators; meeting setup; instant chat; whiteboarding; desktop sharing; and more. 

1.1.2 Available Anytime

GroupWise ensures that your essential communication tools are always available: 

 Caching: The GroupWise Windows, Mac, and Linux clients include a Caching mode that allows 
you to cache GroupWise information to your local drive and continue to work even when you 
aren’t logged into your network mailbox. 

 LDAP Pooling: If you are using LDAP authentication for GroupWise mailbox authentication, 
LDAP pooling ensures that there is always an LDAP server through which authentication can be 
performed.

 Clustering: To ensure that GroupWise data is always available and GroupWise components are 
always running, you can install GroupWise in a cluster on NetWare, Linux, or Windows.

1.1.3 Accessible Anywhere

GroupWise lets you communicate and collaborate with other people by using the device that is most 
convenient:

 Personal Computers: To access your mailbox, you can run the GroupWise Windows client on 
any workstation that uses Windows XP or higher. On Macintosh workstations, you can run the 
GroupWise Mac client. On Linux workstations, you can run the GroupWise Linux client.

 Web Browsers: With GroupWise WebAccess installed, you can also access your mailbox 
through a Web browser, a cellular phone, or a PDA (personal digital assistant) such as Pocket 
PC. The GroupWise WebAccess client formats information to best accommodate the type of 
device on which it is being displayed.

 Mobile Devices: You can use Novell Data Synchronizer to synchronize personal information 
management (PIM) data such as e-mail, appointments, and contacts to synchronize between 
GroupWise and mobile devices.

NOTE: The Data Synchronizer Mobility Pack replaces GroupWise Mobile Server in providing 
synchronization between GroupWise and mobile devices.
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You can synchronize GroupWise with your BlackBerry device by using BlackBerry Enterprise 
Server for GroupWise. 

 Other E-Mail Clients: GroupWise enables you to access your mailbox with any POP3, IMAP4, 
or SOAP e-mail client. 

1.1.4 Always Secure

GroupWise provides extensive security measures to protect your information.

 Encryption: To protect your information as it is stored in the various GroupWise databases and 
moved across the network, GroupWise encrypts the information. Each piece of information is 
encrypted differently through the use of randomly-generated encryption keys.

 Open Security Standards: To further ensure that your information is secure while moving 
across your internal network or across the Internet, GroupWise supports open security 
standards such as Secure Sockets Layer (SSL), Secure Multipurpose Internet Mail Extension (S/
MIME), Public Key Infrastructure (PKI), and Transport Layer Security (TLS). 

 Spam Protection: To protect you from seeing unwanted messages, the GroupWise Windows 
client includes a Junk Mail Handling feature that lets you control unwanted Internet e-mail 
messages. In addition, you can configure the Internet Agent (the GroupWise component 
responsible for sending and receiving Internet e-mail messages) to reject messages from known 
open relay hosts and spam hosts. GroupWise also works with partner products that provide 
additional anti-spam solutions.

 Virus Protection: GroupWise works with partner products to provide solutions that detect and 
eliminate viruses.

For information about additional security solutions available for GroupWise through GroupWise 
partners, see the Novell Partner Product Guide (http://www.novell.com/partnerguide).

1.2 What You Need to Install
GroupWise includes multiple components that you need to install to realize the full benefits of 
GroupWise. However, some components might not be necessary, depending on your needs. The 
following table outlines the components, what they provide, and where to find instructions for 
installing them. 

Table 1-1   Components of Your GroupWise System

Component What it does Go to

Administration, Agents, 
and Windows Client

Necessary for a basic GroupWise 
system. These components are 
required and must be installed 
before any other components.

Chapter 3, “Installing a Basic 
GroupWise System,” on page 25

Internet Agent Provides Internet e-mail 
communication, POP3/IMAP4/
SOAP client access, and paging 
services.

Chapter 4, “Installing the GroupWise 
Internet Agent,” on page 73

WebAccess Provides access to mailboxes 
through a Web browser or mobile 
device.

Chapter 5, “Installing GroupWise 
WebAccess,” on page 101
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In addition to the sections referenced in the above table, this Installation Guide includes the following 
supplemental sections:

 Chapter 10, “Installing Novell Messenger,” on page 239
 Chapter 11, “Installing the Novell Data Synchronizer Mobility Pack,” on page 241
 Chapter 12, “Installing Novell Vibe,” on page 243
 Chapter 13, “Installing Novell Conferencing,” on page 245

The information in these sections is provided as a reference for installing additional components after 
you’ve created your basic GroupWise system.

Calendar Publishing 
Host

Provides public access to personal 
GroupWise calendars and free/busy 
availability to Internet users.

Chapter 6, “Installing the GroupWise 
Calendar Publishing Host,” on page 135

Monitor Provides administrative monitoring 
of the GroupWise agents.

Chapter 7, “Installing GroupWise 
Monitor,” on page 159

Agents Necessary for each new domain and 
post office that you create.

Chapter 8, “Installing GroupWise 
Agents,” on page 181

GroupWise Clients 
(Windows, Mac, and 
Linux)

Can be rolled out to all GroupWise 
users on a convenient schedule.

Chapter 9, “Installing the GroupWise 
Clients,” on page 229

Component What it does Go to
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2 2GroupWise System Requirements

You, as a GroupWise administrator, must ensure that your system meets GroupWise system 
requirements, so that your GroupWise system can be set up successfully. After your GroupWise 
system is set up, you must ensure that users’ workstations meet GroupWise client requirements, so 
that users can run the GroupWise clients successfully.

 Section 2.1, “GroupWise Administration Requirements,” on page 17
 Section 2.2, “GroupWise Client Requirements,” on page 19
 Section 2.3, “Supported Environments,” on page 20

2.1 GroupWise Administration Requirements
 x86-32 processor or x86-64

On a 64-bit processor, GroupWise still runs as a 32-bit application.

 Any of the following server operating systems for the GroupWise agents (Post Office Agent, 
Message Transfer Agent, Internet Agent, WebAccess Agent, Monitor Agent):
 Novell Open Enterprise Server (OES) 2 (NetWare or Linux version) or OES 11, plus the 

latest Support Pack
 NetWare 6.5, plus the latest Support Pack

NOTE: The Monitor Agent is not available for NetWare.

 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack
The X Window System and Open Motif are required by the GUI GroupWise agent server 
consoles for the Post Office Agent, the Message Transfer Agent, and the Internet Agent. By 
default, the GroupWise agents run as daemons without user interfaces.

 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 
2008 R2, plus the latest Service Pack

 Adequate server memory as required by the operating system

 eDirectory 8.7 or later, plus the latest Support Pack, with LDAP enabled

 ConsoleOne 1.3.6h or later, with the LDAP snap-in installed

GroupWise 8 includes ConsoleOne 1.3.6h for Windows and for Linux on the GroupWise 8 DVD 
or downloaded GroupWise 8 software image.
You can install the LDAP snap-in for Linux ConsoleOne along with ConsoleOne. You can 
download the LDAP snap-in for Windows ConsoleOne from the Novell Downloads site (http://
download.novell.com/Download?buildid=FCT5LqrhcGI~).
ConsoleOne requires Java Virtual Machine (JVM) 1.5.11 or later.
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On Windows, ConsoleOne also requires the Novell Client. ConsoleOne 1.3.6h requires version 
4.91 SP3 or later of the Novell Client. If necessary, you can download the latest Novell Client 
from the Novell Product Downloads site (http://download.novell.com).
On Linux, ConsoleOne also requires the X Window System, version X11R6 or later.

 Any of the following environments for running ConsoleOne and the GroupWise Installation 
program:
 Windows XP, Windows Vista, or Windows 7, plus the latest Service Pack, plus the Novell 

Client
 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 

2008 R2, plus the latest Service Pack, plus the Novell Client
 Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support 

Pack
 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack

The X Window System is required by the GUI GroupWise Installation program that steps 
you through the process of creating a new GroupWise system. A text-based Installation 
program is also available.

 Adequate server disk space:

 Software distribution directory: 500 MB for all GroupWise components in one language
 Domain directory: 100-200 MB for the domain database, plus 1 GB or more for message 

queues when links are down
 Post office directory: 5 MB per user (minimum); 100 MB or more per user (recommended); 

plus 100-300 MB for the post office database; plus 500 MB or more for message queues 
when links are down

 MTA/POA installation: approximately 25 MB (varies by platform)
 Internet Agent installation: approximately 37 MB (varies by platform)
 WebAccess installation: approximately 215 MB (111 MB shared with Monitor; varies by 

platform)
 Monitor installation: approximately 140 MB (111 MB shared with WebAccess; varies by 

platform)
 Calendar Publishing Host installation: approximately 7 MB, plus 50 KB per published 

calendar and 50 KB per user for free/busy searching

 Internet connectivity for the Internet Agent

 Internet domain name for your company
 Internet Service Provider (ISP) or in-house DNS address resolution

 Any of the following Web servers for WebAccess, Monitor, and the Calendar Publishing Host:

 NetWare 6.5: Apache 2.0 plus:
 Tomcat 4.1 or later
 JVM 1.4.2 or later
 Jakarta Connector 1.2 or later

 OES 2 Linux / SLES 10: Apache 2.2 plus:
 Tomcat 5.0 or later
 JVM 1.4.2 or later
 ModProxy Module
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 OES 11 / SLES 11: Apache 2.2 plus:
 Tomcat 6.0 or later
 JVM 1.5 or later
 ModProxy Module

 Windows Server 2003/2003 R2: Microsoft Internet Information Server (IIS) 6 or later plus:
 Tomcat 5.5 or later
  JVM 1.5 or later
  Jakarta Connector 1.2 or later

 Windows Server 2008/2008 R2: Microsoft Internet Information Server (IIS) 7 or later plus:
 Tomcat 5.5 or later
  JVM 1.5 or later
  Jakarta Connector 1.2 or later

 Any of the following Web browsers for the agent Web consoles:

 Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox 
 Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox
 Linux: Mozilla Firefox

2.2 GroupWise Client Requirements
 Section 2.2.1, “Windows Client Requirements,” on page 19
 Section 2.2.2, “Mac Client Requirements,” on page 19
 Section 2.2.3, “Linux Client Requirements,” on page 20
 Section 2.2.4, “WebAccess Client Requirements,” on page 20

2.2.1 Windows Client Requirements

 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
 Any of the following desktop operating systems for the GroupWise Windows client:

 Windows XP on a 300 MHz or higher workstation with at least 128 MB of RAM
 Windows Vista on a 1 GHz or higher workstation with at least 1 GB of RAM
 Windows 7 on a 1 GHz or higher workstation with at least 1 GB of RAM

 200 MB of free disk space on each user’s workstation to install the Windows client

2.2.2 Mac Client Requirements

The GroupWise Mac client is not included with GroupWise 8.0.3, but is available in earlier versions of 
GroupWise 8. The GroupWise 8.0.2 Mac client can continue to be used with a GroupWise system that 
has been updated to GroupWise 8.0.3 or to GroupWise 2012.

 x86-32 processor or x86-64 processor; PowerPC

On a 64-bit processor, GroupWise still runs as a 32-bit application.
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 Any of the following desktop operating systems:
 Mac OS 10.6.8 and later (Snow Leopard), Mac OS 10.7 (Lion), Mac OS 10.8 (Mountain Lion) 

or later, for use with the GroupWise 8.0.2 HP3 or HP4 Mac client that is available on the 
Novell Downloads site (http://download.novell.com)
or
Mac OS 10.4 (Tiger), Mac OS 10.5 (Leopard), Mac OS 10.6.7 and earlier (Snow Leopard), for 
the GroupWise 8.0.2 HP2 Mac client that is available on the Novell Downloads site (http://
download.novell.com)

 Mac OS X for Intel
 Mac OS X for PowerPC for the GroupWise 8.0.2 HP2 Mac client that is available on the 

Novell Downloads site (http://download.novell.com)
The GroupWise 8.0.2 HP3 Mac client is not supported on Mac OS X for PowerPC.

 Apple Java Virtual Machine (JVM) 1.5 or later
 75 MB of free disk space on each user’s workstation to install the Mac client

2.2.3 Linux Client Requirements

The GroupWise Linux client is not included with GroupWise 8.0.3, but is available in earlier versions 
of GroupWise 8. The GroupWise 8.0.2 Linux client can continue to be used with a GroupWise system 
that has been updated to GroupWise 8.0.3 or to GroupWise 2012.

 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
 SUSE Linux Enterprise Desktop (SLED) 10 or SLED 11, plus the latest Support Pack, plus the 

KDE desktop or the GNOME desktop
 200 MB of free disk space on each user’s workstation to install the Linux client

2.2.4 WebAccess Client Requirements

 Any of the following Web browsers:
 Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox 
 Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox
 Linux: Mozilla Firefox

 Any mobile device that supports Wireless Access Protocol (WAP) and has a microbrowser that 
supports Hypertext Markup Language (HTML) 4.0 or later, or Wireless Markup Language 
(WML) 1.1 or later

2.3 Supported Environments
 Section 2.3.1, “IPV6 Support,” on page 21
 Section 2.3.2, “Clustering Support,” on page 21
 Section 2.3.3, “Xen Virtualization Support,” on page 21
 Section 2.3.4, “VMware Support,” on page 21
 Section 2.3.5, “Citrix Support,” on page 22
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 Section 2.3.6, “Domain Services for Windows Support,” on page 22
 Section 2.3.7, “Linux File System Support,” on page 22

2.3.1 IPV6 Support

The POA, the MTA, the Internet Agent, and the Monitor Agent support the IPV6 protocol when it is 
available on the server. If it is available, the agent detects it and supports IPV6 by default, along with 
IPV4. The WebAccess Agent and its accompanying Viewer Agent do not support IPV6.

As you configure your GroupWise system and specify the network address of an IPV6 server in 
ConsoleOne, you must specify its DNS hostname. IP Address fields in ConsoleOne do not 
accommodate IPV6 address format.

IPV6 support is available on Linux and Windows. IPV6 support is not currently available on 
NetWare.

2.3.2 Clustering Support

You can set up your GroupWise system in any of the following clustering environments, as described 
in the GroupWise 8 Interoperability Guide:

 “Novell Cluster Services on NetWare”
 “Novell Cluster Services on Linux”
 “Microsoft Clustering Services on Windows”

If you are using one of these clustering environments, follow the installation instructions in the 
GroupWise 8 Interoperability Guide, rather than the installation instructions in this guide.

2.3.3 Xen Virtualization Support

You can install components of your GroupWise system in virtual environments where a software 
program enables one physical server to function as if it were two or more physical servers. Xen 
virtualization technology in Novell Open Enterprise Server (Linux version) and SUSE Linux 
Enterprise Server is supported. For more information, see:

 Open Enterprise Server 2 Virtualization Documentation Web site (http://www.novell.com/
documentation/oes2/virtualization.html#virtualization)

 SLES Virtualization Technology Documentation Web site (http://www.novell.com/
documentation/vmserver).

Large post offices with busy POAs are not good candidates for virtualization. Specialized POAs, such 
as an indexing POA with no mailboxes and users, could be virtualized. Other GroupWise 
components such as the MTA, Internet Agent, and WebAccess Agent do well when virtualized.

2.3.4 VMware Support

GroupWise is supported on the following versions of VMware:

 VMware Server (formally GSX Server), an enterprise-class virtual infrastructure for x86-based 
servers

 VMware ESX Server, a data center-class virtual infrastructure for mission-critical environments
For more information, see the VMware Web site (http://www.vmware.com).
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2.3.5 Citrix Support

Any version of the GroupWise client runs successfully on any 32-bit version of Citrix terminal 
services.

The GroupWise agents run successfully on Citrix XenServer.

For more information, see the Citrix Web site (http://www.citrix.com).

2.3.6 Domain Services for Windows Support

Starting in GroupWise 8 SP1, GroupWise can be installed on the same server with Novell Domain 
Services for Windows (DSfW), and GroupWise objects can be created in a DSfW partition. DSfW uses 
ports 1389 and 1636 instead of the typical default ports of 389 and 636 for LDAP. The GroupWise 8 
SP1 Installation program detects the presence of DSfW and automatically adjusts the LDAP port 
numbers that are used when installing the Internet Agent, WebAccess, and Monitor.

NOTE: Earlier versions of GroupWise cannot be installed on a DSfW server, nor can earlier versions 
of GroupWise eDirectory objects be created in a DSfW partition. However, GroupWise objects can 
still be created in an eDirectory tree that has a DSfW partition, as long as you do not try to create the 
GroupWise objects in the DSfW partition.

2.3.7 Linux File System Support

For best GroupWise performance on Linux, the ext3 file system is recommended. If you are running 
OES Linux and need the feature-rich environment of the NSS file system, GroupWise is also 
supported there. The reiser3 file system is also supported.

NOTE: If you choose to use the NSS file system, turn Salvage off for best performance. For more 
information, see the Novell Open Enterprise Server Documentation Web site (http://
www.novell.com/documentation/oes2).
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II IIInstallation

 Chapter 3, “Installing a Basic GroupWise System,” on page 25
 Chapter 4, “Installing the GroupWise Internet Agent,” on page 73
 Chapter 5, “Installing GroupWise WebAccess,” on page 101
 Chapter 6, “Installing the GroupWise Calendar Publishing Host,” on page 135
 Chapter 7, “Installing GroupWise Monitor,” on page 159
 Chapter 8, “Installing GroupWise Agents,” on page 181
 Chapter 9, “Installing the GroupWise Clients,” on page 229
 Chapter 10, “Installing Novell Messenger,” on page 239
 Chapter 11, “Installing the Novell Data Synchronizer Mobility Pack,” on page 241
 Chapter 12, “Installing Novell Vibe,” on page 243
 Chapter 13, “Installing Novell Conferencing,” on page 245

For additional assistance in planning your GroupWise installation, see GroupWise Best Practices 
(http://wiki.novell.com/index.php/GroupWise) and GroupWise 8 Good and Bad Habits (http://
wiki.novell.com/index.php/GroupWise_8_Good_and_Bad_Habits).
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3 3Installing a Basic GroupWise System

Every Novell GroupWise system, whether it services five users or 50,000 users, starts as a basic 
GroupWise system. The following sections present the background information and installation 
instructions you need to successfully implement your basic GroupWise system. 

 Section 3.1, “Basic System Overview,” on page 25
 Section 3.2, “Planning a Basic GroupWise System,” on page 26
 Section 3.3, “Setting Up a Basic GroupWise System,” on page 48
 Section 3.4, “What’s Next,” on page 67
 Section 3.5, “Basic GroupWise System Summary Sheet,” on page 68

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the GroupWise 
8 Interoperability Guide before starting to set up your GroupWise system.

3.1 Basic System Overview
A basic GroupWise system consists of a single domain (the primary domain) with one post office, a 
document library, and one or more users, as shown below.

Figure 3-1   Basic GroupWise System

Each GroupWise user has a mailbox in the post office; users run the GroupWise client (Windows, 
Mac, Linux, or WebAccess) in order to access their mailboxes and to send and receive mail.
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The GroupWise Post Office Agent (POA) responds to the GroupWise clients’ requests for mailbox 
data and delivers messages between users’ mailboxes in a post office. The GroupWise Message 
Transfer Agent (MTA) routes messages between post offices (if there is more than one post office in 
the domain) and between domains (if there is more than one domain in the system). 

After you finish setting up your basic GroupWise system, you can review Section 3.4, “What’s Next,” 
on page 67 to learn how you can expand your GroupWise system.

3.2 Planning a Basic GroupWise System
The GroupWise Installation program helps you install the GroupWise software to the appropriate 
locations and helps you create and configure your basic GroupWise system (primary domain, post 
office, and agents).

If you are comfortable with your knowledge of GroupWise, you can skip this planning section and 
continue with Section 3.3, “Setting Up a Basic GroupWise System,” on page 48. Otherwise, you 
should use the “Basic GroupWise System Summary Sheet” on page 68 to record your decisions about 
how to set up your basic GroupWise system. The topics in this section present the required 
information in a convenient planning sequence. The Installation Summary Sheet organizes the 
information in the order in which you need it during installation and setup.

 Section 3.2.1, “Determining Installation Locations,” on page 26
 Section 3.2.2, “Planning Your Primary Domain,” on page 30
 Section 3.2.3, “Planning Your Post Office,” on page 36
 Section 3.2.4, “Planning Your GroupWise Agents,” on page 39
 Section 3.2.5, “Sample GroupWise Configurations,” on page 45

For additional assistance in planning your GroupWise installation, see GroupWise 8 Best Practices 
(http://wiki.novell.com/index.php/GroupWise) and GroupWise 8 Good and Bad Habits (http://
wiki.novell.com/index.php/GroupWise_8_Good_and_Bad_Habits).

IMPORTANT: If you plan to install GroupWise in a clustered server environment, refer to the 
GroupWise 8 Interoperability Guide as you plan your GroupWise system.

3.2.1 Determining Installation Locations

The GroupWise Installation program prompts you for information about the Novell eDirectory tree 
where you plan to create GroupWise objects and the network server locations where you plan to 
create GroupWise directories and install software.

 “Novell eDirectory” on page 27
 “ConsoleOne” on page 27
 “GroupWise Software Distribution Directory” on page 28
 “Agent Platform” on page 30
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Novell eDirectory

GroupWise is administered through eDirectory, the directory service provided by Novell. All 
components, such as domains, post offices, libraries, and agents, as well as all users’ GroupWise 
accounts, are configured through objects in eDirectory. You need to make sure that you have 
eDirectory installed in your environment. eDirectory can be installed on NetWare, Linux, or 
Windows. 

GroupWise 8 includes the Novell eDirectory CD or downloadable ISO image to assist those who do 
not already have eDirectory installed and want to install it on Linux or Windows. Follow the 
instructions in the Novell eDirectory Installation Guide (http://www.novell.com/documentation/edir88) 
to install eDirectory, along with its latest Support Pack, and ConsoleOne before proceeding to install 
your basic GroupWise system.

 “Accessing the eDirectory Tree” on page 27
 “Making Sure Users Exist in eDirectory” on page 27

Accessing the eDirectory Tree

In order to access the eDirectory tree, the GroupWise Installation program needs the IP address or 
DNS hostname of a server where a replica of the tree can be found. It also needs an eDirectory 
username with Admin-equivalent rights, the password for the username, and the eDirectory context 
where the User object can be found. Some parts of the installation process require LDAP 
authentication to eDirectory, so LDAP must be enabled on your eDirectory server.

The GroupWise Installation program must extend the schema of the eDirectory tree where you plan 
to create your GroupWise system. Because all objects for a single GroupWise domain must reside in 
the same eDirectory tree, installing a basic system (one domain) requires you to extend one tree only.

Making Sure Users Exist in eDirectory

You must make sure all users who will use GroupWise exist in eDirectory. GroupWise accounts can 
only be assigned to eDirectory User objects and GroupWise External Entity objects.

NOTE: GroupWise external entities represent non-eDirectory users and are added to eDirectory for 
the sole purpose of assigning GroupWise accounts to these users. GroupWise external entities require 
GroupWise licenses but not eDirectory licenses. You can add GroupWise external entities only after 
you have installed GroupWise. 

ConsoleOne

GroupWise administration is performed through ConsoleOne, using the version listed in Section 2.1, 
“GroupWise Administration Requirements,” on page 17. When you install GroupWise, the 
GroupWise Administrator snap-ins are copied into an existing ConsoleOne installation. The 
GroupWise Administrator snap-ins extend the functionality of ConsoleOne to let you administer 
GroupWise. ConsoleOne considerations differ by platform:

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under System Settings, specify the IP address or DNS hostname of a server where a replica of the 
eDirectory tree resides. Also provide the authentication information so that the GroupWise Installation 
program can access the eDirectory tree and extend the schema.
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For more information about ConsoleOne, see “ConsoleOne Administration Tool” in “System” in the 
GroupWise 8 Administration Guide.

GroupWise Software Distribution Directory

During installation, you are prompted to create a GroupWise software distribution directory on a 
network server and then copy selected GroupWise software components to the directory. 

You should consider the following when deciding where to create the software distribution directory:

 “User Access to the Directory” on page 28
 “Disk Space Required for the Software” on page 29
 “Default Software Distribution Directory Location” on page 29

User Access to the Directory

User access considerations depend on which GroupWise client users are running:

NetWare and
Windows:

For a GroupWise system on NetWare or Windows, you need to decide which 
ConsoleOne location you want to use to administer GroupWise. This can be a 
ConsoleOne location on a network server, or it can be on a local workstation. If you plan 
to use ConsoleOne on a local workstation, you need to perform the GroupWise 
installation from that workstation. 

For your convenience, ConsoleOne is included on the GroupWise 8 DVD or 
downloaded GroupWise 8 software image. The GroupWise Installation program lets you 
install ConsoleOne if necessary. You can also use the GroupWise Installation program 
at a later time to install ConsoleOne and the GroupWise Administrator snap-ins to 
additional locations.

The default ConsoleOne installation directory is:

drive:\Novell\ConsoleOne

IMPORTANT: For a GroupWise system on NetWare, you cannot run ConsoleOne to 
administer GroupWise at the NetWare server console. The GroupWise Administrator 
snap-ins to ConsoleOne do not run in that environment.

Linux: For a GroupWise system on Linux, ConsoleOne must already be installed before you 
set up your GroupWise system. 

For your convenience, ConsoleOne is included on the GroupWise 8 DVD or 
downloaded GroupWise 8 software image in the /linux/consoleone directory. To 
install ConsoleOne, copy the ConsoleOne .tar.gz file to a temporary location, extract 
the contents of the file, change to the Linux subdirectory, then run c1-install. At a 
later time, you can install ConsoleOne to additional Linux locations.

The required ConsoleOne installation directory is:

/usr/ConsoleOne

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under ConsoleOne Directory, specify the path for the ConsoleOne location you want to use to administer 
GroupWise. 
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Disk Space Required for the Software

The disk space required for the directory depends on which software components you copy to the 
directory. The maximum disk space required to store all the GroupWise software components for one 
language is approximately 500 MB. For a breakdown by component, see Section 2.1, “GroupWise 
Administration Requirements,” on page 17.

We recommend that you copy at least the GroupWise client files to the directory. This enables users to 
install the GroupWise client from the distribution directory. Otherwise, you need to mount the 
GroupWise 8 DVD or downloaded GroupWise 8 software image as a network volume or file system, or 
distribute the DVD to individual users, unless you use one of the software distribution methods 
described in “Distributing the GroupWise Client” in “Client” in the GroupWise 8 Administration Guide.

NOTE: On Linux, you should install the GroupWise Administration component to your software 
distribution directory. It includes the RPMs for GroupWise Check (GWCheck) and the GroupWise 
Database Copy utility (DBCopy). These RPMs are not installed by the GroupWise Installation 
program. For more information about these utilities, see “Standalone Database Maintenance 
Programs” in “Databases” in the GroupWise 8 Administration Guide.

Default Software Distribution Directory Location

The default location for the software distribution directory varies by platform:

The GroupWise Installation program lets you create one software distribution directory. After you set 
up your basic GroupWise system, you can create additional software distribution directories if 
needed. For example, if not all users can access a single software distribution directory to run the 
GroupWise Windows client Setup program, you can create an additional software distribution 

Windows 
Client:

Users can install the GroupWise Windows client through a TCP/IP or mapped connection 
to the software distribution directory. If you want users to install via a mapped connection, 
you should create the software distribution directory on a server where you can provide 
appropriate user access.

Mac/Linux 
Client:

Users can install the GroupWise Mac/Linux client from the GroupWise 8 DVD, from the 
downloaded GroupWise 8 software image, or from the software distribution directory, 
which requires user access to the file system where the software distribution directory is 
located.

WebAccess 
Client:

The GroupWise WebAccess client does not require that users install any GroupWise 
software on their workstations. 

NetWare: drive:\grpwise\software

Linux: /opt/novell/groupwise/software

Windows: drive:\grpwise\software

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Software Distribution Directory, specify the path for the software distribution directory.

Under Software Selection, mark the software components that you want to copy there.
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directory on a server they can access. For information about creating additional software distribution 
directories, see “Software Directory Management” in “System” in the GroupWise 8 Administration 
Guide.

Agent Platform

The Message Transfer Agent (MTA) and the Post Office Agent (POA) are available as NetWare NLM 
programs, Linux executables, and Windows executables.

In general, GroupWise is most efficient if you match the agent platform with the network operating 
system where the domain and post office are located. For example, if a domain and post office are 
located on a NetWare server, then you would install the NetWare agents for them. However, this is 
not required. For configuration examples, see Section 3.2.5, “Sample GroupWise Configurations,” on 
page 45.

3.2.2 Planning Your Primary Domain

The primary domain functions as the main administration unit for the GroupWise system. Domains 
that you create after the first domain are secondary domains.

When you configure GroupWise information in eDirectory, it is also stored in the GroupWise domain 
database. From the domain database, the GroupWise agents distribute the information to each post 
office database. Users then get the information, such as user addresses, from the post office database. 
Domains can be located on NetWare, Linux, and Windows servers.

In a multiple-post-office system, the domain also organizes post offices into a logical grouping for 
addressing and routing purposes, and enables you to scale your GroupWise system to meet your 
current and future needs.

As you create your basic GroupWise system, the Installation program prompts you for information 
about the primary domain.

 “System and Domain Names” on page 30
 “Domain Directory” on page 31
 “Domain Context” on page 33
 “Domain Language” on page 35
 “Domain Time Zone” on page 36

System and Domain Names

Each domain requires a unique name. The name is used as the Domain object’s name in eDirectory. It 
is also used for addressing and routing purposes within GroupWise, and can appear in the 
GroupWise Address Book. The domain name can reflect a location, company name or branch name, 

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Agent Software Platform, specify the type of agents (NetWare, Linux, or Windows) you want to 
use.
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or some other element that makes sense for your organization. For example, you might want the 
domain name to be the location (such as Provo) while the post office name is one of the company’s 
departments (such as Research). 

A domain name should consist of a single string. Use underscores (_) rather than spaces as separators 
between words to facilitate addressing across the Internet. 

Do not use any of the characters listed below in system and domain names: 

IMPORTANT: Name your domain carefully. After it is created, the name cannot be changed.

You must also provide a name for your GroupWise system. The system name is used when 
connecting to other GroupWise systems; for this reason, it must be different than any other 
GroupWise system with which you might want to connect. The system name can be your company 
name (for example, Novell), GroupWise, or anything else that fits the naming scheme you want to 
use. The system name is displayed only in ConsoleOne so any characters can be used. You cannot 
change the name after your system is created.

Domain Directory

The domain requires a directory structure in which to store database files and temporary files that are 
created during message routing. As you choose a location for the domain directory, consider the 
following: 

 “Security” on page 31
 “Server Platform and Version” on page 32
 “MTA Access” on page 32
 “Disk Space Requirements” on page 32
 “Directory Name” on page 32

Security

GroupWise users never need access to the domain directory, so you should create it in a location that 
you can easily secure.

ASCII characters 0-31 Comma ,

Asterisk * Double quote "

At sign @ Extended ASCII characters that are graphical or typographical symbols; 
accented characters in the extended range can be used

Braces { } Parentheses ( )

Colon : Period .

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under System Settings, specify the name of the GroupWise system that you want to create in eDirectory.

Under Primary Domain Settings, specify the domain name.
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Server Platform and Version

The domain directory can be located on any of the supported platforms listed in Section 2.1, 
“GroupWise Administration Requirements,” on page 17.

MTA Access

The MTA requires direct access to the domain directory so that it can write to the domain database 
(wpdomain.db). Therefore, you might want to consider the server type (NetWare, Linux, or Windows) 
and location (local or remote) of the MTA before deciding on a domain directory. For information 
about the MTA, see Section 3.2.4, “Planning Your GroupWise Agents,” on page 39. For examples of 
possible domain directory locations and MTA configurations, see “Sample GroupWise 
Configurations” on page 45.

IMPORTANT: On Linux, the MTA must be installed on the same server where its directory structure 
is located. A file system mount between Linux servers does not provide the necessary file locking 
mechanisms for the GroupWise Linux MTA to write to the domain database on a remote Linux 
server.

Disk Space Requirements

The domain directory requires a minimum of 100-200 MB of disk space for the domain database. In 
addition, you should plan for an additional 1 GB or more of free disk space for the temporary storage 
of messages when links are down.

Directory Name

You should specify an empty directory for the domain. If you want, the directory can reflect the 
domain name you chose. Use the following platform-specific conventions:

Choose the name and path carefully. After the directory is created, it is difficult to rename. If the 
directory you specify does not exist, it is created during installation.

NetWare: Use a maximum of 8 characters

Linux: Use only lowercase characters

Windows: No limitations.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Primary Domain Settings, specify the full path for the domain directory.
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Domain Context

You can create the Domain object in any Organization or Organizational Unit container in any 
context in your eDirectory tree. The only requirement is that it be in the same tree as the other objects 
associated with the domain (Post Office object, User objects, and so forth).

The following sections provide examples of where you might place your Domain object. Because it is 
helpful to discuss the Domain object’s context in relationship to the Post Office object’s context, the 
examples also include context information for the Post Office object.

 “Objects in the Same Container as Users’ Organizational Units” on page 33
 “Objects Mirror eDirectory Organization” on page 33
 “Objects Mirror Network Server Organization” on page 34
 “Objects in a Dedicated Container” on page 34
 “The GroupWise View in ConsoleOne” on page 35

Objects in the Same Container as Users’ Organizational Units

In the following example, the Domain object (Provo) and Post Office object (Research) reside in the 
same container (Provo) as the organizational units (Accounting, Manufacturing, R&D, and Sales) that 
contain the users. This allows you to associate the domain with a single organization and associate 
one post office with all users within the organization.

Figure 3-2   eDirectory Tree with the GroupWise Objects and Users’ Organizational Units in the Same Organization Container

Objects Mirror eDirectory Organization

The following example is similar to the previous example, except that a separate post office is created 
for each organizational unit that contains users. The Domain object (Provo) resides in the 
organization (Provo) and the Post Office objects reside in the same organizational units (Accounting, 
Manufacturing, R&D, and Sales) as the users.

Figure 3-3   eDirectory Tree with the GroupWise Objects Mirroring the eDirectory Structure
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As in the previous example, this organizational structure allows you to quickly associate users with 
their post offices. In addition, if you have thousands of users split between the different 
organizational units, this method allows you to create multiple post offices with a smaller number of 
users on each post office.

Objects Mirror Network Server Organization

Because the domain and post office have directory structures on network servers, you could also 
choose to place the Domain and Post Office objects in the same context as the servers where the 
directories will reside, as shown in the following example.

Figure 3-4   eDirectory Tree with the GroupWise Objects Located in the Same Containers as the Network Servers Where Their Directories 
Reside

Objects in a Dedicated Container

If, rather than mirroring your eDirectory or server organization, you prefer to keep all your 
GroupWise objects together, you could create a container, such as GroupWise, and place all 
GroupWise objects in that container, as shown below. 

Figure 3-5   eDirectory Tree with the GroupWise Objects in a Dedicated Organizational Unit Container

Administratively, this type of organizational structure makes it easier to restrict a GroupWise 
administrator’s object and property rights to GroupWise objects only. 

For information about GroupWise administrator rights, see “GroupWise Administrator Rights” in 
“Security Administration” in the GroupWise 8 Administration Guide.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Primary Domain Settings, specify the context where you want to create the Domain object. 
34 GroupWise 8 Installation Guide



IMPORTANT: If the context does not already exist in your eDirectory tree, create the context now.

The GroupWise View in ConsoleOne

ConsoleOne includes a GroupWise View, displayed under the GroupWise System container.

The GroupWise View filters out all non-GroupWise objects and shows how GroupWise objects relate 
to each other. For example, in the left pane, notice the Post Office object (Development) is subordinate 
to the Domain object (Provo1). You can select an object in the left pane and display its associated 
objects (User, Resource, and so forth) in the right pane.

Figure 3-6   GroupWise View in ConsoleOne

The GroupWise View is particularly useful if your GroupWise objects are placed in different contexts 
in the eDirectory tree. Rather than searching for GroupWise objects throughout the tree, you can 
administer the objects from the GroupWise View.

Some GroupWise administrative functions can only be done in the GroupWise View. This includes 
such tasks as defining users from other GroupWise systems so that they appear in your system’s 
GroupWise Address Book.

For more information about the GroupWise View, see “GroupWise View” in “System” in the 
GroupWise 8 Administration Guide.

Domain Language

The domain language determines the sort order for items in the GroupWise Address Book. 

NOTE: The list of languages displayed in ConsoleOne includes more languages than GroupWise 
supports. See “GroupWise Languages” on page 42 for a list of valid domain languages.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Primary Domain Settings, specify the language for the domain. The domain language becomes 
the default language for the domain’s post offices. 
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For more information, see “Multilingual GroupWise Systems” in “System” in the GroupWise 8 
Administration Guide.

Domain Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise 
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user in 
New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific Time) for 
a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los Angeles user’s 
calendar at 1:00 p.m. Pacific Time.

3.2.3 Planning Your Post Office

The post office contains users’ mailboxes. Like a domain, a post office requires a name, has a 
directory structure and an eDirectory object, and can be configured to support different languages 
and time zones. Post offices can be located on NetWare, Linux, and Windows servers.

The following sections prepare you to supply the GroupWise Installation program with the required 
information.

 “Post Office Name” on page 36
 “Post Office Directory” on page 37
 “Post Office Context” on page 38
 “Post Office Language” on page 38
 “Post Office Time Zone” on page 39

Post Office Name

The post office, like the domain, requires a unique name. The name is used as the Post Office object’s 
name in eDirectory. It is also used for addressing and routing purposes within GroupWise, and can 
appear in the GroupWise Address Book. The post office name can reflect any element that makes 
sense for your organization. For example, you might want the domain name to be the location (such 
as Provo) while the post office name is one of the company’s departments (such as Research).

Post office names must be a single string. Use underscores (_) rather than spaces as separators 
between words to facilitate addressing across the Internet. The same characters that are invalid in 
domain names are also invalid in post office names (see “System and Domain Names” on page 30). 

IMPORTANT: Name your post office carefully. After it is created, the name cannot be changed.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Primary Domain Settings, specify the time zone for the domain. The domain time zone becomes 
the default time zone for the domain’s post offices. 

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Post Office Settings, specify the name you’ve selected.
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Post Office Directory

The post office requires a directory structure in which to store database files and temporary files that 
are created during message routing and delivery. As you choose a location for the post office 
directory, consider the following:

 “Security” on page 37
 “Server Platform and Version” on page 37
 “POA Access” on page 37
 “Disk Space Requirements” on page 37
 “Directory Names” on page 38

Security

The GroupWise Windows and Mac/Linux clients access the post office through a client/server (TCP/
IP) connection to the Post Office Agent (POA). The WebAccess client uses an HTTP connection. 
Therefore, GroupWise users never need access to the post office directory, so you should create the 
directory in a location that you can easily secure.

Server Platform and Version

The post office directory can be located on any of the supported platforms listed in Section 2.1, 
“GroupWise Administration Requirements,” on page 17.

POA Access

The POA requires direct access to the post office directory so that it can write to the post office 
database (wphost.db). Therefore, you might want to consider the server type (NetWare, Linux, or 
Windows) and location (local or remote) of the POA before deciding on a post office directory. For 
information about the POA, see Section 3.2.4, “Planning Your GroupWise Agents,” on page 39. For 
examples of possible post office directory locations and POA configurations, see Section 3.2.5, 
“Sample GroupWise Configurations,” on page 45. 

IMPORTANT: On Linux, the POA must be installed on the same server where its directory structure 
is located. A file system mount between Linux servers does not provide the necessary file locking 
mechanisms for the GroupWise Linux POA to write to the post office database on a remote Linux 
server.

Disk Space Requirements

The post office directory holds users’ messages and attachments, so you should plan a minimum of 5 
MB per user. 100 MB or more per user is recommended. Although actual messages are relatively 
small, message attachments (documents, spreadsheets, images, and so forth) can greatly increase the 
amount of disk space used.

Using ConsoleOne, you can restrict the amount of disk space users are allowed for their mailboxes. 
When you know the number of users and the amount of disk space allocated to each user, you can 
more accurately determine the amount of disk space required for the post office.

You can reduce the amount of disk space required for the post office by forcing users to run the 
GroupWise Windows and Mac/Linux clients in Caching mode rather than Online mode. In Online 
mode, messages are stored only in the post office. In Caching mode, messages are also stored on 
users’ local drives, so you can reduce the size of users’ Online mailboxes independent of what users 
want to store in personal locations.
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In addition to user messages and attachments, the post office directory also contains a document 
library. If you want to use GroupWise document management, you should take into account the disk 
space you want to provide for storing documents. 

Plan for 100-300 MB for the post office database, which holds the GroupWise Address Book and 
updates to it for download by Remote client users. Also plan 500 MB or more for the temporary 
storage of messages when links are down.

Directory Names

You should specify an empty directory for the post office. If you want, the directory can reflect the 
post office name you chose. Use the following platform-specific conventions:

Choose the name and path carefully. After the directory is created, it is difficult to rename. If the 
directory you specify does not exist, it is created during installation.

Post Office Context

Like the Domain object, you can create the Post Office object in any Organization or Organizational 
Unit container in any context in your eDirectory tree. The only requirement is that it be in the same 
tree as the Domain object and other objects associated with the domain (User objects and so on). For 
configuration examples, see “Domain Context” on page 33.

IMPORTANT: If the context does not already exist in your eDirectory tree, create the context now.

Post Office Language

The post office language determines the sort order for items in the GroupWise Address Book. 

NOTE: The list of languages displayed in ConsoleOne includes more languages than GroupWise 
supports. See “GroupWise Languages” on page 42 for a list of valid post office languages. 

The post office assumes the same language as its domain unless you specify otherwise. For example, 
if you set the domain and post office language to English, the GroupWise Address Book items are 
sorted according to English sort order rules. This is true even if some users in the post office are 
running non-English GroupWise clients such as German or Japanese. Their client interface and Help 
files are in German or Japanese, but the sort order in the GroupWise Address Book is according to 
English standards. Time, date, and number formats for the non-English clients default to the 
workstation language.

NetWare: Use a maximum of 8 characters

Linux: Use only lowercase characters

Windows: No limitations.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Post Office Settings, specify the full path for the post office directory.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Post Office Settings, specify the context where you want to create the Post Office object. 
38 GroupWise 8 Installation Guide



For more information, see “Multilingual GroupWise Systems” in “System” in the GroupWise 8 
Administration Guide.

Post Office Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise 
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user in 
New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific Time) for 
a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los Angeles user’s 
calendar at 1:00 p.m. Pacific Time.

The post office assumes the same time zone as its domain unless you specify otherwise.

3.2.4 Planning Your GroupWise Agents

The Message Transfer Agent (MTA) and Post Office Agent (POA) route messages through the 
GroupWise system. The MTA handles all message traffic between the domain and post office, while 
the POA handles all message traffic within the post office. The GroupWise agents can run on 
NetWare, Linux, and Windows servers.

 Message Transfer Agent: GroupWise requires one MTA per domain, which means that you 
need to install and run one MTA for your basic GroupWise system.

In addition to routing user messages between post offices and between domains, the MTA 
routes administration messages from the domain to the post office. For example, when a user is 
given a GroupWise account in eDirectory, the user is added to the GroupWise domain database. 
At the same time, the MTA routes an administration message from the domain to the post office 
so that the POA can add the user to the post office database. After the user is added to the post 
office database, the post office’s users can see the newly added user’s information in the 
GroupWise Address Book 

 Post Office Agent:  GroupWise requires one POA per post office, which means that you need to 
install and run one POA for your basic GroupWise system.
The POA routes messages within the post office, updates the post office database when it 
receives administration messages from the MTA, and performs other maintenance tasks in the 
post office.

The following sections prepare you to supply the information required when installing the MTA and 
POA:

 “Agent Location” on page 40
 “POA Configuration” on page 41
 “MTA Link to the Post Office” on page 41
 “Agent Web Consoles” on page 42

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Post Office Settings, specify the language for the post office. 

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Post Office Settings, specify the time zone where the post office is located.
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 “GroupWise Languages” on page 42
 “NetWare Installation Options: Automatic Startup and Protected Mode” on page 43
 “Linux Installation Option: Automatic Startup” on page 43
 “Windows Installation Options: SNMP Traps and Service vs. Application” on page 44

Agent Location

The MTA requires direct access to the domain directory so that it can write to the domain database. 
The POA requires direct access to the post office directory so that it can write to the post office 
database.

In general, we recommend that you install an agent on the same server as its directory. For example, 
you would install the MTA on the same server as the domain directory and the POA on the same 
server as the post office directory. This ensures that the agent always has access to its directory.

Figure 3-7   Direct Access between Agents and Directories

However, if necessary, you can install the agent on a different server from its directory if you are 
using NetWare or Windows. This requires the agent to have a direct link (mapped drive or UNC 
path) to its directory on the remote server in order to function. The following diagram illustrates the 
direct links:

Figure 3-8   MTA with UNC Path or Mapped Drive to Domain and Post Office Directories; POA with UNC Path or Mapped Drive to 
the Post Office Directory

IMPORTANT: On Linux, file system mounts between Linux servers do not provide the necessary file 
locking mechanisms for the GroupWise Linux agents to access their databases on remote Linux 
servers.
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For the purpose of simplifying the setup of your basic GroupWise system, you are required to install 
both the MTA and the POA to the same server. If, at a later time, you decide that you want to run one 
of the agents on a different server, see Chapter 8, “Installing GroupWise Agents,” on page 181.

Consider these platform-specific guidelines:

POA Configuration

In order to configure the POA, you need to know the IP address or DNS hostname of the server 
where you plan to install the POA. The POA uses its client/server port to communicate with 
GroupWise clients; the default client/server port is 1677. The POA uses its message transfer port to 
communicate with the MTA; the default message transfer port is 7101. Use these default port 
numbers unless they are already in use by another program on the server where you plan to install 
the POA.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port 
Numbers” in the GroupWise 8 Administration Guide.

MTA Link to the Post Office

To route user and administration messages to the post office, the MTA requires a TCP/IP connection 
with the post office’s POA. The MTA uses its message transfer port to communicate with the POA; 
the default message transfer port is 7100. Use this default port number unless it is already in use by 
another program on the server where you plan to install the MTA.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port 
Numbers” in the GroupWise 8 Administration Guide.

NetWare: When installing the NetWare agents, we recommend you use the sys:\system directory 
on the NetWare server. This simplifies the use of startup files and ensures that the agent 
NLM programs are in the server’s search path. If you use a different directory, you must add 
that directory to the server’s search path.

Linux: The Linux agents are automatically installed to /opt/novell/groupwise/agents. On 
Linux, do not move the agent software to a different location.

Windows: The default installation directory is c:\Program Files\Novell\GroupWise 
Server\Agents. However, you can install the agents to any directory you want.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Installation for your software platform, specify the installation path for the agents.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under POA Network Address, specify the IP address or DNS hostname of the POA’s server, along with 
the required port numbers.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under MTA Network Address, specify the IP address or DNS hostname of the MTA’s server, along with 
the required port number.
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Agent Web Consoles

The MTA and POA provide agent server consoles to let you monitor and configure the agents while 
at the agent servers. The availability of agent server consoles varies by platform.

When the MTA and POA server consoles are not available, you can monitor and configure the agents 
through a Web browser. This feature, referred to as the agent Web console, lets you access the agents’ 
statistics and diagnostic information from any location where you are connected to the Internet and 
have access to a Web browser.

By default, the MTA Web console is enabled on port 7180 and the POA Web console is enabled on 
port 7181. Use these default port numbers unless they are already in use by another program on the 
server where you plan to install the agents.

In your browser, you access the agent Web consoles using the following URLs:

http://mta_network_address:port

http://poa_network_address:port

where mta_network_address and poa_network_address are the agents’ IP addresses or DNS hostnames 
and port is the agent’s HTTP port number.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port 
Numbers” in the GroupWise 8 Administration Guide.

GroupWise Languages

GroupWise 8 is available in multiple languages. Available languages are listed on the “Basic 
GroupWise System Summary Sheet” on page 68. GroupWise Administrator snap-ins for ConsoleOne 
and the GroupWise agents are available in five languages. However, the GroupWise agents can send 
administrative messages such as undeliverable notifications to the GroupWise clients in the full 
range of GroupWise client languages.

By default, the agents start in the language selected for the domain. If that language has not been 
installed, the agents start in the language used by the operating system. If that language has not been 
installed, the agents start in English.

NOTE: For NetWare and Windows, the downloadable GroupWise 8 software image is available in 
multilanguage and English-only versions. For Linux, all available languages are included in the same 
RPM, so all languages are always installed.

NetWare: The MTA and POA consoles are always displayed.

Linux: The MTA and POA consoles are displayed only if you start the agents with the --show 
startup switch on the command line or if you use the show = yes option in the GroupWise 
High Availability service configuration file (gwha.conf).

Windows: The MTA and POA consoles are displayed if you run the agents as applications but are not 
displayed if you run the agents as services.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under POA Network Address, specify the POA’s HTTP port.

Under MTA Network Address, specify the MTA’s HTTP port.
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For more information, see “Multilingual GroupWise Systems” in “System” in the GroupWise 8 
Administration Guide.

NetWare Installation Options: Automatic Startup and Protected Mode

You can have the Installation program add a reference to the grpwise.ncf file in the NetWare 
server’s autoexec.ncf file so that the GroupWise agents are automatically loaded whenever the 
server is started. 

You can also have the Installation program configure the NetWare agents to run in Protected Mode, 
which starts them in their own protected address space on the NetWare server.

Linux Installation Option: Automatic Startup

The Linux GroupWise agents are Run Control compliant. You can have the Installation program 
create symbolic links to the grpwise script in the rc3.d and rc5.d directories so that the agents load 
on restart into run level 3 or 5, depending on the configuration of your Linux system.

If you want to configure the agents for high availability, as described in “Enabling the Groupwise 
High Availability Service for the Linux GroupWise Agents” on page 209, they must be configured to 
start automatically on system startup.

NetWare 
and 
Windows:

Decide which languages you want to install.

Linux: All languages are always automatically installed. You can run any GroupWise program in 
any available language at any time.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Agent Language Selection, mark the languages you want to install for the ConsoleOne snap-ins 
and the GroupWise agents. The GroupWise Administrator languages are copied to the ConsoleOne 
location. The GroupWise agent languages are copied to the software distribution directory.

Under Client Language Selection, select the languages that you plan to install the GroupWise clients in. 
This enables the agents to send administrative messages to the clients in each user’s client language. 
The GroupWise client language files are copied to the software distribution directory.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under NetWare Installation Options, mark whether or not you want to configure the NetWare server to 
start the GroupWise agents automatically or in a protected address space.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Linux Installation Option, mark whether or not you want to configure the Linux server to start the 
GroupWise agents automatically.
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Windows Installation Options: SNMP Traps and Service vs. Application

If you are installing the GroupWise agents on Windows, you have the following additional 
installation options:

 “SNMP Services” on page 44
 “Application vs. Service” on page 44

SNMP Services

If you want the GroupWise agents to be able to communicate with SNMP management and 
monitoring programs, you must configure them for this functionality during installation. The 
Windows SNMP service must already be enabled on the Windows server in order to configure this 
functionality for the GroupWise agents.

For more information about SNMP, see the following sections in the GroupWise 8 Administration 
Guide:

 “Setting Up SNMP Services for the POA” in “Post Office Agent”
 “Setting Up SNMP Services for the MTA” in “Message Transfer Agent”

Application vs. Service

You can run the Windows MTA and POA as normal applications or as services. When you run the 
agents as Windows services, they must run under a specific user account. The user account you use 
depends on where the domain and post office directories are located: 

 When the domain and post office directories are located on the same server where you are 
installing the agents, the agents can run under the local system account. 

 When the domain and post office directories are located on a remote server, you must specify a 
user with rights to access the domain and post office directories. 

As with all Windows services, you can start the agents manually or have them start automatically 
each time the Windows server restarts.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Windows Installation Options, mark whether you want to configure the GroupWise agents to 
communicate with SNMP management and monitoring programs. If you do, ensure that the Windows 
SNMP service is enabled on the GroupWise agent server.

Windows If the Windows agents need to log in to another Windows server, provide a Windows 
username and password.

NetWare: If the Windows agents need to log in to a NetWare server, provide an existing 
eDirectory username and password, or create a new account for the agents, as 
described in “Creating a NetWare Account for Agent Access (Optional)” on page 193.

Linux: Configuring the Windows agents to log in to a Linux server is not recommended.
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NOTE: On Windows Server 2008, the Windows agents running as services cannot interact with the 
desktop. They must run as background processes.

3.2.5 Sample GroupWise Configurations

Many different configurations are possible for your GroupWise system. The following diagrams 
illustrate some of the ways a basic GroupWise system (primary domain and one post office) can be 
set up.

 “NetWare 6.5 Server” on page 45
 “Linux Server” on page 45
 “Windows Server 2003” on page 46
 “Open Enterprise Server and Windows Server 2003” on page 46

NetWare 6.5 Server

The following diagram shows a basic GroupWise system set up on a single NetWare 6.5 server.

Figure 3-9   GroupWise System Installed on a Single NetWare 6.5 Server

Linux Server

The following diagram shows all GroupWise components on a Linux server.

BASIC GROUPWISE SYSTEM SUMMARY SHEET

Under Windows: Installation Options, mark whether you want to run the GroupWise agents as Windows 
services.

If you want to run the agents as Windows services, under Windows: Service Information, record the 
account the agents will run under, and if necessary, the password for the account. Also select whether 
you want the service to start automatically or manually.
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Figure 3-10   GroupWise System Installed on a Single Linux Server

Windows Server 2003

The following diagram shows all GroupWise components on Windows Server 2003.

Figure 3-11   GroupWise System Installed on a Single Windows Server 2003 Machine

Open Enterprise Server and Windows Server 2003

The following diagram shows the domain, post office, and software distribution directory on a server 
running the NetWare version of Novell Open Enterprise Server (OES). The MTA and POA, located on 
a Windows Server 2003 machine, use a UNC path to access the domain directory and post office 
directory on the OES NetWare server.
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Figure 3-12   GroupWise System Installed on an OES NetWare Server and Windows Server 2003 Machine

The following diagram shows the domain and MTA on a NetWare 6.5 server. The post office, 
software distribution directory, and POA are on a Windows Server 2003 machine. The MTA 
communicates with the POA through TCP/IP.

Figure 3-13   GroupWise System Installed on a NetWare 6.5 Server and Windows Server 2003 Machine

NOTE: The above configuration has the MTA on one server and the POA on another. Because the 
basic GroupWise system setup requires you to install the MTA and POA on the same server, you 
would need to do additional setup to create a similar configuration.
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3.3 Setting Up a Basic GroupWise System
Follow the setup instructions for the platform where you are creating your basic GroupWise system:

 Section 3.3.1, “NetWare and Windows: Setting Up a Basic GroupWise System,” on page 48
 Section 3.3.2, “Linux: Setting Up a Basic GroupWise System,” on page 57

3.3.1 NetWare and Windows: Setting Up a Basic GroupWise System

You should have already reviewed Section 3.2, “Planning a Basic GroupWise System,” on page 26 
and filled out the summary sheet. The following sections step you through the GroupWise 
Installation program for creating a new GroupWise system.

 “Starting the Windows GroupWise Installation Program” on page 48
 “Installing Your Basic GroupWise System” on page 50
 “Starting the GroupWise Agents” on page 52
 “Setting Up and Running the GroupWise Windows Client on Your Local Machine” on page 53
 “Installing the GroupWise Administrator Snap-Ins to Additional Windows Machines” on 

page 53
 “Setting Up Predefined Installations” on page 55

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the GroupWise 
8 Interoperability Guide before starting to set up your GroupWise system.

Starting the Windows GroupWise Installation Program

1 Select an appropriate location to run the GroupWise Installation program.

2 Configure the Windows machine to ensure GroupWise database integrity across the network:
2a At the selected Windows machine, right-click the Novell Client icon (the Red N) on the 

toolbar at the bottom of your screen, then click Novell Client Properties.
2b Click Advanced Settings.
2c Set File Caching to Off.
2d Set File Commit to On.
2e Click OK to save the new Novell Client settings.
2f Reboot the Windows machine to put the new settings into effect.

NetWare: If you are setting up your basic GroupWise system on NetWare, you can run the 
Installation program from any Windows machine that meets the administrator 
machine requirements listed in Section 2.1, “GroupWise Administration 
Requirements,” on page 17.

Windows: If you are setting up your basic GroupWise system on Windows, you must run the 
Installation program from the Windows server where you want to create your initial 
domain and post office and install the Windows agents. The server must meet the 
administrator machine requirements as well as the server operating system 
requirements listed in Section 2.1, “GroupWise Administration Requirements,” on 
page 17.
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3 If you are setting up your basic GroupWise system on NetWare, map a drive to the NetWare 
server where you want to create your initial domain and post office and install the GroupWise 
agents. 

4 Log in as an Admin equivalent to the eDirectory tree in which you are creating your GroupWise 
system.

5 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run setup.exe at the root of the downloaded GroupWise 8 software image.

6 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: All available languages are included on the GroupWise 8 DVD and the multilanguage 
version of the downloaded GroupWise 8 software image, but you can select which languages you 
want to install.

The main GroupWise System Installation page appears.

7 Click Install GroupWise System, then click Yes to accept the License Agreement and display the 
Installation Type page.
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When you create a new GroupWise system, you are performing a Standard installation. Other 
installation options on this page are described in “Setting Up Predefined Installations” on 
page 55.

8 Click Next to accept the default of Standard.

9 Make sure that Create a New System is selected, then click Next.
10 Continue with Installing Your Basic GroupWise System.

Installing Your Basic GroupWise System

1 Follow the prompts to provide the following information from your Basic GroupWise System 
Summary Sheet.
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Software Platform
ConsoleOne Path
Software Distribution Directory
Software Selection
After the GroupWise Installation program has gathered this administrative information, it is 
ready to gather information about the eDirectory tree and the GroupWise objects to create.

2 Follow the prompts to provide the following information from your Basic GroupWise System 
Summary Sheet.

GroupWise System Name and System Settings
Primary Domain Settings
Post Office Settings
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After the GroupWise Installation program has gathered eDirectory information, it is ready to 
gather GroupWise agent information.

3 Follow the prompts to provide the following information from your Basic GroupWise System 
Summary Sheet.

POA Network Address
MTA Network Address
Installation Path
NetWare Installation Options or Windows Installation Option
Agent Language Selection
Client Language Selection

4 If you are installing to a Windows server, provide the following information from your Basic 
GroupWise System Summary Sheet.

Windows Service Information
5 On the Summary and Modification page:

5a Review the installation information you have provided.
5b If you need to change information, select the information to change, then click Edit Setting.
5c Specify the desired information, then click OK.

6 Click Install to start the installation.
Status messages keep you informed about the installation and system creation progress.

7 Click Finish when the installation and system creation is completed.

Starting the GroupWise Agents

The GroupWise Installation program does not start the agent for you. For instructions, see the 
instructions for your agent platform: 

 “Starting the NetWare GroupWise Agents” on page 197
 “Starting the Windows GroupWise Agents” on page 222
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IMPORTANT: The GroupWise agents must be running in order to access your GroupWise mailbox 
to send and receive messages.

Setting Up and Running the GroupWise Windows Client on Your Local Machine

To test your new GroupWise system, you can install and run the GroupWise Windows client on your 
local machine. To accomplish this test quickly, follow the instructions in the specific sections of 
Chapter 9, “Installing the GroupWise Clients,” on page 229 that are listed below, in order to create 
test GroupWise user accounts and mailboxes.

 “Assigning GroupWise Accounts to eDirectory Users” on page 230
 “Installing and Starting the GroupWise Windows Client” on page 231

As an easy test, create the test GroupWise account for your own eDirectory user. You can delete it 
after the test if you want your permanent mailbox elsewhere in the GroupWise system. Make sure 
that you can log in to the test GroupWise account. As a further test, create a second test account, 
install the client on a second machine, and exchange messages between the two users. Then skip to 
Section 4.5, “What’s Next,” on page 96. Or you can install the GroupWise Administrator snap-ins to 
additional locations, as described in Installing the GroupWise Administrator Snap-Ins to Additional 
Windows Machines.

Installing the GroupWise Administrator Snap-Ins to Additional Windows 
Machines

As part of creating your basic GroupWise system, the GroupWise Administrator snap-ins to 
ConsoleOne were installed in one location. If ConsoleOne is installed in multiple locations and if you 
want to be able to administer GroupWise from those locations, you need to install the GroupWise 
snap-ins to each ConsoleOne installation.

1 Go to the Windows machine where you want to install the GroupWise snap-ins to ConsoleOne.
2 Configure the Windows machine, as described in Step 2 in “Starting the Windows GroupWise 

Installation Program” on page 48.
3 Make sure you are logged in as an Admin equivalent and have network access to a software 

distribution directory (or the GroupWise 8 DVD or downloaded software image) and the domain 
directory.

4 Start the GroupWise Installation program (setup.exe).
5 Click Install GroupWise System, click Yes to accept the License Agreement, then click Next to 

display the GroupWise Components page.
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6 Select Install Individual Components.
7 Deselect GroupWise Agents, then click Next.

8 Deselect Copy Files to a Software Distribution Directory, then click Next.
9 Follow the prompts to install the GroupWise Administrator snap-ins to ConsoleOne on your 

current Windows machine.
10 Repeat Step 1 through Step 9 for each location where you want to install the GroupWise snap-

ins.
11 Skip to Section 3.4, “What’s Next,” on page 67.
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Setting Up Predefined Installations

Whenever you run any installation using the Windows GroupWise Installation program, from a full 
system creation to installation of a single GroupWise component, you can save all the information 
you provide during the installation into a configuration file. You then have the option of performing 
that installation again and again using the previous installation information as defaults for the next 
installation, or performing an express installation with no intervention on your part.

You can create installation configuration files to create a new GroupWise system, update an existing 
GroupWise system, and install GroupWise administration, agents (POA and MTA), and the Internet 
Agent. 

NOTE: You cannot currently create installation configuration files to install GroupWise WebAccess, 
GroupWise Monitor, the GroupWise Calendar Publishing Host, or the GroupWise Windows client. 
Predefined installations are not available when you run the Linux Installation program. Additional 
predefined installations will be available in a future GroupWise release.

 “Deciding Where to Store Installation Configuration Files” on page 55
 “Creating an Installation Configuration File” on page 55
 “Running a Predefined Installation” on page 56

Deciding Where to Store Installation Configuration Files

You can store installation configuration files in any convenient location, taking into account the 
following:

 If you run the GroupWise Installation program only from your own workstation, you can store 
the configuration files locally. However, if you want them to be available from multiple locations 
or to multiple users, you should store them on the network.

 For the least amount of interaction during predefined installations, you can create the 
configuration files with passwords stored in them. Passwords are stored in clear text. Therefore, 
if you store the configuration files with passwords, you should store them in a secure location.

Creating an Installation Configuration File

1 Create a directory where you want to store installation configuration files.
2 Run an installation that you want to repeat. 

The final Installation program page allows you to create the configuration file.
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3 Select Save Settings for a Future Installation.
4 Specify the full path and filename for the installation configuration file.

The configuration filename automatically receives a .cfg extension
5 Select Save Passwords in the Configuration File if you store your configuration files in a secure 

location and you do not want to be prompted for passwords during an express installation.
6 Click Finish to complete the current installation.

Running a Predefined Installation

1 Start the GroupWise Installation program, click Install GroupWise System, then click Yes to accept 
the License Agreement.

2 Select Predefined.
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3 Browse to and select the installation configuration file from a previous installation that you want 
to repeat.

4 If you want to run the predefined installation without intervention or if you want to stop only 
for providing passwords, select Use Predefined Settings in an Express Install.
or
If you want to use the settings in the installation configuration file as default as you run the 
Installation program yourself, do not select Use Predefined Settings in an Express Install.
This option allows you to quickly click through the Installation program pages, while adjusting 
only a few settings for the current installation.

5 Click Next to start the predefined installation.

3.3.2 Linux: Setting Up a Basic GroupWise System

You should have already reviewed Section 3.2, “Planning a Basic GroupWise System,” on page 26 
and filled out the summary sheet. The following sections step you through the GroupWise 
Installation program.

 “Starting the Linux GroupWise Installation Program” on page 57
 “Installing the GroupWise Software” on page 58
 “Selecting a Linux Mount Directory” on page 59
 “Using ConsoleOne to Create Your Basic GroupWise System” on page 60
 “Installing and Starting the Linux GroupWise Agents” on page 63
 “Setting Up and Running the GroupWise Linux Client on Your Local Machine” on page 66
 “Installing the GroupWise Administrator Snap-Ins to Additional Linux Machines” on page 67

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the GroupWise 
8 Interoperability Guide before starting to set up your GroupWise system.

If you are new to Linux, you might want to review Appendix A: Useful Linux Commands for 
Administering a GroupWise System in the GroupWise 8 Administration Guide before beginning to set 
up your GroupWise system on Linux.

Starting the Linux GroupWise Installation Program

1 Make sure that ConsoleOne is installed on your Linux server.
ConsoleOne is installed in /usr/ConsoleOne. If ConsoleOne and eDirectory have not yet been 
installed on your system, see “Novell eDirectory” on page 27.

2 At a Linux server that meets the administrator machine requirements listed in Section 2.1, 
“GroupWise Administration Requirements,” on page 17, insert the GroupWise 8 DVD. 
or
Run ./install at the root of the downloaded GroupWise 8 software image.

3 Specify the root password, then click OK.
The X Window System is required for running the GUI GroupWise Installation program. If you 
are not using the X Window System, you can install GroupWise components individually, as 
described in “Installing the GroupWise Agents Using the Text-Based Installation Program” on 
page 201. However, you must use the GUI GroupWise Installation program to create your basic 
GroupWise system.
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4 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: On Linux, all available languages are included in the GroupWise RPMs, so all languages 
are always installed.

5 Continue with Installing the GroupWise Software.

Installing the GroupWise Software

1 Click Create or Update a GroupWise System.

The list on the left details the steps the Installation program performs for you.
2 Click Next, accept the License Agreement, then click Next.
3 Follow the prompts to provide the following information from your Basic GroupWise System 

Summary Sheet.

Software Distribution Directory
Software Selection
The Installation program automatically installs the GroupWise Administrator snap-ins to 
ConsoleOne under /usr/ConsoleOne. Then, the Installation program copies the selected 
software components into your software distribution directory.
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4 When the copying is complete, click Next.

5 Select Creating a New GroupWise System, then click Next.
You use the New System utility in ConsoleOne to create your basic GroupWise system.

6 Click Run to start ConsoleOne.
7 Continue with Selecting a Linux Mount Directory.

Selecting a Linux Mount Directory

The first time you start ConsoleOne with the GroupWise Administrator snap-ins installed, you are 
prompted to specify a Linux mount directory under which you create mount points. Typically, Linux 
servers and workstations use /mnt for this purpose. In the future as your system grows, this 
information helps ConsoleOne resolve the UNC paths of GroupWise database locations into Linux 
paths. Although the mount directory information is not used when you are creating your basic 
GroupWise system, it is gathered at this time for later reference.

GroupWise databases can be located on Linux servers, NetWare servers, or Windows servers. In the 
Linux mount directory, you will eventually create mount points that have the same names as the 
servers that are mounted to those mount points. You will need to do this for each server where a 
domain or post office is located that you want to access from ConsoleOne on Linux. The following 
table illustrates the correspondence between UNC paths and mount points for GroupWise database 
locations on Linux, NetWare, and Windows, assuming the typical mount directory of /mnt:

Table 3-1   Correspondence between UNC Paths and Mount Points

Platform GroupWise Domain UNC Path Corresponding Linux Mount Point

Linux \\linux_server\gw_partition\
domain_directory

/mnt/linux_server/
gw_partition

NetWare \\netware_server\gw_volume\
domain_directory

/mnt/netware_server/
gw_volume

Windows \\windows_server\gw_share\
domain_directory

/mnt/windows_server/
gw_share
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IMPORTANT: Although NetWare and Windows are not case-sensitive operating systems, the case of 
characters in pathnames becomes significant when the directory structure is mounted to a Linux 
machine.

1 In the Linux Mount Directory dialog box, browse to and select the Linux mount directory, then 
click OK.

The typical Linux mount directory is /mnt.
In the future, you and other GroupWise administrators might have different mount points 
depending on the workstation or server where ConsoleOne runs. To change the mount directory 
later in ConsoleOne, click Tools > GroupWise System Operations > System Preferences > Linux 
Settings. The mount directory information is stored in a user-specific preferences file 
(.consoleone/SnapinPrefs.ser) in each GroupWise administrator’s home directory.

2 Continue with Using ConsoleOne to Create Your Basic GroupWise System.

Using ConsoleOne to Create Your Basic GroupWise System

ConsoleOne automatically attempts to authenticate to an eDirectory tree when it starts.

1 Fill in the following fields, then click Login to start ConsoleOne:

If the Login dialog box does not appear automatically, select the NDS object, then click File > 
Authenticate.
Login Name: Provide a Novell eDirectory username that has rights to create eDirectory objects.
Password: Provide the password for the username.
Tree: Type or select the eDirectory tree where you want to create GroupWise objects.
If the eDirectory tree is located on a Windows server, you might need to specify the IP address of 
the server instead of the tree name.
Context: Provide the full context of the User object associated with the username you provided.

2 Under the NDS object, select the tree where you want to create the GroupWise system, then click 
Tools > GroupWise Utilities > New System.
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3 Follow the prompts to provide the GroupWise system and domain information from your Basic 
GroupWise System Summary Sheet.

Software Distribution Directory
Software Selection
eDirectory Tree
eDirectory Schema Extension
System Name
Primary Domain
Domain Directory
Domain Context
Domain Language
Domain Time Zone

4 Follow the prompts to provide the GroupWise post office information from your Basic 
GroupWise System Summary Sheet.

Post Office Name
Post Office Directory
Post Office Context
Post Office Language
Post Office Time Zone

5 Follow the prompts to provide information about how to link the domain and the post office 
from your Basic GroupWise System Summary Sheet.

Post Office Link
POA Network Address
MTA Network Address
When you have provided the system, domain, post office, and agent information for your 
GroupWise system, you are ready to create users. However, adding users at this point is 
optional. After the Installation program has finished, you can add users to the post office at any 
time by using ConsoleOne. We recommend that you just add two test users at this time.
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6 Add users as needed, then click Next.
The Installation program summarizes your overall progress.

7 Click Next to display a summary of the system, domain, post office, and agent information you 
entered.
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After you have verified that the information you entered is correct, you are ready to create your 
GroupWise system.

8 Click Next to create your GroupWise system.
The Installation program summarizes your overall progress.

9 Click Next to install the MTA and POA software.
10 Continue with Installing and Starting the Linux GroupWise Agents.

Installing and Starting the Linux GroupWise Agents

At this point, the Installation program has created eDirectory objects and network server directories 
associated with your GroupWise system. You now need to install and start the MTA and POA on 
your Linux server.

 “Installing the Linux Agents” on page 63
 “Starting the Linux Agents with a User Interface” on page 64

Installing the Linux Agents

The GroupWise Installation program starts the Agent Configuration program for you.
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Figure 3-14   Introduction Page

1 Review the Introduction, then click Next.
On the Configuration Complete page, Launch GroupWise Agents on System Startup is selected by 
default.

IMPORTANT: If you want to configure the agents for high availability, as described in 
“Enabling the Groupwise High Availability Service for the Linux GroupWise Agents” on 
page 209, they must be configured to start automatically on system startup.

2 If you do not want the agents to start automatically when the server restarts, deselect Launch 
GroupWise Agents on System Startup.

3 Click Exit to complete the agent configuration.
4 Continue with Starting the Linux Agents with a User Interface.

Starting the Linux Agents with a User Interface

1 In a terminal window, become root by entering su - and the root password.
2 Change to the GroupWise agent bin directory.

cd /opt/novell/groupwise/agents/bin

3 Use one of the following commands to start the MTA:
        Syntax: 

./gwmta --show --home domain_directory &

./gwmta --show @domain_name.mta &

        Example: 

./gwmta --show --home /gwsystem/domlnx &

./gwmta --show @provo.mta &

The --show startup switch starts the MTA with a server console interface similar to that provided 
for the NetWare and Windows MTAs. This user interface requires that the X Window System 
and Open Motif be running on the Linux server.
The --home startup switch specifies the domain directory and is required to start the MTA.
The @domain.mta startup switch specifies the MTA startup files, which contains the --home 
startup switch.
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To remind yourself of these commands when you are at your Linux server, view the gwmta man 
page.
The ampersand (&) causes the MTA to run in the background, so that the terminal window you 
started it in is again available for use.

The status messages displayed on the MTA server console are also written to the MTA log file 
(mmddmta.nnn) in the /var/log/novell/groupwise/domain.mta directory. The log file name 
includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day.
In ConsoleOne, you can see that the domain database has been updated by the MTA because the 
Version field on the Identification page of the Domain object shows 8 when the database update 
is complete.

4 Wait until the domain has been updated before you start the POA.
5 Use one of the following commands to start the POA:

        Syntax: 

./gwpoa --show --home post_office_directory &

./gwpoa --show @post_office_name.poa &

        Example: 

./gwpoa --show --home /gwsystem/polnx &

./gwpoa --show @polnx.poa &

To remind yourself of these commands when you are at your Linux server, view the gwpoa man 
page.
Installing a Basic GroupWise System 65



The status messages displayed on the POA server console are also written to the POA log file 
(mmddpoa.nnn) in the /var/log/novell/groupwise/post_office.poa directory. The log file 
name includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day.
In ConsoleOne, you can see that the post office database has been updated by the POA because 
the Version field on the Identification page of the Post Office object shows 8 when the database 
update is complete.
After the post office database has been updated, you can install the GroupWise Linux client and 
connect to the post office.

6 If you want to finish setting up your basic GroupWise system, continue with Setting Up and 
Running the GroupWise Linux Client on Your Local Machine.
or
If you want to learn more about managing the GroupWise agents on Linux, skip to the following 
sections in Chapter 8, “Installing GroupWise Agents,” on page 181:
 “Starting the Linux GroupWise Agents as Daemons” on page 204
 “Monitoring the Linux GroupWise Agents from Your Web Browser” on page 205
 “Starting the Linux GroupWise Agents on System Startup” on page 206
 “Running the Linux GroupWise Agents As a Non-root User” on page 207
 “Enabling the Groupwise High Availability Service for the Linux GroupWise Agents” on 

page 209
 “Stopping the Linux GroupWise Agents” on page 215

Setting Up and Running the GroupWise Linux Client on Your Local Machine

To test your new GroupWise system, you can install and run the GroupWise Linux client on your 
local machine. To accomplish this test quickly, follow the instructions in the specific sections of 
Chapter 9, “Installing the GroupWise Clients,” on page 229 that are listed below, in order to create 
test GroupWise user accounts and mailboxes.

 “Assigning GroupWise Accounts to eDirectory Users” on page 230
 “Installing and Starting the GroupWise Linux Client” on page 235
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As an easy test, create the test GroupWise account for your own eDirectory user. You can delete it 
after the test if you want your permanent mailbox elsewhere in the GroupWise system. Make sure 
that you can log in to the test GroupWise account. As a further test, create a second test account, 
install the client software on a second machine, and exchange messages between the two users. Then 
skip to Section 4.5, “What’s Next,” on page 96. Or you can install the GroupWise Administrator snap-
ins to additional locations, as described in Installing the GroupWise Administrator Snap-Ins to 
Additional Linux Machines.

Installing the GroupWise Administrator Snap-Ins to Additional Linux Machines

As part of creating your basic GroupWise system, the GroupWise Administrator snap-ins to 
ConsoleOne were installed under /usr/ConsoleOne of the server where you ran the GroupWise 
Installation program. If ConsoleOne is installed in multiple locations and if you want to be able to 
administer GroupWise from those locations, you need to install the GroupWise snap-ins to each 
ConsoleOne installation.

1 Go to the Linux machine where you want to install the GroupWise snap-ins to ConsoleOne.
2 Make sure you are logged in as root and have network access to the software distribution 

directory (or GroupWise 8 DVD or downloaded software image) and the domain directory.
3 Start the GroupWise Installation program (install), then click Install Products > GroupWise 

Administration > Install Administration.
4 When the installation is complete, click OK, then click Configure GroupWise Administration.
5 Accept the License Agreement, then follow the prompts to provide the necessary information.
6 Repeat Step 1 through Step 5 for each location where you want to install the GroupWise snap-

ins.
7 Skip to What’s Next.

3.4 What’s Next
After you have set up your basic GroupWise system, you can expand the system by:

 Setting up access to the Internet through the GroupWise Internet Agent. See Chapter 4, 
“Installing the GroupWise Internet Agent,” on page 73.

 Setting up GroupWise WebAccess so that users can access their mailboxes through a Web 
browser on a computer or mobile device such as a cell phone. See Chapter 5, “Installing 
GroupWise WebAccess,” on page 101. 

 Setting up a GroupWise Calendar Publishing Host so that GroupWise users can share their 
personal calendars and free/busy information with Internet users. See Chapter 6, “Installing the 
GroupWise Calendar Publishing Host,” on page 135.

 Setting up GroupWise Monitor to monitor your GroupWise agents. See Chapter 7, “Installing 
GroupWise Monitor,” on page 159.

 Installing the MTA or POA on a different server than the one you installed to during the basic 
system setup. See Chapter 8, “Installing GroupWise Agents,” on page 181.

 Setting up users to run the GroupWise client on their workstations. See Chapter 9, “Installing the 
GroupWise Clients,” on page 229.

 Setting up instant messaging capabilities for users. See Chapter 10, “Installing Novell 
Messenger,” on page 239.

 Setting up synchronization between users’ GroupWise mailboxes and their mobile devices. See 
Chapter 11, “Installing the Novell Data Synchronizer Mobility Pack,” on page 241.
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 Setting up team collaboration capabilities. See Chapter 12, “Installing Novell Vibe,” on page 243.
 Setting up phone conferencing capabilities. See Chapter 13, “Installing Novell Conferencing,” on 

page 245.

After your GroupWise system is fully installed, you can refer to sections of the GroupWise 8 
Administration Guide as you maintain your GroupWise system by:

 Adding more users to the post office. See “Users”. 
 Defining resources that users can schedule. See “Resources”. 
 Defining groups of users that GroupWise users can select when addressing messages. See 

“Distribution Lists, Groups, and Organizational Roles”.
 Changing the GroupWise client from Online mode to Caching mode so that users’ messages are 

stored on a local drive as well as in the post office. See “Client”.
 Setting up GroupWise Remote so that Windows client users can access their mailboxes from a 

computer that is not directly connected to your network. See “Client”. 
 Controlling the functionality of users’ GroupWise client software. See “Client”.
 Configuring your current post office’s library or setting up additional libraries. See “Libraries 

and Documents”.
 Adding additional post offices to the domain. See “Post Offices”.
 Adding additional domains to the system. See “Domains”.
 Configuring the Post Office Agent (POA) and Message Transfer Agent (MTA) to support secure 

connections (SSL). See “Post Office Agent” and “Message Transfer Agent”.
 Connecting to other GroupWise 5.x, 6.x, 7., or 8 systems. See the GroupWise 8 Multi-System 

Administration Guide.

3.5 Basic GroupWise System Summary Sheet

Installation Program Field Value for Your GroupWise 
System Explanation

Agent Software Platform: 

 NetWare

 Windows

 Linux

Section 3.2.1, “Determining 
Installation Locations,” on page 26

ConsoleOne Directory: Section 3.2.1, “Determining 
Installation Locations,” on page 26

Software Distribution Directory: Section 3.2.1, “Determining 
Installation Locations,” on page 26
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Software Selection: 

 ConsoleOne Snapins

 GroupWise Monitor

 NetWare Agents

 Windows Agents

 GroupWise WebAccess

 GroupWise Calendar 
Publishing Host

 GroupWise Internet Agent

 GroupWise Client for 
Windows

Section 3.2.1, “Determining 
Installation Locations,” on page 26

System Settings: 

 DNS hostname or IP address 
of tree

 Username

 Context

 Password

 GroupWise system name

Section 3.2.1, “Determining 
Installation Locations,” on page 26

“System and Domain Names” on 
page 30

Primary Domain Settings: 

 Domain name

 Path to domain database

 Domain object context

 Domain language

 Domain time zone:

Section 3.2.2, “Planning Your 
Primary Domain,” on page 30

Post Office Settings: 

 Post office name

 Path to post office database

 Post office object context

 Post office language

 Post office time zone:

Section 3.2.3, “Planning Your Post 
Office,” on page 36

Installation Program Field Value for Your GroupWise 
System Explanation
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POA Network Address: 

 IP address

 DNS hostname

 Client/server port

(default 1677)

 Message transfer port

(default 7101)

 HTTP port

(default 7181)

Section 3.2.4, “Planning Your 
GroupWise Agents,” on page 39

MTA Network Address: 

 IP address

 DNS hostname

 Message transfer port

(default 7100)

 HTTP port

(default 7180)

Section 3.2.4, “Planning Your 
GroupWise Agents,” on page 39

Installation Path: “Agent Location” on page 40

NetWare Installation Options: 

 Launch the GroupWise agents 
on system startup

 Launch GroupWise agents in 
Protected Mode

“NetWare Installation Options: 
Automatic Startup and Protected 
Mode” on page 43

Linux Installation Option: 

 Launch the GroupWise agents 
on system startup

“Linux Installation Option: 
Automatic Startup” on page 43

Windows Installation Options: 

 Install and configure SNMP for 
GroupWise agents

 Install as Windows services

“Windows Installation Options: 
SNMP Traps and Service vs. 
Application” on page 44

Agent Languages to Install: 

 English

 French

 German

 Brazilian Portuguese

 Spanish

Section 3.2.4, “Planning Your 
GroupWise Agents,” on page 39

Installation Program Field Value for Your GroupWise 
System Explanation
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Client Language to Support: 

 English

 French

 German

 Brazilian Portuguese

 Spanish

 Arabic

 Chinese Traditional

 Chinese Simplified

 Czech

 Danish

 Dutch

 Finnish

 Hebrew

 Hungarian

 Italian

 Japanese

 Korean

 Norwegian

 Polish

 Russian

 Swedish

Section 3.2.4, “Planning Your 
GroupWise Agents,” on page 39

Windows Service Information: 

 Use local system account

 Allow service to interact 
with desktop

 Use this Windows user 
account

 Name of Windows user 
account

 Password

 Startup type

 Automatic

 Manual

 Disabled

“Application vs. Service” on 
page 44

Installation Program Field Value for Your GroupWise 
System Explanation
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4 4Installing the GroupWise Internet Agent

The Novell GroupWise Internet Agent enables you to send and receive messages over the Internet. 
The following sections provide information to help you successfully install the Internet Agent in your 
existing GroupWise system.

 Section 4.1, “GroupWise Internet Agent Overview,” on page 73
 Section 4.2, “Internet Agent System Requirements,” on page 77
 Section 4.3, “Planning the GroupWise Internet Agent,” on page 78
 Section 4.4, “Setting Up the Internet Agent,” on page 86
 Section 4.5, “What’s Next,” on page 96
 Section 4.6, “GroupWise Internet Agent Installation Summary Sheet,” on page 96

IMPORTANT: If you plan to install the Internet Agent in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install the Internet Agent. 

4.1 GroupWise Internet Agent Overview
The Internet Agent allows communication between GroupWise users and users of other messaging 
systems who send e-mail across the Internet. The Internet Agent picks up inbound e-mail messages 
from the Internet, converts them from RFC-822 or MIME format to the GroupWise message format, 
and then passes the converted messages to the GroupWise Message Transfer Agent (MTA).

For outgoing messages to the Internet, the GroupWise MTA passes the messages to the Internet 
Agent, which then converts the messages to Internet messaging format, and then sends them to the 
designated Internet addresses.
Installing the GroupWise Internet Agent 73



Figure 4-1   GroupWise Internet Agent Connecting a GroupWise System to the Internet

Choose from the following list of topics to learn more about the capabilities of the GroupWise 
Internet Agent. 

 “SMTP/MIME Service” on page 75
 “POP3 Service” on page 75
 “IMAP4 Service” on page 76
 “LDAP Services” on page 76
 “iCal and iMip Services” on page 76
 “Secure Connections via SSL” on page 76
 “Access Control” on page 76
 “Multiple Threading” on page 76
 “SNMP-Compliant” on page 76
 “SMP Support (NetWare Only)” on page 77
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SMTP/MIME Service

The SMTP/MIME service in the Internet Agent allows you to send and receive e-mail with standard 
encoding on attachments, international character sets, and multipart messages. Multimedia e-mail 
with images, sound, and video can also be exchanged. The service also includes these additional 
features:

 SMTP Dial-Up Service: The Internet Agent includes SMTP dial-up functionality. This can be 
useful when your system does not meet the requirements of a dedicated Internet connection, or 
when you prefer not to have a permanent Internet connection. With the SMTP dial-up feature, 
you can establish a schedule to periodically check the message store without maintaining a 
permanent link.

 Flexible Addressing: The Internet Agent offers full GroupWise addressing support, including 
system groups, nicknames, and individual users.
The Internet Agent also takes advantage of GroupWise Internet addressing, which allows 
inbound messages addressed in a variety of formats to be delivered to GW users. These formats 
include:

UserID@Internet_domain_name
UserID.PostOffice@Internet_domain_name
Last_Name.First_Name@Internet_domain_name
First_Name.Last_Name@Internet_domain_name
First_Initial_Last_Name@Internet_domain_name

 Internet Users in the Address Book: Internet users can be added to the GroupWise Address 
Book so users won’t have to remember long Internet addresses.

 Real-Time Blacklists: Organizations such as SpamCop provide lists of IP addresses that are 
known to be open relay hosts or spam hosts. You can use the real-time blacklists provided by 
such sites to protect your users from offensive spam.

 Spam Protection: Anti-spam services use different indicators to mark potential spam. One 
might use a string of asterisks; the more asterisks, the greater the likelihood that the message is 
spam. Another might use a numerical value; the higher the number, the greater the likelihood 
that the message is spam. You can configure the Internet Agent to recognize as spam whatever 
indicators your anti-spam service uses and flag such messages for processing by the client Junk 
Mail Handling feature.

 Accounting: The accounting feature provides inbound and outbound tracking of messages 
passing through Internet Agent. This lets administrators track how the Internet Agent is being 
used. GroupWise Monitor includes a Gateway Accounting report that organizes information 
gathered in Internet Agent accounting files into a format that is visually easy to read.

 DNS Name Resolution: The Internet Agent can access a DNS server directly to resolve host 
names to IP addresses, or it can rely on a relay host to perform the name resolution.

 Connect to Other GroupWise Systems Through the Internet: With passthrough addressing, 
you can connect to other GroupWise systems anywhere on the Internet and have access to all of 
the GroupWise features. The Internet simply becomes a mail transport medium for GroupWise.

POP3 Service

The Post Office Protocol 3 (POP3) service in the Internet Agent allows you to download messages 
from your GroupWise post office to a POP3 client application such as a Web browser’s e-mail 
program or a Telnet application. The Internet Agent acts as the POP3 server, providing a TCP 
connection between the user’s GroupWise post office and a POP3 client. Accessing the GroupWise 
post office via the Internet Agent’s POP3 server capability, users can retrieve their e-mail messages 
and manage them through user ID login options.
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IMAP4 Service

The GroupWise Internet Agent supports the Internet Messaging Access Protocol 4 (IMAP4). As an 
IMAP4 server, the Internet Agent allows IMAP4-compliant e-mail clients to read and manipulate 
GroupWise messages.

LDAP Services

The Internet Agent supports the Lightweight Directory Access Protocol (LDAP) directory standard 
with LDAP server capability that allows access for directory searches of GroupWise post offices. 
Using LDAP Public Access, Internet mail clients can do lookups on GroupWise users and address 
information.

iCal and iMip Services

The Internet Agent supports iCalendar (iCal), the Internet Calendaring and Scheduling core object 
specification (RFC 2445), and iMIP, the iCalendar Message-based Interoperability Protocol (RFC 
2447). When a GroupWise user sends an appointment to an external Internet user, the Internet agent 
converts the appointment into an iMIP message that can be read and accepted, declined, or canceled 
in compatible e-mail systems such as Microsoft Exchange and Lotus Notes. GroupWise users can also 
receive and accept, decline, or cancel appointments from users of these e-mail systems. Accept/
decline notifications are also exchanged between systems. In addition, tasks to an from users in other 
e-mail systems can be marked Completed.

Secure Connections via SSL

The Internet Agent supports the use of SSL for its connections to SMTP hosts, POP3 clients, IMAP4 
clients, and Internet Agent Web console. 

Access Control

The Internet Agent program includes security capabilities called Access Control that allow 
administrators to control user access to all services (SMTP/MIME, LDAP, POP3, and IMAP4). Access 
Control can help you reduce costs and provide added security.

With the SMTP/MIME service, Access Control can be used to block messages being sent to or 
received from specific host or IP addresses.

Multiple Threading

Multiple threading allows more than one send or receive process to be running concurrently. You can 
configure the number of threads to enhance the speed and performance of the Internet Agent. The 
number of threads are set separately for the SMTP/MIME service, POP3 service, IMAP4 service, and 
LDAP service.

SNMP-Compliant

The Internet Agent can be managed by any SNMP-compliant network manager, such as the alarm 
management features of Novell ZENworks Server Management.
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SMP Support (NetWare Only)

The NetWare Internet Agent supports Symmetric Multi-Processing (SMP), letting it take advantage 
of a server with multiple processors.

4.2 Internet Agent System Requirements
The following sections define the Internet Agent’s requirements:

 Section 4.2.1, “Network Server Requirements,” on page 77
 Section 4.2.2, “GroupWise System Requirements,” on page 78
 Section 4.2.3, “Internet Connectivity Requirements,” on page 78

4.2.1 Network Server Requirements

The network server where you install the Internet Agent must meet the following requirements:

 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.

 Any of the following server operating systems for the GroupWise Internet Agent:

 Novell Open Enterprise Server (OES) 2 (NetWare or Linux version) or OES 11, plus the 
latest Support Pack

 NetWare 6.5, plus the latest Support Pack
 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack

The X Window System and Open Motif are required by the GUI Internet Agent server 
console. By default, the Internet Agent runs as a daemon without a user interface.

 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 
2008 R2, plus the latest Service Pack

 Adequate server memory as required by the operating system

 Any of the following environments for running the GroupWise Installation program:

 Windows XP, Windows Vista, or Windows 7, plus the latest Service Pack, plus the Novell 
Client

 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 
2008 R2, plus the latest Service Pack, plus the Novell Client

 Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support 
Pack

 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack
The X Window System is required by the GUI GroupWise Installation program that steps 
you through the process of creating a new GroupWise system. A text-based Installation 
program is also available.

 Adequate server disk space:

 17 MB for the Internet Agent program files.
 200 MB minimum for message file processing. The actual amount is determined by the 

number and size of message files being processed at one time by the Internet Agent.
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4.2.2 GroupWise System Requirements

The GroupWise system in which you install the Internet Agent must meet the following 
requirements:

 The domain’s version must be equal to or later than the Internet Agent’s version. The domain’s 
version is determined by the Message Transfer Agent (MTA) version running for it.

 The versions of any post offices that the Internet Agent accesses on behalf of POP3 or IMAP4 
clients must be equal to or later than the Internet Agent’s version. A post office’s version is 
determined by the Post Office Agent (POA) version running for it.

4.2.3 Internet Connectivity Requirements

Before you install the Internet Agent, you need to ensure that your network is configured for Internet 
connectivity.

 Internet Connection: You can connect to the Internet by using a direct connection over a leased 
line or a standard switched telephone line.

 Internet Domain Name: You must have an Internet domain name. The domain name must be 
defined by an MX RR (mail exchanger resource record) in DNS. 

 DNS Server Access or Relay Host Access: If you want the Internet Agent to send messages 
directly to other SMTP hosts, it requires access to a DNS server for address resolution. 
Otherwise, it requires access to a relay host that can perform the address resolution and message 
routing. Make sure the server where you plan to install the Internet Agent is configured to access 
a DNS server or can access your relay host. For specific details, refer to your server 
documentation.

 IP Address: The Internet Agent’s server requires a static IP address and a fully qualified DNS 
hostname.

4.3 Planning the GroupWise Internet Agent
Use the “GroupWise Internet Agent Installation Summary Sheet” on page 96 to record your decisions 
about how to install the Internet Agent. The topics in this section present the required information in 
a convenient planning sequence. The Installation Summary Sheet organizes the information in the 
order in which you need it during installation.

 Section 4.3.1, “Selecting the Internet Agent Platform,” on page 79
 Section 4.3.2, “Gathering Server Information,” on page 79
 Section 4.3.3, “Selecting the Internet Agent Installation Directory,” on page 80
 Section 4.3.4, “Gathering Domain and Gateway Information,” on page 80
 Section 4.3.5, “Selecting the Gateway Object Name,” on page 81
 Section 4.3.6, “Specifying the Internet Mail Domain Name for Your GroupWise System,” on 

page 81
 Section 4.3.7, “Handling Outbound Mail,” on page 81
 Section 4.3.8, “Enabling the Internet Agent Web Console,” on page 82
 Section 4.3.9, “NetWare Installation Options: Automatic Startup, Protected Mode, and 

Clustering,” on page 82
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 Section 4.3.10, “Linux Installation Options: LDAP Information, Automatic Startup, and 
Clustering,” on page 83

 Section 4.3.11, “Windows Installation Options: SNMP Traps and Service vs. Application,” on 
page 84

For additional assistance in planning your GroupWise installation, see GroupWise Best Practices 
(http://wiki.novell.com/index.php/GroupWise) and GroupWise 8 Good and Bad Habits (http://
wiki.novell.com/index.php/GroupWise_8_Good_and_Bad_Habits).

IMPORTANT: If you plan to install the Internet Agent in a clustered server environment, refer to the 
GroupWise 8 Interoperability Guide as you plan your Internet Agent installation. 

4.3.1 Selecting the Internet Agent Platform

The Internet Agent is available as a NetWare NLM program, a Linux executable, and a Windows 
executable.

4.3.2 Gathering Server Information

Prior to GroupWise 7, the Internet Agent and the MTA communicated by transferring message files 
through message queue directories, as shown in diagrams in GroupWise 8 Troubleshooting 3: Message 
Flow and Directory Structure:

 “Mapped/UNC Link: Outbound Transfer to the Internet Successful”
 “Mapped/UNC Link: Inbound Transfer from the Internet Successful”

Starting in GroupWise 7, you can configure the Internet Agent so that it uses TCP/IP to communicate 
with the MTA, instead of message files, as shown in these additional diagrams:

 “TCP/IP Link: Outbound Transfer to the Internet Successful”
 “TCP/IP Link: Inbound Transfer from the Internet Successful”

The GroupWise Installation program needs to know the network address of the server where the 
Internet Agent will run. For best performance, install the Internet Agent on the same server with the 
domain it belongs to. In this configuration, in a GroupWise system with a single Internet Agent, UNC 
links between the Internet Agent and the MTA are sufficient. Therefore, the Internet Agent 
Installation program displays a default port number of 0 (zero), indicating that TCP/IP will not be 
used.

In a larger GroupWise system with multiple Internet Agents, you can configure the Internet Agent to 
communicate with the MTA by way of TCP/IP. This configuration enables you to designate an 
alternate Internet Agent for the domain. With this configuration, if the domain’s primary Internet 
Agent goes down, the MTA can fail over to another Internet Agent in your GroupWise system until 
the primary Internet Agent is up and running again. This feature is especially useful in larger 
GroupWise systems where multiple Internet Agents handle a large number of Internet messages.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Software Platform, mark whether you plan to install the Internet Agent on NetWare, Linux, or 
Windows. Review Section 4.2, “Internet Agent System Requirements,” on page 77 to ensure that the 
specific server you have selected meets the listed requirements.
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If you want to enable TCP/IP communication between the Internet Agent and the MTA, use a port 
number of 7102 or any other available port number. If you do not want to enable TCP/IP 
communication, use 0 (zero) as the port number.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port 
Numbers” in the GroupWise 8 Administration Guide.

4.3.3 Selecting the Internet Agent Installation Directory

You should install the Internet Agent on the same server where the domain directory is located. The 
Internet Agent installation directory depends on the platform where you are installing it. 

Consider these platform-specific guidelines:

4.3.4 Gathering Domain and Gateway Information

The Internet Agent requires a GroupWise gateway directory in which to store configuration 
information and work files. The gateway directory must be located under a GroupWise domain 
directory. The default directory name is gwia. If you change the name, use the following platform-
specific conventions:

After you specify the domain directory location and a gateway directory name, the GroupWise 
Installation program creates the gateway directory under the domain\wpgate directory (for example, 
provo\wpgate\gwia).

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Server Information, list the IP address and DNS hostname of the server where you plan to install 
the Internet Agent. Also, specify the port number for TCP/IP communication if you want to enable it.

NetWare: When installing the NetWare Internet Agent, we recommend that you use the 
sys:\system directory on the NetWare server. This simplifies access to the Internet 
Agent configuration file and ensures that the NLM program is in the server’s search path. If 
you use a different directory, you must add that directory to the server’s search path.

Linux: The Linux Internet Agent is automatically installed to /opt/novell/groupwise/
agents. 

Windows: The default installation directory is c:\Program Files\Novell\GroupWise 
Server\GWIA. However, you can install the Internet Agent to any directory you want.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Installation Path, record the directory where you want to install the Internet Agent software.

NetWare: Use a maximum of 8 characters

Linux: Use only lowercase characters

Windows: No limitations.
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4.3.5 Selecting the Gateway Object Name

The Internet Agent also requires a GroupWise Gateway object in Novell eDirectory. By default, it is 
named the same as the gateway directory and is referred to as the Internet Agent object. This object 
stores the Internet Agent’s information and enables configuration of the agent through ConsoleOne.

The Internet Agent’s object is created below the Domain object. If you have multiple domains, the 
GroupWise Installation program uses the Domain object associated with the domain directory where 
you are creating the Internet Agent’s gateway directory.

4.3.6 Specifying the Internet Mail Domain Name for Your GroupWise System

When e-mail users across the Internet address messages to GroupWise users, the address includes 
the Internet mail domain for your GroupWise system (for example, novell.com). Typically, the 
Internet mail domain name for your GroupWise system is the name of your company, with its 
accompanying domain type (.com, .edu, and so on).

4.3.7 Handling Outbound Mail

If the Internet Agent is connected to the Internet and is able to perform DNS name resolution, it can 
send messages from GroupWise users directly across the Internet to Internet users. However, you 
might prefer to keep the Internet Agent behind your firewall. To accomplish this, you can configure 
the Internet Agent to route all outbound messages to a relay host.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under GroupWise Domain, specify the domain name and the full path to the domain directory where you 
want to create the gateway directory, then give the gateway directory a name.

If you are installing the Linux Internet Agent, record the eDirectory context of the Domain object in LDAP 
format (for example, cn=provo3,ou=groupwise,o=corporate).

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Internet Agent Object Name, specify the name you want to give the Internet Agent’s eDirectory 
object. The default name is the same as the gateway directory name you chose under GroupWise 
Domain.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Internet Mail Domain Name, specify the name you want your GroupWise system to be known by 
across the Internet.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEETT

Under Relay Host, mark how you want to handle outbound mail. If you plan to use a relay host, specify 
the IP address of the relay host.
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4.3.8 Enabling the Internet Agent Web Console

The Internet Agent server console enables you to monitor the Internet Agent from the server where it 
is running. If you want, you can enable the Internet Agent Web console. The Web console lets you 
view the Internet Agent’s statistical and diagnostic information through a Web browser, which is 
useful if want to see the Internet Agent’s activity without physically visiting the agent’s server.

You access the Web console by entering the Internet Agent’s network address and HTTP port number 
in a Web browser (for example, http://172.16.5.18:9850). If necessary, you can change the 
Internet Agent’s default HTTP port number (9850).

If you want to restrict access to the Web console, you can assign a username and password. This can 
be any username and password you want. By default, the username and password are passed 
through a non-secure connection between the Web browser and the Internet Agent. Therefore, we 
recommend that you do not use an existing eDirectory username and password unless you secure 
this connection by using SSL. For information about securing the Internet Agent’s connections, see 
“Internet Agent” in the GroupWise 8 Administration Guide.

4.3.9 NetWare Installation Options: Automatic Startup, Protected Mode, and 
Clustering

When you install the NetWare Internet Agent, the following options specific to NetWare are available 
in the GroupWise Installation program:

 “Automatic Startup” on page 82
 “Protected Mode” on page 82
 “Novell Cluster Services” on page 83

Automatic Startup

You can have the Installation program add a reference to the gwia.ncf file in the NetWare server’s 
autoexec.ncf file so that the Internet Agent is automatically loaded whenever the server is started.

Protected Mode

You can have the Installation program configure the NetWare Internet Agent to run in Protected 
Mode, which starts it in its own protected address space on the NetWare server.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Enable Web Console, select Yes if you want to enable the Internet Agent Web console. If you 
want to restrict access to the Web console, enter a username and password. 

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under NetWare Installation Options, mark whether you want to configure the NetWare server to start the 
Internet Agent automatically.
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Novell Cluster Services

Novell Cluster Services is a server clustering system that ensures high availability and manageability 
of critical network resources including volumes (where GroupWise domains reside) and applications 
(such as the Internet Agent). Novell Cluster Services supports failover, failback, and migration of 
individually managed cluster resources. 

The NetWare Internet Agent can be configured to take advantage of the fault-tolerant environment 
provided by Novell Cluster Services if the following requirements are met:

 The domain where the Internet Agent is installed has already been created on a shared NSS 
volume in the cluster.

 The NetWare Internet Agent is being installed to a server that is part of the same cluster.

When the Internet Agent is configured for clustering, its startup file is configured with shared 
volume names rather than specific server names.

4.3.10 Linux Installation Options: LDAP Information, Automatic Startup, and 
Clustering

When you install the Linux Internet Agent, the following Linux-specific options are available in the 
Installation program:

 “LDAP Information” on page 83
 “Automatic Startup” on page 84
 “Clustering on Linux” on page 84

LDAP Information

The Installation program needs to access eDirectory through LDAP. eDirectory access is required in 
order to create the Internet Agent object. To obtain access, the Installation program needs the IP 
address and port number of an LDAP server, along with an eDirectory username and password to 
log in with. The user must have sufficient rights to create GroupWise objects in eDirectory. Because 
the Installation program uses LDAP to access eDirectory, you must provide the username in LDAP 
format. For example:

cn=admin,ou=users,o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For 
background information about SSL, see “Trusted Root Certificates and LDAP Authentication” in 
“Security Administration” in the GroupWise 8 Administration Guide.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under NetWare Installation Options, mark whether or not you want to configure the NetWare server to 
start the Internet Agent in Protected Mode.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under NetWare Installation Options, mark whether you want to configure the NetWare Internet Agent for 
clustering. If you do, follow the installation instructions in “Implementing the Internet Agent in a NetWare 
Cluster” in the GroupWise 8 Interoperability Guide, rather than the installation instructions in this guide.
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IMPORTANT: If you do not want to use SSL, the LDAP server must be configured to accept clear 
text passwords. This is configured on the server’s LDAP Group object in ConsoleOne by deselecting 
Require TLS for Simple Binds with Password. The LDAP snap-in to ConsoleOne is required in order to 
change the setting.

Automatic Startup

The Linux Internet Agent is Run Control compliant. You can have the Installation program create 
symbolic links to the grpwise script in the rc3.d and rc5.d directories so that the Internet Agent 
starts on server restart into run level 3 or 5, depending on the configuration of your Linux system.

If you want to configure the Internet Agent for high availability, as described in “Enabling the 
Groupwise High Availability Service for the Linux GroupWise Agents” on page 209, it must be 
configured to start automatically on system startup.

Clustering on Linux

On Linux, you can install the Internet Agent on Novell Cluster Services. The Linux GroupWise 
Installation program provides a Configure GroupWise for Clustering option that simplifies the process 
of installing the Linux Internet Agent on multiple nodes in the cluster. 

4.3.11 Windows Installation Options: SNMP Traps and Service vs. Application

When you install the Windows Internet Agent, you have choices about how the Internet Agent 
interacts with the Windows operating system.

 “SNMP Traps” on page 85
 “Service vs. Application” on page 85

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Linux LDAP Authentication, specify the IP address and port number of an LDAP server, a 
username in LDAP format, the password for the username, and if necessary, the full path to your SSL 
root certificate file.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Linux Installation Options, mark whether or not you want to configure the Linux server to start the 
Internet Agent automatically.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Linux Installation Options, mark whether or not you want to configure the Linux Internet Agent for 
clustering using Novell Cluster Services. If you do, follow the installation instructions provided in 
“Implementing the Internet Agent in a Linux Cluster” in Novell Cluster Services on Linux in the 
GroupWise 8 Interoperability Guide, rather than the installation instructions provided in this guide.
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SNMP Traps

If you want to use an SNMP manager program, such as the Management and Monitoring Services 
component of Novell ZENworks Server Management, to monitor the Windows Internet Agent, you 
must install some SNMP components along with the Internet Agent software.

NOTE: The NetWare and Linux Internet Agents rely on operating system components for SNMP 
functionality and do not require this installation option.

Service vs. Application

When you run the Windows Internet Agent as a service, it can start automatically and run without a 
user interface, just like any Windows service.

When you run the Windows Internet Agent as a service, it must run under a specific Windows user 
account. 

When the Internet Agent domain is located on the same server where you are installing the Internet 
Agent, the Internet Agent can run under the local system account. Installing the Internet Agent on the 
same server with its domain is recommended.

If the Internet Agent domain is located on a remote server, you must specify a user with rights to 
access the domain directory.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Windows Installation Path, mark Install and Configure SNMP for GroupWise Agents if you want to 
use an SNMP manager program.

If this option is dimmed during installation, the SNMP service has not been enabled on the Windows 
server where you are installing the Internet Agent. If you want to monitor the Internet Agent from an 
SNMP management program, the SNMP service must be enabled so you can select this option.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Windows Installation Path, mark Install as Windows Service if you want to run the Internet Agent 
as a service.

Windows If the Windows Internet Agent needs to log in to another Windows server, provide a 
Windows username and password.

NetWare: If the Windows Internet Agent needs to log in to a NetWare server, provide an existing 
eDirectory username and password, or create a new account for the agents, as described 
in “Creating a NetWare Account for Agent Access (Optional)” on page 193.

Linux: Configuring the Windows Internet Agent to log in to a Linux server is not recommended.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Windows Service Information, record the account the Internet Agent will run under, and if 
necessary, the password for the account.
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As with all Windows services, the Windows Internet Agent can be started automatically or manually 
as a service each time the Windows server restarts.

NOTE: On Windows Server 2008, the Windows Internet Agent running as a service cannot interact 
with the desktop. It must run as a background process.

4.4 Setting Up the Internet Agent
Complete the following tasks to set up the Internet Agent:

 Section 4.4.1, “Installing the Internet Agent,” on page 86
 Section 4.4.2, “Setting Up Internet Addressing,” on page 91
 Section 4.4.3, “Assigning a Postmaster,” on page 92
 Section 4.4.4, “Starting the Internet Agent,” on page 93
 Section 4.4.5, “Testing the Internet Agent,” on page 96

4.4.1 Installing the Internet Agent

As you install the Internet Agent, you are prompted to supply configuration information. You should 
have already reviewed Section 4.3, “Planning the GroupWise Internet Agent,” on page 78 and filled 
out the summary sheet. The following sections step you through the GroupWise Installation program 
for installing the Internet Agent.

 “NetWare and Windows: Installing the Internet Agent Software” on page 86
 “Linux: Installing the Internet Agent Software” on page 89

IMPORTANT: If you plan install the Internet Agent in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install the Internet Agent. 

NetWare and Windows: Installing the Internet Agent Software

To install the Internet Agent:

1 Select an appropriate location to run the GroupWise Installation program.

GROUPWISE INTERNET AGENT INSTALLATION SUMMARY SHEET

Under Windows Service Information, mark how you want the Windows Internet Agent to start each time 
the server is restarted.

NetWare: If you are installing the NetWare Internet Agent, you can run the Installation 
program from any Windows machine that meets the administrator machine 
requirements listed in Section 2.1, “GroupWise Administration Requirements,” on 
page 17.

Windows: If you are installing the Windows Internet Agent, you must run the Installation 
program at the Windows server were you want to install the Internet Agent. It must 
also meet the administrator machine requirements as well as the server operating 
system requirements listed in Section 2.1, “GroupWise Administration 
Requirements,” on page 17.
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2 Make sure that no other GroupWise agents are running on the server where you want to install 
the Internet Agent.

3 Make sure that you have access to the directory where you want to install the Internet Agent and 
to the domain directory.

4 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the 
Installation program to create the Internet Agent object.

5 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run setup.exe from the root of the GroupWise 8 software image.
or
If you have already copied the Internet Agent software to a software distribution directory, run 
setup.exe from the root of the software distribution directory to start the GroupWise 
Installation program.

6 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: All available languages are included on the GroupWise 8 DVD and the multilanguage 
version of the downloaded GroupWise 8 software image, but you can select which languages you 
want to install.

The main GroupWise System Installation page appears.

7 Click Install GroupWise System, then click Yes to accept the License Agreement and display the 
Installation Type page.
Installing the GroupWise Internet Agent 87



When you install the Internet Agent, you are performing a Standard installation. Other 
installation options on this page are described in “Setting Up Predefined Installations” on 
page 55.

8 Click Next to accept the default of Standard.

9 Select Install Individual Components, deselect GroupWise Administration and GroupWise Agents, 
then select GroupWise Internet Agent.

10 Follow the prompts, using the following information from the GroupWise Internet Agent 
Installation Summary Sheet:

Software Platform
Installation Path
NetWare Installation Options or Windows Installation Options
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Server Information
Web Console Information
Relay Host
GroupWise Domain
GroupWise Internet Agent Name
Internet Mail Domain Name

11 If you are installing to a Windows server, provide the following information from your Basic 
GroupWise System Summary Sheet:

Windows Service Information
12 On the Summary and Modification page:

12a Review the installation information you have provided.
12b If you need to change information, select the information to change, then click Edit Setting.
12c Specify the desired information, then click OK.

13 Click Install to start the Internet Agent installation.
Status messages keep you informed about the installation progress.

14 Click Finish, when the installation is complete, then skip to Section 4.4.2, “Setting Up Internet 
Addressing,” on page 91.

Linux: Installing the Internet Agent Software

As you install the Internet Agent, you are prompted to supply configuration information. Use 
Section 4.6, “GroupWise Internet Agent Installation Summary Sheet,” on page 96 to understand the 
prompts and to record your installation and configuration information.

 “Installing the Internet Agent” on page 89
 “Configuring the Internet Agent” on page 90

IMPORTANT: If you plan to install the Internet Agent in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install the Internet Agent. 

If you are new to Linux, you might want to review Appendix A: Useful Linux Commands for 
Administering a GroupWise System in the GroupWise 8 Administration Guide before you install the 
Internet Agent on Linux.

Installing the Internet Agent

1 Make sure that LDAP is running on your eDirectory server and that it is configured to accept 
login from the Installation program.
The Installation program requires eDirectory access in order to create the Internet Agent object 
in eDirectory. The Installation program uses LDAP to gain the required access.

2 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run install from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the Internet Agent software to a software distribution directory, run 
./install from the root of the software distribution directory to start the GroupWise 
Installation program.
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The X Window System is required for running the GUI GroupWise Installation program. If you 
are not using the X Window System, you can install GroupWise components individually, as 
described in “Installing the GroupWise Agents Using the Text-Based Installation Program” on 
page 201.

3 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are 
always installed.

The main GroupWise System Installation page appears.

4 Click Install Products > GroupWise Internet Agent > Install Internet Agent
5 When the installation is complete, click OK.

The Internet Agent software is installed to /opt/novell/groupwise/agents.
6 Continue with Configuring the Internet Agent.

Configuring the Internet Agent

1 After the Internet Agent files have been installed, click Configure Internet Agent.
The Internet Agent installation and configuration steps are separate so that you can install 
updated agent software without repeating the agent configuration steps.
90 GroupWise 8 Installation Guide



2 Follow the prompts, using the following information from the GroupWise Internet Agent 
Installation Summary Sheet in the order listed.

Server Information
Relay Host
Internet Mail Domain Name
Domain Directory
LDAP Authentication
Gateway Object
On the Configuration Complete page, Launch Internet Agent on System Startup is selected by 
default.

IMPORTANT: If you want to configure the Internet Agent for high availability, as described in 
“Enabling the Groupwise High Availability Service for the Linux GroupWise Agents” on 
page 209, it must be configured to start automatically on system startup.

3 If you do not want the Internet Agent to start automatically when the server restarts, deselect 
Launch Internet Agent on System Startup.

4 Click Exit to complete the configuration.
5 Continue with Setting Up Internet Addressing.

4.4.2 Setting Up Internet Addressing

When you install the GroupWise Internet Agent, GroupWise by default supports native Internet-
style addressing consisting of a username and Internet domain name (for example, 
userID@Internet_domain_name). The GroupWise Installation program provided the opportunity for 
you to specify your Internet domain name on the Mail Domain Name page. It also offered you the 
alternative of entering the information from ConsoleOne. This can be convenient if you want to 
install the Internet Agent before you have received your Internet domain name from your Internet 
Service Provider (ISP). If you selected Enter from ConsoleOne on the Mail Domain Name page during 
installation, follow the instructions below to provide the Internet domain name in ConsoleOne.

1 In ConsoleOne, select the GroupWise System object, then click Tools > GroupWise System 
Operations > Internet Addressing.

2 Click Create.
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3 Specify the Internet domain name that you have received from your ISP (for example, 
yourcompanyname.com).

4 Add a description if needed, then click OK to add the Internet domain name to the list.
5 Click OK again to save the Internet domain name as part of your GroupWise system.

For more information about Internet addressing, see “Configuring Internet Addressing” in 
“Internet Agent” in the GroupWise 8 Administration Guide.
Your GroupWise system is now configured to receive e-mail addressed to that Internet domain 
name.

6 Continue with Assigning a Postmaster.

4.4.3 Assigning a Postmaster 

The Internet requires each site to assign at least one user to be a Postmaster. The Postmaster is 
assigned to be the recipient of messages addressed to postmaster@host. 

1 In ConsoleOne, right-click the Internet Agent object, then click Properties.
2 Click GroupWise > Gateway Administrators.

3 On the Gateway Administrators page, click Add, select a GroupWise user to be the Postmaster, 
then click OK.

4 Select the user from the list, then click Postmaster.
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5 Click OK to save the information.
6 Continue with Starting the Internet Agent.

The Internet Agent can also be configured to send problem messages to the Postmaster. For 
instructions, see “Determining What to Do with Undeliverable Messages” in “Internet Agent” in the 
GroupWise 8 Administration Guide.

4.4.4 Starting the Internet Agent

After you’ve installed the Internet Agent, set up Internet addressing, and configured a Postmaster, 
you can start the Internet Agent.

 “NetWare: Starting the Internet Agent” on page 93
 “Linux: Starting the Internet Agent” on page 93
 “Windows: Starting the Internet Agent” on page 95

NetWare: Starting the Internet Agent

During installation, the Installation program copied the gwia.ncf startup file to the sys:\system 
directory (unless you specified a different directory). You use this file when you load the Internet 
Agent.

If you chose to have the Installation program add the gwia.ncf command to your autoexec.ncf, the 
Internet Agent loads whenever you start the server.

To manually start the Internet Agent:

1 At the NetWare server console, enter gwia to run the gwia.ncf file. 
If the Internet Agent does not start successfully, see “Starting the NetWare GroupWise Agents” 
on page 197.
After you have started the Internet Agent, verify that the program is running. You can monitor 
the program from the Internet Agent server console. Press F10-Options, then press F9-Stats. If 
you see an error message in the Statistics window, the program has not loaded properly.

2 If you enabled the Internet Agent Web console, you can use the following URL to view the Web 
console:

http://internet_agent_network_address:http_port

For example:

http://172.16.5.18:9850

For more information, see “Using the Internet Agent Web Console” in “Internet Agent” in the 
GroupWise 8 Administration Guide.

3 Skip to with Section 4.4.5, “Testing the Internet Agent,” on page 96.

Linux: Starting the Internet Agent

To start the Linux Internet Agent with a user interface:

1 If Sendmail, Postfix, or any other SMTP daemon is enabled on your Linux server, disable it 
before starting the Internet Agent.
For example, use the following commands to stop and disable Postfix:
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/etc/init.d/postfix stop
chkconfig postfix off

As an alternative, you could configure the Internet Agent to bind exclusively to the server IP 
address, as described in “Binding the Internet Agent to a Specific IP Address” in “Internet 
Agent” in the GroupWise 8 Administration Guide, so that the Internet Agent does not conflict with 
the default Postfix IP address of 127.0.0.1 (the loopback address).

2 If you want to use the Internet Agent for POP3 and IMAP4 mail, make sure no POP3 or IMAP4 
daemons are running on your Linux server.

3 Make sure that the MTA for the domain is running.
4 In a terminal window, become root by entering su - and the root password.
5 Change to the /opt/novell/groupwise/agents/bin directory.
6 Enter the following command to start the Internet Agent:

./gwia --show @gwia.cfg &

The --show switch starts the Internet Agent with a server console interface similar to that 
provided for the NetWare and Window Internet Agent. This user interface requires that the X 
Window System and Open Motif be running on the Linux server.
The @ startup switch points to the Internet Agent startup file and is required to start the Internet 
Agent.
The ampersand (&) causes the Internet Agent to run in the background, so that the terminal 
window you started it in is again available for use.
To remind yourself of this command when you are at your Linux server, view the gwia man 
page.

The status messages displayed on the Internet Agent server console are also written to the 
Internet Agent log file (mmddlog.nnn) in the /var/log/novell/groupwise/domain.gwia 
directory. The log file name includes the month and day when it was created, along with an 
incrementing extension to accommodate multiple log files on the same day.
After the Internet Agent starts successfully, refer to the following sections in Chapter 8, 
“Installing GroupWise Agents,” on page 181 for additional information about managing the 
Internet Agent on Linux:
 “Starting the Linux GroupWise Agents as Daemons” on page 204
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 “Monitoring the Linux GroupWise Agents from Your Web Browser” on page 205
 “Starting the Linux GroupWise Agents on System Startup” on page 206
 “Running the Linux GroupWise Agents As a Non-root User” on page 207
 “Enabling the Groupwise High Availability Service for the Linux GroupWise Agents” on 

page 209
 “Stopping the Linux GroupWise Agents” on page 215
 “Uninstalling the Linux GroupWise Agents” on page 217

7 Skip to Section 4.4.5, “Testing the Internet Agent,” on page 96

Windows: Starting the Internet Agent

1 If the domain directory is not on the Internet Agent server, map a drive to the domain directory 
as a user that has rights to access the domain directory.

2 If the Internet Agent is installed as a Windows application, click Start > All Programs > GroupWise 
Internet Agent > GroupWise Internet Agent.

or
If the Internet Agent is installed as a Windows service, click the Start menu > Control Panel > 
Administrative Tools > Services. Right-click the GWIA service, then click Start.
If the Internet Agent does not start successfully, see “Starting the Windows GroupWise Agents” 
on page 222.

3 If you enabled the Internet Agent Web console, use the following URL to log into the Web 
console:

http://internet_agent_network_address:http_port

For example:

http://172.16.5.18:9850

For more information, see “Using the Internet Agent Web Console” in “Internet Agent” in the 
GroupWise 8 Administration Guide.

4 Continue with Testing the Internet Agent.
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4.4.5 Testing the Internet Agent

After you’ve started the Internet Agent, you should send a message to ensure that the system is 
working properly. 

1 Open a new mail message in your GroupWise client.
2 In the To field, enter the Internet address of a colleague or friend that is not in your GroupWise 

system.
3 Send the message, then contact the recipient to verify that he or she received it.
4 Have the recipient reply to your message to verify that you receive the reply in your GroupWise 

mailbox.
5 Continue with What’s Next.

4.5 What’s Next
The “Internet Agent” section of the GroupWise 8 Administration Guide provides information to help 
you further configure and maintain the Internet Agent, including how to:

 Configure addressing options. See “Configuring Internet Addressing” and “Configuring How 
the Internet Agent Handles E-Mail Addresses”.

 Optimize configuration settings for the SMTP/MIME, IMAP, POP, and LDAP services. See 
“Configuring Internet Services”.

 Use SSL to secure connections between the Internet Agent and other SMTP hosts, POP/IMAP 
clients, and the Internet Agent Web console. See “Securing Internet Agent Connections with 
SSL”

 Control users’ access to SMTP/MIME (inbound and outbound), IMAP, and POP services. See 
“Controlling User Access to the Internet”

 Protect users from spam. See “Blocking Unwanted E-Mail from the Internet”
 Control logging for the Internet Agent. See “Using Internet Agent Log Files”

4.6 GroupWise Internet Agent Installation Summary Sheet

Installation Program Field Value for Your GroupWise 
System

Explanation

Agent Software Platform: 

 NetWare

 Windows

 Linux

Section 4.3.1, “Selecting the 
Internet Agent Platform,” on 
page 79

Installation Path: Section 4.3.3, “Selecting the 
Internet Agent Installation 
Directory,” on page 80
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NetWare Installation Options: 

 Launch the Internet Agent on 
system startup

 Launch the Internet Agent in 
Protected Mode

 Configure the Internet Agent 
for clustering

Section 4.3.9, “NetWare Installation 
Options: Automatic Startup, 
Protected Mode, and Clustering,” 
on page 82

Linux Installation Options: 

 Launch the Internet Agent on 
system Startup

 Configure the Internet Agent 
for clustering

Section 4.3.10, “Linux Installation 
Options: LDAP Information, 
Automatic Startup, and Clustering,” 
on page 83

Windows Installation Options: 

 Install and configure SNMP for 
the Internet Agent

 Install the Internet Agent as a 
Windows service

Section 4.3.11, “Windows 
Installation Options: SNMP Traps 
and Service vs. Application,” on 
page 84

Server Information: 

 TCP/IP address

IP address

DNS hostname

 Message transfer port

(default 7102)

Section 4.3.2, “Gathering Server 
Information,” on page 79

Enable Web Console: 

 Yes

Username

Password

HTTP port

(default 9850)

 No

Section 4.3.8, “Enabling the 
Internet Agent Web Console,” on 
page 82

Relay Host: 

 Send outbound mail directly to 
Internet hosts

 Send outbound mail through a 
relay host

IP address of the relay host 
machine

Section 4.3.7, “Handling Outbound 
Mail,” on page 81

Installation Program Field Value for Your GroupWise 
System Explanation
Installing the GroupWise Internet Agent 97



GroupWise Domain: 

 Domain directory

 Internet Agent subdirectory

 Domain context in LDAP 
format

Section 4.3.4, “Gathering Domain 
and Gateway Information,” on 
page 80

LDAP Authentication: 

Linux only

 LDAP server IP address

 Port

 Username

 Password

 Use SSL connection

 Yes

Path to SSL certificate 
file

 No

Section 4.3.10, “Linux Installation 
Options: LDAP Information, 
Automatic Startup, and Clustering,” 
on page 83

Internet Agent Object Name: 

 DNS hostname or IP address 
of tree

 Username

 Context

 Password

 Internet Agent object name

Domain name and context

“Accessing the eDirectory Tree” on 
page 27

Section 4.3.5, “Selecting the 
Gateway Object Name,” on page 81

Internet Mail Domain Name: 

 Enter from ConsoleOne

Section 4.3.6, “Specifying the 
Internet Mail Domain Name for Your 
GroupWise System,” on page 81

Installation Program Field Value for Your GroupWise 
System Explanation
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Service Information: 

Windows only

 User local system account

 Allow service to interact 
with desktop

 Use this Windows user 
account

 Name of Windows user 
account

 Password

 Startup type

 Automatic

 Manual

 Disabled

Section 4.3.11, “Windows 
Installation Options: SNMP Traps 
and Service vs. Application,” on 
page 84

Installation Program Field Value for Your GroupWise 
System Explanation
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5 5Installing GroupWise WebAccess

Novell GroupWise WebAccess enables user access to GroupWise mailboxes through Web browsers, 
WAP-enabled cellular phones, and Pocket PCs. The following sections provide information to help 
you successfully install GroupWise WebAccess (including GroupWise WebPublisher if desired) in 
your existing GroupWise system.

 Section 5.1, “GroupWise WebAccess Overview,” on page 101
 Section 5.2, “WebAccess System Requirements,” on page 105
 Section 5.3, “Planning GroupWise WebAccess,” on page 107
 Section 5.4, “Setting Up GroupWise WebAccess,” on page 115
 Section 5.5, “What’s Next,” on page 129
 Section 5.6, “GroupWise WebAccess Installation Summary Sheets,” on page 130

IMPORTANT: If you plan to install WebAccess in a clustered server environment, see the GroupWise 
8 Interoperability Guide before you install WebAccess. 

5.1 GroupWise WebAccess Overview
 Section 5.1.1, “GroupWise WebAccess Introduction,” on page 101
 Section 5.1.2, “GroupWise WebAccess Components,” on page 102
 Section 5.1.3, “One WebAccess Server vs. Two,” on page 103
 Section 5.1.4, “WebAccess Security Requirements,” on page 103
 Section 5.1.5, “GroupWise Document Viewer Agent,” on page 105

5.1.1 GroupWise WebAccess Introduction

GroupWise WebAccess, when used in a Web browser, provides most of the functionality available in 
the other GroupWise clients. For information about tasks that can be completed using the WebAccess 
client, see the WebAccess Help after installation. WebAccess client functionality on mobile devices or 
PDAs might be limited in comparison to the other GroupWise clients.

GroupWise WebAccess also includes GroupWise WebPublisher, an optional extension to GroupWise 
WebAccess. GroupWise WebPublisher lets GroupWise users publish documents from a GroupWise 
library to the Web. Web users can then view the published documents in their Web browsers.
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Figure 5-1   Login Requirements for WebAccess v.s WebPublisher

As shown above, GroupWise WebAccess requires users to have a mailbox in a GroupWise post office. 
GroupWise WebPublisher, on the other hand, is designed to provide public access to GroupWise 
library documents; WebPublisher users do not require a mailbox. 

After you’ve finished setting up GroupWise WebAccess, you should look at Section 5.5, “What’s 
Next,” on page 129 for additional information you might want to be aware of as you configure, 
maintain, and expand GroupWise WebAccess. 

5.1.2 GroupWise WebAccess Components

GroupWise WebAccess consists of four components: the WebAccess Application, the WebPublisher 
Application, the WebAccess Agent, and the Document Viewer Agent. 

Figure 5-2   GroupWise WebAccess Components

WebAccess Application: The WebAccess Application, which resides on the Web server, provides the 
WebAccess user interface. As users perform actions in the WebAccess client, the WebAccess 
Application passes information between the Web browser and the WebAccess Agent.

WebPublisher Application: The WebPublisher Application, which resides on the Web server, 
provides the WebPublisher user interface. As users perform actions in the WebPublisher client, the 
WebPublisher Application passes information between the Web browser and the WebAccess Agent.

WebAccess Agent: The WebAccess Agent receives user requests from the WebAccess Application 
and WebPublisher Application, accesses post offices and libraries to process the requests, and then 
passes information back to the applications.

The WebAccess Agent is required for both WebAccess and WebPublisher. The WebAccess 
Application must be installed in order to use WebAccess. Likewise, the WebPublisher Application 
must be installed in order to use WebPublisher.

Document Viewer Agent: The Document Viewer Agent isolates the document conversion task from 
the WebAccess Agent. The Viewer Agent can simultaneously convert multiple documents into 
HTML format. If it encounters a problem converting a document, the problem does not affect 
conversion of other documents, nor does it affect the functioning of the WebAccess Agent. Therefore, 
WebAccess users do not experience interruptions because of documents that fail to convert into 
HTML.
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5.1.3 One WebAccess Server vs. Two

The WebAccess Application and WebPublisher Application can be installed to a NetWare, Linux, or 
Windows Web server. If desired, you can install the WebAccess Agent and the Viewer Agent on the 
same server with the Web server.

Figure 5-3   The GroupWise WebAccess Application, WebPublisher Application, WebAccess Agent, and Viewer Agent Are All Installed 
on the Web Server

The server where they run together must be a Web server because the WebAccess Application is 
installed into the Web server installation.

The WebAccess Agent and Viewer Agent can also run on a different server from where the 
WebAccess Application runs.

Figure 5-4   The GroupWise WebAccess and WebPublisher Applications Are Installed on the Web Server, and the WebAccess Agent and 
Viewer Agent Are Installed on a NetWare or Windows Server 

Security, which discussed in Section 5.1.4, “WebAccess Security Requirements,” on page 103, might 
also determine whether you run the WebAccess Agent and Viewer Agent on the same server as the 
Web server.

5.1.4 WebAccess Security Requirements

GroupWise WebAccess can be configured to support the level of security you have established for 
your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use WebAccess on a 
secured intranet), you can install the WebAccess components to any servers that provide access for 
your users and meet the requirements listed in Section 5.2, “WebAccess System Requirements,” on 
page 105. 
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If you plan to use WebAccess to provide users with access to their mailboxes from anywhere on the 
Internet (rather than simply within a secured intranet), and you already have a firewall in place to 
provide security, you have the following options for configuring WebAccess:

 Install all WebAccess components inside your firewall and use a proxy service. See 
“Configuration with a Proxy Service” on page 104. This is the recommended configuration.

 Install the WebAccess and WebPublisher Applications on a Web server outside your firewall and 
the WebAccess Agent and Viewer Agent on a server inside your firewall. See “Configuration 
without a Proxy Service” on page 104.

Configuration with a Proxy Service

If your firewall includes a proxy service, you can install the WebAccess Application and 
WebPublisher Application to a Web server inside your firewall, and the WebAccess Agent and 
Viewer Agent to another server inside the firewall, as shown in the following illustration.

Figure 5-5   WebAccess Installed inside the Firewall

If desired, the WebAccess Agent and Viewer Agent can also be installed to the Web server rather than 
a separate server, as discussed in Section 5.1.3, “One WebAccess Server vs. Two,” on page 103.

Configuration without a Proxy Service

If your firewall does not provide a proxy service, you need to install the WebAccess Application and 
WebPublisher Application to a Web server that is outside the firewall. Because the WebAccess Agent 
requires direct access (mapped drive or UNC path) to a GroupWise domain directory, it needs to be 
installed to a server that is located within the firewall.

Figure 5-6   WebAccess Installed outside the Firewall

The firewall must allow inbound IP packets to be sent from the Web server to the IP address and port 
number of the WebAccess Agent (for example, 172.16.5.18:7205).

In addition, the firewall must allow outbound IP packets to be sent from the WebAccess Agent to the 
Web server. This requires all high ports (above 1023) to be open to outbound IP packets. 
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5.1.5 GroupWise Document Viewer Agent

The documents that users attach to e-mail messages are as varied as the combinations of document 
formats, tools, and users throughout the world. In order to display documents in your Web browser, 
WebAccess must convert them to HTML. Because some documents contain unexpected data, 
WebAccess cannot convert them. Before GroupWise 7, the WebAccess Agent sometimes shut down 
when it could not convert a document. This occurrence then interrupted the activities of all 
WebAccess users.

Starting in GroupWise 7, the Document Viewer Agent resolved the problem by taking over the 
document conversion task from the WebAccess Agent. The Viewer Agent processes multiple 
documents simultaneously, and if it encounters a problem with a document, the problem does not 
affect its processing of other documents, nor does it affect the functioning of the WebAccess Agent. 
Therefore, WebAccess users no longer experience interruptions because of documents that fail to 
convert into HTML.

The Viewer Agent is automatically installed along with the WebAccess Agent, and the WebAccess 
Agent manages the Viewer Agent, starting and stopping it as needed. The default configuration of 
the Viewer Agent is sufficient to provide basic document conversion functionality. The default 
configuration includes a minimum of 5 worker threads that run independently of the Viewer Agent 
process. Additional Viewer Agent functionality can be enabled using startup switches in the Viewer 
Agent startup file (gwdva.dva). Configuring the Viewer Agent in ConsoleOne is not currently 
possible. For more information, see “Configuring the Document Viewer Agent” in “WebAccess” in 
the GroupWise 8 Administration Guide.

5.2 WebAccess System Requirements
 GroupWise 8 system: The GroupWise 8 WebAccess Agent can only access GroupWise 8 post 

offices and libraries

 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.

 Any of the following server operating systems for the WebAccess Agent and the Viewer Agent:

 Novell Open Enterprise Server (OES) 2 (NetWare or Linux version) or OES 11, plus the 
latest Support Pack

 NetWare 6.5, plus the latest Support Pack
 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack 
 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 

2008 R2, plus the latest Service Pack

 Adequate server memory as required by the operating system

NOTE: On NetWare only, the Document Viewer Agent requires 1 GB of memory for its own use 
in its default configuration of 5 worker threads.

 Any of the following Web servers for the WebAccess Application and the WebPublisher 
Application:
 NetWare 6.5: Apache 2.0 plus:

 Tomcat 4.1
 JVM 1.4.2
 Jakarta Connector 1.2
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 OES 2 Linux / SLES 10: Apache 2.2 plus:
 Tomcat 5.0 or later
 JVM 1.4.2 or later
 ModProxy Module

 OES 11 / SLES 11: Apache 2.2 plus:
 Tomcat 6.0 or later
 JVM 1.5 or later
 ModProxy Module

 Windows Server 2003/2003 R2: Microsoft Internet Information Server (IIS) 6 or later plus:
  Tomcat 5.5 or later
 JVM 1.5 or later
 Jakarta Connector 1.2 or later

 Windows Server 2008/2008 R2: Microsoft Internet Information Server (IIS) 7 or later plus:
 Tomcat 5.5 or later
 JVM 1.5 or later
 Jakarta Connector 1.2 or later

 Any of the following Web browsers for the WebAccess client and the WebAccess Agent Web 
console:
 Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox 
 Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox
 Linux: Mozilla Firefox

 Any mobile device that supports Wireless Access Protocol (WAP) and has a microbrowser that 
supports Hypertext Markup Language (HTML) 4.0 or later, or Wireless Markup Language 
(WML) 1.1 or later

 Any of the following environments for running the GroupWise Installation program:

 Windows XP, Windows Vista, or Windows 7, plus the latest Service Pack, plus the Novell 
Client

 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 
2008 R2, plus the latest Service Pack, plus the Novell Client

 Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support 
Pack

 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack
The X Window System is required by the GUI GroupWise Installation program that steps 
you through the process of creating a new GroupWise system. A text-based Installation 
program is also available.

 Adequate server disk space:

 Approximately 215 MB for the WebAccess program files (111 MB shared with Monitor; 
varies by platform)

 Approximately 50 MB for the Document Viewer Agent program files (varies by platform)
 Adequate disk space for the document cache and document quarantine used by the 

associated Document Viewer Agent, as described in “Configuring the Document Viewer 
Agent” in “WebAccess” in the GroupWise 8 Administration Guide 
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5.3 Planning GroupWise WebAccess
Use the “GroupWise WebAccess Installation Summary Sheets” on page 130 to record your decisions 
about how to install WebAccess. The topics in this section present the required information in a 
convenient planning sequence. The Installation Summary Sheets organize the information in the 
order in which you need it during installation.

 Section 5.3.1, “Deciding Where to Install the GroupWise WebAccess Components,” on page 107
 Section 5.3.2, “Determining the WebAccess Agent’s Configuration,” on page 108
 Section 5.3.3, “Determining the WebAccess and WebPublisher Applications’ Configuration,” on 

page 114

For additional assistance in planning your GroupWise installation, see GroupWise Best Practices 
(http://wiki.novell.com/index.php/GroupWise) and GroupWise 8 Good and Bad Habits (http://
wiki.novell.com/index.php/GroupWise_8_Good_and_Bad_Habits).

IMPORTANT: If you plan to install WebAccess in a clustered server environment, refer to the 
GroupWise 8 Administration Guide as you plan your WebAccess installation. 

5.3.1 Deciding Where to Install the GroupWise WebAccess Components

After reviewing Section 5.1, “GroupWise WebAccess Overview,” on page 101 and the system 
requirements listed in Section 5.2, “WebAccess System Requirements,” on page 105, plan where you 
want to install the WebAccess components in your system. 

 “Web Access Server” on page 107
 “Web Server” on page 108

Web Access Server

For best performance, the WebAccess Agent should be installed on the same server where the 
domain it belongs to is located. If you need to install it on a remote server, you can create a secondary 
domain on the remote server so that the WebAccess Agent has a local domain and MTA to 
communicate with. The default installation directories are

NetWare: sys:\system

Linux: /opt/novell/groupwise/agents

Windows: c:\Program Files\Novell\GroupWise Server\WebAccess

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Agent Software Platform, mark the platform where you will install the WebAccess Agent.

Under Server Information, specify the directory where you want to install the WebAccess Agent software.
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Web Server

The WebAccess Application integrates with your Web server. The location of the Monitor Application 
files that are installed depends on the Web server that it is being integrated with. The default Web 
server paths vary by platform:

The Web server uses a servlet engine in order to incorporate product-specific components, such as 
the WebAccess Application, into its functioning.

IMPORTANT: Starting with GroupWise 8, you must update the WebAccess Agent and the 
WebAccess Application at the same time. Mixed-version configurations are no longer supported.

5.3.2 Determining the WebAccess Agent’s Configuration

As you install the WebAccess Agent, you are prompted to supply the configuration information 
described in the following sections:

 “Network Address” on page 108
 “Gateway Directory Location and Name” on page 109
 “Gateway Object Name” on page 109
 “Domain and Post Office Access” on page 110
 “Web Console” on page 111
 “WebPublisher” on page 111
 “NetWare Installation Option: Clustering” on page 112
 “Linux Installation Options: LDAP Information and Clustering” on page 112
 “Windows Installation Options: SNMP Traps and Service vs. Application” on page 113

Network Address

The WebAccess Agent communicates with the WebAccess Application and WebPublisher 
Application (on the Web server) through TCP/IP.

Apache Web Server for NetWare: drive:\Apache2

Apache Web Server for OES Linux:

Tomcat for OES Linux:

/etc/opt/novell/httpd/conf.d

/var/opt/novell/tomcat5/webapps

Apache Web Server for SLES:

Tomcat for SLES:

/etc/apache2/conf.d

/srv/www/tomcat5/base/webapps

Microsoft Internet Information Server 
(IIS) for Windows:

c:\inetpub\wwwroot

GROUPWISE WEBACCESS APPLICATION INSTALLATION SUMMARY SHEET

Under Web Server Information, select the type of Web server where you will install the WebAccess 
Application and WebPublisher Application, then specify the Web server’s root directory. 

On Windows, if the Internet Information Server services more than one Web site, specify the Web site 
where you want to install the WebAccess Application.
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For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port 
Numbers” in the GroupWise 8 Administration Guide.

Gateway Directory Location and Name

The WebAccess Agent requires a GroupWise gateway directory in which to store configuration 
information and work files. The gateway directory must be located under a GroupWise domain 
directory. The default directory name is webac80a. If you change the name, use the following 
platform-specific conventions:

After you specify the domain directory location and a gateway directory name, the Installation 
program creates the gateway directory under the domain\wpgate directory (for example, 
provo\wpgate\webac80a).

Gateway Object Name

The WebAccess Agent also requires a GroupWise Gateway object in Novell eDirectory. By default, it 
is named the same as the gateway directory and is referred to as the WebAccess Agent object. This 
object stores the WebAccess Agent’s information and enables configuration of the agent through 
ConsoleOne.

The WebAccess Agent object is created below the Domain object. If you have multiple domains, the 
Installation program uses the Domain object associated with the domain directory where you are 
creating the WebAccess Agent gateway directory.

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Server Address, specify the IP address or DNS hostname of the WebAccess Agent’s server, then 
specify the port number for the agent to use. The default is 7205.

NetWare: Use a maximum of 8 characters

Linux: Use only lowercase characters

Windows: No limitations.

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Gateway Directory, specify the domain name and the full path to the domain directory where you 
want to create the gateway directory, then give the gateway directory a name. If you are installing the 
WebAccess Application on a different server from where you are installing the WebAccess agent, record 
the gateway directory on the GroupWise WebAccess/WebPublisher Application Installation Summary 
Sheet as well.

If you are installing the Linux WebAccess Agent, record the eDirectory context of the Domain object (for 
example, cn=provo3,ou=groupwise,o=corporate).

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Gateway Object, specify the name you want to give the WebAccess Agent object. The default 
name is the same as the gateway directory name you chose under Gateway Directory.
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Domain and Post Office Access

The WebAccess Agent requires access to the domain. It also requires access to each post office where 
mailboxes or libraries are located that WebAccess or WebPublisher users will access.

 Domain: The WebAccess Agent needs direct access to the domain directory so that it can write 
to its gateway directory (domain\wpgate\webac80a). If the WebAccess Agent cannot be 
installed on the same server where the domain directory is located, you can create an 
intermediary domain on the WebAccess Agent server so that the WebAccess Agent has a local 
MTA to communicate with.

 Post Office: The WebAccess Agent needs direct access to the post office directory so that it can 
write to the POA’s input queue, or it needs client/server access (TCP/IP) to the post office’s POA. 
By default, the WebAccess Agent uses whatever access mode has been established for the post 
office on the Post Office Settings property page of the Post Office object in ConsoleOne. TCP/IP 
is highly recommended.

If the WebAccess Agent must access a remote server in order to access a domain or post office, it 
needs to be able to log in to the remote server.

NetWare: Ensure that an eDirectory user account exists that provides the required access to the 
domain and post office directories. For direct access to the domain directory or a post 
office directory, the WebAccess Agent needs Read, Write, Create, Erase, Modify, and File 
Scan rights.

Windows: Ensure that a Windows user account exists on the Windows server for the agent.

If the domain or any post office directories directly accessed by the WebAccess Agent are 
on remote Windows servers, ensure that the Windows user account provides Full Control 
access to those directories.

If the domain directory or any post office directories directly accessed by the WebAccess 
Agent are on remote NetWare servers, ensure that the WebAccess Agent has an 
eDirectory user account with the same username and password as the agent’s Windows 
user account. The eDirectory account must provide Read, Write, Create, Erase, Modify, 
and File Scan rights to the directories.

GROUPWISE WEBACCESS INSTALLATION SUMMARY SHEET

Under NetWare eDirectory Authentication, specify the eDirectory username and password you want the 
WebAccess Agent to use to access the domain directory and post office directories. This applies to the 
NetWare WebAccess Agent only.

If you are using the Windows WebAccess Agent, ensure that the appropriate Windows and eDirectory 
user accounts exist. Specify them under WIndows Service User and NetWare eDirectory Authentication 
so that the Windows WebAccess Agent can access domains on Windows and NetWare servers.
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Web Console

The WebAccess Agent server console enables you to monitor the WebAccess Agent from the server 
where it is running. If you want, you can enable the WebAccess Agent Web console. The Web console 
lets you view the WebAccess Agent’s statistical and diagnostic information through a Web browser, 
which is useful if want to see the WebAccess Agent’s activity without physically visiting the agent’s 
server.

You access the Web console by entering the WebAccess Agent’s network address and HTTP port 
number in a Web browser (for example, http://172.16.5.18:7211). If necessary, you can change 
the WebAccess Agent’s default HTTP port number (7211).

If you want to restrict access to the Web console, you can assign a username and password. This can 
be any username and password you want. By default, the username and password are passed 
through a non-secure connection between the Web browser and the WebAccess Agent. Therefore, do 
not use an existing eDirectory username and password unless you secure this connection by using 
SSL. For information about securing the WebAccess Agent’s connections, see “WebAccess” in the 
GroupWise 8 Administration Guide.

WebPublisher

You can choose whether or not you want the WebAccess Agent to support GroupWise WebPublisher. 
If you enable WebPublisher support, you need to specify a GroupWise account (mailbox ID and 
password). The GroupWise account serves two purposes:

 GroupWise users publish documents to WebPublisher users by sharing the documents with this 
GroupWise account.

 When Internet users access WebPublisher, the WebAccess Agent logs in to this GroupWise 
account. This lets the WebAccess Agent know which documents have been shared with 
WebPublisher users. It can then retrieve these documents (and only these documents) for the 
WebPublisher users.

Create a new GroupWise account specifically for GroupWise WebPublisher. If you’ve already created 
an eDirectory account for the WebAccess Agent to use when accessing domain or post office 
directories, as described in “Domain and Post Office Access” on page 110, you might want to create 
the GroupWise account under that eDirectory user account.

If you enable GroupWise WebPublisher support, you need to select the libraries that you want to 
make public. The WebAccess Agent, acting on behalf of WebPublisher users, only accesses 
documents in public libraries.

Making a library public does not automatically give WebPublisher users access to all documents in 
the library. For WebPublisher users to have access to a document in a public library, the document’s 
owner must have shared the document with the WebPublisher user account. 

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Enable Web Console, select Yes if you want to enable the Web console. If you want to restrict 
access to the Web console, provide a username and password. 

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under WebPublisher Support, select Yes if you want to enable the WebAccess Agent to support 
WebPublisher, then enter the Mailbox ID and password for the GroupWise account you want the 
WebAccess Agent to use. 
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NOTE: When a WebPublisher user requests a library document in HTML format rather than its 
native format, the Viewer Agent renders the document from its native format to HTML format. The 
Viewer Agent can be configured to cache the HTML document to a subdirectory of the WebAccess 
Agent installation directory. This enables the WebAccess Agent to use the cached document for 
future requests. For instructions to configure the Viewer Agent, see “WebAccess” in the GroupWise 8 
Administration Guide.

NetWare Installation Option: Clustering

Novell Cluster Services is a server clustering system that ensures high availability and manageability 
of critical network resources including volumes (where GroupWise domains and post offices reside) 
and applications (such as the GroupWise WebAccess Agent). Novell Cluster Services supports 
failover, failback, and migration of individually managed cluster resources. 

During installation, the NetWare WebAccess Agent can be configured to take advantage of the fault-
tolerant environment provided by Novell Cluster Services if the following requirements are met:

 The domains and post offices to be serviced by the NetWare WebAccess Agent have already 
been created on shared NSS volumes in the cluster.

 The NetWare WebAccess Agent is being installed to a server that is part of the same cluster.

When the WebAccess Agent is configured for clustering, its startup file (webac80a.waa) is configured 
with shared volume names rather than specific server names.

Linux Installation Options: LDAP Information and Clustering

When you install the Linux WebAccess Agent, the following Linux-specific options are available in 
the Installation program:

 “LDAP Information” on page 112
 “Clustering on Linux” on page 113

LDAP Information

If you are installing the Linux WebAccess Agent and WebAccess Application, the Installation 
program needs to access eDirectory through LDAP. eDirectory access is required in order to create 
the WebAccess Agent and WebAccess Application objects. To obtain access, the Installation program 
needs the IP address and port number of an LDAP server, along with an eDirectory username and 

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under WebPublisher Libraries, list the libraries from which documents can be shared. The Installation 
program lists all libraries in your GroupWise system. If you want, you can wait until then to select 
libraries.

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Server Address, mark whether or not you want to configure the NetWare WebAccess Agent for 
clustering. If you do, follow the installation instructions in “Implementing WebAccess in a NetWare 
Cluster” in “Novell Cluster Services on NetWare” in the GroupWise 8 Interoperability Guide, rather than 
the installation instructions in this guide.
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password to log in with. The user must have sufficient rights to create GroupWise objects in 
eDirectory. Because the Linux Installation program uses LDAP to access eDirectory, you must 
provide the username in LDAP format. For example:

cn=admin,ou=users,o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For 
background information about SSL, see “Trusted Root Certificates and LDAP Authentication” in 
“Security Administration” in the GroupWise 8 Administration Guide. 

IMPORTANT: If you do not want to use SSL, the LDAP server must be configured to accept clear 
text passwords. This is configured on the server’s LDAP Group object in ConsoleOne by deselecting 
Require TLS for Simple Binds with Password. The LDAP snap-in to ConsoleOne is required in order to 
change the setting.

Clustering on Linux

On Linux, you can install the WebAccess Agent on Novell Cluster Services. The Linux GroupWise 
Installation program provides a Configure GroupWise for Clustering option that simplifies the process 
of installing the Linux WebAccess Agent on multiple nodes in the cluster. 

Windows Installation Options: SNMP Traps and Service vs. Application

The Windows WebAccess Agent can be configured to support SNMP. This enables the WebAccess 
Agent to be monitored and managed through an SNMP management program.

NOTE: The NetWare and Linux WebAccess Agents rely on operating system components for SNMP 
functionality and do not require this installation option.

The WebAccess Agent can run as a Windows service rather than a standard Windows application. To 
do so, the WebAccess Agent service requires a user account. The requirements for the Windows 
service user account are the same as those listed for the Windows WebAccess Agent in “Domain and 
Post Office Access” on page 110. 

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Linux LDAP Authentication, specify the IP address and port number of an LDAP server, a 
username in LDAP format, the password for the username, and if necessary, the full path to your SSL 
root certificate file.

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Linux Installation Options, mark whether you want to configure the Linux WebAccess Agent for 
clustering using Novell Cluster Services. If you do, follow the installation instructions in “Implementing 
WebAccess in a Linux Cluster” in Novell Cluster Services on Linux in the GroupWise 8 Interoperability 
Guide, rather than the installation instructions in this guide.

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

If you want the WebAccess Agent to support SNMP, under Windows Execution, select Install and 
Configure SNMP for WebAccess Agent. 
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NOTE: On Windows Server 2008, the Windows WebAccess Agent running as a service cannot 
interact with the desktop. It must run as a background process.

5.3.3 Determining the WebAccess and WebPublisher Applications’ 
Configuration

As you install the WebAccess Application and/or the WebPublisher Application to a Web server, you 
are prompted to supply the configuration information described in the following sections:

 “Default Language” on page 114
 “eDirectory Objects and Configuration Files” on page 114

NOTE: You should have already selected the Web server where you will install the WebAccess 
Application and WebPublisher Application. If you have not, see Section 5.3.1, “Deciding Where to 
Install the GroupWise WebAccess Components,” on page 107.

Default Language

The Installation program installs all available languages. You need to specify which language should 
be used when displaying the Novell Web Services page. When users access the Novell Web Services 
page, they can use the default language for WebAccess or WebPublisher, or they can select another 
language.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 8 Administration 
Guide.

eDirectory Objects and Configuration Files

WebAccess Application and WebPublisher Application configuration information is stored in two 
places: 

 eDirectory objects

GROUPWISE WEBACCESS AGENT INSTALLATION SUMMARY SHEET

Under Windows Execution Options, select Run WebAccess Agent as a Windows Service.

Under Windows Service User, enter the username and password for the service’s user account. 

GROUPWISE WEBACCESS APPLICATION INSTALLATION SUMMARY SHEET

Under Default Language, specify the language for the Novell Web Services page.
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 The webacc.cfg and webpub.cfg files, located in the following directories:

The WebAccess Application object and WebPublisher Application object allow you to easily modify 
configuration information in ConsoleOne. The eDirectory information is the master information; any 
changes made to the objects in eDirectory are also written to the configuration files.

In some installation scenarios, such as installing to a Web server outside a firewall, you might not 
have access to eDirectory, which means the Installation program cannot create the objects. It can, 
however, still create the configuration files on the Web server. In this case, to change the application’s 
configuration, you need to manually modify the webacc.cfg and webpub.cfg files. 

You need to select the eDirectory container where you want the objects created. They are all created 
in the same container. The default container is the Domain object, which means the objects are 
created beneath the Domain object along with the MTA, Internet Agent, and WebAccess objects.

NOTE: Each application also has several providers associated with it. For example, the WebAccess 
Application has a GroupWise Provider and an LDAP Provider. The GroupWise Provider is the 
component that actually communicates with the WebAccess Agent to request information for users. 
The LDAP Provider communicates with LDAP servers to enable users to search LDAP address 
books. Provider objects are created in the same location as the application objects.

5.4 Setting Up GroupWise WebAccess

IMPORTANT: Starting with GroupWise 8, you must update the WebAccess Agent and the 
WebAccess Application at the same time. Mixed-version configurations are no longer supported.

 Section 5.4.1, “NetWare and Windows: Setting Up GroupWise WebAccess,” on page 115
 Section 5.4.2, “Linux: Setting Up GroupWise WebAccess,” on page 122
 Section 5.4.3, “Testing GroupWise WebAccess and WebPublisher,” on page 127

5.4.1 NetWare and Windows: Setting Up GroupWise WebAccess

Complete the following tasks to set up GroupWise WebAccess and WebPublisher: 

 “Installing the WebAccess Agent” on page 116
 “Installing the WebAccess Application and WebPublisher Application” on page 118
 “Starting GroupWise WebAccess” on page 121

NetWare: sys:\novell\groupwise\webaccess
sys:\novell\groupwise\webpublisher

Linux: /var/opt/novell/groupwise/webaccess
/var/opt/novell/groupwise/webpublisher

Windows c:\novell\groupwise\webaccess
c:\novell\groupwise\webpublisher

GROUPWISE WEBACCESS APPLICATION INSTALLATION SUMMARY SHEET

Under WebAccess Application Object and if needed, under WebPublisher Application Object, specify the 
tree where you want the objects created, then specify the context. If you will be installing from a location 
where you don’t have access to eDirectory, you can skip this item.
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IMPORTANT: If you plan to install GroupWise WebAccess in a clustered server environment, see 
the GroupWise 8 Interoperability Guide before you install WebAccess. 

Installing the WebAccess Agent

The following steps provide instructions for installing the WebAccess Agent. For information about 
installing the WebAccess and WebPublisher Applications to a Web server, see “Installing the 
WebAccess Application and WebPublisher Application” on page 118.

1 Select an appropriate location to run the GroupWise Installation program.

2 Make sure that no other GroupWise agents are running on the server where you want to install 
the WebAccess Agent.

3 Make sure that you have access to the directory where you want to install the WebAccess Agent 
and to the domain directory.

4 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the 
Installation program to create the WebAccess Agent object.

5 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run setup.exe from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the WebAccess Agent software to a software distribution directory, 
run setup.exe from the root of the software distribution directory to start the GroupWise 
Installation program.

6 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: All available languages are included on the GroupWise 8 DVD and the multilanguage 
version of the downloaded GroupWise 8 software image, but you can select which languages you 
want to install.

The main GroupWise System Installation page appears.

NetWare: If you are installing the NetWare WebAccess Agent, you can run the Installation 
program from any Windows machine that meets the administrator machine 
requirements listed in Section 2.1, “GroupWise Administration Requirements,” on 
page 17.

Windows: If you are installing the Windows WebAccess Agent, you must run the Installation 
program at the Windows server were you want to install the WebAccess Agent. It 
must also meet the administrator machine requirements and server operating 
system requirements listed in Section 2.1, “GroupWise Administration 
Requirements,” on page 17.
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7 Click More Components, then click Install WebAccess.
8 Select the interface language for the Installation program, then click OK.
9 Click Yes to accept the License Agreement and display the GroupWise WebAccess: Components 

dialog box.

10 Select GroupWise WebAccess Agent and deselect GroupWise WebAccess Application and GroupWise 
WebPublisher Application.
You can also install the WebAccess Application and WebPublisher Application to your Web 
server at this time, if you have the appropriate Web server file system access and eDirectory 
access, as described in “Installing the WebAccess Application and WebPublisher Application” 
on page 118.

11 Follow the prompts to provide information about WebAccess Agent configuration, using the 
following information from the GroupWise WebAccess Agent Installation Summary Sheet.

Server Information
Server Address
Gateway Directory
Gateway Object
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Windows Execution (Windows only)
Directory Authentication (NetWare only)
Windows Service User (Windows only)
Enable Web Console
WebPublisher Support (WebPublisher only)
WebPublisher Libraries (WebPublisher only)

12 If you are installing the WebAccess Application and WebPublisher Application along with the 
WebAccess Agent, skip to Step 12 in Installing the WebAccess Application and WebPublisher 
Application.
or
If you are installing the WebAccess Application and WebPublisher Application on a different 
server as a separate task, continue with Step 1 in Installing the WebAccess Application and 
WebPublisher Application.

Installing the WebAccess Application and WebPublisher Application

The following steps provide instructions for installing the WebAccess Application and WebPublisher 
Application. For information about installing the WebAccess Agent, see “Installing the WebAccess 
Agent” on page 116.

1 Select an appropriate location to run the GroupWise Installation program.

2 Make sure that you have access to the domain directory.
3 Make sure that you have the file system access required to install the WebAccess Application 

and the WebPublisher Application:
 You need full file system rights to the GroupWise domain directory. See “Gateway 

Directory Location and Name” on page 109.
 You need full file system rights to the Web server. See Section 5.3.1, “Deciding Where to 

Install the GroupWise WebAccess Components,” on page 107.
4 Shut down the Web server and Java.

NetWare: If you are installing to a NetWare Web server, you can run the WebAccess 
Installation program on any Windows machine that meets the administrator 
machine requirements listed in Section 2.1, “GroupWise Administration 
Requirements,” on page 17.

Windows: If you are installing to a Windows Web server, you must run the WebAccess 
Installation program on that server. It must meet the administrator machine 
requirements listed in Section 2.1, “GroupWise Administration Requirements,” on 
page 17.
118 GroupWise 8 Installation Guide



5 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the 
Installation program to create the WebAccess objects.

6 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run setup.exe from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the WebAccess Agent software to a software distribution directory, 
run setup.exe from the root of the software distribution directory to start the GroupWise 
Installation program.

7 Click More Components, then click Install WebAccess.
8 Select the interface language for the Installation program, then click OK.
9 Click Yes to accept the License Agreement and display the GroupWise WebAccess: Components 

dialog box.

NetWare: NetWare 6.5:

unload apache2
unload java

Linux: Novell Open Enterprise Server 2 Linux installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/novell-tomcat5 stop

SUSE Linux Enterprise Server 10 installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/tomcat5 stop

Windows: 1. At the Windows server, click Start > Administrative Tools > Services.

2. Right-click World Wide Web Publishing Service, then click Stop.
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10 Select GroupWise WebAccess Application and GroupWise WebPublisher Application (if you plan to 
use WebPublisher). 

11 Deselect the GroupWise WebAccess Agent option, then click OK.
12 Follow the prompts to provide information about WebAccess Application and WebPublisher 

configuration, using the following information from the GroupWise WebAccess/WebPublisher 
Application Installation Summary Sheet.

Gateway Directory
Web Server Information
Default Language
WebAccess Application Object
WebPublisher Application Object

13 When the installation is complete, select from the following options:
Launch Installation Summary: This option displays a list of the information you provided 
during installation. You can print it for future reference.
Start the GroupWise WebAccess Agent: This option starts the WebAccess Agent immediately. 
If you want to configure the server to start the WebAccess Agent automatically each time the 
server restarts, see “Starting the NetWare GroupWise Agents” on page 197 or “Starting the 
Windows GroupWise Agents” on page 222.

NOTE: If you installed only the applications, this option does not appear.

Restart the Web Server: This option starts the Web server, which loads the WebAccess 
Application (and WebPublisher Application if you installed it). 

NOTE: If you installed the WebAccess Application to the Internet Information Server (IIS) on 
Windows, the WebAccess Installation program automatically installed Tomcat 5.5 to the 
following directory on your Windows Web server:

c:\novell\groupwise\tomcat5.5

The Installation program then starts Tomcat as a Windows service for use by WebAccess.

14 Click Finish to exit the WebAccess Installation program.
15 Click Finish to exit the GroupWise Installation program as well.
16 Skip to Section 5.4.3, “Testing GroupWise WebAccess and WebPublisher,” on page 127.
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Starting GroupWise WebAccess

If you did not have the Installation program start the WebAccess Agent, complete the following 
steps:

1 Restart Java and the Web server. 

This loads the WebAccess Application (and WebPublisher Application if you installed it).
2 Start the WebAccess Agent

When you start the WebAccess Agent, the Document Viewer Agent also starts. However, the 
Viewer Agent cannot run as a Windows service.
If the WebAccess Agent does not start successfully, see “Starting the NetWare GroupWise 
Agents” on page 197.

3 If you enabled the WebAccess Agent Web console, you can use the following URL to view the 
Web console:

http://webaccess_agent_network_address:http_port

For example:

http://172.16.5.18:7211

For more information, see “Using the WebAccess Agent Web Console” in “WebAccess” in the 
GroupWise 8 Administration Guide.

4 Skip to Section 5.4.3, “Testing GroupWise WebAccess and WebPublisher,” on page 127.

NetWare: NetWare 6.5:

tomcat4
apache2

Linux: Novell Open Enterprise Server 2 Linux installation of Apache:

/etc/init.d/novell-tomcat5 start
/etc/init.d/apache2 start

SUSE Linux Enterprise Server 10 installation of Apache:

/etc/init.d/tomcat5 start
/etc/init.d/apache2 start

Windows: 1. At the Windows server, click Start > Administrative Tools > Services.

2. Right-click Tomcat 5.5, then click Start.

3. Right-click World Wide Web Publishing Service, then click Start.

NetWare: Enter strtweb.ncf at the NetWare server console.

Windows: To run as an application, click Start > All Programs > Novell GroupWise 
WebAccess > GroupWise WebAccess.

To run as a service, from the Control Panel click Administrative Tools > Services. 
Right-click the WebAccess service, then click Start.
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5.4.2 Linux: Setting Up GroupWise WebAccess

Complete the following tasks to set up GroupWise WebAccess and WebPublisher. These tasks are 
designed to help you get Linux WebAccess up and running as quickly as possible and to help you 
manage the WebAccess Agent in the future. 

 “Installing the Linux WebAccess Agent” on page 122
 “Configuring the Linux WebAccess Agent” on page 123
 “Installing and Configuring the WebAccess Application and WebPublisher Application” on 

page 124
 “Configuring WebPublisher” on page 125
 “Restarting the Web Server” on page 126
 “Starting the Linux WebAccess Agent” on page 126

IMPORTANT: If you are installing GroupWise WebAccess in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install WebAccess. 

If you are new to Linux, you might want to review Appendix A: Useful Linux Commands for 
Administering a GroupWise System in the GroupWise 8 Administration Guide before you install 
GroupWise WebAccess on Linux.

Installing the Linux WebAccess Agent

1 Make sure that Apache 2 and Tomcat 5 are installed as your Web server.
They might not be installed by default on your system.

2 Make sure that LDAP is running on your eDirectory server and that it is configured to accept 
login from the Installation program.
The Installation program requires eDirectory access in order to create the WebAccess Agent 
object in eDirectory. The Installation program uses LDAP to gain the required access.

3 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run install from the root of the GroupWise 8 software image.
or
If you have already copied the Internet Agent software to a software distribution directory, run 
./install from the root of the software distribution directory to start the GroupWise 
Installation program.
The X Window System is required for running the GUI GroupWise Installation program. If you 
are not using the X Window System, you can install GroupWise components individually, as 
described in “Installing the GroupWise Agents Using the Text-Based Installation Program” on 
page 201.

4 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are 
always installed.

The main GroupWise System Installation page appears.
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5 Click Install Products > GroupWise WebAccess > Install WebAccess Agent.
6 When the installation is complete, click OK.

The WebAccess Agent software is installed to /opt/novell/groupwise/agents.
7 Continue with Configuring the Linux WebAccess Agent.

Configuring the Linux WebAccess Agent

1 After the WebAccess Agent files have been installed, click Configure WebAccess Agent.
The WebAccess Agent installation and configuration steps are separate so that you can install 
updated agent software without repeating the agent configuration steps.

2 Follow the prompts to configure the WebAccess Agent, using the following information from 
the GroupWise WebAccess Installation Summary Sheets in the order listed.

Server Address
Gateway Directory
LDAP Authentication
Gateway Object
On the Configuration Complete page, Launch WebAccess Agent on System Startup is selected by 
default.
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IMPORTANT: If you want to configure the WebAccess Agent for high availability, as described 
in “Enabling the Groupwise High Availability Service for the Linux GroupWise Agents” on 
page 209, it must be configured to start automatically on system startup.

3 If you do not want the WebAccess Agent to start automatically when the server restarts, deselect 
Launch WebAccess Agent on System Startup.

4 Click Exit to complete the configuration.
5 Continue with Installing and Configuring the WebAccess Application and WebPublisher 

Application.

Installing and Configuring the WebAccess Application and WebPublisher 
Application

1 After installing and configuring the WebAccess Agent, click Install GroupWise WebAccess 
Application.

2 When the installation is complete, click OK.
3 Click Configure WebAccess Application.

4 Follow the prompts to provide information about the WebAccess Application, using the 
following information from the GroupWise WebAccess Installation Summary Sheets in the 
order listed.

Gateway Directory
Web Server Information
LDAP Authentication
WebAccess Objects

5 On the Configuration Complete page, click Exit to complete the configuration.
The WebAccess Application and the WebPublisher Application are installed into the following 
directories:

/etc/opt/novell/groupwise/webaccess
/var/opt/novell/groupwise/webaccess
/etc/opt/novell/groupwise/webpublisher
/var/opt/novell/groupwise/webpublisher

and are linked into your Web server.
6 If you installed WebPublisher, continue with Configuring WebPublisher.
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or
Skip to “Restarting the Web Server” on page 126

Configuring WebPublisher

After installing and configuring WebAccess, as described in Section 5.4.2, “Linux: Setting Up 
GroupWise WebAccess,” on page 122, if you want to enable WebPublisher as well, you must perform 
some manual configuration.

1 In ConsoleOne, connect to the domain where the WebAccess Agent object was created during 
installation.

2 In a convenient context, create a new user specifically for use with WebPublisher.
3 Add the new user to a post office and provide a GroupWise password for the WebPublisher 

user.
4 Browse to and right-click the WebAccess Agent object (by default, webac80a), then click 

Properties > WebPublisher.

5 In the GroupWise Mailbox ID field, specify the WebPublisher user you created in Step 2 above.
6 Click Add, then select the library for WebPublisher to access for documents.
7 Select Assign General User Access to WebPublisher Users.
8 Click OK to save the WebPublisher configuration information.
9 Restart your Web server, as described in “Restarting the Web Server” on page 126

10 Restart the WebAccess Agent, as described in “Starting the Linux WebAccess Agent” on 
page 126.

In order to add documents to the library so that they can be viewed on the Internet, WebPublisher 
users must use the GroupWise Windows client. See “Publishing Documents to the Web with 
WebPublisher” in “Document Management” in the GroupWise 8 Windows Client User Guide. 

NOTE: WebPublisher functionality is not currently available in the GroupWise Mac/Linux client.
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Restarting the Web Server

In order to load the WebAccess Application (and WebPublisher Application if you installed it), you 
must restart the Web server.

Starting the Linux WebAccess Agent

To start the Linux WebAccess Agent with a user interface:

1 Make sure you are logged in as root.
2 Make sure that the MTA for the domain is running.
3 Change to the /opt/novell/groupwise/agents/bin directory.
4 To start the WebAccess Agent, enter one of the following commands:

./gwinter --show --home domain_directory/wpgate/webac80a &

./gwinter --show @webac80a.waa &

The WebAccess Agent --show switch does not display a server console interface like the other 
GroupWise agents. Instead, WebAccess configuration and status information displays in the 
terminal window where you start the WebAccess Agent.
The --home startup switch specifies the gateway directory and is required to start the WebAccess 
Agent.
The @webac80a.waa startup switch specifies the WebAccess Agent startup file, which contains 
the --home startup switch.
The ampersand (&) causes the WebAccess Agent to run in the background, so that the terminal 
window you started it in is again available for use.
To remind yourself of these commands when you are at your Linux server, view the gwinter 
man page.

NetWare: NetWare 6.5:

unload apache2
unload java
tomcat4
apache2

Linux: Novell Open Enterprise Server 2 Linux installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/novell-tomcat5 stop
/etc/init.d/novell-tomcat5 start
/etc/init.d/apache2 start

SUSE Linux Enterprise Server 10 installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/tomcat5 stop
/etc/init.d/tomcat5 start
/etc/init.d/apache2 start

Windows 1. At the Windows server, click Start > Administrative Tools > Services.

2. Right-click Tomcat 5.5, then click Restart.

3. Right-click World Wide Web Publishing Service, then click Restart.
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NOTE: When you start the WebAccess Agent, the Document Viewer Agent also starts.

Status messages for the WebAccess Agent are written to the WebAccess Agent log file 
(mmddlog.nnn) in the /var/log/novell/groupwise/domain.webac80a/000.prc directory. The 
log file name includes the month and day when it was created, along with an incrementing 
extension to accommodate multiple log files on the same day.
After the WebAccess Agent starts successfully, refer to the following sections in Chapter 8, 
“Installing GroupWise Agents,” on page 181 for additional information about managing the 
WebAccess Agent on Linux:
 “Starting the Linux GroupWise Agents as Daemons” on page 204
 “Monitoring the Linux GroupWise Agents from Your Web Browser” on page 205
 “Starting the Linux GroupWise Agents on System Startup” on page 206
 “Running the Linux GroupWise Agents As a Non-root User” on page 207
 “Enabling the Groupwise High Availability Service for the Linux GroupWise Agents” on 

page 209
 “Stopping the Linux GroupWise Agents” on page 215
 “Uninstalling the Linux GroupWise Agents” on page 217

5 Continue with Testing GroupWise WebAccess and WebPublisher.

5.4.3 Testing GroupWise WebAccess and WebPublisher

To test GroupWise WebAccess and WebPublisher, complete the steps in the following sections:

 “Testing WebAccess on a Workstation” on page 127
 “Testing WebAccess on a Mobile Device” on page 128
 “Testing GroupWise WebPublisher” on page 129

Testing WebAccess on a Workstation

1 To access the WebAccess client, enter the IP address or hostname of the Web server plus the 
directory where the Novell Web Services page is located:.

http://web_server_address/gw
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2 Select a GroupWise WebAccess language and service, then click Go to display the Login page.
You can bypass the Novell Web Services page to go directly to the Login page by using the 
following URL:

http://web_server_address/gw/webacc

where web_server_address is the IP address or DNS hostname of your Web server. If the Web 
server uses SSL, use https rather than http.

3 Type your GroupWise user ID or GroupWise full name in the Name box and your GroupWise 
mailbox password in the Password box.

4 Select the desired connection speed.
High (Broadband): Select this option if your connection to the Internet is faster than a 56 KB 
modem.
Low (Dial-up): Select this option if your are on a 56 KB modem or slower. This reduces the 
amount of data downloaded from the server by disabling Name Completion so that the 
Frequent Contacts Address Book does not need to be downloaded, and by disabling some 
aspects of AutoUpdate in the message list, such as no updating after a send or delete action.

5 Select additional settings as needed.
Use the Basic Interface: Select this option for a mobile device. It uses simplified templates and 
assumes a smaller display area. A few features, such as Name Completion, right-click menus, 
and drag-and-drop functionality, are not available in the basic interface. For more information, 
see the GroupWise WebAccess Basic Interface Quick Start.
Remember My Settings: Select this option to use the options you selected above as the defaults 
the next time you log in to the WebAccess client.

6 Click Login to display the GroupWise WebAccess main window.
7 Click Help for more information about using GroupWise WebAccess.

Testing WebAccess on a Mobile Device

1 Enter the following URL:

http://web_server_address/gw/webacc
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where web_server_address is the IP address or DNS hostname of your Web server. If the Web 
server uses SSL, use https rather than http.
Follow the instructions in your mobile device’s documentation to add this URL to your Favorites 
or Bookmarks so you don’t need to type the URL every time you log in.

2 Enter your GroupWise user ID and GroupWise mailbox ID.

Testing GroupWise WebPublisher

GroupWise WebPublisher only supports access through a Web browser on a computer. Mobile 
devices are not supported.

1 To access the WebPublisher client, enter the IP address or hostname of the Web server plus the 
directory where the Novell Web Services page is located:

http://web_server_address/gw

where web_server_address is the IP address or DNS hostname of your Web server. 
2 Select a GroupWise WebPublisher language, then click Go to display GroupWise WebPublisher.

You can bypass the Novell Web Services page to go directly to WebPublisher by using the 
following URL:

http://web_server_address/gw/webpub

where web_server_address is the IP address or DNS hostname of your Web server. If the Web 
server uses SSL, use https rather than http.

3 To search for a specific document, enter the search words, then click Search.
or
To browse the documents in a library, click Document Browse, then click the library you want to 
browse. When you browse a library, the first 10 documents are listed. You can list additional 
documents if desired.

4 Click Help for more information about using GroupWise WebPublisher.

5.5 What’s Next
The “WebAccess” section of the GroupWise 8 Administration Guide provides information to help you 
further configure and maintain GroupWise WebAccess, including how to:

 Scale GroupWise WebAccess to meet the needs of your users and environment. See “Scaling 
Your WebAccess Installation”.

 Control users’ access to GroupWise WebAccess. See “Managing User Access”.
 Secure connections via SSL. See “Securing WebAccess Agent Connections with SSL”.
 Modify the WebAccess Agent’s configuration information, including the number of threads 

allocated for request processing. See “Configuring the WebAccess Agent”.
 Monitor the WebAccess Agent and the WebAccess Application. See “Monitoring WebAccess 

Operations”.
 Control logging for the WebAccess Agent, WebAccess Application, and WebPublisher 

Application. See “Using WebAccess Log Files”
 Modify configuration information for the WebAccess Application and WebPublisher 

Application. See “Configuring the WebAccess Application” and “Configuring the WebPublisher 
Application”
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If you want to use the WebAccess client on a mobile device, see the GroupWise WebAccess Basic 
Interface Quick Start (http://www.novell.com/documentation/gw8).

5.6 GroupWise WebAccess Installation Summary Sheets
 Section 5.6.1, “GroupWise WebAccess Agent Installation Summary Sheet,” on page 130
 Section 5.6.2, “GroupWise WebAccess/WebPublisher Application Installation Summary Sheet,” 

on page 132

5.6.1 GroupWise WebAccess Agent Installation Summary Sheet 

Installation Program Field Value for Your GroupWise 
System

Explanation

Agent Software Platform: 

 NetWare

 Windows

 Linux

Section 5.3.1, “Deciding Where to 
Install the GroupWise WebAccess 
Components,” on page 107

Components: 

 GroupWise WebAccess Agent

Section 5.1.2, “GroupWise 
WebAccess Components,” on 
page 102

Server Information: 

 Installation path

Section 5.3.1, “Deciding Where to 
Install the GroupWise WebAccess 
Components,” on page 107

Server Address: 

 Network address

IP address

DNS hostname

TCP port

(default 7205)

 Configure the WebAccess 
Agent for clustering

“Network Address” on page 108

“NetWare Installation Option: 
Clustering” on page 112

Gateway Directory: 

 Domain name

 Domain directory path

 Gateway directory name

 Domain context

“Gateway Directory Location and 
Name” on page 109

Gateway Object: “Gateway Object Name” on 
page 109
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eDirectory Authentication 

NetWare only

 Username

 Password

“Domain and Post Office Access” 
on page 110

Execution Options: 

Windows only

 Install and configure SNMP for 
the WebAccess Agent

 Run the WebAccess Agent as 
a Windows service

Automatic startup

Normal startup

“Windows Installation Options: 
SNMP Traps and Service vs. 
Application” on page 113

Service User: 

Windows only

 Username

 Password

“Domain and Post Office Access” 
on page 110

Enable Web Console: 

 Yes

Username

Password

HTTP port

(default 9850)

 No

“Web Console” on page 111

WebPublisher Support: 

 Yes

Mailbox ID

Password

 No

“WebPublisher” on page 111

WebPublisher Libraries: “WebPublisher” on page 111

Installation Program Field Value for Your GroupWise 
System Explanation
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5.6.2 GroupWise WebAccess/WebPublisher Application Installation 
Summary Sheet

LDAP Authentication: 

Linux only

 LDAP Server IP Address

 Port

 Username

 Password

 Use SSL Connection

 Yes

Path to SSL certificate 
file

 No

“Linux Installation Options: LDAP 
Information and Clustering” on 
page 112

Installation Program Field Value for Your GroupWise 
System Explanation

Installation Program Field
Value for Your GroupWise 
System Explanation

Components: 

 GroupWise WebAccess 
Application

 GroupWise WebPublisher 
Application

Section 5.1.2, “GroupWise 
WebAccess Components,” on 
page 102

Gateway Directory: “Gateway Directory Location and 
Name” on page 109
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Web Server Information: 

NetWare/Windows

 Apache Web Server for 
NetWare

 Path to the Web server’s root 
directory

Windows

 Microsoft Internet Information 
Server (IIS) for Windows

 Path to the Web server’s root 
directory

 Web site

Linux

 Apache path

/etc/apache2/conf.d

 Tomcat path

/srv/www/tomcat5/base/
webapps

Section 5.3.1, “Deciding Where to 
Install the GroupWise WebAccess 
Components,” on page 107

Installation Program Field Value for Your GroupWise 
System Explanation
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Default Language: 

Windows only

 Arabic

 Brazilian Portuguese

 Chinese Simplified

 Chinese Traditional

 Czech

 Danish

 Dutch

 English

 Finnish

 French

 German

 Hebrew

 Hungarian

 Italian

 Japanese

 Korean

 Norwegian

 Polish

 Russian

 Spanish

 Swedish

“Default Language” on page 114

WebAccess Application Object: 

 Tree

 Context

“eDirectory Objects and 
Configuration Files” on page 114

WebPublisher Application 
Object: 

 Tree

 Context

“eDirectory Objects and 
Configuration Files” on page 114

Installation Program Field Value for Your GroupWise 
System Explanation
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6 6Installing the GroupWise Calendar 
Publishing Host

The Novell GroupWise Calendar Publishing Host publishes GroupWise users’ personal calendars to 
the Internet, so that they are readily available to colleagues who are not part of the GroupWise 
system. Items on users’ main GroupWise Calendars that are not included on personal calendars are 
not published. The Calendar Publishing Host also returns free/busy schedule status to Internet 
colleagues who want to set up appointments with GroupWise users. The free/busy search checks the 
main GroupWise Calendar as well as personal calendars.

 Section 6.1, “GroupWise Calendar Publishing Host Overview,” on page 135
 Section 6.2, “Calendar Publishing Host System Requirements,” on page 137
 Section 6.3, “Planning a Calendar Publishing Host,” on page 138
 Section 6.4, “Setting Up a Calendar Publishing Host,” on page 143
 Section 6.5, “What’s Next,” on page 154
 Section 6.6, “GroupWise Calendar Publishing Host Installation Summary Sheet,” on page 155

6.1 GroupWise Calendar Publishing Host Overview
 Section 6.1.1, “Calendar Publishing Host Introduction,” on page 135
 Section 6.1.2, “Calendar Publishing Host Components,” on page 136
 Section 6.1.3, “Calendar Publishing Host Security Requirements,” on page 136

6.1.1 Calendar Publishing Host Introduction

The GroupWise Calendar Publishing Host enables Internet users to view GroupWise users’ 
published calendars and to retrieve free/busy information from their calendars to assist with 
scheduling available appointment times. Internet users do not need access to the GroupWise system 
in order to view published calendars and obtain free/busy status.

Figure 6-1   No Login Required for the Calendar Publishing Host

As shown above, users at Web browsers can access the Calendar Publishing Host across the Internet 
without needing to log in. Information provided by the Calendar Publishing Host is publicly 
available to Internet users everywhere. 

GroupWise Calendar
Publishing Host

Post Office
Agent

Browser

No Login

Internet
Intranet
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6.1.2 Calendar Publishing Host Components

The GroupWise Calendar Publishing Host includes two components: the Calendar Publishing Host 
itself, which connects to the Internet through a Web server, and the Post Office Agent (POA), which 
connects to your GroupWise system:

Figure 6-2   GroupWise Calendar Publishing Host Components

Calendar Publishing Host: The Calendar Publishing Host, which resides on the Web server, 
provides the browser interface for users across the Internet. As users request calendar and free/busy 
information from GroupWise users, the Calendar Publishing Host passes the information between 
the Web browser and the POA.

Post Office Agent: The POA receives user requests from the Calendar Publishing Host, accesses post 
offices and mailboxes to process the requests, and then passes information back to the Calendar 
Publishing Host in the form of ICS (Internet Calendaring and Scheduling) files and IFB (Internet Free 
Busy) files. These files can be imported into GroupWise, Outlook, and Mac iCal calendaring 
applications.

6.1.3 Calendar Publishing Host Security Requirements

The GroupWise Calendar Publishing Host can be configured to support the level of security you 
have established for your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use the Calendar 
Publishing Host on a secured intranet), you can install the Calendar Publishing Host to any server 
that provides access for your users and meets the requirements listed in Section 6.2, “Calendar 
Publishing Host System Requirements,” on page 137. 

If you plan to use the Calendar Publishing Host to provide calendar and free/busy information to 
users anywhere on the Internet (rather than simply within a secured intranet), and you already have 
a firewall in place to provide security, you have the following options for configuring the Calendar 
Publishing Host:

 Install the Calendar Publishing Host inside your firewall and use a proxy service, as described in 
“Configuration with a Proxy Service” on page 136. This is the recommended configuration.

 Install the Calendar Publishing Host on a Web server outside your firewall and have it 
communicate with a POA through your firewall, as described in “Configuration without a Proxy 
Service” on page 137.

Configuration with a Proxy Service

If your firewall includes a proxy service, you can install the Calendar Publishing Host to a Web server 
inside your firewall, and it can communicate with a POA that is also inside the firewall, as shown in 
the following illustration:

Post Office
Agent

Web
Server Post Office

Calendar
Publishing Host

Web
Browser
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Figure 6-3   Calendar Publishing Host Installed inside the Firewall

Configuration without a Proxy Service

If your firewall does not provide a proxy service, you need to install the Calendar Publishing Host to 
a Web server that is outside the firewall. Because the POA requires direct access (mapped drive or 
UNC path) to a GroupWise post office directory, the POA needs to be installed to a server that is 
inside your firewall.

Figure 6-4   Calendar Publishing Host Installed outside the Firewall

The firewall must allow inbound IP packets to be sent from the Web server to the IP address and 
calendar publishing port number of the POA (for example, 172.16.5.18:7171).

In addition, the firewall must allow outbound IP packets to be sent from the POA to the Web server. 
This requires all high ports (above 1023) to be open to outbound IP packets. 

6.2 Calendar Publishing Host System Requirements
 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.

 Any of the following Web servers:

 NetWare 6.5: Apache 2.0 plus:
 Tomcat 4.1
 JVM 1.4.2
 Jakarta Connector 1.2

 OES 2 Linux / SLES 10: Apache 2.2 plus:
 Tomcat 5.0 or later
 JVM 1.4.2 or later
 ModProxy Module

 OES 11 / SLES 11: Apache 2.2 plus:
 Tomcat 6.0 or later

Firewall Server
with Proxy

Service

GroupWise
SystemWeb Server

with Calendar 
Publishing Host

Network Server
with Post Office

Agent
Internet

Web Server
with Calendar 

Publishing Host

GroupWise
SystemFirewall

Server
Network Server
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 JVM 1.5 or later
 ModProxy Module

 Windows Server 2003/2003 R2: Microsoft Internet Information Server (IIS) 6 or later plus:
 Tomcat 5.5 or later
 JVM 1.5 or later
 Jakarta Connector 1.2 or later

 Windows Server 2008/2008 R2: Microsoft Internet Information Server (IIS) 7 or later plus:
 Tomcat 5.5 or later
 JVM 1.5 or later
 Jakarta Connector 1.2 or later

 Adequate server memory as required by the Web server operating system

 Any of the following Web browsers for the GroupWise Calendar Publishing Host user Web 
pages and the Calendar Publishing Host Administration Web console:
 Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox 
 Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox
 Linux: Mozilla Firefox

 Any of the following environments for running the GroupWise Installation program:

 Windows XP, Windows Vista, or Windows 7, plus the latest Service Pack, plus the Novell 
Client

 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 
2008 R2, plus the latest Service Pack, plus the Novell Client

 Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support 
Pack

 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack
The X Window System is required by the GUI GroupWise Installation program that steps 
you through the process of creating a new GroupWise system. A text-based Installation 
program is also available.

 Adequate server disk space:

 Approximately 7 MB for the Calendar Publishing Host software
 50 KB per published calendar

6.3 Planning a Calendar Publishing Host
Use the “GroupWise Calendar Publishing Host Installation Summary Sheet” on page 155 to record 
your decisions about how to install and configure the Calendar Publishing Host. The topics in this 
section present the required information in a convenient planning sequence. The Installation 
Summary Sheet organizes the information in the order in which you need it during installation and 
configuration.

 Section 6.3.1, “Selecting the Calendar Publishing Host Platform,” on page 139
 Section 6.3.2, “Gathering Web Server Information,” on page 139
 Section 6.3.3, “Determining the Configuration of the Calendar Publishing Host,” on page 139
 Section 6.3.4, “Connecting the Calendar Publishing Host to a POA,” on page 140
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 Section 6.3.5, “Designing Your Calendar Browse List,” on page 141
 Section 6.3.6, “Selecting Calendar Publishing Settings,” on page 141
 Section 6.3.7, “Configuring Authentication to the Administration Web Console,” on page 142

For additional assistance in planning your GroupWise installation, see GroupWise Best Practices 
(http://wiki.novell.com/index.php/GroupWise) and GroupWise 8 Good and Bad Habits (http://
wiki.novell.com/index.php/GroupWise_8_Good_and_Bad_Habits).

6.3.1 Selecting the Calendar Publishing Host Platform

The GroupWise Calendar Publishing Host can be installed to a Web server on NetWare, Linux, or 
Windows. See Section 6.2, “Calendar Publishing Host System Requirements,” on page 137 for 
supported Web servers.

6.3.2 Gathering Web Server Information

The Installation program needs to know the root directory for your Web server. For Linux, the path to 
Tomcat is also required. The default paths vary by platform:

6.3.3 Determining the Configuration of the Calendar Publishing Host

In ConsoleOne, the Calendar Publishing Host is identified by a unique name. The name might 
include the platform or location of the Calendar Publishing Host, or perhaps the users it serves. 

IMPORTANT: Do not use any double-byte characters in the name.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION SUMMARY SHEET

Under Software Platform, mark whether you plan to install the Calendar Publishing Host to a NetWare, 
Linux, or Windows Web server

Apache Web Server for NetWare: drive:\Apache2

Apache Web Server for OES Linux:

Tomcat for OES Linux:

/etc/opt/novell/httpd/conf.d

/var/opt/novell/tomcat5/webapps

Apache Web Server for SLES:

Tomcat for SLES:

/etc/apache2/conf.d

/srv/www/tomcat5/base/webapps

Microsoft Internet Information Server 
(IIS) for Windows:

c:\inetpub\wwwroot

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION SUMMARY SHEET

Under Web Server Information, mark the Web server you are using and specify the path to its root 
directory. The default path is usually appropriate.

On Windows, if the Internet Information Server services more than one Web site, specify the Web site 
where you want to install the Calendar Publishing Host.
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The Calendar Publishing Host name is stored in the calhost.cfg file, located in the following 
directories

You typically need only one Calendar Publishing Host. However, depending on the size of your 
GroupWise system and the locations of your GroupWise users, you might need several in different 
locations if some users experience slowness when accessing the initial location. You specify the name 
of the Calendar Publishing Host during installation and in ConsoleOne. The name must match in 
both places.

The Calendar Publishing Host uses the DNS hostname of the Web server as part of its base URL.

http://web_server_address:port/gwcal

where web_server_address is the DNS hostname of the Web server and port is the port number on 
which the Calendar Publishing Host communicates with the Web server. The default port number is 
80; it does not need to be specified if your Web server uses that default.

IMPORTANT: Select the URL carefully. This URL is disseminated by GroupWise users to their 
Internet colleagues when they publish their personal calendars and free/busy information. If you 
change the URL later, GroupWise users would need to send updated information to Internet 
colleagues. 

The Calendar Publishing Host also needs the IP address and TCP port number of the Web server so 
that they can communicate.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port 
Numbers” in the GroupWise 8 Administration Guide.

6.3.4 Connecting the Calendar Publishing Host to a POA

The Calendar Publishing Host connects to your GroupWise system through the POA of a post office. 
For initial installation, you enable one POA for calendar publishing. As you roll out calendar 
publishing to your GroupWise users, you must enable calendar publishing for the POA of every post 
office where users publish calendars and free/busy information.

The initially selected POA must be configured to communicate with the Calendar Publishing Host. 
The POA server’s IP address or DNS hostname is required, along with a calendar publishing port 
(7171 by default). Use the default port number unless it is already in use by another program on the 
server where you plan to install the Calendar Publishing Host. 

NetWare: sys:\novell\groupwise\calhost

Linux: /var/opt/novell/groupwise/calhost

Windows c:\novell\groupwise\calhost

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION SUMMARY SHEET

Under Calendar Publishing Host Name, specify a unique name for this Calendar Publishing Host.

Under Calendar Publishing Host Configuration, list the same name for the Calendar Publishing Host, 
along with its base URL (http://web_server_address/gwcal), the IP address of the Web server, 
and the Web server port number (by default, 80).
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For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port 
Numbers” in the GroupWise 8 Administration Guide.

6.3.5 Designing Your Calendar Browse List

The Calendar Publishing Host collects a list of published calendars for Internet users to browse and 
select from at the following URL:

http://web_server_address/gwcal/calendar

However, by default, no calendars are displayed in the calendar browse list. You can handle the 
calendar browse list in three different ways:

 Do not provide a calendar browse list, so that users need to notify Internet colleagues by e-mail 
of the URL to access their published calendars.

 Use the calendar browse list only for calendars of general corporate interest. If you want to have 
such a corporate browse list, you restrict which users can list calendars on the browse list, by 
allowing only a few specific users who manage the corporate calendars to publish to the 
calendar browse list.

 Allow most, if not all, users to publish their personal calendars on the calendar browse list. This 
open approach to the calendar browse list makes users’ published calendars easily accessible to 
anyone who knows the URL of the calendar browse list for your GroupWise system.

6.3.6 Selecting Calendar Publishing Settings

After you have set up the Calendar Publishing Host, you can configure how you want it to work for 
your GroupWise users. The following settings are available in ConsoleOne:

 Enable Calendar Publishing: Select this option to let users publish personal GroupWise 
calendars on the Internet. Calendar publishing is disabled by default. When you enable it, users 
of the Windows client and the WebAccess client can right-click a personal calendar, then click 
Publish to select options for publishing the personal calendar.

 Enable Rules to Move Items to a Published Calendar: Select this option so that users can create 
rules to automatically transfer certain types of calendar items to specific personal calendars that 
are published. Using rules is disabled by default.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION SUMMARY SHEET

Under Calendar Publishing Post Office, specify the name of the post office you have chosen to enable for 
calendar publishing during initial installation (for example, the POA for your own post office). Specify the 
IP address or DNS hostname of the POA that services the post office, along with the calendar publishing 
port number. The default port number is 7171.

Under Post Office Agent Information, transfer the IP address or DNS hostname and the calendar 
publishing port. You need this information when you install the Calendar Publishing Host.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION SUMMARY SHEET

Under Calendar Browse List, mark whether you want to enable the calendar browse list, and if so, what 
kind (corporate or open).
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 Enable Subscribe to Calendar: Select this option to allow users to subscribe to Internet 
calendars that are updated on a regular basis, such as calendars for sporting events. Calendar 
subscription is disabled by default.

 Enable Publish Free/Busy Search: Select this option to allow users to make their appointment 
information available to external users, so that external users can perform free/busy searches on 
users’ GroupWise calendars. Free/busy searching is disabled by default

6.3.7 Configuring Authentication to the Administration Web Console

An Administration Web console is provided for additional configuration of the Calendar Publishing 
Host. To protect that Administration Web console, you must create or select at least one calendar 
publishing administrator user and an administrative group for that user to belong to. For example, 
you might create a user named CalPubAdmin and a group named CalPubAdminGrp. You could also 
select an existing user and add this user to the administrative group. This user does not need any 
special administrative rights. It does not need a GroupWise mailbox.

You can have the User object and the Group object in any convenient eDirectory container. The 
container must exist before you install the Calendar Publishing Host. Because you specify the 
container context during installation, you do not need to specify it each time you log in to the 
Administration Web console.

As an administrator, you use the Calendar Publishing Host Administration Web console to manage 
the Calendar Publishing Host. The Calendar Publishing Host uses LDAP authentication to allow you 
to log in to the Administration Web console. For secure logins, configure the Calendar Publishing 
Host to use SSL for the LDAP connection. During Calendar Publishing Host installation, you must 
specify a trusted root certificate file that is used to establish the LDAP SSL connection. For more 
information about LDAP SSL, see “Trusted Root Certificates and LDAP Authentication” in “Security 
Administration” in the GroupWise 8 Administration Guide.

How to use the Administration Web console for ongoing administration is described in “Configuring 
the Calendar Publishing Host” in “Calendar Publishing Host” in the GroupWise 8 Administration 
Guide.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION SUMMARY SHEET

Under Calendar Publishing Options, mark the options you want to enable for the Calendar Publishing 
Host.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION SUMMARY SHEET

Under Authentication Information, specify the name of the Calendar Publishing Host administrator user 
(for example, CalPubAdmin), the context of the administrator User object (for example, 
ou=Users,o=yourcompanyname), and the name of the administrative group (for example, 
CalPubAdminGrp). You specify the context of the user and the group when you install the Calendar 
Publishing Host. You set up the User and Group objects in ConsoleOne.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION SUMMARY SHEET

Under LDAP Server Information, specify the IP address or DNS hostname of a server where LDAP is 
enabled. Also specify the LDAP port. The default secure port is 636. Specify the full path to the SSL root 
certificate file.
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6.4 Setting Up a Calendar Publishing Host
As you set up the Calendar Publishing Host, use the GroupWise Calendar Publishing Host 
Installation Summary Sheet that you filled out in Section 6.3, “Planning a Calendar Publishing Host,” 
on page 138 to provide the required information.:

 Section 6.4.1, “Installing the Calendar Publishing Host,” on page 143
 Section 6.4.2, “Configuring the Calendar Publishing Host in ConsoleOne,” on page 148
 Section 6.4.3, “Enabling Calendar Publishing,” on page 149
 Section 6.4.4, “Restarting the Web Server and Tomcat,” on page 150
 Section 6.4.5, “Configuring a POA for Calendar Publishing,” on page 151
 Section 6.4.6, “Setting Up Calendar Publishing Administration,” on page 151
 Section 6.4.7, “Using the Published Calendar Browse List,” on page 152
 Section 6.4.8, “Testing Calendar Publishing,” on page 152

6.4.1 Installing the Calendar Publishing Host

 “NetWare and Windows: Installing the Calendar Publishing Host Software” on page 143
 “Linux: Installing the Calendar Publishing Host Software” on page 145

NetWare and Windows: Installing the Calendar Publishing Host Software

1 Make sure that you have created the Calendar Publishing Host administrative user and group, 
and that the Calendar Publishing Host server is configured for an SSL LDAP connection, as 
described in Section 6.3.7, “Configuring Authentication to the Administration Web Console,” on 
page 142.

2 Select an appropriate location to run the GroupWise Installation program.

3 Log in as an Admin equivalent to the eDirectory tree where GroupWise is installed.
4 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.

or
Run setup.exe from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the Calendar Publishing Host software to a software distribution 
directory, run setup.exe from the root of the software distribution directory.

5 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NetWare: If you are installing the Calendar Publishing Host on NetWare, you can run the 
Installation program from any Windows machine that meets the administrator 
machine requirements listed in Section 2.1, “GroupWise Administration 
Requirements,” on page 17.

Windows: If you are installing the Calendar Publishing Host on Windows, you must run the 
Installation program at the Windows Web server were you want to install the 
Calendar Publishing Host. It must meet the administrator machine requirements as 
well as the server operating system requirements listed in Section 2.1, “GroupWise 
Administration Requirements,” on page 17.
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NOTE: All available languages are included on the GroupWise 8 DVD and the multilanguage 
version of the downloaded GroupWise 8 software image, but you can select which languages you 
want to install.

The main GroupWise System Installation page appears.

6 Click More Components, then click Install Calendar Publishing Host to start the Calendar Publishing 
Host Installation program.

7 Select the language in which you want to run the Calendar Publishing Host Installation 
program, then click OK.

8 Click Yes to accept the License Agreement and start the Calendar Publishing Host installation.

9 Follow the prompts to provide the information from your GroupWise Calendar Publishing Host 
Installation Summary Sheet.

Calendar Publishing Host Name
Post Office Agent Information
Web Server Information
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LDAP Server Information
Authentication Information

10 When the installation is complete, select from the following options:

Launch Installation Summary: This option displays a list of the information you provided 
during installation. You can print it for future reference.
Restart the Web Server: This option starts the Web server, which loads the Calendar Publishing 
Host Application. 

NOTE: If you installed the Calendar Publishing Host to the Internet Information Server (IIS) on 
Windows, the Calendar Publishing Host Installation program automatically installed Tomcat 5.5 
to the following directory on your Windows Web server:

c:\novell\groupwise\tomcat5.5

The Installation program then starts Tomcat as a Windows service for use by the Calendar 
Publishing Host.

11 Click Finish to exit the Calendar Publishing Host Installation program.
12 Click Finish to exit the GroupWise Installation program as well.

After installing the Calendar Publishing Host, additional configuration in ConsoleOne is still 
required.

13 Skip to Section 6.4.2, “Configuring the Calendar Publishing Host in ConsoleOne,” on page 148.

Linux: Installing the Calendar Publishing Host Software

1 Make sure that Apache 2 and Tomcat 5 are installed as your Web server.
They might not be installed by default on your Linux server.

2 Make sure that LDAP is running on your eDirectory server.
3 Make sure that you have created the Calendar Publishing Host administrative user and group, 

and that the Calendar Publishing Host server is configured for an SSL LDAP connection, as 
described in Section 6.3.7, “Configuring Authentication to the Administration Web Console,” on 
page 142.

4 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run install from the root of the downloaded GroupWise 8 software image.
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or
If you have already copied the Calendar Publishing Host software to a software distribution 
directory, run ./install from the root of the software distribution directory.
The X Window System is required for running the GUI GroupWise Installation program. If you 
are not using the X Window System, you can install GroupWise components individually, as 
described in “Installing the GroupWise Agents Using the Text-Based Installation Program” on 
page 201.

5 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are 
always installed.

The main GroupWise System Installation page appears.

6 Click Install Products > GroupWise Calendar Publishing Host > Install Calendar Publishing Host 
Application to start the Calendar Publishing Host Installation program.

7 When the software installation is complete, click OK.
The Calendar Publishing Host software is installed to the following directories:

/opt/novell/groupwise/calhost
/etc/opt/novell/groupwise/calhost
/var/opt/novell/groupwise/calhost

and is linked into Tomcat.
8 Click Configure Calendar Publishing Host Application.
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9 Click Next, accept the License Agreement, then click Next.
10 Follow the prompts to configure the Calendar Publishing Host, using the following information 

from the GroupWise Calendar Publishing Host Installation Summary Sheet:

Calendar Publishing Host Name
Post Office Agent Information
Web Server Information
LDAP Server Information
Authentication Information

11 Click Exit to exit the Calendar Publishing Host Installation program.
12 Exit the GroupWise Installation program as well.

After installing the Calendar Publishing Host, additional configuration in ConsoleOne is still 
required.

13 Continue with Configuring the Calendar Publishing Host in ConsoleOne.
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6.4.2 Configuring the Calendar Publishing Host in ConsoleOne

Use the information under Calendar Publishing Host Configuration and Calendar Browse List on your 
GroupWise Calendar Publishing Host Installation Summary Sheet as you configure the Calendar 
Publishing Host.

1 In ConsoleOne, select the GroupWise System object, then click Tools > GroupWise System 
Operations > Web Calendar Publishing Hosts.

2 Click Add.

3 Specify a unique name by which the Calendar Publishing Host will be known in your 
GroupWise system. 

IMPORTANT: This must be the same name that you used during installation, as described in 
Section 6.3.3, “Determining the Configuration of the Calendar Publishing Host,” on page 139. If 
you decide that you want to use a different name after you have already installed the Calendar 
Publishing Host software, you must reinstall the software, then specify the same name that you 
provided during installation when you configure the Calendar Publishing Host in ConsoleOne.

4 Specify the base URL for the Calendar Publishing Host in the following format:

http://web_server_address:port/gwcal

where web_server_address is the IP address or DNS hostname of the Web server where you 
installed the Calendar Publishing Host software and port is the port number on which the 
Calendar Publishing Host communicates with the Web server. The default port number is 80 and 
does not need to be specified if your Web server uses that default.
The base URL does not point to information that is displayable in your browser. Displayable 
URLs are listed in Section 6.3.3, “Determining the Configuration of the Calendar Publishing 
Host,” on page 139.

5 Specify the IP address of the server where the Calendar Publishing Host is running.
This information enables the POA to communicate with the Calendar Publishing Host.

6 Specify the TCP port number on which the Calendar Publishing Host is configured to 
communicate with the POA. 
The default is 7171.

7 Click OK to save the Calendar Publishing Host configuration information.
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8 If you want to allow users to add their published calendars to the calendar browse list as the 
default for your GroupWise system, select Enable Publishing of Calendars to the Browse List.
or
If you want to set up a corporate calendar browse list or provide no calendar browse list, leave 
Enable Publishing of Calendars to the Browse List deselected.

9 Click OK when you are finished.
10 Restart the POA so that it picks up the configuration information for the new Calendar 

Publishing Host.
11 Continue with Enabling Calendar Publishing.

6.4.3 Enabling Calendar Publishing

Use the information under Calendar Publishing Options on your GroupWise Calendar Publishing Host 
Installation Summary Sheet as you enable calendar publishing.

1 In ConsoleOne, browse to and select post office where you want to enable calendar publishing.
For convenience in testing your Calendar Publishing Host setup, you might want to start with 
your post office.

2 Click Tools > GroupWise Utilities.
3 Click Client Options > Environment > Calendar.
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The calendar publishing options are disabled by default. As you roll out calendar publishing, 
you can use Client Options to enable it at the domain, post office, and user level.

4 Select a Calendar Publishing Host from the drop-down list.
5 Set the Calendar options as you planned under Calendar Publishing Options on your 

GroupWise Calendar Publishing Host Installation Summary Sheet.
6 Click OK to save the calendar publishing settings, then click Close.
7 Continue with Restarting the Web Server and Tomcat

6.4.4 Restarting the Web Server and Tomcat

To put the ConsoleOne settings into effect, you must restart the Web server and Tomcat.

NetWare: NetWare 6.5:

unload apache2
unload java
tomcat4
apache2

Linux: Novell Open Enterprise Server 2 Linux installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/novell-tomcat5 stop
/etc/init.d/novell-tomcat5 start
/etc/init.d/apache2 start

SUSE Linux Enterprise Server 10 installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/tomcat5 stop
/etc/init.d/tomcat5 start
/etc/init.d/apache2 start
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This loads the Calendar Publishing Host into your Web server so that it is available for use.

Continue with Configuring a POA for Calendar Publishing.

6.4.5 Configuring a POA for Calendar Publishing

After calendar publishing is enabled, the POA can look up calendar information and return it to the 
Calendar Publishing Host in the form of ICS (Internet Calendaring and Scheduling) or IFB (Internet 
Free Busy) files. Internet users can import these files into GroupWise, Outlook, and Mac iCal 
calendaring applications.

Use the information under Calendar Publishing Post Office on your GroupWise Calendar Publishing 
Host Installation Summary Sheet as you configure the POA.

1 In ConsoleOne, browse to and select the post office where calendar publishing is enabled, right-
click the POA object for the post office, then click Properties.

2 Click GroupWise > Agent Settings.
3 Select Enable Calendar Publishing.
4 Adjust the number in the Max Calendar Publishing Threads field as needed.

The default maximum number of calendar publishing threads is 4. By default, the POA creates 2 
calendar publishing threads and automatically creates additional threads as needed until the 
maximum number is reached. You cannot set the maximum higher than 4, but you can reduce 
the number of threads to conserve POA resources for other activities.

5 Click OK to save the calendar publishing configuration settings.
6 As you roll out calendar publishing to your GroupWise users, enable calendar publishing on the 

POA for each post office where users will publish calendars and free/busy information.
To determine which POAs have been enabled for calendar publishing, see “Viewing Calendar 
Publishing Status at the POA Web Console” in “Calendar Publishing Host” in the GroupWise 8 
Administration Guide.

6.4.6 Setting Up Calendar Publishing Administration

After calendar publishing has been enabled and the POA is communicating with the Calendar 
Publishing Host, you use the Calendar Publishing Host Administration Web console to monitor the 
Calendar Publishing Host and to make configuration changes as needed.

Use the information under Authentication Information on your GroupWise Calendar Publishing Host 
Installation Summary Sheet as you set up Calendar Publishing Host administration. You now set up 
the objects in ConsoleOne that correspond to the objects you specified during installation.

1 In ConsoleOne, browse to and select the container where you want to have the calendar 
publishing administrator User and Group objects.

2 If you want to create a new User object:
2a Right-click the container, then click New > User.
2b Fill in the required fields, including a password
2c Click OK to create the new User object.

Windows 1. At the Windows server, click Start > Administrative Tools > Services.

2. Right-click Tomcat 5.5, then click Restart.

3. Right-click World Wide Web Publishing Service, then click Restart.
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3 Create the new administrative group.
3a Right-click the container where the administrator User object is located, then click New > 

Group.
3b Fill in the required fields.
3c Click OK to create the new Group object.

4 Right-click the new User object or an existing User object, then click Properties.
5 Click Memberships > Group Membership.
6 Click Add, select the new administrative group you created in Step 3, then click OK to assign the 

administrator user to the group.
7 Click OK to close the Group Membership page.
8 Continue with Using the Published Calendar Browse List.

6.4.7 Using the Published Calendar Browse List

If you selected Enable Publishing of Calendars to the Browse List as your GroupWise system default in 
Step 8 in Section 6.4.2, “Configuring the Calendar Publishing Host in ConsoleOne,” on page 148, skip 
to Section 6.4.8, “Testing Calendar Publishing,” on page 152.

If you are planning to implement a corporate calendar browse list, you can enable publishing of 
calendars to the browse list for yourself for testing purposes.

1 Browse to and right-click your User object, then click Properties.
2 Click GroupWise > Calendar Publishing.
3 Select Override, then select Enable Publishing of Calendars to the Browse List.

This give you the right to add your calendars to the calendar browse list so that you can test the 
setup of the Calendar Publishing Host.

4 Continue with Testing Calendar Publishing.

6.4.8 Testing Calendar Publishing

Now that you have set up a Calendar Publishing Host, you can test it by:

 “Publishing a Personal Calendar” on page 152
 “Displaying the Browse List of Calendars” on page 153
 “Publishing Free/Busy Information” on page 154

Publishing a Personal Calendar

1 In the GroupWise Windows client, create and populate a personal calendar, as described in 
“Creating a Personal Calendar” in “Calendar” in the GroupWise 8 Windows Client User Guide.

2 Right-click the personal calendar, then click Publish.
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3 Select Publish This Calendar.
For more information, see “Publishing Personal Calendars on the Internet” in “Calendar” in the 
GroupWise 8 Windows Client User Guide.
This feature is also available in the GroupWise WebAccess Client, as described in “Publishing 
Personal Calendars on the Internet” in the GroupWise 8 WebAccess Client User Guide.
For more information, see the GroupWise 8 Calendar Publishing Host User Quick Start (http://
www.novell.com/documentation/gw8/gw8_calpubuser_qs/gw8_calpubuser_qs.html).

4 Click Send Publish Location, then address and send the resulting message, which provides the 
URL from which Internet colleagues can obtain your calendar information.

5 Click OK to publish the selected personal calendar.
6 Check your mailbox for the notification sent by the Calendar Publishing Host.
7 Continue with Displaying the Browse List of Calendars.

Displaying the Browse List of Calendars

1 Display the following URL:

http://web_server_address/gwcal/calendar

Your newly published personal calendar should appear on the list.
2 Click your calendar to view it in its published format.

This assures you that your calendar is available for access by users across the Internet.
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Publishing Free/Busy Information

1 In the GroupWise Windows client, click Tools > Options.
2 Click Calendar > Free/Busy.

3 Click Send Free/Busy Publish Location, then address and send the resulting message, which 
provides the URL from which Internet colleagues can obtain your free/busy information.

4 Click OK, then click Close.
5 Check your mailbox for the notification sent by the Calendar Publishing Host.

6.5 What’s Next
The “Calendar Publishing Host” section of the GroupWise 8 Administration Guide provides 
information to help you further configure and maintain the Calendar Publishing Host:

 Using the Administration Web console to change the configuration of the Calendar Publishing 
Host. See “Configuring the Calendar Publishing Host”.

 Changing the appearance of the calendar browse list to represent your company. See 
“Customizing the Calendar Publishing Host Logo”.

 Restricting the posted list of calendars to those of corporate importance. See “Creating a 
Corporate Calendar Browse List”.

 Monitoring the Calendar Publishing Host at the POA Web console and through Calendar 
Publishing Host log files. See “Monitoring Calendar Publishing”.
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6.6 GroupWise Calendar Publishing Host Installation Summary 
Sheet

Installation Program Field
Value for Your GroupWise 
System Explanation

Software Platform: 

 NetWare

 Windows

 Linux

Section 6.3.1, “Selecting the 
Calendar Publishing Host 
Platform,” on page 139

Calendar Publishing Host Name: Section 6.3.3, “Determining the 
Configuration of the Calendar 
Publishing Host,” on page 139

Post Office Agent Information: 

 POA network address

 IP address

 DNS hostname

 Calendar publishing port

Section 6.3.4, “Connecting the 
Calendar Publishing Host to a 
POA,” on page 140

NetWare Web Server Information: 

 Apache Web Server for NetWare

drive:\apache2

Section 6.3.2, “Gathering Web 
Server Information,” on 
page 139

Windows Web Server Information: 

 Microsoft Internet Information 
Server (IIS) for Windows

c:\inetpub\wwwroot

 Web site

Section 6.3.2, “Gathering Web 
Server Information,” on 
page 139
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Linux Web Server Information: 

Novell Open Enterprise Server Linux

 Apache path

/etc/opt/novell/httpd/
conf.d

 Tomcat path

/var/opt/novell/tomcat5/
webapps

SUSE Linux Enterprise Server

 Apache path

/etc/apache2/conf.d

 Tomcat path

/srv/www/tomcat5/webapps

Section 6.3.2, “Gathering Web 
Server Information,” on 
page 139

LDAP Server Information: 

 LDAP server address

 Port

 Root certificate of the LDAP server

Section 6.3.7, “Configuring 
Authentication to the 
Administration Web Console,” 
on page 142

Authentication Information: 

 Administrator username

 User container for contextless login

 Administrative group that the user 
must belong to

Section 6.3.7, “Configuring 
Authentication to the 
Administration Web Console,” 
on page 142

Calendar Publishing Host 
Configuration: 

 Name

 URL

 Description

 IP address

 TCP port

Section 6.3.3, “Determining the 
Configuration of the Calendar 
Publishing Host,” on page 139

Calendar Browse List: 

 Yes

 Corporate (restricted)

 Open

 No

Section 6.3.5, “Designing Your 
Calendar Browse List,” on 
page 141

Installation Program Field Value for Your GroupWise 
System Explanation
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Calendar Publishing Options: 

 Enable calendar publishing

 Enable rules to move items to a 
published calendar

 Enable subscribe to calendar

 Enable publish free/busy searches

Section 6.3.6, “Selecting 
Calendar Publishing Settings,” 
on page 141

Calendar Publishing Post Office: 

 Name:

 POA network address

 IP address

 DNS hostname

 Calendar publishing port

Section 6.3.4, “Connecting the 
Calendar Publishing Host to a 
POA,” on page 140

Installation Program Field Value for Your GroupWise 
System Explanation
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7 7Installing GroupWise Monitor

Novell GroupWise Monitor is a monitoring and management tool that allows you to monitor 
GroupWise agents and gateways from any location where you are connected to the Internet and have 
access to a Web browser. Some agent administration can also be performed from your Web browser. 
The topics below help you plan and set up GroupWise Monitor:

 Section 7.1, “GroupWise Monitor Overview,” on page 159
 Section 7.2, “Monitor System Requirements,” on page 161
 Section 7.3, “Planning GroupWise Monitor,” on page 163
 Section 7.4, “Setting Up GroupWise Monitor,” on page 167
 Section 7.5, “Using GroupWise Monitor,” on page 174
 Section 7.6, “GroupWise Monitor Installation Summary Sheets,” on page 177

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install Monitor. 

7.1 GroupWise Monitor Overview
GroupWise Monitor consists of two components:

Monitor Agent: The Monitor Agent continuously polls other GroupWise agents (POA, MTA, 
Internet Agent, WebAccess Agent, as well as the Messenger Agents, and GroupWise gateways), 
gathers status information from them, and displays the status information at the Monitor Agent 
server console. The Monitor Agent also services requests for agent status information from the 
Monitor Application. 

NOTE: The Monitor Agent server console is available on Windows, but not on Linux.

Monitor Application: The Monitor Application extends the capability of your Web server so that 
agent status information can be displayed in your Web browser. Two browser-based consoles are 
available:

 The Monitor Web console, provided by the Monitor Application, takes advantage of your Web 
server’s capabilities to make agent status information available to you when you are outside 
your firewall.

 The Monitor Agent Web console, provided by the Monitor Agent itself, can be used only behind 
your firewall but provides capabilities not available in the Monitor Web console. This section 
focuses on using the full-featured Monitor Agent Web console. Specific differences in 
functionality between the two Web consoles are summarized in “Comparing the Monitor 
Consoles” in “Monitor” in the GroupWise 8 Administration Guide.

NOTE: The Monitor browser-based consoles are available on both Windows and Linux.
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The Monitor Agent and the Monitor Application can run on the same server or on different servers, 
depending on the needs of your system.

 “One Monitor Server vs. Two” on page 160
 “Monitor Security Requirements” on page 160

7.1.1 One Monitor Server vs. Two

The Monitor Agent and the Monitor Application can run together on a Linux server or a Windows 
server, as illustrated below:

Figure 7-1   Monitor Agent and Application Installed on the Same Machine

The server where they run together must be a Web server because the Monitor Application is 
installed into the Web server installation.

The Monitor Agent and the Monitor Application can also run on different servers. In addition to 
running on a Linux or Windows server, the Monitor Application can also run on a NetWare server in 
conjunction with a Web server running on that platform, as illustrated below:

Figure 7-2   Monitor Agent Installed on a Windows Machine with the Monitor Application Installed on a NetWare, Linux, or Windows

Security, discussed in the Monitor Security Requirements, might also determine whether you run the 
Monitor Agent on the same server as the Web server.

7.1.2 Monitor Security Requirements

GroupWise Monitor can be configured to support the level of security you have established for your 
Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use Monitor on a 
secured intranet), you can install the Monitor components to any servers that provide access for your 
GroupWise administrators and that meet the requirements listed in Section 7.2, “Monitor System 
Requirements,” on page 161. 
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If you plan to use Monitor to provide GroupWise administrators with access to your GroupWise 
system from anywhere on the Internet (rather than simply within a secured intranet), and you 
already have a firewall in place to provide security, you have the following options for configuring 
Monitor:

 Install both Monitor components inside your firewall and use a proxy service. See “Configuring 
Monitor with a Proxy Service” on page 161. This is the recommended configuration.

 Install the Monitor Application on a Web server outside your firewall and the Monitor Agent on 
a server inside your firewall. See “Configuring Monitor without a Proxy Service” on page 161.

Configuring Monitor with a Proxy Service

If your firewall includes a proxy service, you can install the Monitor Application to a Web server 
inside your firewall, and the Monitor Agent to another server inside the firewall, as shown in the 
following illustration.

Figure 7-3   Monitor Installed inside the Firewall

If desired, the Monitor Agent can also be installed to the Web server rather than a separate server, as 
discussed in Section 7.1.1, “One Monitor Server vs. Two,” on page 160.

Configuring Monitor without a Proxy Service

If your firewall does not provide a proxy service, you need to install the Monitor Application to a 
Web server that is outside the firewall. Because the Monitor Agent requires direct access to a 
GroupWise domain directory, it needs to be installed to a server that is located within the firewall. It 
should be installed to the same server where a domain directory is located.

Figure 7-4   Monitor Installed outside the Firewall

The firewall must allow inbound IP packets to be sent from the Web server to the IP address and port 
number of the Monitor Agent (for example, 172.16.5.18:8200).

In addition, the firewall must allow outbound IP packets to be sent from the Monitor Agent to the 
Web server. This requires all high ports (above 1023) to be open to outbound IP packets. 

7.2 Monitor System Requirements
 x86-32 processor or x86-64 processor
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On a 64-bit processor, GroupWise still runs as a 32-bit application.

 Any of the following server operating systems for the Monitor Agent:

 Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support 
Pack

 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack
 Windows Server 2003, Windows 2003 R2, Windows Server 2008, or Windows Server 2008 

R2, plus the latest Service Pack

 Adequate server memory as required by the operating system

 Any of the following Web servers for the Monitor Application:

 NetWare 6.5: Apache 2.0 plus:
 Tomcat 4.1
 JVM 1.4.2
 Jakarta Connector 1.2

 OES 2 Linux / SLES 10: Apache 2.2 plus:
 Tomcat 5.0 or later
 JVM 1.4.2 or later
 ModProxy Module

 OES 11 / SLES 11: Apache 2.2 plus:
 Tomcat 6.0 or later
 JVM 1.5 or later
 ModProxy Module

 Windows Server 2003/2003 R2: Microsoft Internet Information Server (IIS) 6 or later plus:
 Tomcat 5.5 or later
 JVM 1.5 or later
 Jakarta Connector 1.2 or later

 Windows Server 2008/2008 R2: Microsoft Internet Information Server (IIS) 7 or later plus:
 Tomcat 5.5 or later
 JVM 1.5 or later
 Jakarta Connector 1.2 or later

 Any of the following Web browsers for the Monitor Web consoles:

 Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox 
 Macintosh: The latest version of Safari 1.0 for your version of Mac OS; Mozilla Firefox
 Linux: Mozilla Firefox

 Any of the following environments for running the GroupWise Installation program:

 Windows XP, Windows Vista, or Windows 7, plus the latest Service Pack, plus the Novell 
Client

 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 
2008 R2, plus the latest Service Pack, plus the Novell Client

 Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support 
Pack
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 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack
The X Window System is required by the GUI GroupWise Installation program that steps 
you through the process of creating a new GroupWise system. A text-based Installation 
program is also available.

 Adequate server disk space:

 Approximately 140 MB for the Monitor program files (111 MB shared with WebAccess; 
varies by platform)

 50 MB to 100 MB for log files if you plan to use Monitor’s reporting capabilities that rely on 
MTA message logging, as described in “Generating Reports” in “Monitor” in the GroupWise 
8 Administration Guide

7.3 Planning GroupWise Monitor
Use the “GroupWise Monitor Installation Summary Sheets” on page 177 to record your decisions 
about how to install GroupWise Monitor. The topics in this section present the required information 
in a convenient planning sequence. The Installation Summary Sheet organizes the information in the 
order in which you need it during installation.

 Section 7.3.1, “Deciding Where to Install the GroupWise Monitor Components,” on page 163
 Section 7.3.2, “Determining the Monitor Agent’s Configuration,” on page 165
 Section 7.3.3, “Determining the Monitor Application’s Configuration,” on page 166

For additional assistance in planning your GroupWise installation, see GroupWise Best Practices 
(http://wiki.novell.com/index.php/GroupWise) and GroupWise 8 Good and Bad Habits (http://
wiki.novell.com/index.php/GroupWise_8_Good_and_Bad_Habits).

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, refer to 
the GroupWise 8 Interoperability Guide as you plan your Monitor installation.

7.3.1 Deciding Where to Install the GroupWise Monitor Components

After reviewing Section 7.1, “GroupWise Monitor Overview,” on page 159 and the system 
requirements listed in Section 7.2, “Monitor System Requirements,” on page 161, plan where you 
want to install the Monitor components in your system.

 “Monitor Server” on page 163
 “Web Server” on page 164

Monitor Server

The Monitor Agent runs on Linux and Windows. On Linux, the Monitor Agent runs as a daemon. On 
Windows, the Monitor Agent runs as an application. The Monitor Agent cannot be run as a Windows 
service.

If you want to install the Monitor Agent and the Monitor Application on the same server, you can 
install them at the same time. If you want to install them on different servers, you must run the 
Monitor Installation program twice, once for each server. For example, you might want to install the 
Monitor Application on NetWare for use with a NetWare Web server, but you must always install the 
Monitor Agent on Linux or Windows. 
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The Monitor Agent needs to communicate with an MTA. If possible, install the Monitor Agent on the 
same server where a domain and MTA are already located. If you want to install the Monitor Agent 
on its own server, consider creating a domain on that server specifically for helping the Monitor 
Agent communicate with the rest of your GroupWise system.

The installation directory for the Monitor Agent depends on the platform:

Web Server

The Monitor Application integrates with your Web server to pass agent status information gathered 
by the Monitor Agent to your Web browser for display in the Monitor Web console. The location of 
the Monitor Application files that are installed depends on the Web server that it is being integrated 
with. The default Web server paths vary by platform:

The Web server uses a servlet engine in order to incorporate product-specific components, such as 
the Monitor Application, into its functioning.

Linux: The Linux Monitor Agent is automatically installed to /opt/novell/groupwise/
agents.

Windows: The default installation directory is c:\Program Files\Novell\GroupWise 
Server\Monitor.

GROUPWISE MONITOR AGENT INSTALLATION SUMMARY SHEET

Under Agent Software Platform, mark the platform (Linux or Windows) where you plan to install the 
Monitor Agent.

Under Server Information, specify the directory on the Linux or Windows server where you want to install 
the Monitor Agent software.

Apache Web Server for NetWare: drive:\Apache2

Apache Web Server for OES Linux:

Tomcat for OES Linux:

/etc/opt/novell/httpd/conf.d

/var/opt/novell/tomcat5/webapps

Apache Web Server for SLES:

Tomcat for SLES:

/etc/apache2/conf.d

/srv/www/tomcat5/base/webapps

Microsoft Internet Information Server 
(IIS) for Windows:

c:\inetpub\wwwroot

GROUPWISE MONITOR APPLICATION INSTALLATION SUMMARY SHEET

Under Web Server Information, select the type of Web server you want to use with Monitor, and specify 
the directory path to the Web server root directory.

On Windows, if the Internet Information Server services more than one Web site, specify the Web site 
where you want to install the Monitor Application.
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7.3.2 Determining the Monitor Agent’s Configuration

As you install the Monitor Agent, you are prompted to supply the configuration information 
described in the following sections:

 “Systems to Monitor” on page 165
 “Monitor Agent Network Address” on page 165
 “Domain Directory Path” on page 165
 “Windows Installation Option: Default Monitor Agent Language” on page 166
 “Linux Installation Option: LDAP Information” on page 166

Systems to Monitor

The Monitor Agent can monitor both GroupWise agents and Messenger agents. In addition, the 
Monitor Agent works in conjunction with the GroupWise High Availability service on Linux to 
automatically restart GroupWise and Messenger agents that go down unexpectedly

It is not necessary to have an entire GroupWise system installed in order for the Monitor Agent to 
monitor Messenger agents. For more information, see “Setting Up the High Availability Service” in 
“Installing a Novell Messenger System” in the Novell Messenger 2.2 Installation Guide.

Monitor Agent Network Address

The Monitor Agent communicates with the Monitor Application and with monitored agents by way 
of TCP/IP.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port 
Numbers” in the GroupWise 8 Administration Guide.

Domain Directory Path

The Monitor Agent can gather information about the locations of GroupWise agents to monitor by 
reading from a domain database. Using the gathered information, the Monitor Agent can display a 
list of monitored agents when you start it for the first time.

GROUPWISE MONITOR AGENT INSTALLATION SUMMARY SHEET

Under System Options, mark whether you want to monitor a GroupWise system, a Messenger system, or 
both.

GROUPWISE MONITOR AGENT INSTALLATION SUMMARY SHEET

Under Server Information, record the IP address or DNS hostname of the Linux or Windows server 
where you plan to install the Monitor Agent software. Use the default port number of 8200 unless that 
number is already in use on that server.

GROUPWISE MONITOR AGENT INSTALLATION SUMMARY SHEET

Under Domain Directory, specify the directory path to a domain where a GroupWise 6.x or later MTA is 
running.
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Windows Installation Option: Default Monitor Agent Language

GroupWise Monitor is automatically installed in all available languages. During installation, you can 
select a default language for the Monitor Agent server console interface, which is available only on 
Windows.

NOTE: On Linux, you use the Monitor Web consoles exclusively.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 8 Administration 
Guide.

Linux Installation Option: LDAP Information

If you are installing the Linux Monitor Agent and Monitor Application, the Installation program 
needs to access eDirectory through LDAP. eDirectory access is required in order to create the Monitor 
Application objects. To obtain access, the Installation program needs the IP address and port number 
of an LDAP server, along with an eDirectory username and password to log in with. The user must 
have sufficient rights to create GroupWise objects in eDirectory. Because the Linux Installation 
program uses LDAP to access eDirectory, you must provide the username in LDAP format. For 
example:

cn=admin,ou=users,o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a root certificate file. For 
background information about SSL, see “Trusted Root Certificates and LDAP Authentication” in 
“Security Administration” in the GroupWise 8 Administration Guide. 

IMPORTANT: If you do not want to use SSL, the LDAP server must be configured to accept clear 
text passwords. This is configured on the server’s LDAP Group object in ConsoleOne by deselecting 
Require TLS for Simple Binds with Password.

7.3.3 Determining the Monitor Application’s Configuration

As you install the Monitor Application to a Web server, you are prompted to supply the 
configuration information described in the following sections:

 “eDirectory Objects and Configuration File” on page 167
 “Default Monitor Web Console Language” on page 167

GROUPWISE MONITOR AGENT INSTALLATION SUMMARY SHEET

Under Default Language, specify a default language.

GROUPWISE MONITOR AGENT INSTALLATION SUMMARY SHEET

Under LDAP Authentication, specify the IP address and port number of an LDAP server, a username in 
LDAP format, the password for the username, and if necessary, the full path to your SSL root certificate 
file.
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eDirectory Objects and Configuration File

Monitor Application configuration information is stored in two places: 

 In Novell eDirectory
 In a configuration file (gwmonitor.cfg), located in the following directories:

You can easily modify the configuration information in ConsoleOne by editing the properties of the 
GroupWise Monitor Application object (named GroupWiseMonitor). However, the configuration file 
is required if you need to install the Monitor Application to a Web server that is outside your firewall, 
where access to eDirectory is not available. 

eDirectory is considered the master location for the Monitor Application configuration information. 
Any changes made directly to the Monitor Application configuration file are overwritten the next 
time the information in eDirectory is modified and saved.

The default configuration information is sufficient for an initial Monitor installation. For more 
information about configuring Monitor, see “Monitor” in the GroupWise 8 Administration Guide.

Default Monitor Web Console Language

GroupWise Monitor is automatically installed in all available languages. If necessary, you can select a 
different default language for the Monitor Web console interface than you selected for the Monitor 
Agent server console interface.

NOTE: The Monitor Agent server console interface is available only on Windows.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 8 Administration 
Guide.

7.4 Setting Up GroupWise Monitor
Follow the instructions for the platform where you are setting up GroupWise Monitor:

 Section 7.4.1, “Windows: Setting Up GroupWise Monitor,” on page 168
 Section 7.4.2, “Linux: Setting Up GroupWise Monitor,” on page 170

Linux: /var/opt/novell/groupwise/monitor/gwmonitor.cfg

Windows: c:\Novell\GroupWise\gwmonitor

GROUPWISE MONITOR APPLICATION INSTALLATIONSUMMARY SHEET

Under Monitor Application Object, specify the tree and context where you want the Installation program 
to create the GroupWise Monitor Application object (named GroupWiseMonitor) and the accompanying 
Monitor Provider object (named GroupWiseProvider).

GROUPWISE MONITOR AGENT INSTALLATION SUMMARY SHEET

Under Default Language, specify a default language for the Monitor Web console
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IMPORTANT: If you are installing GroupWise Monitor in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install Monitor. 

7.4.1 Windows: Setting Up GroupWise Monitor

1 At a Windows server that meets the requirements listed in Section 2.1, “GroupWise 
Administration Requirements,” on page 17, log in as an Admin equivalent to the eDirectory tree 
in which you are installing Monitor.

2 If you want to monitor non-HTTP-enabled agents (such as earlier versions of any GroupWise 
agent), install the SNMP service for Windows.
This enables the Monitor Agent to use SNMP in addition to HTTP.

3 Make sure no GroupWise agents are currently running on the Windows server where you plan 
to install the Monitor Agent.

4 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run setup.exe from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the Monitor Agent software to a software distribution directory, run 
setup.exe from the root of the software distribution directory to start the GroupWise 
Installation program.

5 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: All available languages are included on the GroupWise 8 DVD and the multilanguage 
version of the GroupWise 8 software image, but you can select which languages you want to 
install.

The main GroupWise System Installation page appears.

6 Click More Components, then click Install Monitor.
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7 Select the interface language for the Installation program, then click OK.
8 Click Yes to accept the License Agreement and display the GroupWise Monitor: Components 

dialog box.

9 Follow the prompts to provide information about Monitor Agent configuration, using the 
following information from the GroupWise Monitor Installation Summary Sheets.

Components
Server Information
System Options
Domain Directory 
Default Language

10 Follow the prompts to provide information about Monitor Application configuration, using the 
following information from the GroupWise Monitor Installation Summary Sheets.

Agent Information
Web Server Information
Default Language
Monitor Application Object

11 When the installation is complete, select from the following options:
Launch Installation Summary: This option displays a list of the information you provided 
during installation. You can print it for future reference.
Start the GroupWise Monitor Agent: This option starts the Monitor Agent immediately. If you 
want to configure the server to start the Monitor Agent automatically each time the server 
restarts, see “Starting the NetWare GroupWise Agents” on page 197 or “Starting the Windows 
GroupWise Agents” on page 222.

NOTE: If you installed only the Monitor Application, this option does not appear.

Restart the Web Server: This option starts the Web server, which loads the Monitor Application. 

NOTE: If you installed the Monitor Application to the Internet Information Server (IIS) on 
Windows, the Monitor Installation program automatically installed Tomcat 5.5 to the following 
directory on your Windows Web server:

c:\novell\groupwise\tomcat5.5

The Installation program then starts Tomcat as a Windows service for use by Monitor.

12 Click Finish to exit the Monitor Installation program.
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13 Click Finish to exit the GroupWise Installation program as well.
If you chose to start the Monitor Agent immediately, the Monitor Agent server console displays 
on the Windows server.

If the Monitor Agent does not start successfully, see “Starting the Windows GroupWise Agents” 
on page 222

14 If you use a proxy service, follow the instructions in “Configuring Proxy Service Support for the 
Monitor Web Console” in “Monitor” in the GroupWise 8 Administration Guide.

7.4.2 Linux: Setting Up GroupWise Monitor

Complete the following tasks to install GroupWise Monitor on Linux:

 “Installing the Linux Monitor Agent” on page 170
 “Configuring the Linux Monitor Agent” on page 171
 “Installing and Configuring the Monitor Application” on page 172
 “Restarting the Web Server” on page 173
 “Starting the Linux Monitor Agent as a Daemon” on page 173

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install Monitor. 

If you are new to Linux, you might want to review Appendix A: Useful Linux Commands for 
Administering a GroupWise System in the GroupWise 8 Administration Guide before you install the 
GroupWise Monitor on Linux.

Installing the Linux Monitor Agent

1 Make sure that Apache 2 and Tomcat 5 are installed as your Web server.
They might not be installed by default on your system.

2 Make sure that LDAP is running on your eDirectory server and that it is configured to accept 
login from the Installation program.
The Installation program requires eDirectory access in order to create the Monitor objects in 
eDirectory. The Installation program uses LDAP to gain the required access.

3 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
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Run install from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the Monitor Agent software to a software distribution directory, run 
./install from the root of the software distribution directory to start the GroupWise 
Installation program.
The X Window System is required for running the GUI GroupWise Installation program. If you 
are not using the X Window System, you can install GroupWise components individually, as 
described in “Installing the GroupWise Agents Using the Text-Based Installation Program” on 
page 201.

4 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are 
always installed.

The main GroupWise System Installation page appears.

5 Click Install Products > GroupWise Monitor > Install GroupWise Monitor Agent.
6 When the installation is complete, click OK.

The Monitor Agent software is installed to /opt/novell/groupwise/agents.
7 Continue with Configuring the Linux Monitor Agent.

Configuring the Linux Monitor Agent

1 After the Monitor Agent files have been installed, click Configure Monitor.
The Monitor Agent installation and configuration steps are separate so that you can install 
updated agent software without repeating the agent configuration steps.
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2 Follow the prompts to configure the Monitor Agent, using the following information from the 
GroupWise Monitor Agent Installation Summary Sheet.

System Options
Domain Directory
On the Configuration Complete page, Launch Monitor Agent on System Startup is selected by 
default.

3 Click Exit to complete the installation.
4 Continue with Installing and Configuring the Monitor Application.

Installing and Configuring the Monitor Application

1 After installing and configuring the Monitor Agent, if necessary, click Install Monitor Application.
The Monitor Application is installed into the following directories:

/etc/opt/novell/groupwise/monitor
/var/opt/novell/groupwise/monitor

and is linked into your Web server.
2 When the file copy is complete, click OK.
3 Click Configure Monitor Application.
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4 Follow the prompts to provide information about Monitor Application, using the following 
information from the GroupWise Monitor Application Installation Summary Sheet in the order 
listed.

Server Information
Web Server Information
LDAP Authentication
Monitor Application Object

5 Click Exit to complete the configuration.
6 If you use a proxy service, follow the instructions in “Configuring Proxy Service Support for the 

Monitor Web Console” in “Monitor” in the GroupWise 8 Administration Guide.
7 Continue with Restarting the Web Server.

Restarting the Web Server

In order to load the Monitor Application, you must restart the Web server.

Starting the Linux Monitor Agent as a Daemon

NOTE: Unlike the other GroupWise agents, you do not need to be logged in as root in order to start 
the Monitor Agent.

1 Make sure you know the path to a domain directory where a domain database (wpdomain.db) is 
located or the IP address of a server where the MTA is running.

2 Change to the GroupWise agent bin directory.

cd /opt/novell/groupwise/agents/bin

3 Use one of the following commands to start the Monitor Agent:

NetWare: NetWare 6.5:

unload apache2
unload java
tomcat4
apache2

Linux: Novell Open Enterprise Server 2 Linux installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/novell-tomcat5 stop
/etc/init.d/novell-tomcat5 start
/etc/init.d/apache2 start

SUSE Linux Enterprise Server 10 installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/tomcat5 stop
/etc/init.d/tomcat5 start
/etc/init.d/apache2 start

Windows 1. At the Windows server, click Start > Administrative Tools > Services.

2. Right-click Tomcat 5.5, then click Restart.

3. Right-click World Wide Web Publishing Service, then click Restart.
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./gwmon --home /domain_directory &

./gwmon --ipa IP_address --ipp port_number &

The --home startup switch specifies a domain directory where the Monitor Agent can access a 
domain database.
The --ipa startup switch specifies the IP address of a server where an MTA is running, which is 
another way for the Monitor Agent to obtain information from a domain database. The --ipp 
startup switch specifies the port number of the MTA’s HTTP port on which the Monitor Agent 
communicates with the MTA.
The ampersand (&) causes the Monitor Agent to run in the background, so that the terminal 
window you started it in is again available for use.
To remind yourself of these commands when you are at your Linux server, view the gwmon 
man page.
You can also start the Monitor Agent by using its startup script (/etc/init.d/grpwise-ma), as 
described in the grpwise-ma man page.
The Monitor Agent does not have a --show switch. The Monitor log file (mmddmon.nnn) for status 
messages is located in the /var/log/novell/groupwise/gwmon directory. The log file name 
includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day. The Monitor Agent can also be monitored from 
your Web browser.
If the Monitor Agent does not start successfully, see “Starting the Linux GroupWise Agents as 
Daemons” on page 204.

4 If you use a proxy service, follow the instructions in “Configuring Proxy Service Support for the 
Monitor Web Console” in “Monitor” in the GroupWise 8 Administration Guide.

5 After the Monitor Agent starts successfully, refer to the following sections in Chapter 8, 
“Installing GroupWise Agents,” on page 181 for additional information about managing the 
Monitor Agent on Linux:
 “Starting the Linux GroupWise Agents on System Startup” on page 206
 “Configuring the Monitor Agent to Communicate with the Groupwise High Availability 

Service” on page 214
 “Stopping the Linux GroupWise Agents” on page 215
 “Uninstalling the Linux GroupWise Agents” on page 217

6 For instructions on using the Monitor Web consoles, skip to Section 7.5, “Using GroupWise 
Monitor,” on page 174.

7.5 Using GroupWise Monitor
You can use GroupWise Monitor in various environments:

 Section 7.5.1, “Monitor Agent Server Console on a Windows Server,” on page 174
 Section 7.5.2, “Monitor Web Consoles in Your Web Browser,” on page 175

7.5.1 Monitor Agent Server Console on a Windows Server

To start the Monitor Agent on a Windows server and display the Monitor Agent server console, click 
Start > All Programs > GroupWise Monitor > GroupWise Monitor. The Monitor Agent server console 
appears.
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Figure 7-5   Monitor Agent Console

At the Monitor Agent server console, you can perform many activities, for example:

 Use items on the Configuration menu to configure the Monitor Agent as needed.
 Use items on the View menu to choose how much and what kind of agent status information to 

display.
 Create agent groups in order to monitor related agents together.
 Use items on the Reports menu to check the status of links throughout your GroupWise system 

and to organize status information into a format that can be e-mailed or printed.
 Use items on the Actions menu to control agent polling.

For more information about using the Monitor Agent server console, see “Monitor” in the GroupWise 
8 Administration Guide.

7.5.2 Monitor Web Consoles in Your Web Browser

Monitor has two different Web consoles. The Monitor Web console uses the capabilities of your Web 
server to provide access from outside your firewall. The Monitor Agent Web console is provided by 
the Monitor Agent itself and provides additional functionality beyond that which is available from 
outside your firewall.

 “Monitor Web Console” on page 175
 “Monitor Agent Web Console” on page 176

Monitor Web Console

To display agent status information in your Web browser from outside your firewall, enter the 
Monitor Web console URL in your Web browser:

https://network_address/gwmon/gwmonitor

where network_address represents the IP address or DNS hostname of the server where your Web 
server runs. The Monitor Web console appears.
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Figure 7-6   Monitor Web Console

You can use this same URL to view the same agent status information in various browsers and 
mobile devices.

You can perform many of the same monitoring activities at the Monitor Web console as you can at the 
Monitor Agent server console. Refer to the online help in the Monitor Web console for additional 
information about each Monitor Web console page.

For more information about using the Monitor Web console, see “Monitor” in the GroupWise 8 
Administration Guide.

Monitor Agent Web Console

To display agent status information in your Web browser from inside your firewall, enter the Monitor 
Agent Web console URL in your Web browser:

http://network_address:8200

Figure 7-7   Monitor Agent Web Console

For instructions on protecting the Monitor Agent Web console with a password, see “Configuring 
Authentication and Intruder Lockout for the Monitor Web Console” in “Monitor” in the GroupWise 8 
Administration Guide.
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7.6 GroupWise Monitor Installation Summary Sheets
 Section 7.6.1, “GroupWise Monitor Agent Installation Summary Sheet,” on page 177
 Section 7.6.2, “GroupWise Monitor Application Installation Summary Sheet,” on page 178

7.6.1 GroupWise Monitor Agent Installation Summary Sheet 

Installation Program Field Value for Your GroupWise 
System

Explanation

Agent Software Platform: 

 Linux

 Windows

Section 7.3.1, “Deciding Where to 
Install the GroupWise Monitor 
Components,” on page 163

Components: 

 GroupWise Monitor Agent

Section 7.1, “GroupWise Monitor 
Overview,” on page 159

Server Information: 

 Installation path

 Network address

IP address

DNS hostname

TCP port

Section 7.3.1, “Deciding Where to 
Install the GroupWise Monitor 
Components,” on page 163

“Monitor Agent Network Address” 
on page 165

System Options: 

 GroupWise

 Novell Messenger

“Systems to Monitor” on page 165

Domain Directory: “Domain Directory Path” on 
page 165

Default Language: 

Windows only

 English

 French

 German

 Brazilian Portuguese

 Spanish

“Windows Installation Option: 
Default Monitor Agent Language” 
on page 166
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7.6.2 GroupWise Monitor Application Installation Summary Sheet

LDAP Authentication: 

Linux only

 LDAP Server IP Address

 Port

 Username

 Password

 Use SSL Connection

 Yes

Path to SSL certificate 
file

 No

“Linux Installation Option: LDAP 
Information” on page 166

Installation Program Field Value for Your GroupWise 
System Explanation

Installation Program Field Value for Your GroupWise 
System Explanation

Components: 

 GroupWise Monitor 
Application

Section 7.1, “GroupWise Monitor 
Overview,” on page 159

Agent Information: “Monitor Agent Network Address” 
on page 165
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Web Server Information: 

Windows

 Apache Web Server for 
NetWare

 Path to the Web server’s root 
directory

Windows

 Microsoft Internet Information 
Server (IIS) for Windows

 Path to the Web server’s root 
directory

 Web site

Linux

 Apache path

/etc/apache2/conf.d

 Tomcat path

/srv/www/tomcat5/base/
webapps

Section 7.3.1, “Deciding Where to 
Install the GroupWise Monitor 
Components,” on page 163

Installation Program Field Value for Your GroupWise 
System Explanation
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Default Language: 

Windows only

 Arabic

 Brazilian Portuguese

 Chinese Simplified

 Chinese Traditional

 Czech

 Danish

 Dutch

 English

 Finnish

 French

 German

 Hebrew

 Hungarian

 Italian

 Japanese

 Korean

 Norwegian

 Polish

 Russian

 Spanish

 Swedish

“Default Monitor Web Console 
Language” on page 167

Monitor Application Objects: 

 Tree

 Context

“eDirectory Objects and 
Configuration File” on page 167

Installation Program Field Value for Your GroupWise 
System Explanation
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8 8Installing GroupWise Agents

Novell GroupWise agents are first installed and started as part of installing a basic GroupWise 
system, as described in Chapter 3, “Installing a Basic GroupWise System,” on page 25. The following 
sections help you install additional agents as you create new domains and post offices in your 
growing GroupWise system.

 Section 8.1, “GroupWise Agent Overview,” on page 181
 Section 8.2, “Agent System Requirements,” on page 183
 Section 8.3, “Planning the GroupWise Agents,” on page 184
 Section 8.4, “Setting Up the GroupWise Agents,” on page 190
 Section 8.5, “What’s Next,” on page 225
 Section 8.6, “GroupWise Agent Installation Summary Sheet,” on page 225

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install the agents. 

8.1 GroupWise Agent Overview
Each time you create a new post office, you must set up at least one Post Office Agent (POA) for it. 
Some of the POA’s tasks in the post office include:

 Connecting GroupWise clients to mailboxes through network connections (TCP/IP, IMAP, 
SOAP)

 Sending messages to other users and delivering incoming messages into mailboxes
 Indexing messages and documents to support the Find feature in the GroupWise clients
 Managing disk space usage in the post office and controlling the size of messages that users are 

allowed to send and receive

Each time you create a new domain, you must set up a Message Transfer Agent (MTA) for it. Some of 
the MTA’s tasks in the domain include:

 Routing user messages between post offices and domains
 Routing administration messages throughout the GroupWise system so that databases are kept 

in sync
 Synchronizing GroupWise user information with Novell eDirectory user information
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The POA requires direct access to the post office directory so that it can write to the post office 
database. The MTA requires direct access to the domain directory so that it can write to the domain 
database. In addition, the POA and the MTA must be able to communicate with each other.

 Section 8.1.1, “Local Access to Databases,” on page 182
 Section 8.1.2, “Remote Access to Databases,” on page 182
 Section 8.1.3, “Links between the MTA and the POA,” on page 183

8.1.1 Local Access to Databases

The preferred way to fulfil this requirement is to install each agent on the same server with its 
directory. Running an agent locally on the same server where its directory and database are located 
simplifies network connections, because no remote login is required. In addition, it reduces network 
traffic and protects database integrity. The following diagram illustrates direct access:

Figure 8-1   Direct Access between Agents and Directories

8.1.2 Remote Access to Databases

If necessary, you can install the agent on a different server from its directory if you are using NetWare 
or Windows. This requires the agent to have a direct link (mapped drive or UNC path) to its directory 
on the remote server in order to function. The following diagram illustrates the direct links:

Figure 8-2   Direct Links between Agents and Directories

IMPORTANT: On Linux, file system mounts between Linux servers to not provide the necessary file 
locking mechanisms for the GroupWise Linux agents to access their databases on remote Linux 
servers.
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8.1.3 Links between the MTA and the POA

To route user and administration messages to the post office, the MTA requires a TCP/IP link to the 
POA for the post office, or alternatively, a direct link (mapped drive or UNC path for NetWare or 
Windows) to the post office directory. The following diagram illustrates the alternatives:

Figure 8-3   MTA Link Alternatives

IMPORTANT: On Linux, file system mounts between Linux servers to not provide the necessary file 
locking mechanisms for the GroupWise Linux agents to access their databases on remote Linux 
servers.

8.2 Agent System Requirements
 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.

 Any of the following server operating systems for the POA and the MTA:

 Novell Open Enterprise Server (OES) 2 (NetWare or Linux version) or OES 11, plus the 
latest Support Pack

 NetWare 6.5, plus the latest Support Pack
 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack

The X Window System and Open Motif are required by the GUI GroupWise agent server 
consoles. By default, the agents run as daemons without user interfaces.

 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 
2008 R2, plus the latest Service Pack

 Adequate server memory as required by the operating system

 Any of the following environments for running the GroupWise Installation program:

 Windows XP, Windows Vista, or Windows 7, plus the latest Service Pack, plus the Novell 
Client

 Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server 
2008 R2, plus the latest Service Pack, plus the Novell Client

 Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support 
Pack
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 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack
The X Window System is required by the GUI GroupWise Installation program that steps 
you through the process of creating a new GroupWise system. A text-based Installation 
program is also available.

 Approximately 25 MB for the agent software (varies by platform)

The amount of memory actually used by the POA depends on the number of active users, as 
illustrated by the table below:

Table 8-1   Memory Usage Examples

The POA typically performs best with abundant cache memory available. On the server where it 
runs, at least 2 GB of memory is recommended.

8.3 Planning the GroupWise Agents
Use the “GroupWise Agent Installation Summary Sheet” on page 225 to record your decisions about 
how to install the GroupWise agents. The topics in this section present the required information in a 
convenient planning sequence. The Installation Summary Sheet organizes the information in the 
order in which you need it during installation.

 Section 8.3.1, “Selecting the Agent Platform,” on page 185
 Section 8.3.2, “Selecting the Agent Location,” on page 185
 Section 8.3.3, “Selecting the Agent Installation Directory,” on page 185
 Section 8.3.4, “Gathering Domain and Post Office Information,” on page 186
 Section 8.3.5, “Deciding Which Languages to Install,” on page 186
 Section 8.3.6, “NetWare Installation Options: Automatic Startup, Protected Mode, and 

Clustering,” on page 187
 Section 8.3.7, “Linux Installation Options: Automatic Startup and Clustering,” on page 188
 Section 8.3.8, “Windows Installation Options: SNMP Traps and Service vs. Application,” on 

page 188

For additional assistance in planning your GroupWise installation, see GroupWise Best Practices 
(http://wiki.novell.com/index.php/GroupWise) and GroupWise 8 Good and Bad Habits (http://
wiki.novell.com/index.php/GroupWise_8_Good_and_Bad_Habits).

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, refer to 
the GroupWise 8 Interoperability Guide as you plan your agent installation. 

Concurrent Users
Actual Memory Usage 
at Peak Time

100 active users (100-250 users in post office) 80 MB

250 active users (250-500 users in post office) 160 MB

500 active users (500-1000 users in post office) 250 MB

1000 active users (1000-2500 users in post office) 500 MB
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8.3.1 Selecting the Agent Platform

The MTA and POA are available as NetWare NLM programs, Linux executables, and Windows 
executables.

In general, GroupWise is most efficient if you match the agent platform with the network operating 
system where the post office and domain are located. For example, if a domain and post office are 
located on a NetWare server, then you would install the NetWare agents for them. However, this is 
not required. 

Those with mixed networks might wonder what platform combinations are possible. For more 
information, see the following sections in the GroupWise 8 Administration Guide:

 “Cross-Platform Issues in the Post Office” in “Post Office Agent”
 “Cross-Platform Issues between Domains and Post Offices” in “Message Transfer Agent”

8.3.2 Selecting the Agent Location

Record which GroupWise agents you plan to run on the selected server (POA, MTA, or both) and 
whether you want to install the agents locally or remotely in relation to their directories and 
databases, as described in Section 8.1, “GroupWise Agent Overview,” on page 181.

If the NetWare agents need to access their directories and databases on remote NetWare servers, you 
must add configuration information to the agent startup files to provide the needed access. Use the /
dn switch to specify the distinguished name of the agent object that was created along with the 
Domain or Post Office object. The remote servers must be in the same eDirectory tree as the server 
where the agents are running.

8.3.3 Selecting the Agent Installation Directory

The agent installation directory depends on the platform where you are installing the agents. 

Consider these platform-specific guidelines:

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agent Software Platform, mark whether you plan to install the agents on NetWare, Linux, or 
Windows. Review Section 8.2, “Agent System Requirements,” on page 183 to ensure that the specific 
server you have selected meets the listed requirements.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agents and Locations, mark the agents to install and their locations relative to the directories and 
databases they need to access.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agents and Locations, for the NetWare agents, record the startup switches and settings you need 
to add to the agent startup files after installation if you are installing the agents on a different NetWare 
server from where their directories and databases are located.
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Both the MTA and the POA are installed to the specified directory.

8.3.4 Gathering Domain and Post Office Information

Record the following information about the domain and post office for which you are installing and 
setting up the GroupWise agents: 

The domain and post office must exist before you install the agents for them. If necessary, create the 
domain and post office that you are installing the agents for now. See following sections of the 
GroupWise 8 Administration Guide for instructions:

 “Creating a New Domain”
 “Post Offices”

8.3.5 Deciding Which Languages to Install

If you have administrators with various language preferences, you can install and run the GroupWise 
agents in multiple languages. You should also install all languages used by GroupWise client users, 
so that message status information returned from the POA to users’ mailboxes matches the language 
in which each user is running the client.

NOTE: On Linux, all available languages are included in the RPMs, so all languages are always 
installed.

NetWare: When installing the NetWare agents, we recommend you use the sys:\system directory 
on the NetWare server. This simplifies the use of startup files and ensures that the NLM 
programs are in the server’s search path. If you use a different directory, you must add that 
directory to the server’s search path.

Linux: The Linux agents are automatically installed to /opt/novell/groupwise/agents. 

Windows: The default installation directory is c:\Program Files\Novell\GroupWise 
Server\Agents. However, you can install the agents to any directory you want.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Installation Path, record the directory where you want to install the GroupWise agent software.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Domain Information, record the domain name and path to the domain directory for the new 
domain.

Under Post Office Information, record the post office name and path to the post office directory for the 
new post office.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agent Language Selection, list the languages you want to install the agents for.

Under Client Language Selection, list the client languages that you want the agents to be able to support.
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By default, the agents start in the language selected for the domain. If that language has not been 
installed, the agents start in the language used by the operating system. If that language has not been 
installed, the agents start in English.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 8 Administration 
Guide.

8.3.6 NetWare Installation Options: Automatic Startup, Protected Mode, and 
Clustering 

When you install the NetWare GroupWise agents, the following options specific to NetWare are 
available in the Installation program:

 “Automatic Startup” on page 187
 “Protected Mode” on page 187
 “Novell Cluster Services” on page 187

Automatic Startup

You can have the Installation program add a reference to the grpwise.ncf file in the NetWare 
server’s autoexec.ncf file so that the GroupWise agents are automatically loaded whenever the 
server is started.

Protected Mode

You can have the Installation program configure the NetWare agents to run in Protected Mode, 
which starts them in their own protected address space on the NetWare server.

Novell Cluster Services

Novell Cluster Services is a server clustering system that ensures high availability and manageability 
of critical network resources including volumes (where GroupWise domains and post offices reside) 
and applications (such as the GroupWise agents). Novell Cluster Services supports failover, failback, 
and migration of individually managed cluster resources. 

The NetWare GroupWise agents can be configured to take advantage of the fault-tolerant 
environment provided by Novell Cluster Services if the following requirements are met:

 The domains and post offices to be serviced by the NetWare agents have already been created on 
shared NSS volumes in the cluster.

 The NetWare agents are being installed to a server that is part of the same cluster.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agent Options, mark whether or not you want to configure the NetWare server to start the 
GroupWise agents automatically.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agent Options, mark whether or not you want to configure the NetWare server to start the 
GroupWise agents in Protected Mode.
Installing GroupWise Agents 187



When the agents are configured for clustering, their startup files are configured with shared volume 
names rather than specific server names. In addition, the POA is configured to more effectively 
reestablish logins with GroupWise clients when a failover or migration situation arises.

8.3.7 Linux Installation Options: Automatic Startup and Clustering

When you install the Linux GroupWise agents, the following options specific to Linux are available 
in the Installation program:

 “Automatic Startup” on page 188
 “Clustering on Linux” on page 188

Automatic Startup

The Linux GroupWise agent are Run Control compliant. You can have the Installation program 
create symbolic links to the grpwise script in the rc3.d and rc5.d directories so that the agents load 
on restart into run level 3 or 5, depending on the configuration of your Linux system.

Clustering on Linux

On Linux, you can install the GroupWise agents on Novell Cluster Services. The Linux GroupWise 
Installation program provides a Configure GroupWise for Clustering option that simplifies the process 
of installing the Linux GroupWise agents on multiple nodes in the cluster. 

8.3.8 Windows Installation Options: SNMP Traps and Service vs. Application

When you install the Windows agents, you have choices about how the agents interact with the 
Windows operating system.

 “SNMP Traps” on page 189
 “Service vs. Application” on page 189

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agent Options, mark whether or not you want to configure the NetWare agents for clustering. If 
you do, follow the installation instructions in “Setting Up a Domain and Post Office in a NetWare Cluster” 
in “Novell Cluster Services on NetWare” in the GroupWise 8 Interoperability Guide, rather than the 
installation instructions in this guide.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agent Options, mark whether or not you want to configure the Linux server to start the GroupWise 
agents automatically.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agent Options, mark whether you want to configure the Linux GroupWise agents for clustering 
using Novell Cluster Services. If you do, follow the installation instructions provided in “Setting Up a 
Domain and a Post Office in a Linux Cluster” in Novell Cluster Services on Linux in the GroupWise 8 
Interoperability Guide, rather than the installation instructions in this guide.
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SNMP Traps

If you want to use an SNMP manager program, such as the Management and Monitoring Services 
component of Novell ZENworks Server Management, to monitor the agents, you must install some 
SNMP components along with the Windows agent software.

If this option is dimmed during installation, the SNMP service has not been enabled on the Windows 
server where you are installing the agents. If you want to monitor the agents from an SNMP 
management program, the SNMP service must be enabled so you can select this option. For 
instructions, see the following sections in the GroupWise 8 Administration Guide:

 “Setting Up SNMP Services for the POA”
 “Setting Up SNMP Services for the MTA”

NOTE: The NetWare and Linux agents rely on operating system components for SNMP functionality 
and do not require this installation option.

Service vs. Application

When you run the GroupWise Windows agents as services, they can start automatically and run 
without a user interface.

When you run the Windows agents as services, they must run under a specific Windows user 
account. 

When domains and post offices are located on the same server where you are installing the agents, 
the agents can run under the local system account. You can also display the agent server consoles 
when the agent software, directories, and databases are local. 

When domains and post offices are located on a remote server, you must specify a user with rights to 
access the domain and post office directories. 

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Agent Options, mark Install and Configure SNMP for GroupWise Agents if you want to use an 
SNMP manager program.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Windows Service Information, mark Install as Windows Services if you want to run the agents as 
services.

Remote Windows Server: If the Windows agents need to log in to a another Windows server, provide a 
Windows username and password. 

Remote NetWare Server: If the Windows agents need to log in to a NetWare server, provide an 
existing eDirectory username and password, or create a new account for 
the agents, as described in “Creating a NetWare Account for Agent Access 
(Optional)” on page 193.
Installing GroupWise Agents 189



As with all Windows services, the Windows agents can be started automatically or manually as 
services each time the Windows server restarts.

NOTE: On Windows Server 2008, the Windows agents running as services cannot interact with the 
desktop. They must run as background processes.

8.4 Setting Up the GroupWise Agents
After creating a new domain or post office, you need to configure the Agent object (MTA or POA) 
that was automatically created with it, then follow the setup instructions for the platform where you 
are installing the GroupWise agents:

 Section 8.4.1, “Configuring New Agent Objects in eDirectory,” on page 190
 Section 8.4.2, “NetWare: Setting Up the GroupWise Agents,” on page 191
 Section 8.4.3, “Linux: Setting Up the GroupWise Agents,” on page 198
 Section 8.4.4, “Windows: Setting Up the GroupWise Agents,” on page 218

8.4.1 Configuring New Agent Objects in eDirectory

When you create new post offices and domains, Agent objects are automatically created for them. 
Most agent configuration can be done after installation, but a few settings should be established 
before you install the agent software.

1 In ConsoleOne, browse to and expand the eDirectory container where the new post office or 
domain is located to display its contents.

2 Select the Post Office object or Domain object to display its contents.
3 Right-click the Agent object, then click Properties to display the agent Identification page.
4 In the Description field, type a brief description of the agent for display at the agent server 

console.
5 In the Platform field, select NetWare, Linux, or Windows.
6 Click OK to save the new Agent object properties.
7 Repeat these steps for each new post office and domain for which you are installing agents.
8 Continue with the installation instructions for the platform where you are installing the 

GroupWise agents.
 Section 8.4.2, “NetWare: Setting Up the GroupWise Agents,” on page 191

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Windows Service Information, record the account the agents will run under, and if necessary, the 
password for the account.

GROUPWISE AGENT INSTALLATION SUMMARY SHEET

Under Windows Service Information, mark how you want the Windows agents to start each time the 
server is restarted.
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 Section 8.4.3, “Linux: Setting Up the GroupWise Agents,” on page 198
 Section 8.4.4, “Windows: Setting Up the GroupWise Agents,” on page 218

8.4.2 NetWare: Setting Up the GroupWise Agents

Complete the following tasks to set up the NetWare agents. These tasks are designed to help you get 
the POA and MTA up and running as quickly as possible.

 “Preparing the NetWare Server for the Agents” on page 191
 “Installing the NetWare Agent Software” on page 193
 “Editing the NetWare Agent Startup Files” on page 196

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install the agents. 

Refer to the following additional tasks as you maintain all the GroupWise agents on NetWare:

 “Starting the NetWare GroupWise Agents” on page 197
 “Stopping the NetWare GroupWise Agents” on page 198
 “Uninstalling the NetWare GroupWise Agents” on page 198

Preparing the NetWare Server for the Agents

Make sure the NetWare server where you plan to install the GroupWise agents has been properly 
prepared to run the agents:

 “Obtaining a Static IP Address for the NetWare Server” on page 191
 “Setting Recommended NetWare Server Parameters for the NetWare POA” on page 191
 “Setting Recommended NSS Parameters for the NetWare POA” on page 192
 “Setting Recommended NetWare Server Parameters for the NetWare MTA” on page 193
 “Creating a NetWare Account for Agent Access (Optional)” on page 193
 “Adding the NetWare Agent Installation Directory to the Server Search Path (Optional)” on 

page 193

Obtaining a Static IP Address for the NetWare Server

The NetWare server where the GroupWise agents run should have a static IP address. DHCP should 
not be used to dynamically assign an IP address for it. Make sure the server where you plan to install 
the agents has a static IP address.

Setting Recommended NetWare Server Parameters for the NetWare POA

Some default settings on the NetWare server where you plan to run the NetWare POA might be 
inadequate for configurations of more than 100 concurrent client/server user connections. If your 
anticipated post office size indicates a need for more than 100 concurrent client/server connections, 
check the server parameters on the NetWare server to make sure they are adequate for the 
anticipated number of GroupWise client connections. For example, in a medium-size post office of 
500 users, use the following settings:
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Table 8-2   NetWare Server Parameters for Best Performance

The Document Conversion Agent, which assists the POA with indexing by converting some 
document types to HTML for indexing, runs in a protected address space, so that if a particular file 
fails the HTML conversion process, the stability of the POA is not affected. Use the following 
NetWare server parameters to configure the protected address space:

Table 8-3   NetWare Server Parameters for the Document Conversion Agent Protected Address Space

Depending on the stability of the Document Conversion Agent as it converts documents to HTML on 
your NetWare server, you might need to increase the Memory Protection Restart Count setting to 
improve stability.

Setting Recommended NSS Parameters for the NetWare POA

If you run the NetWare POA on NetWare 6.5 Novell Storage Services (NSS) volumes, you can 
significantly improve GroupWise performance by using the following parameters and settings on the 
nss command in the autoexec.ncf file:

/NameCacheSize=20000
/OpenFileHashShift=15
/ClosedFileCacheSize=50000
/CacheBalance=60 

The best /ClosedFileCacheSize setting for a server depends on many things, such as the amount of 
memory on the server, the load on the POA, and the number of other programs running on the 
server. For example, the 50000 setting can work well for a server that has 650 MB of memory. 
Experiment with various settings in order to optimize performance.

The following TID, although originally written for GroupWise 5.x and NetWare 5.x, applies to 
GroupWise 8 and NetWare 6.5 as well:

 TID 10065215: Resolving GroupWise Performance Issues with NSS Volumes in the Novell 
Support Knowledgebase (http://www.novell.com/support)

Parameter Setting 

Maximum Packet Receive Buffers 2500

Minimum Packet Receive Buffers 1000

Maximum Concurrent Disk Cache Writes 200

TCP Minshall Algorithm On

TCP Nagle Algorithm On

Parameter Setting 

Restart Server on Address Space Cleanup Failure Off

Memory Protection Abend after Restart Count Off

Memory Protection Restart Count 10

Memory Protection Fault Cleanup On
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Setting Recommended NetWare Server Parameters for the NetWare MTA

The default Maximum Packet Receive Buffers setting on a NetWare server is inadequate for the 
NetWare MTA in configurations that include numerous TCP/IP and remote file connections. Set 
Maximum Packet Receive Buffers to at least 2500 for the NetWare MTA in such configurations.

Creating a NetWare Account for Agent Access (Optional)

When the GroupWise agents run on a different NetWare server from where their directories and 
databases are located, and they are not set up to authenticate through eDirectory (using the /dn 
startup switch), the agents must use a specific eDirectory username and password to log in to that 
server.

To create a user for the agents to log in as:

1 In ConsoleOne, create a new user (such as GWAgents).
2 Provide a password for that user (such as GWise).
3 Grant that user the following rights to all domain, post office, and document storage directories:

 Read or execute files
 Write to files
 Create files or directories
 Erase files or directories
 Modify files (rename or change attributes)
 File scan

4 After you install the agent software, add the /user and /password startup switches to the agent 
startup files so that the agents can log in to the remote server as the user you have created.

Adding the NetWare Agent Installation Directory to the Server Search Path (Optional)

If you have selected a directory other than sys:\system to install the agents to, add the agent 
installation directory to the server search path by adding a search command to the autoexec.ncf 
file.

Installing the NetWare Agent Software

After you have prepared the NetWare server to run the GroupWise agents, you are ready to install 
them.

At a Windows machine that meets the administrator machine requirements listed in Section 2.1, 
“GroupWise Administration Requirements,” on page 17:

1 Map a drive to the NetWare server where you want to install the agents. 
2 Make sure you have sufficient rights to install software in the desired directory.
3 Make sure that no other GroupWise agents are running on the server where you want to install 

the agents.
4 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the 

Installation program to create the Agent objects.
5 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.

or
Run setup.exe from the root of the downloaded GroupWise 8 software image.
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or
If you have already copied the agent software to a software distribution directory, run 
setup.exe from the root of the software distribution directory to start the GroupWise 
Installation program.

6 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: All available languages are included on the GroupWise 8 DVD and the multilanguage 
version of the downloaded GroupWise 8 software image, but you can select which languages you 
want to install.

The main GroupWise System Installation page appears.

7 Click Install GroupWise System, then click Yes to accept the License Agreement and display the 
Installation Type page.
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When you install the agents, you are performing a Standard installation. Other installation 
options on this page are described in “Setting Up Predefined Installations” on page 55.

8 Click Next to accept the default of Standard.

9 Select Install Individual Components, then deselect GroupWise Administration.
10 Follow the prompts to provide NetWare Agent information from your Basic GroupWise System 

Summary Sheet.

Installation Path
Agent Installation Options
Agent Language Selection
Client Language Selection
Domain Information
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Post Office Information
11 On the Summary and Modification page:

11a Review the installation information you have provided.
11b If you need to change information, select the information to change, then click Edit Setting.
11c Specify the desired information, then click OK.

12 Click Install to start the agent installation.
Status messages keep you informed about the installation progress.

13 Click Finish, when the installation is complete.
If you want to start the agents later or if the Installation program fails to start them successfully, 
see “Starting the NetWare GroupWise Agents” on page 197.

14 If necessary, modify the agent startup files as described in “Editing the NetWare Agent Startup 
Files” on page 196, then manually start the NetWare agents by running grpwise.ncf.

15 To monitor an agent from your Web browser, view the agent Web console by supplying the IP 
address and port number of the agent. For example:

http://172.16.5.18:1677
http://172.16.5.18:7100
http://172.16.5.18:7180
http://172.16.5.18:7181

When viewing the agent Web console, you can specify the POA client/server port, the MTA 
message transfer port, or the default HTTP port that is established during installation. The POA 
client/server port and the MTA message transfer port are automatically redirected to their 
respective HTTP ports.

Editing the NetWare Agent Startup Files

The Installation program creates a customized agent startup file for each domain and post office 
location. The first 8 characters of the post office and domain names became the names of the agent 
startup files, along with an agent-specific extension. For example, if the post office name is acctpo, 
then the POA startup file is named acctpo.poa. The Installation program also customizes each 
startup file with the correct /home switch setting, pointing to the domain or post office directory. 

Each startup file also provides a comprehensive list of startup switches, with all but the /home switch 
commented out. You can use any ASCII text editor to set the startup switches. The agent startup files 
are located in the agent installation directory.

When the MTA is not on the same server as the domain directory, you need to edit the MTA startup 
file to include the MTA’s eDirectory distinguished name. When the POA is not on the same server as 
the post office directory, you need to edit the POA startup file to include the POA’s eDirectory 
distinguished name.

The /dn-distinguished_object_name startup switch is located in Section 1 of the startup file. Delete the 
semicolon (;) at the beginning of the line and replace the distinguished_object_name variable with the 
distinguished name of the MTA or POA. For example, if the MTA is for a domain named Provo that is 
located in a container named Novell, you would enter:

/dn-mta.provo.novell

After modifying the startup files, use the grpwise.ncf file to start the NetWare agents from the 
NetWare server console.
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If you want to learn more about running the NetWare agents, continue with “Starting the NetWare 
GroupWise Agents” on page 197. If you want to customize the configuration of the NetWare agents 
or expand your GroupWise system, skip to Section 8.5, “What’s Next,” on page 225.

Starting the NetWare GroupWise Agents

You might have one or more GroupWise agents installed on each NetWare server in your GroupWise 
system. You can start the GroupWise agents on NetWare in several ways:

 “Manually with a Load Command” on page 197
 “Manually with an NCF File” on page 197
 “Automatically in the Server’s Autoexec.ncf File” on page 198

If you encounter any problems starting the GroupWise agents, see “Strategies for Agent Problems” in 
GroupWise 8 Troubleshooting 2: Solutions to Common Problems for assistance. 

Manually with a Load Command

You can use the NetWare load command to start the NetWare GroupWise agents at the NetWare 
server console or a remote console:

The startup file for the POA is named after the post office. The startup file for the MTA is named after 
the domain. The startup file for the Internet Agent is always gwia.cfg. The WebAccess Agent startup 
file is named after the WebAccess Agent object in eDirectory (typically webacc80a.waa).

At the NetWare server console or remote console, you can use the agent server consoles described in 
the GroupWise 8 Administration Guide:

 “Using the POA Server Console”
 “Using the MTA Server Console”
 “Using the Internet Agent Server Console”
 “Using the WebAccess Agent Server Console”

Manually with an NCF File

For your convenience, the Installation program creates NCF files for starting the NetWare GroupWise 
agents:

During installation, the grpwise.ncf file is configured with one or more POA and/or MTA load 
commands depending on the domains and/or post offices you listed during installation.

POA: load gwpoa.nlm @ startup_filename.poa

MTA: load gwmta.nlm @ startup_filename.mta

Internet Agent: load gwia.nlm @gwia.cfg

WebAccess: load gwinter @startup_filename.waa

POA and/or MTA: grpwise

Internet Agent: gwia

WebAccess: strtweb
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Automatically in the Server’s Autoexec.ncf File

When the GroupWise agents are running smoothly, you should modify the main NetWare 
configuration file (autoexec.ncf) to load the NetWare GroupWise agents automatically whenever 
you restart the server. You can add either the load commands or the NCF commands to the 
autoexec.ncf file.

When you are not at the NetWare server console, you can monitor the GroupWise agents from their 
Web consoles described in the GroupWise 8 Administration Guide:

 “Using the POA Web Console”
 “Using the MTA Web Console”
 “Using the Internet Agent Web Console”
 “Using the WebAccess Agent Web Console”

Stopping the NetWare GroupWise Agents

At the NetWare server console, use Exit (F7). If a GroupWise agent does not respond to Exit (F7), you 
can use the unload command to unload the agent NLM. For WebAccess, you can use the stopweb 
command.

Uninstalling the NetWare GroupWise Agents

If you move the GroupWise agents to a different server, you can uninstall the agent software from the 
old location to reclaim disk space.

IMPORTANT: If you added load commands to the autoexec.ncf file to automatically start the 
agents when the NetWare server starts, edit the autoexec.ncf file and remove the agent load 
commands.

8.4.3 Linux: Setting Up the GroupWise Agents

Complete the following tasks to set up the Linux agents. These tasks are designed to help you get the 
Linux agents up and running as quickly as possible.

 “Installing the GroupWise Agents on Linux” on page 199
 “Installing the GroupWise Agents Using the Text-Based Installation Program” on page 201
 “Starting the Linux Agents with a User Interface” on page 202

POA and MTA: Stop the POA and the MTA, then run the GroupWise Installation program (setup.exe). On 
the Install Type page, select Uninstall, then follow the prompts. 

Internet Agent: Stop the Internet Agent, then run the GroupWise Installation program (setup.exe). On the 
Install Type page, select Uninstall, then follow the prompts.

WebAccess: Stop the WebAccess Agent. Delete the WebAccess Agent software files listed in “NetWare 
Installation Directory” in “Directory Structure Diagrams” in GroupWise 8 Troubleshooting 3: 
Message Flow and Directory Structure. If you want to delete the WebAccess Application 
from your Apache Web server, locate the WebAccessUninstall.ini file under the 
Tomcat root directory (for example, under \tomcat\5). It lists all files that the GroupWise 
Installation program installed to your Web server. Delete the listed files to uninstall the 
WebAccess Application from your Web server.
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IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install the agents. 

Refer to the following additional tasks as you maintain all the GroupWise agents on Linux:

 “Starting the Linux GroupWise Agents as Daemons” on page 204
 “Starting the Linux GroupWise Agents on System Startup” on page 206
 “Running the Linux GroupWise Agents As a Non-root User” on page 207
 “Enabling the Groupwise High Availability Service for the Linux GroupWise Agents” on 

page 209
 “Stopping the Linux GroupWise Agents” on page 215
 “Uninstalling the Linux GroupWise Agents” on page 217

If you are new to Linux, you might want to review Appendix A: Useful Linux Commands for 
Administering a GroupWise System in the GroupWise 8 Administration Guide before you install the 
GroupWise agents on Linux.

Preparing the Linux Server for the Agents

Make sure the Linux server where you plan to install the GroupWise agents has been properly 
prepared to run the agents:

 “Obtaining a Static IP Address for the Linux Server” on page 199
 “Increasing the Number of Open Files” on page 199

Obtaining a Static IP Address for the Linux Server

The Linux server where the GroupWise agents run should have a static IP address. DHCP should not 
be used to dynamically assign an IP address for it. Make sure the server where you plan to install the 
agents has a static IP address.

Increasing the Number of Open Files

On a server where you anticipate heavy GroupWise traffic, you might need to increase the maximum 
number of files that Linux allows to be open at the same time.

1 Edit the /etc/security/limits.conf file.
2 Add the following lines at the bottom of the file:

* soft nofile 8192
* hard nofile 65536

3 Save the file and exit the text editor.

Installing the GroupWise Agents on Linux

1 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run install from the root of the downloaded GroupWise 8 software image.
or
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If you have already copied the agent software to a software distribution directory, run ./
install from the root of the software distribution directory to start the GroupWise Installation 
program.
The X Window System is required for running the GUI GroupWise Installation program. If you 
are not using the X Window System, you can install GroupWise components individually, as 
described in “Installing the GroupWise Agents Using the Text-Based Installation Program” on 
page 201.

2 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are 
always installed.

The main GroupWise System Installation page appears.

3 Click Install Products > GroupWise Agents > Install Agents.
4 When the installation is complete, click OK.

The GroupWise agent software is installed to /opt/novell/groupwise/agents.
5 Click Configure GroupWise Agents.

The agent installation and configuration steps are separate so that you can install updated agent 
software without repeating the agent configuration steps.
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6 Follow the prompts to provide Linux Agent information from your GroupWise Agent 
Installation Summary Sheet.

Domain Information
Post Office Information
On the Configuration Complete page, Launch GroupWise Agents on System Startup is selected by 
default. 

IMPORTANT: If you want to configure the agents for high availability, as described in 
“Enabling the Groupwise High Availability Service for the Linux GroupWise Agents” on 
page 209, they must be configured to start automatically on system startup.

7 If you do not want the agents to start automatically when the server restarts, deselect Launch 
GroupWise Agents on System Startup. 

8 Click Exit to complete the configuration.
9 Skip to “Starting the Linux Agents with a User Interface” on page 202 or “Starting the Linux 

GroupWise Agents as Daemons” on page 204 depending on whether or not you want a user 
interface on the Linux server where the agents run.

Installing the GroupWise Agents Using the Text-Based Installation Program

If you want to install any of the GroupWise agents on a server where the X Window System is not 
running, you can use the text-based GroupWise Installation program. The server must have 
openmotif-libs installed. You must still use ConsoleOne to create the associated domain or post 
office before you can install and configure the agent software.

1 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run install from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the software to a software distribution directory, run ./install from 
the root of the software distribution directory to start the GroupWise Installation program.
If you need to perform the installation from a remote location, you can use ssh to access the 
remote Linux server. Copy the linux subdirectory of the GroupWise 8 DVD or the downloaded 
GroupWise 8 software image to the server where you want to install the agent software, then run 
the text-based GroupWise Installation program to install the agents on the Linux server.

2 Enter the number of the language you want to use for the installation.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are 
always installed.

3 Enter y if you want to configure the GroupWise agents for clustering.
or
Enter n if you are not installing the GroupWise agents in a cluster.

4 Enter the number of the language you want to use for reading the License Agreement.
5 Press any key to scroll through the License Agreement, then enter y to accept the License 

Agreement.
6 In the list of agents, enter the number for the GroupWise agent component that you want to 

install.
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1. GroupWise Agents
2. GroupWise WebAccess
3. GroupWise Monitor
4. GroupWise Internet Agent
5. GroupWise Calendar Publishing Host
6. GroupWise Client
7. View the Readme
0.1 Exit

7 In the list of actions, enter 1 to install the agent software

1. Install GroupWise Agents
2. Configure GroupWise Agents
0. Return

A status bar indicates progress.
8 When the installation is complete, enter y to configure the agent component.
9 Follow the prompts to provide the configuration information, then press any key to exit.

In the text-based Installation program, you can press Ctrl+C to return to the previous menu.
10 To install additional agents, start the text-based Installation program again.0
11 When you have installed the agents that you want to run on the text-only server, skip to 

“Starting the Linux GroupWise Agents as Daemons” on page 204.

NOTE: The text-based GroupWise Installation program does not run on all Windows versions of 
ssh. An open source product named PuTTY that can be downloaded from the Internet free of charge 
is compatible with the text-based GroupWise Installation program. There are several Web sites where 
PuTTY is available for download.

Starting the Linux Agents with a User Interface

1 In a terminal window, become root by entering su - and the root password.
2 Change to the GroupWise agent bin directory.

cd /opt/novell/groupwise/agents/bin

3 Enter one of the following commands to start the MTA:
        Syntax: 

./gwmta --show --home domain_directory &

./gwmta --show @domain.mta &

        Example: 

./gwmta --show --home /gwsystem/domlnx &

./gwmta --show @provo.mta &

The --show startup switch starts the MTA with a server console interface similar to that provided 
for the NetWare and Windows MTA. This user interface requires that the X Window System and 
Open Motif be running on the Linux server.
The --home startup switch specifies the domain directory and is required to start the MTA.
The @domain.mta startup switch specifies the MTA startup file, which contains the --home 
startup switch. The MTA startup file is named after the domain that the MTA services. The 
Installation program created the MTA startup file in the /opt/novell/groupwise/agents/
share directory. Because the Installation program prompted you for the domain directory, it set 
the --home switch for you in the startup file.
The ampersand (&) causes the MTA to run in the background, so that the terminal window you 
started it in is again available for use.
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To remind yourself of these commands when you are at your Linux server, view the gwmta man 
page.

The status messages displayed on the MTA server console are also written to the MTA log file 
(mmddmta.nnn) in the /var/log/novell/groupwise/domain.mta directory. The log file name 
includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day.
In ConsoleOne, you can see that the MTA has updated the domain database because the Version 
field on the Identification page of the Domain object shows 8 when the database update is 
complete.

4 Wait until the domain database has been updated before you start the POA.
5 Use the following command to start the POA:

        Syntax: 

./gwpoa --show --home post_office_directory &

./gwpoa --show @post_office.poa &

        Example: 

./gwpoa --show --home /gwsystem/polnx &

./gwpoa --show @research.poa &

The --home startup switch specifies the post office directory and is required to start the POA.
The @post_office.poa startup switch specifies the POA startup file, which contains the --home 
startup switch. The POA startup file is named after the post office that the POA services. The 
Installation program created the POA startup file in the /opt/novell/groupwise/agents/
share directory. Because the Installation program prompted you for the post office directory, it 
set the --home switch for you in the startup file.
To remind yourself of these commands when you are at your Linux server, view the gwpoa man 
page.
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The status messages displayed on the POA server console are also written to the POA log file 
(mmddpoa.nnn) in the /var/log/novell/groupwise/post_office.poa directory. The log file 
name includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day.
In ConsoleOne, you can see that the POA has updated the post office database because the 
Version field on the Identification page of the Post Office object shows 8 when the database 
update is complete.
If you encounter any problems starting the GroupWise agents, see “Strategies for Agent 
Problems” in GroupWise 8 Troubleshooting 2: Solutions to Common Problems for assistance. 
After the post office database has been updated, users can connect to the post office using either 
the Windows client or the Mac/Linux client.
When you start the Linux agents with a user interface, you can use the agent server consoles 
described in the following sections in the GroupWise 8 Administration Guide.
 “Using the POA Server Console”
 “Using the MTA Server Console”

Starting the Linux GroupWise Agents as Daemons

All of the Linux GroupWise agents except the Monitor Agent can be started by using the grpwise 
script. The Monitor Agent uses its own customized grpwise-ma script that works essentially the 
same way.

1 Make sure you are logged in as root.
2 Change to the /etc/init.d directory.
3 To start all of the Linux GroupWise agents that are installed on the server, enter the following 

command:

./grpwise start

4 To confirm that the agents have started, enter the following command:

./grpwise status

Agent status is displayed in terms of the names of the domain and post office associated with 
each agent. It lists the agent locations in the following format: 
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When using the grpwise script, you refer to the agents by the location names displayed when 
you list agent status, not by the names of the agent executables.

5 Use the following set of commands as needed to start the agents as daemons and verify their 
status:

IMPORTANT: For convenience in typing the command, the agent_location_name is not case 
sensitive.

The GroupWise agents are Run Control compliant. During installation, a symbolic link is 
created from /etc/init.d/grpwise to /usr/sbin/rcgrpwise. Typically, /usr/sbin is already 
on your path, so you can run rcgrpwise from any directory, rather than changing to /etc/
init.d in order to run the grpwise script. A /usr/sbin/grpwise-ma link is also created for the 
Monitor Agent.
To remind yourself of these commands when you are at your Linux server, view the grpwise 
man page.
When you use the grpwise script to start the GroupWise agents as daemons, they run without a 
user interface. 
If Novell Messenger agents are installed on the same server, the grpwise script also starts them.

Monitoring the Linux GroupWise Agents from Your Web Browser

To monitor any GroupWise agent from your Web browser, view the agent Web console by supplying 
the IP address or DNS hostname and the port number of the agent. The following table lists the 
default port numbers:

POA: post_office.domain

MTA: domain

Internet Agent: gwia.domain

WebAccess: webac80a.domain

Document Viewer Agent: gwdva.hostname

./grpwise start Starts the GroupWise agents that are 
installed on the server

./grpwise start agent_location_name Starts the specified agent

./grpwise status Displays the status of the GroupWise 
agents that are installed on the server

./grpwise status agent_location_name Displays the status of the specified agent

./grpwise print Lists the contents of the gwha.conf file
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Table 8-4   GroupWise Agent Web Console URLs

Figure 8-4   Linux POA Web Console

For more information about the agent Web consoles, including instructions on protecting the agent 
Web consoles with passwords, see the following sections in the GroupWise 8 Administration Guide.

 “Using the POA Web Console”
 “Using the MTA Web Console”
 “Using the Internet Agent Web Console”
 “Using the WebAccess Agent Web Console”
 “Using the Monitor Web Console”

Starting the Linux GroupWise Agents on System Startup

If you selected Launch GroupWise Agents on System Startup in the Installation program, the Installation 
program configured your system so that the agents start automatically each time you restart your 
server. The Agent Installation programs always creates a grpwise startup script in /etc/init.d for 
starting the agents, as described in “Starting the Linux GroupWise Agents as Daemons” on page 204. 
To enable automatic startup, the Agent Installation programs also create symbolic links named 
Snngrpwise in the rc3.d and rc5.d directories so that the agents load on restart into level 3 or 5, 
depending on the configuration of your Linux system. The value of nn is determined by the 
chkconfig command during installation so that the GroupWise agents are started in the proper 
sequence with other processes running on the server.

When the grpwise script runs and starts the GroupWise agents, the agents read the agent startup 
files in /opt/novell/groupwise/agents/share to check for configuration information provided by 
startup switches. Because the --show switch cannot be used in the startup files, the agents do not run 

POA: http://server_network_address:7181

MTA: http://server_network_address:7180

Internet Agent: http://server_network_address:9850

WebAccess: http://server_network_address:7211

Monitor: http://server_network_address:8200
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with server console interfaces when started automatically when the server restarts, unless you 
modify the gwha.conf file as described in “Enabling the Groupwise High Availability Service for the 
Linux GroupWise Agents” on page 209.

Running the Linux GroupWise Agents As a Non-root User

For security reasons, it is preferable that the GroupWise agents not run with root user privileges. For 
example, if an intruder manages to assume the identity of a GroupWise agent, the intruder gains all 
the privileges of the commandeered process. If the process is running with root user privileges, then 
the intruder has root access to your system. If the process is running as a user with minimal 
privileges, then the intruder has only restricted access to your system. Therefore, your system is more 
secure if the GroupWise agents do not run as root.

The root user still needs to start the agents, because the agents do need to access some root-only 
resources on startup. However, you can configure the agents to switch to a different user after they 
start. After the agents are running as the non-root user, they need adequate access to the locations 
where each domain, post office, library, and software distribution directory is located.

 “Setting Up Typical Non-root Access” on page 207
 “Setting Up Non-root Access on an NSS Volume on Novell Open Enterprise Server Linux” on 

page 208
 “Changing the Non-root User” on page 209

NOTE: You can configure the POA, the MTA, and the Internet Agent to run as a non-root user. The 
WebAccess Agent, with its accompanying Viewer Agent, must still run as root. Unlike the other 
agents, the Monitor Agent can be started as a non-root user by default, so no setup is required for it 
to run as a non-root user.

Setting Up Typical Non-root Access

To configure the GroupWise agents to switch users after startup:

1 Make sure you are logged in as root.
2 Select a Linux user for the agents to run as and make sure that the user is listed in the /etc/

passwd file.
You might want to create a new user specifically for this purpose, perhaps named gwagents.

3 Change to the groupwise directory under /etc:

cd /etc/opt/novell/groupwise

4 Create a new agents directory, then change to that directory:

mkdir agents
cd agents

5 Create a file named uid.conf.
6 Type the selected username in the file, for example:

gwagents

7 Stop and then start the agents.
While starting as root, the agents automatically change the ownership of the domain and post 
office directory structures from root to the user you specified in the uid.conf file. Then they 
switch users and run as the user you specified, rather than as root.
If you list the agent processes, you can observe that they are no longer running as root.
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ps -eaf | grep gw

If the post office and domain are located on different servers, you must complete the above steps 
on each server.

IMPORTANT: All agents running on the same server must run as the same user.

If you later want to change the user that the agents are running as, follow the instructions in 
“Changing the Non-root User” on page 209.

Setting Up Non-root Access on an NSS Volume on Novell Open Enterprise Server Linux

When your domains, post offices, libraries, and software distribution directories are located on a 
Novell Open Enterprise Server (OES) Linux NSS volume, you must set up an eDirectory user for the 
agents to run as and you must Linux-enable that user. On OES Linux, you can use Novell iManager 
to accomplish these tasks.

To configure the agents to switch users after startup and provide access to an NSS volume:

1 Select or create an eDirectory user for the agents to run as.
You might want to create a new user specifically for this purpose, perhaps named gwagents. The 
username must not match any local usernames on the Linux server.
1a From the Open Enterprise Server Welcome page in your Web browser, expand Network 

Management, then click iManager 2.5.x.
1b In the iManager Links box, click Open Novell iManager 2.5.
1c To log in to iManager, specify a username, a password, and a tree.
1d In the left pane, expand Users, then click Create User.
1e Provide the required information, then click OK.

The user does not need a password
2 Linux-enable the user you just created.

2a In the left pane, expand Linux User Management, then click Enable User for Linux.
2b Browse to and select the user you just created, then click OK.
2c Select the primary group for the user to belong to (for example, admingroup).
2d Change /bin/bash to /bin/false because the user does not need a shell.
2e Click OK to Linux-enable the user.

3 In a terminal window, change to the groupwise directory under /etc:

cd /etc/opt/novell/groupwise

4 Create a new agents directory, then change to that directory.

mkdir agents
cd agents

5 Create a file named uid.conf
6 Type the selected username in the file, for example:

gwagents
7 Use the following command to grant the user the required rights to the directories that the 

agents need to access on the local server:

rights -f /directory -r rwcemf trustee user.context.tree
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The POA needs access to the post office directory. The MTA and the Internet Agent need access 
to the domain directory.

8 Stop and then start the agents.
While starting as root, the agents automatically change the ownership of the domain and post 
office directory structures from root to the user you specified in the uid.conf file. Then they 
switch users and run as the user you specified, rather than as root.
If you list the agent processes, you can observe that they are no longer running as root.

ps -eaf | grep gw

If the post office and domain are located on different servers, you must complete the above steps 
on each server.

IMPORTANT: All agents running on the same server must run as the same user.

If you later want to change the user that the agents are running as, follow the instructions in 
“Changing the Non-root User” on page 209.

Changing the Non-root User

To prevent an agent from running as a different user than the one for which it was originally 
configured, the GroupWise agents create a uid.run file in the domain or post office directory that 
they service. The Internet agent creates the uid.run file in its gateway directory (typically domain/
wpgate/gwia).

If , for any reason, the user specified in the uid.run file does not match the user specified in the 
uid.conf file, the agent displays the following message: 

Error: Running the agent with conflicting effective users

This could happen if the user specified in the uid.conf file is manually edited, or if the uid.conf file 
is deleted, thus changing or removing the information about the user that the agent should run as. If 
this message appears, verify that the uid.conf file specifies the desired user, then delete the uid.run 
file.

After displaying the message, the agent does not start, because it no longer has appropriate 
permissions in the domain or post office directory that it needs to service. By deleting the uid.run 
file, you enable the agent to reset the permissions in the domain or post office directory to 
appropriate user and then start successfully.

After configuring an agent to run as a specific non-root user:

 If you want the agent to run as a different non-root user, modify the uid.conf file in the /etc/
opt/novell/groupwise/agents directory to specify the desired non-root user, then delete the 
uid.run file from the directory serviced by the agent.

 If you want the agent to run as root, delete the uid.conf file from the /etc/opt/novell/
groupwise/agents directory and delete the uid.run file from the directory serviced by the 
agent.

Enabling the Groupwise High Availability Service for the Linux GroupWise 
Agents

The GroupWise High Availability service (gwha) makes sure that if the MTA, the POA, the Internet 
Agent, or the WebAccess Agent with its accompanying Document Viewer Agent goes down for any 
reason, it starts again automatically. On NetWare, this capability is provided by using a restartable 
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protected address space. On Windows, Microsoft Clustering Services automatically restarts a service 
that is not responding. However, on Linux, some clustering environments do not include this 
capability, so it is built into the Linux GroupWise agents. 

The GroupWise High Availability service is installed automatically, starts when your server boots, 
and makes sure that any GroupWise agents installed on the server are running. However, the 
GroupWise High Availability service does not start the GroupWise agents initially. For more 
information, see “Starting the Linux GroupWise Agents on System Startup” on page 206.

The GroupWise High Availability service relies on the Monitor Agent to detect when a GroupWise 
agent is no longer running. The Monitor Agent notifies the Groupwise High Availability service of 
any problem, then the High Availability service immediately issues the command to start the 
problem agent. The Groupwise High Availability service runs as root, as configured in the /etc/
xinetd.d/gwha file.

A single Monitor Agent can service multiple instances of the Groupwise High Availability service on 
multiple servers, as long as all instances use the same username and password to communicate with 
the Monitor Agent.

 “Configuring the GroupWise High Availability Service in the gwha file” on page 210
 “Configuring the Groupwise High Availability Service in the gwha.conf File” on page 210
 “Creating a GroupWise High Availability Service User” on page 213
 “Configuring the Monitor Agent to Communicate with the Groupwise High Availability 

Service” on page 214

Configuring the GroupWise High Availability Service in the gwha file

The basic configuration for the GroupWise High Availability service is contained in the /etc/
xinetd.d/gwha file:

socket_type = stream
user = root
server = /opt/novell/groupwise/agents/bin/gwha
wait = no
instances = 1
protocol = tcp
type = UNLISTED
port = 8400
disable = yes

The only option you can change in this file is the port number. By default, the GroupWise High 
Availability service listens on port 8400. If that port number is already in use on the server where you 
are setting up the GroupWise High Availability service, you can change the port number in the gwha 
file. The GroupWise High Availability service must use the same port number on all servers where 
you want it to restart the GroupWise agents.

Do not change any other options in this file. 

Configuring the Groupwise High Availability Service in the gwha.conf File

The Groupwise High Availability service is controlled by a configuration file (gwha.conf) located in 
the /etc/opt/novell/groupwise directory. The configuration file provides a section for configuring 
SSL for communication between the Groupwise High Availability service and the Monitor Agent, 
followed by sections for each agent installed on the server, as shown below. The headings for the 
sections match the agent locations listed in “Starting the Linux GroupWise Agents as Daemons” on 
page 204.
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[gwha]
ssl       = no
key       =
cert      =
password  =

[domain_name]
server    = /opt/novell/groupwise/agents/bin/gwmta
command   = /etc/init.d/grpwise
startup   = domain_name.mta
delay     = 2
wait      = 10

[post_office_name.domain_name]
server    = /opt/novell/groupwise/agents/bin/gwpoa
command   = /etc/init.d/grpwise
startup   = post_office_name.poa
delay     = 2
wait      = 10

[gwia.domain_name]
server    = /opt/novell/groupwise/agents/bin/gwia
command   = /etc/init.d/grpwise
startup   = gwia.cfg
delay     = 2
wait      = 10

[webac80a.domain]
server    = /opt/novell/groupwise/agents/bin/gwinter
command   = /etc/init.d/grpwise
startup   = webac80a.waa
delay     = 2
wait      = 10

[gwdva.server_name]
server    = /opt/novell/groupwise/agents/bin/gwdva
command   = /etc/init.d/grpwise
startup   = gwdva.dva
delay     = 2
wait      = 10

To set up the Groupwise High Availability service:

1 In a terminal window, become root by entering su - and the root password.
2 Before starting to configure the Groupwise High Availability service, test the agents by starting 

and stopping them manually with a user interface so that their agent server consoles display:
2a Change to the root directory of the Linux server.
2b Start the GroupWise agents manually, including providing the full path to the executable 

and including the --show switch, to make sure that they are set up and configured correctly.

/opt/novell/groupwise/agents/bin/gwpoa --show @post.poa
/opt/novell/groupwise/agents/bin/gwmta --show @dom.mta
/opt/novell/groupwise/agents/bin/gwia --show @gwia.cfg
/opt/novell/groupwise/agents/bin/gwinter --show @webac80a.waa

2c After verifying that the agents start correctly, stop the agents.
3 If you use SSL, you need to modify the Groupwise High Availability service configuration file 

(gwha.conf):
3a Change to the /etc/opt/novell/groupwise directory.
3b Edit the gwha.conf file in a text editor.
3c Under the [gwha] section, fill in the fields as follows:
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[gwha]
ssl = yes
key = filename.key
cert = filename.crt
password = password

3d Save the file, then exit the text editor.
4 If you changed the port number for the GroupWise High Availability service, as described in 

“Configuring the GroupWise High Availability Service in the gwha file” on page 210, add the 
following line to the [gwha] section:

port = port_number

Replace port_number with the new port number you specified in the gwha file.
5 If you want to control how the script manages starting and stopping the agents, modify the 

delay =  and wait =  settings in the Groupwise High Availability service configuration file 
(gwha.conf).
The delay =  setting controls the length of time between when the script issues the command to 
start an agent and when the script displays a message indicating that the agent has started. The 
default delay time is 2 seconds. Under certain circumstances, an agent could encounter a 
problem and fail to start after 2 seconds. In this case, you would receive the success message but 
the agent would not be running. You need to increase the delay =  setting to accommodate the 
length of time it typically takes for the agent to start successfully on your system.
The wait =  setting controls the length of time between when the script issues the command to 
stop an agent and when the script kills the agent if the agent has not yet stopped. The default 
wait time is 10 seconds. Under certain circumstances, an agent could take longer than 10 seconds 
to perform a normal shutdown, and killing the agent under those circumstances would not be 
appropriate. You need to increase the wait = setting to accommodate the length of time it 
usually takes for the agent to shut down. A message notifies you if the script kills an agent 
because its shutdown exceeds the wait = setting.
The default settings are usually appropriate, so you do not need to change them unless you 
frequently encounter problems with starting or stopping an agent with the script.
5a Change to the /etc/opt/novell/groupwise directory.
5b Edit the gwha.conf file in a text editor

Each agent has its own section in the file, for example:

[Waltham2]
server = /opt/novell/groupwise/agents/bin/gwmta
command = /etc/init.d/grpwise
startup = waltham2.mta
delay = 2
wait = 10

5c Change the delay =  and wait =  settings as needed.
5d Save the file, then exit the text editor.

NetWare: Filenames can consist of up to 8 characters, with extensions of up to 3 characters.

Linux: Use only lowercase characters.

Windows: No limitations
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6 If you want the script to start the agents with a user interface on the Linux server, add the show =  
setting in the Groupwise High Availability service configuration file (gwha.conf). This is 
equivalent to using the --show startup switch on the command line when starting the agent.
6a Change to the /etc/opt/novell/groupwise directory.
6b Edit the gwha.conf file in a text editor

Each agent has its own section in the file, for example:

[Waltham2]
server = /opt/novell/groupwise/agents/bin/gwmta
command = /etc/init.d/grpwise
startup = waltham2.mta
delay = 2
wait = 10

6c Add show = yes to the section for each agent that you want to start with a user interface.
If you need to eliminate the user interface, use show = no or delete the show = line from the 
file.

6d Save the file, then exit the text editor.
7 Enable the Groupwise High Availability service:

7a In YaST, click Network Services > Network Services (inetd).
7b If necessary, select Enable to activate the list of services.
7c Scroll down to the gwha line, select it, then click Toggle Status (On or Off) to change the status 

to On.
7d Click Finish.

8 Start the agents.
8a Change to the /etc/init.d directory.
8b Enter the following command to start the GroupWise agents that are installed on the server:

./grpwise start

8c Use the following command to verify agent status:

./grpwise status

For more information about using the grpwise script, see “Starting the Linux GroupWise 
Agents as Daemons” on page 204

9 Continue with Creating a GroupWise High Availability Service User.

Creating a GroupWise High Availability Service User

The GroupWise High Availability service needs a login user on each server where GroupWise agents 
need to be restarted.

1 Create a new user and associated password on the local Linux server to represent the 
GroupWise High Availability service.
You might name it gwha.

IMPORTANT: Use a local user account for use only by the GroupWise High Availability service. 
Do not use a Novell Linux-enabled user.
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2 Create the same user on each Linux server where you want the GroupWise High Availability 
service to restart the GroupWise agents.

3 Continue with Configuring the Monitor Agent to Communicate with the Groupwise High 
Availability Service.

Configuring the Monitor Agent to Communicate with the Groupwise High Availability Service

After you have the Groupwise High Availability service set up and working correctly, you need to 
configure the Monitor Agent to communicate with it and test it to make sure that you can rely on it in 
the future. Although you need a GroupWise High Availability service running on each server where 
there are GroupWise agents, you need only one Monitor Agent to monitor all agents in your 
GroupWise system.

1 Start the Monitor Agent with the --hauser and --hapassword startup switches.
If you use the grpwise-ma script to start the Monitor Agent, as described in “Starting the Linux 
Monitor Agent as a Daemon” on page 173, you can edit it to include the switches:
1a Change to the /etc/init.d directory, then edit the grpwise-ma script.
1b Locate the following line:

#MA_OPTIONS="--hauser username --hapassword password 
--hapoll 120"

1c Remove the pound sign (#) from the beginning of the line.
1d Replace username and password with the username and password you established in Step 1 

in “Creating a GroupWise High Availability Service User” on page 213.

MA_OPTIONS="--hauser gwha --hapassword gwagents --hapoll 120"

The Monitor Agent uses the --hauser and --hapassword switches to communicate with the 
Groupwise High Availability service on port 8400, as configured in the /etc/xinetd.d/
gwha file.
The --hapoll switch specifies that the Monitor Agent should check the status of GroupWise 
agents every 120 seconds. You can use the MA_OPTIONS variable to add any Monitor 
Agent startup switches to the grpwise-ma script as needed. For information about Monitor 
Agent startup switches, see “Using Monitor Agent Startup Switches” in “Monitor” in the 
GroupWise 8 Administration Guide.

1e Save the file, then exit the text editor.
1f Start the Monitor Agent.

2 Stop one of the agents.
3 Check the status of the agent you stopped to make sure it is stopped.
4 Wait for the next Monitor Agent polling cycle.

You can check and, if necessary, change the Monitor Agent polling cycle in the Monitor Agent 
Web console. Click Preferences, then scroll down to the HTTP Settings section. 

5 After the polling cycle has passed, check the status of the agent again.
The agent that you stopped should now be running again. 
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Stopping the Linux GroupWise Agents

How you stop the Linux GroupWise Agents depends on how you started them.

 “From the Agent Console User Interface” on page 215
 “Using the grpwise Script” on page 215
 “Manually as Daemons” on page 216

From the Agent Console User Interface

When you use the --show startup switch to start the GroupWise agents, you can stop them from the 
agent server console interface.

1 Click File > Exit > Yes.

Because the WebAccess Agent does not have the same type of agent server console as the other Linux 
agents, you can stop it by closing the terminal window in which it is running.

Using the grpwise Script

When you start the GroupWise agents with the grpwise script, you can also use the script to stop 
them. The same applies for the Monitor Agent and its grpwise-ma script.

1 Make sure you are logged in as root.
2 Change to the /etc/init.d directory.
3 To stop all of the GroupWise agents installed on the server, enter the following command:

./grpwise stop

4 To confirm that the agents have stopped, enter the following command:

./grpwise status

Agent status is displayed in terms of the names of the domain and post office associated with 
each agent. It lists the agent locations in the following format: 

5 Use the following set of commands as needed to stop the agents as daemons and verify their 
status:

POA: post_office.domain

MTA: domain

Internet Agent: gwia.domain

WebAccess: webac80a.domain

Document 
Viewer Agent

gwdva.hostname
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IMPORTANT: For convenience in typing the command, the agent_location_name is not case 
sensitive.

NOTE: The GroupWise agents are Run Control compliant. During installation, a symbolic link is 
created from /etc/init.d/grpwise to /usr/sbin/rcgrpwise. Typically, /usr/sbin is already 
on your path, so you can run rcgrpwise from any directory, rather than changing to /etc/
init.d in order to run the grpwise script. A /usr/sbin/grpwise-ma link is also created. 

Manually as Daemons

When you start the GroupWise agents manually on the command line (without using the grpwise 
script), use the standard Linux kill command to stop them.

1 Make sure you are logged in as root.
2 Determine the process IDs (PIDs) of the agent to kill:

All of the PIDs for the specified agent are listed.
3 Kill the first process listed for each agent:

        Syntax: 

kill PID

        Example: 

kill 1483
kill 1892

It might take a few seconds for all agent processes to terminate.
4 Repeat the ps commands to verify that the agents have stopped.

You can also restart the MTA and the Internet Agent without stopping them first using the following 
command:

./grpwise stop Stops the GroupWise agents that are installed 
on the server

./grpwise stop agent_location_name Stops the specified agent

./grpwise status Displays the status of the GroupWise agents that 
are installed on the server

./
grpwise status agent_location_name

Displays the status of the specified agent

POA: ps -eaf | grep gwpoa

MTA: ps -eaf | grep gwmta

Internet Agent: ps -eaf | grep gwia

WebAccess: ps -eaf | grep gwinter

Monitor: ps -eaf | grep gwmon
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Syntax: 

kill -HUP PID

Example: 

kill -HUP 1483

The -HUP (hang up) option is equivalent to using Restart in the MTA and Internet Agent server 
console or Web console. Because the other agents do not have a Restart feature in their consoles, the -
HUP option cannot be used to restart them.

Uninstalling the Linux GroupWise Agents

If you move the GroupWise agents to a different server, the GroupWise agent software can be 
uninstalled just like any other software on Linux. To determine what GroupWise software is 
currently installed on the Linux server, use the following command:

rpm -qa | grep groupwise

This lists all of the GroupWise RPM packages on the server. The POA and the MTA are together in 
the same RPM. WebAccess and Monitor have two RPMs each, one for the agent software and one for 
the application software. The following list provides the list of all GroupWise agent and 
administration RPMs that you might need to uninstall from a server:

Use the following command to uninstall a GroupWise RPM package:

rpm -e novell-groupwise-package

Uninstalling the RPMs does not uninstall files created after installation by the GroupWise programs. 
To see what GroupWise files are created in locations other than under /opt/novell/groupwise and 
its subdirectories, see the Linux sections of “Agent Installation Directories” in the GroupWise 8 
Troubleshooting 3: Message Flow and Directory Structure:

 POA and MTA: “Linux Installation Directory”
 Internet Agent: “Linux Installation Directory”

POA and MTA: novell-groupwise-agents-version-date

Internet Agent: novell-groupwise-gwia-version-date

WebAccess: novell-groupwise-gwinter-version-date

novell-groupwise-webaccess-version-date

Monitor: novell-groupwise-gwmon-version-date

novell-groupwise-monitor-version-date

Calendar Publishing Host novell-groupwise-calhost-version-date

Groupwise High Availability 
Service

novell-groupwise-gwha-version-date

GroupWise Administrator novell-groupwise-admin-version-date

GroupWise Check novell-groupwise-gwcheck-version-date

GroupWise Database Copy novell-groupwise-dbcopy-version-date
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 WebAccess: “Linux Installation Directory”
 Monitor: “Linux Installation Directory”

8.4.4 Windows: Setting Up the GroupWise Agents

Complete the following tasks to set up the Windows agents. These tasks are designed to help you get 
the Windows POA and MTA up and running as quickly as possible:

 “Preparing the Windows Server for the Windows Agents” on page 218
 “Installing the Windows Agent Software” on page 219

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see the 
GroupWise 8 Interoperability Guide before you install the agents. 

Refer to the following additional tasks as you maintain all the GroupWise agents on Windows:

 “Starting the Windows GroupWise Agents” on page 222
 “Stopping the Windows GroupWise Agents” on page 224
 “Uninstalling the Windows GroupWise Agents” on page 224

Preparing the Windows Server for the Windows Agents

Make sure the Windows server where you plan to install the GroupWise Windows POA and MTA 
has been properly prepared to run the agents:

 “Obtaining a Static IP Address” on page 218
 “Mapping Drives to Post Offices and Domains” on page 218
 “Creating a Windows User Account for Remote Access (Optional)” on page 219
 “Enabling SNMP (Optional)” on page 219

Obtaining a Static IP Address

The Windows server where the GroupWise Windows agents run should have a static IP address. 
DHCP should not be used to dynamically assign an IP address for it. Make sure the server where you 
plan to install the Windows agents has a static IP address.

Mapping Drives to Post Offices and Domains

The Windows POA requires direct access to the post office directory so that it can write to the post 
office database. The Windows MTA requires direct access to the domain directory so that it can write 
to the domain database. If the agents are not installed on the same server where their directories are 
located, make sure the server has drives mapped to all locations where the agents need access. If you 
are running the Windows POA for a post office located on a NetWare server, you might need to 
increase Maximum File Locks Per Connection from its default setting on the Windows server.

After installation, the agents can access their directories using either mapped drives or UNC paths. 
However, mapped drives are required during installation so that the agent startup files can be set up 
properly.
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Creating a Windows User Account for Remote Access (Optional)

If you specified a new Windows username and password, create the new Windows user account so it 
is ready when you start the agents for the first time. 

1 In the Windows Control Panel, double-click Users and Passwords to add a new user.
2 Grant the user Full Control rights in the domain and post office directories.

Enabling SNMP (Optional)

If you want to monitor the GroupWise Windows agents from an SNMP manager program, such as 
the Management and Monitoring Services component of Novell ZENworks Server Management, 
SNMP must be enabled on the Windows server where the agents are installed. If it is not already 
enabled, you should enable it before you run the Installation program. 

1 In the Windows Control Panel, double-click Add/Remove Programs.
2 Click Add/Remove Windows Components.
3 Select Management and Monitoring Tools, click Details, select Simple Network Management Protocol, 

then click OK
4 Follow the prompts to finish the installation.

Installing the Windows Agent Software

After you have prepared the Windows server to run the GroupWise Windows POA and MTA, you 
are ready to install them.

At a Windows server that meets the requirements listed in Section 2.1, “GroupWise Administration 
Requirements,” on page 17:

1 Make sure you have mapped drives to all domain and post office directories for which you are 
installing agents.

2 Make sure that no other GroupWise agents are running on the server where you want to install 
the agents.

3 Make sure that you have access to the directory where you want to install the Internet agents.
4 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the 

Installation program to create the Agent objects.
5 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.

or
Run setup.exe from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the agent software to a software distribution directory, run 
setup.exe from the root of the software distribution directory to start the GroupWise 
Installation program.

6 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: All available languages are included on the GroupWise 8 DVD and the multilanguage 
version of the downloaded GroupWise 8 software image, but you can select which languages you 
want to install.

The main GroupWise System Installation page appears.
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7 Click Install GroupWise System, then click Yes to accept the License Agreement and display the 
Installation Type page.

When you install the agents, you are performing a Standard installation. Other installation 
options on this page are described in “Setting Up Predefined Installations” on page 55.

8 Click Next to accept the default of Standard.
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9 Select Install Individual Components, then deselect GroupWise Administration.
10 Follow the prompts to provide the Windows agent information from your GroupWise Agent 

Installation Summary Sheet.

Installation Path
Agent Installation Options
Agent Language Selection
Client Language Selection
Domain Information
Post Office Information
Installation Options
Windows Service Information

11 On the Summary and Modification page:
11a Review the installation information you have provided.
11b If you need to change information, select the information to change, then click Edit Setting.
11c Specify the desired information, then click OK.

12 Click Install to start the agent installation.
Status messages keep you informed about the installation progress.

13 Click Finish, when the installation is complete.
If you want to start the agents later or if the Installation program fails to start them successfully, 
see “Starting the Windows GroupWise Agents” on page 222.

14 To monitor an agent from your Web browser, view the agent Web console by supplying the IP 
address and port number of the agent. For example:

http://172.16.5.18:1677
http://172.16.5.18:7100
http://172.16.5.18:7180
http://172.16.5.18:7181

When viewing the agent Web console, you can specify the POA client/server port, the MTA 
message transfer port, or the HTTP port established during installation.
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15 If you want to learn more about running the Windows agents, continue with “Starting the 
Windows GroupWise Agents” on page 222 and “Stopping the Windows GroupWise Agents” on 
page 224.
or
If you want to customize the configuration of the Windows agents or expand your GroupWise 
system, skip to Section 8.5, “What’s Next,” on page 225.

Starting the Windows GroupWise Agents

You might have one or more GroupWise agents installed on each Windows server in your 
GroupWise system. You can start the GroupWise agents on Windows in several ways:

 “Manually As Applications” on page 222
 “Automatically When the Windows Server Starts” on page 222
 “Manually or Automatically as Services” on page 223

If you encounter any problems starting the GroupWise agents, see “Strategies for Agent Problems” in 
GroupWise 8 Troubleshooting 2: Solutions to Common Problems for assistance. 

Manually As Applications

On the Windows desktop, click Start > All Programs, select the GroupWise agent, then start the 
GroupWise agent.

You can also use desktop shortcuts to start the GroupWise agents. The GroupWise Installation 
program automatically creates desktop shortcuts for the POA, the MTA, and the Internet Agent. You 
can easily create desktop shortcuts for WebAccess and Monitor by linking to the following target 
files:

When you start the GroupWise agents as applications, you can use the agent server consoles 
described in the GroupWise 8 Administration Guide:

 “Using the POA Server Console”
 “Using the MTA Server Console”
 “Using the Internet Agent Server Console”
 “Using the WebAccess Agent Server Console”
 “Using the Monitor Agent Server Console”

Automatically When the Windows Server Starts

After the GroupWise agents are running smoothly, you should configure them to start automatically 
whenever you restart the Windows server.

For example, on a Windows Server 2003 machine:

1 Click Start > Control Panel > Scheduled Tasks > Add Scheduled Task.
2 Click Next to start the Scheduled Task Wizard.
3 Browse to and select the GroupWise agent that you want to start automatically, then click Next.

WebAccess: c:\Program Files\Novell\GroupWise Server\WebAccess\strtweb.bat

Monitor: c:\Program Files\Novell\GroupWise Server\Monitor\gwmon.exe
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The GroupWise agents are listed in the following alphabetical order:

GroupWise Monitor
Internet Agent GWIA
MTA domain_name
POA post_office_name

4 Change the task name if desired, select When My Computer Starts, then click Next.
5 Change the name of the user that runs the agent if desired, type the password twice, then click 

Next.
6 If the agent requires a startup file, select Open Advanced Properties to edit properties, then click 

Finish to create the new scheduled task.
For the POA, the MTA, and the Internet Agent:

7 In the Run field of the Properties dialog box, add the startup file for the agent, as in the following 
examples:

c:\Program Files\Novell\GroupWise Server\Agents\gwpoa.exe
@post_office_name.poa

c:\Program Files\Novell\GroupWise Server\Agents\gwmta.exe
@domain_name.mta

c:\Program Files\Novell\GroupWise Server\Agents\gwia.exe @gwia.cfg

8 Click OK to save the updated properties.
9 To see the scheduled task, click Start > Control Panel > Scheduled Tasks.

The new scheduled task is listed under the Add Scheduled Task menu item.
10 To edit the scheduled task, right-click it, then click Properties.

Manually or Automatically as Services

If you installed the GroupWise agents as services, you can manage them just like you would any 
other Windows services.

NOTE: The Monitor Agent cannot currently be installed as a Window service.

For example, on a Windows Server 2003 machine:

1 From the Windows desktop, click Start > Administrative Tools > Services.
2 Select the agent service, then click Start.

The POA service is named after the post office. The MTA service is named after the domain. The 
Internet Agent service is named GWIA. The WebAccess Agent service is named WebAccess 
(webaccess_agent_object_name).

3 (Optional) Check the status of the agent service by using the Windows Event Viewer:
3a From Administrative Tools, double-click Event Viewer.
3b Click Application Log, then sort the log entries on the Source column.
3c Scroll to the agent service, then double-click a log entry to view information about it.

4 To configure the agent service to start automatically when the server reboots, right-click the 
agent service, then click Properties.

5 In the Startup Type field, click Automatic, then click OK.
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When running as services, the GroupWise agents typically do not display an agent console on the 
Windows server where they are running. Instead, you can monitor the GroupWise agents by using 
their Web consoles described in the GroupWise 8 Administration Guide:

 “Using the POA Web Console”
 “Using the MTA Web Console”
 “Using the Internet Agent Web Console”
 “Using the WebAccess Agent Web Console”

Stopping the Windows GroupWise Agents

How you stop the Windows GroupWise agents depends on how you started them.

 “As Applications” on page 224
 “As Services” on page 224

As Applications

When the GroupWise agents run as applications, you can stop them from their server consoles.

If the GroupWise agent does not respond to Exit, you can close the agent server console window to 
stop the agent or use the Windows Task Manager to terminate the agent task.

As Services

When the GroupWise agents run as Windows services, you can stop them as you would any other 
Windows services.

For example, on a Windows Server 2003 machine:

1 From the Windows desktop, click Start > Administrative Tools > Services.
2 Select the agent service, then click Stop.

The POA service is named after the post office. The MTA service is named after the domain. The 
Internet Agent service is named GWIA. The WebAccess Agent service is named WebAccess 
(webaccess_agent_object_name).

Uninstalling the Windows GroupWise Agents

If you move the GroupWise agents to a different server, you can uninstall the agent software from the 
old location to reclaim disk space.

POA: At the POA server console, click File > Exit.

MTA: At the MTA server console, click File > Exit.

Internet Agent: At the Internet Agent server console, click File > Exit.

WebAccess: From the Windows desktop, click the title bar of the window in which the WebAccess Agent 
or Document Viewer Agent is running, then press F7.

Monitor: At the Monitor Agent server console, click Configuration > Exit.

POA and MTA: Stop the POA and the MTA, then run the GroupWise Installation program (setup.exe). On 
the Install Type page, select Uninstall, then follow the prompts
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8.5 What’s Next
After you have created new domains and post offices, and installed the agents for them, you can 
complete their configuration by referring to the following sections of the GroupWise 8 Administration 
Guide:

 Refining the configuration of the agents to meet the specific needs of the new domains and post 
offices. See “Post Office Agent” and “Message Transfer Agent”.

 Refining the configuration of the new domains and post offices. See “Post Offices” and 
“Domains”.

 Adding users to the new post offices. See “Users”.

8.6 GroupWise Agent Installation Summary Sheet

Internet Agent: Stop the Internet Agent, then run the GroupWise Installation program (setup.exe). On the 
Install Type page, select Uninstall, then follow the prompts This deletes most of the contents 
of the c:\Program Files\Novell\GroupWise Server\GWIA directory and uninstalls 
the Internet Agent as a Windows service.

WebAccess: Stop the WebAccess Agent. Delete the contents of the c:\Program 
Files\Novell\GroupWise Server\WebAccess directory to delete the WebAccess 
Agent software. If the WebAccess Agent was running as a Windows service, run Delete 
Service.exe in the \internet\webacces subdirectory of the GroupWise software 
distribution directory. If you want to delete the WebAccess Application from your Apache 
Web server, locate the WebAccessUninstall.ini file under the Tomcat root directory 
(for example, under \tomcat\5). It lists all files that the GroupWise Installation program 
installed to your Web server. Delete the listed files to uninstall the WebAccess Application 
from your Web server.

Monitor: Stop the Monitor Agent. Delete the contents of the c:\Program 
Files\Novell\GroupWise Server\Monitor directory.

Installation Program Field Value for Your GroupWise 
System

Explanation

Agent Software Platform: 

 NetWare

 Windows

 Linux

Section 8.3.1, “Selecting the Agent 
Platform,” on page 185
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Agents and Locations: 

POA:

 Local to post office

 Different server from post 
office

/dn setting (NetWare only)

MTA

 Local to domain

 Different server from domain

/dn setting (NetWare only)

Section 8.3.2, “Selecting the Agent 
Location,” on page 185

Installation Path: Section 8.3.3, “Selecting the Agent 
Installation Directory,” on page 185

NetWare Installation Options: 

 Launch the GroupWise agents 
on system startup

 Launch the GroupWise agents 
in Protected Mode

 Configure the GroupWise 
agents for clustering

“NetWare Installation Options: 
Automatic Startup, Protected Mode, 
and Clustering” on page 187

Linux Installation Options: 

 Launch the GroupWise agents 
on system startup

 Configure the GroupWise 
Agents for Clustering

“Linux Installation Options: 
Automatic Startup and Clustering” 
on page 188

Windows Installation Options: 

 Install and configure SNMP for 
GroupWise agents

 Install as Windows services

“Windows Installation Options: 
SNMP Traps and Service vs. 
Application” on page 188

Agent Language Selection: 

 English

 French

 German

 Brazilian Portuguese

 Spanish

Section 8.3.5, “Deciding Which 
Languages to Install,” on page 186

Installation Program Field Value for Your GroupWise 
System Explanation
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Client Language Selection: 

 Arabic

 Brazilian Portuguese

 Chinese Traditional

 Chinese Simplified

 Czech

 Danish

 Dutch

 English

 Finnish

 French

 German

 Hebrew

 Hungarian

 Italian

 Japanese

 Korean

 Norwegian

 Polish

 Russian

 Spanish

 Swedish

Section 8.3.5, “Deciding Which 
Languages to Install,” on page 186

Domain Information: 

 Name

 Path

Section 8.3.4, “Gathering Domain 
and Post Office Information,” on 
page 186

Post Office Information: 

 Name

 Path

Section 8.3.4, “Gathering Domain 
and Post Office Information,” on 
page 186

Installation Program Field Value for Your GroupWise 
System Explanation
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Service Information: 

Windows only

 User local system account

 Allow service to interact 
with desktop

 Use this Windows user 
account

 Name of Windows user 
account

 Password

 Startup type

 Automatic

 Manual

 Disabled

Section 8.3.8, “Windows Installation 
Options: SNMP Traps and Service 
vs. Application,” on page 188

Installation Program Field Value for Your GroupWise 
System Explanation
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9 9Installing the GroupWise Clients

The following sections assist you with assigning GroupWise accounts to users and with installing the 
Novell GroupWise 8 Windows, Mac, and Linux clients.

 Section 9.1, “GroupWise Client Overview,” on page 229
 Section 9.2, “Setting Up GroupWise Client Users,” on page 229
 Section 9.3, “Installing and Starting the GroupWise Windows Client,” on page 231
 Section 9.4, “Installing and Starting the GroupWise Mac Client,” on page 234
 Section 9.5, “Installing and Starting the GroupWise Linux Client,” on page 235
 Section 9.6, “What’s Next,” on page 237

For information about client licensing requirements, see “Auditing Mailbox License Usage in the Post 
Office” in “Post Offices” in the GroupWise 8 Administration Guide.

9.1 GroupWise Client Overview
Each user with a GroupWise account has a mailbox in a post office. In a corporate workplace 
environment, GroupWise users with Windows workstations can run the GroupWise Windows client 
to access their mailboxes and to send and receive mail. GroupWise users with Macintosh or Linux 
workstations can run the GroupWise Mac or Linux client. 

GroupWise users can also access their mailboxes via a Web browser, WAP-enabled cellular phone, 
Palm OS device, or Windows Pocket PC device by using the GroupWise WebAccess client. For 
information about WebAccess, see Chapter 5, “Installing GroupWise WebAccess,” on page 101.

The GroupWise Windows client provides a full set of features, the GroupWise WebAccess and Mac/
Linux clients provides a similar but more limited set of features.

9.2 Setting Up GroupWise Client Users
 Section 9.2.1, “Assigning GroupWise Accounts to Users,” on page 229
 Section 9.2.2, “Implementing System-Wide Rollouts,” on page 231

9.2.1 Assigning GroupWise Accounts to Users

After you’ve finished your basic GroupWise system setup, you need to add users to the post office 
before they can log in to a GroupWise client. To do so, follow the instructions in one of the following 
sections:

 “Assigning GroupWise Accounts to eDirectory Users” on page 230
 “Assigning GroupWise Accounts to Non-eDirectory Users” on page 230
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Assigning GroupWise Accounts to eDirectory Users 

To give an eDirectory user a GroupWise account in the post office:

1 In ConsoleOne, right-click the user you want to give an account to, then click Properties.
2 Click the GroupWise tab to display the GroupWise Account page.
3 In the Post Office field, click the Browse button to select the post office.
4 In the Mailbox ID field, specify the name the user will use when logging in to his or her mailbox. 

The field defaults to the eDirectory username. 
5 Click OK.

Assigning GroupWise Accounts to Non-eDirectory Users

You give a non-eDirectory user a GroupWise account in a post office by adding the user to eDirectory 
as a GroupWise external entity.

1 In ConsoleOne, right-click the container where you want to create the GroupWise external 
entity, click New, then click Object to display the New Object dialog box.

2 In the list, select GroupWise External Entity, then click OK to display the Create GroupWise 
External Entity dialog box.

3 Define the following properties:
GroupWise Object ID: Specify the user’s GroupWise ID. The user’s ID, along with the user’s 
post office and domain, provide the user with a unique name within the GroupWise system.
Last Name: Specify the user’s last name.
GroupWise Post Office: Select the post office where you want the user’s mailbox.
External Network ID: Specify the user’s network ID for the network that he or she logs in to.
Define Additional Properties: Select this option so that you can define additional information 
such as the user’s first name. The user’s first name appears in the GroupWise Address Book.
Create Another External Entity: As soon as you select Define Additional Properties, this option 
becomes unavailable.

4 Click Create.
5 Specify the user’s first name in the Given Name field.
6 Fill in any other fields you want, then click OK.

The user is given a GroupWise account in the post office you selected and can access his or her 
mailbox through the GroupWise client.

Logging In to GroupWise as a Non-eDirectory User

Because non-eDirectory users do not log in to eDirectory, the GroupWise clients cannot use the 
GroupWise information in eDirectory to automatically log in to the users’ post office. When a non-
eDirectory user starts a GroupWise client for the first time, he or she is prompted for a GroupWise 
user ID and post office location (IP address and port number). You need to provide non-eDirectory 
users with this information.

If you don’t want to provide non-eDirectory users with the post office information, you can automate 
the login process by creating a GroupWise name server. A GroupWise name server is a DNS 
hostname entry that defines the TCP/IP address of the POA. During startup, the GroupWise client 
automatically looks for the GroupWise name server in DNS. For information about creating a 
GroupWise name server, see “Post Office Agent” in the GroupWise 8 Administration Guide.
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9.2.2 Implementing System-Wide Rollouts

For a system-wide rollout of the GroupWise client software, you might want to consider alternatives 
to each user installing from the DVD, the downloaded software image, or the software distribution 
directory.

For the GroupWise Windows client, if you have Novell ZENworks Desktop Management, you can 
use it, along with the .msi files included with GroupWise 8, to distribute the client. Or, you can have 
a login script run the client setup program with a response file to perform a silent install on 
workstations.

For the GroupWise Linux client, you can use ZENworks Linux Management for a system-wide 
rollout.

For more information about these and other installation methods, see “Client” in the GroupWise 8 
Administration Guide. 

9.3 Installing and Starting the GroupWise Windows Client
 Section 9.3.1, “GroupWise Windows Client Workstation Requirements,” on page 231
 Section 9.3.2, “Installing the Windows Client,” on page 231
 Section 9.3.3, “Starting the Windows Client,” on page 233

9.3.1 GroupWise Windows Client Workstation Requirements

 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.

 Any of the following Windows versions:

 Windows XP on a 300 MHz or higher workstation with at least 128 MB of RAM
 Windows Vista on a 1 GHz or higher workstation with at least 1 GB of RAM
 Windows 7 on a 1 GHz or higher workstation with at least 1 GB of RAM

 200 MB of free disk space to install the GroupWise Windows client

9.3.2 Installing the Windows Client

1 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run setup.exe from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the Windows client software to a software distribution directory, run 
setup.exe from the root of the software distribution directory to start the GroupWise 
Installation program. 
In order to install from the software distribution directory, users need a drive mapped to the 
software distribution directory. Users also require Read and File Scan rights to the 
drive:\grpwise\software directory to start the GroupWise Installation program and to the 
drive:\grpwise\software\client\win32 directory to run the Windows Client Setup 
program.
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2 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

NOTE: All available languages are included on the GroupWise 8 DVD and the multilanguage 
version of the downloaded GroupWise 8 software image, but you can select which languages you 
want to install.

The main GroupWise System Installation page appears.

3 Click Install More Components > Install GroupWise Client to start the client Setup program.
4 Select the language in which you want to run the client Setup program, then click OK.
5 Click Next to display the Setup Type dialog box.

6 Select one of the following options:
Typical: For a new installation, installs the most commonly used components in the standard 
installation directory of c:\Program Files\Novell\Groupwise without prompting for further 
information. By default, this installs the software integration and Internet browser mail 
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integration. A GroupWise icon is added to your Desktop as well as to the Quick Launch bar. 
However, Notify is not added to your startup group. This means Notify does not run when 
Windows starts. 
Upgrade: For an update installation, installs GroupWise 8 over your existing installation of 
GroupWise with the same components you already had installed. The installation directory is 
also the same as your previous installation of GroupWise. 
Custom: For a new or update installation, allows you to select what components of GroupWise 
you want to install. Select this option if you want to add Notify to your Startup group.
See “Client” in the GroupWise 8 Administration Guide for more information about setting up 
GroupWise Remote and Caching modes.

7 Click Next. 
8 If you selected Typical or Upgrade:

8a Click Install to install the client files.
When the client Setup program has completed, a shortcut to run GroupWise appears on 
your desktop and on the Quick Launch bar.

8b Click Finish to exit the GroupWise Installation program.
9 If you selected Custom:

9a Make sure each component you want to install is selected.
Languages: Select which languages to install. 
Software Integrations: Select the applications for integration with GroupWise Document 
Management Services for saving and retrieving files from GroupWise libraries.
Internet Browser Mail Integration: Sets GroupWise to be the default e-mail program on 
the workstation, so that whenever the user clicks an e-mail link on a Web page or chooses 
the Mail command in the browser, GroupWise starts.

9b Click Next.
9c Select the Program Folder where you want to add the GroupWise icons.

The default is Novell GroupWise.
9d Select if you want the GroupWise icon added to your Desktop and Quick Launch.
9e Select if you want Notify added to the Startup Folder. This starts Notify when Windows 

starts. 
You can also choose to start Notify when GroupWise starts, as described in “Starting Notify 
When GroupWise Starts ” in “Notify” in the GroupWise 8 Windows Client User Guide.

9f Click Next. 
9g Click Install to install the client files.

When the client Setup program has completed, a shortcut to run GroupWise appears on 
your desktop. 

9h Click Finish to exit the GroupWise Installation program.

9.3.3 Starting the Windows Client

At startup, the Windows GroupWise client needs to know the location (IP address/hostname and 
port number) of the user’s post office. There are three ways that the client can get this information:

 If the user is logged into eDirectory, the GroupWise client can read eDirectory for the post 
office’s location.
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 If the user is not logged into eDirectory, the GroupWise client can use a GroupWise name server 
to get the user’s post office location.
 A GroupWise name server is a DNS hostname entry that defines the IP address of the post 
office’s POA. During startup, the GroupWise client automatically looks for the GroupWise name 
server in DNS. For information about creating a GroupWise name server, see “Post Office 
Agent” in the GroupWise 8 Administration Guide.

 The user can provide the post office location when prompted.

To start the GroupWise Windows client for the first time:

1 Double-click the GroupWise icon on the Windows desktop.
2 Enter the password and post office address information, then click OK.

See also “Getting Started” in the GroupWise 8 Windows Client User Guide.

9.4 Installing and Starting the GroupWise Mac Client
The GroupWise Mac client is not included with GroupWise 8 Support Pack 3, but is available in 
earlier versions of GroupWise 8. The GroupWise 8 Support Pack 2 Mac client can continue to be used 
with a GroupWise system that has been updated to GroupWise 8 Support Pack 3 or to GroupWise 
2012.

 Section 9.4.1, “GroupWise Mac Client,” on page 234
 Section 9.4.2, “Installing the Mac Client,” on page 235
 Section 9.4.3, “Starting the Mac Client,” on page 235

9.4.1 GroupWise Mac Client

 x86-32 processor or x86-64 processor; PowerPC

On a 64-bit processor, GroupWise still runs as a 32-bit application.

 Any of the following desktop operating systems:

 Mac OS 10.6.8 and later (Snow Leopard), Mac OS 10.7 (Lion), Mac OS 10.8 (Mountain Lion) 
or later, for use with the GroupWise 8.0.2 HP3 or HP4 Mac client that is available on the 
Novell Downloads site (http://download.novell.com)
or
Mac OS 10.4 (Tiger), Mac OS 10.5 (Leopard), Mac OS 10.6.7 and earlier (Snow Leopard), for 
the GroupWise 8.0.2 HP2 Mac client that is available on the Novell Downloads site (http://
download.novell.com)

 Mac OS X for Intel
 Mac OS X for PowerPC for the GroupWise 8.0.2 HP2 Mac client that is available on the 

Novell Downloads site (http://download.novell.com)
The GroupWise 8.0.2 HP3 Mac client is not supported on Mac OS X for PowerPC.

 Apple Java Virtual Machine (JVM) 1.5 or later

 75 MB of free disk space to install the GroupWise Mac client
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9.4.2 Installing the Mac Client

1 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program, 
double-click the CDROM icon that appears on your desktop, double-click the mac folder, then 
double-click the GroupWise .dmg file to create the GroupWise package.
or
Double-click the downloaded GroupWise .dmg file to create the GroupWise package.

2 Drag the GroupWise package to the Applications folder to install the software on your Mac.
3 Drag the GroupWise package from the Applications folder to the Mac dock to create a 

GroupWise icon for convenient access.
4 Click the GroupWise Mac client icon on the dock to start the Mac client.

9.4.3 Starting the Mac Client

At startup, the GroupWise Mac client needs to know the location (IP address/hostname and port 
number) of the user’s post office. There are three ways that the client can get this information:

 If the user is logged into eDirectory, the GroupWise client can read eDirectory for the post 
office’s location.

 If the user is not logged into eDirectory, the GroupWise client can use a GroupWise name server 
to get the user’s post office location.
 A GroupWise name server is a DNS hostname entry that defines the IP address of the post 
office’s POA. During startup, the GroupWise client automatically looks for the GroupWise name 
server in DNS. For information about creating a GroupWise name server, see “Post Office 
Agent” in the GroupWise 8 Administration Guide.

 The user can provide the post office location when prompted.

To start the GroupWise Mac client for the first time:

1 Click the GroupWise icon on the Mac dock.
2 Enter the password and post office address information, then click OK.

See also “Getting Started” in the GroupWise 8 Mac/Linux Client User Guide.

9.5 Installing and Starting the GroupWise Linux Client
The GroupWise Linux client is not included with GroupWise 8 Support Pack 3, but is available in 
earlier versions of GroupWise 8. The GroupWise 8 Support Pack 2 Linux client can continue to be 
used with a GroupWise system that has been updated to GroupWise 8 Support Pack 3 or to 
GroupWise 2012.

 Section 9.5.1, “GroupWise Linux Client Workstation Requirements,” on page 235
 Section 9.5.2, “Prerequisites on SUSE Linux Enterprise Desktop 11,” on page 236
 Section 9.5.3, “Installing the Linux Client,” on page 236
 Section 9.5.4, “Starting the Linux Client,” on page 237

9.5.1 GroupWise Linux Client Workstation Requirements

 x86-32 processor or x86-64 processor
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On a 64-bit processor, GroupWise still runs as a 32-bit application.

 SUSE Linux Enterprise Desktop (SLED) 10 or SLED 11, plus the latest Support Pack, plus the 
KDE desktop or the GNOME desktop

 Java Virtual Machine (JVM) 1.5 or later

 200 MB of free disk space to install the GroupWise Linux client

9.5.2 Prerequisites on SUSE Linux Enterprise Desktop 11

If you are installing the Linux client on SUSE Linux Enterprise Desktop (SLED) 11, you need to 
manually install the libstdc++33 library. 

If you are installing the Linux client on SLED 10, skip to “Installing the Linux Client” on page 236.

To install the libstdc++33 library:

1 On the SLED 11 desktop, click Computer > YaST to launch the YaST Control Center.
2 Click Software > Software Management.
3 In the search field, type libstdc++33, then select it when it appears in the Packages listing 

section.
4 Click Install > Apply.
5 Continue with “Installing the Linux Client” on page 236.

9.5.3 Installing the Linux Client

1 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run ./install from the root of the downloaded GroupWise 8 software image.
or
If you have already copied the client software to a software distribution directory, run ./
install from the root of the software distribution directory to start the GroupWise Installation 
program.

2 Specify the root password, then click OK.
3 Select the language you want, then click OK.

The main GroupWise System Installation page appears.
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4 Click Install Products > Install GroupWise Client.
The GroupWise Linux client is installed to /opt/novell/groupwise/client. The installation 
process adds a GroupWise Linux client icon to your desktop.

5 Double-click the GroupWise Linux client icon to start the Linux client.

You can also install the Linux client by changing to the /client/linux directory on the GroupWise 8 
DVD or downloaded GroupWise 8 software image, then installing the RPM.

9.5.4 Starting the Linux Client

At startup, the GroupWise Linux client needs to know the location (IP address/hostname and port 
number) of the user’s post office. There are three ways that the client can get this information:

 If the user is logged into eDirectory, the GroupWise client can read eDirectory for the post 
office’s location.

 If the user is not logged into eDirectory, the GroupWise client can use a GroupWise name server 
to get the user’s post office location.
 A GroupWise name server is a DNS hostname entry that defines the IP address of the post 
office’s POA. During startup, the GroupWise client automatically looks for the GroupWise name 
server in DNS. For information about creating a GroupWise name server, see “Post Office 
Agent” in the GroupWise 8 Administration Guide.

 The user can provide the post office location when prompted.

To start the GroupWise Linux client for the first time:

1 Double-click the GroupWise icon on the Linux desktop.
2 Enter the password and post office address information, then click OK.

If you want to start the GroupWise Linux client from the command line:

1 Enter the following:

groupwise

During installation, a symbolic link is create in the /usr/bin directory that points to the 
GroupWise executable, so that you can execute the command in any directory.

2 Specify the username, password, and server information, then click OK.

See also “Getting Started” in the GroupWise 8 Mac/Linux Client User Guide.

9.6 What’s Next
For information about using the features in the GroupWise Windows, Linux, and Mac clients, click 
Help > Help Topics, or Help > User Guide in the client. The user guides are available at the GroupWise 8 
Documentation Web site (http://www.novell.com/documentation/gw8).
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10 10Installing Novell Messenger

Novell Messenger is a corporate-based, secure instant messaging solution that supports instant 
messaging, presence, and archiving of conversations. The Messenger client integrates with the 
GroupWise Windows client to provide access to instant messaging features from within the 
GroupWise Windows client.

Novell Messenger is installed separately from GroupWise and does not rely on your GroupWise 
system. All Messenger information is stored in eDirectory, not in GroupWise databases. For more 
information, see the Novell Messenger 2.2 Installation Guide.
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11 11Installing the Novell Data Synchronizer 
Mobility Pack

You can use Novell Data Synchronizer to synchronize e-mail and other Personal Information 
Manager (PIM) data from Novell GroupWise to mobile devices. The Mobility Pack includes Data 
Synchronizer, the GroupWise Connector, and the Mobility Connector. Additional connectors can be 
added to a Synchronizer system to synchronize GroupWise data to other supported applications.

For more information, see:

 Novell Data Synchronizer Documentation Web site (http://www.novell.com/documentation/
datasynchronizer1)

 Novell Data Synchronizer Connectors Documentation Web site (http://www.novell.com/
documentation/datasync_connectors1)
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12 12Installing Novell Vibe

Novell Vibe enhances GroupWise by bringing together people and the content they need to do their 
jobs. Users create workspaces and invite others to participate, from within or outside organizational 
boundaries. Virtual teams can easily and securely manage, share, locate, and access documents, 
calendars, discussion forums, wikis, and blogs. Powerful workflow functions can track project status 
and progress. Team workspaces enable enterprise social networking, with team members chosen not 
by their proximity, but for their expertise.

For more information, see:

 Novell Vibe Documentation Web site (http://www.novell.com/documentation/vibe32)
 “Novell Vibe” in the GroupWise 8 Interoperability Guide

NOTE: Novell Vibe 3.2 is the next major product release after Novell Teaming 2.1.
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13 13Installing Novell Conferencing

Novell Conferencing enhances GroupWise by providing instant telephone conferencing, phone 
number management, meeting scheduling and management, meeting presence, chat, desktop 
sharing, whiteboarding, and more.

For more information, see:

 Novell Conferencing Documentation Web site (http://www.novell.com/documentation/
novell_conferencing)

 “Using GroupWise with Conferencing” in the GroupWise 8 Interoperability Guide
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III IIIUpdate

 Chapter 14, “What’s New in GroupWise 8,” on page 249
 Chapter 15, “Understanding the Update Process,” on page 255
 Chapter 16, “Preparing Your GroupWise System for Update,” on page 261
 Chapter 17, “Updating Your GroupWise 7 System to Version 8,” on page 263
 Chapter 18, “Updating Your GroupWise 5.x or 6.x System to Version 8,” on page 277
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14 14What’s New in GroupWise 8

Novell GroupWise 8 provides substantial improvements over GroupWise 7 in five areas:

 Section 14.1, “GroupWise Windows Client,” on page 249
 Section 14.2, “GroupWise Mac/Linux Client,” on page 249
 Section 14.3, “GroupWise WebAccess Client,” on page 249
 Section 14.4, “GroupWise Administration,” on page 250
 Section 14.5, “GroupWise Agents,” on page 252

14.1 GroupWise Windows Client
The Windows client now lets you choose either OpenOffice or Microsoft Word as your editor when 
composing messages, and provides Auto-Save protection against message loss. Panels can be 
configured to display Web pages and RSS feeds. Improved Calendar features include accepting items 
into any calendar, publishing personal GroupWise calendars and free/busy schedules on the Web, 
subscribing to calendars on the Web, and checking the free/busy schedules of Internet users. 
Improved Contact features include business card format, a contacts index with lettered tabs, multiple 
Contacts folders, and contact photos. Improved Tasklist features include subtasks, percent complete, 
date complete, and task sorting. 

For information about using new features, from the GroupWise Windows client, click Help > What’s 
New, or see “What’s New in GroupWise 8” in the GroupWise 8 Windows Client User Guide.

14.2 GroupWise Mac/Linux Client
The Mac/Linux client has added many features, including the Home Folder, the Nav Bar, more 
flexible panels, toolbar customization, categories, improved Find capabilities, item personalization, 
item type modification, multiple calendars, calendar selection for appointment acceptance, shared 
calendars, updated calendar views, import/export calendars, additional forms for calendar printing, 
date/time format modification, CASA login support, Auto-Save protection against message loss, 
external accounts (POP, IMAP, and NNTP), and Notify. 

For information about using new features, from the GroupWise Mac/Linux client, click Help > What’s 
New, or see “What’s New in GroupWise 8” in the GroupWise 8 Mac/Linux Client User Guide.

14.3 GroupWise WebAccess Client
The WebAccess client now provides a scrollable message list, auto-save protection against message 
loss, name completion, HTML Compose mode, improved spell checking, and categories. Calendar 
enhancements include a graphical Calendar with multiple-calendar support, drag-and-drop 
appointments, publishing personal GroupWise calendars and free/busy schedules on the Web, 
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calendar colors, and automatic time zone synchronization with your workstation. Contact 
Management now includes a contact summary, e-mail history, and notes. Keyboard shortcuts such as 
Ctrl+A to select all items and Del to delete items make the new message list very easy to use.

For information about using new features, from the GroupWise WebAccess client, click Help > Help 
Topics > Appendix A: What’s New, or see “What’s New In GroupWise 8 WebAccess” in the GroupWise 8 
WebAccess Client User Guide.

14.4 GroupWise Administration
GroupWise administrators benefit from a new GroupWise Installation program that streamlines 
creation of a basic GroupWise system (administration, domain, post office, and agents) and that 
provides for saving installation options so that installations can be repeated without interaction. The 
GroupWise snap-ins to ConsoleOne have been improved to provide more currently appropriate 
agent settings defaults, more efficient addressing for external Internet domains, a significantly larger 
maximum mailbox size, the ability to set the default MIME encoding character set, and the ability to 
customize the Training and Tutorials URL. The options file for GroupWise Check now uses the same 
XML format across NetWare, Linux, and Windows so that the same options file can be used on any 
platform. The following sections provide additional detail:

 Section 14.4.1, “Enhanced Installation Program,” on page 250
 Section 14.4.2, “E-Mail Address Publishing,” on page 251
 Section 14.4.3, “Simplified Addressing for External GroupWise Systems,” on page 251
 Section 14.4.4, “Client Auditing,” on page 251
 Section 14.4.5, “Customized Client User Training and Tutorials URL,” on page 251
 Section 14.4.6, “Default MIME Encoding,” on page 251
 Section 14.4.7, “New Format for the GWCheck Options File,” on page 252
 Section 14.4.8, “Updated Identity Manager Driver,” on page 252
 Section 14.4.9, “Access Control for Distribution Lists (v8.0.2),” on page 252
 Section 14.4.10, “Attachment Restrictions for Specified File Types (v8.0.2),” on page 252
 Section 14.4.11, “Maximum Number of Recipients (v8.0.2),” on page 252

14.4.1 Enhanced Installation Program

The GroupWise 8 Installation program provides the following new capabilities:

 Runs on Windows Vista and Windows 7.
 Streamlines installing and updating a basic GroupWise system (administration, domain, post 

office, MTA, POA, and Internet Agent). Additional components (GroupWise WebAccess, 
GroupWise Monitor, and Calendar Publishing Host) are installed separately.

 Enables you to save all installation option settings you select, so that you can run the installation 
again on additional servers, either by using the saved selections as defaults, or by performing an 
installation that automatically uses the save selections and requires no interactions at all.
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14.4.2 E-Mail Address Publishing

The GroupWise databases and eDirectory both contain information about users’ e-mail address 
formats. When you change settings for users’ GroupWise e-mail addresses, you can publish the 
changes to eDirectory so that user e-mail address information matches in both places.

For setup instructions, see “Publishing E-Mail Addresses to eDirectory.” in “System” in the 
GroupWise 8 Administration Guide.

14.4.3 Simplified Addressing for External GroupWise Systems

Before GroupWise 8, if you wanted users in your GroupWise system to be able to exchange messages 
conveniently with users in another GroupWise system, you needed to set up external domains, 
external post offices, and external users, or use dynamic Internet links, as described in “Connecting 
to Other GroupWise Systems” in the GroupWise 8 Multi-System Administration Guide.

Starting with GroupWise 8, you can set up an Internet domain in GroupWise to represent the other 
GroupWise system. As a result, messages are routed to the other GroupWise system based on links 
set up in the Link Configuration Tool, rather than through the Internet Agent.

For setup instructions, see “Using External System Links” in “Connecting to Other GroupWise 
Systems” in the GroupWise 8 Multi-System Administration Guide.

14.4.4 Client Auditing

ConsoleOne can now display the number of users who are using the Windows, Mac, or Linux client. 
The client version is also displayed.

For instructions, see “Viewing Current Client Usage in the Post Office” in “Post Offices” in the 
GroupWise 8 Administration Guide.

14.4.5 Customized Client User Training and Tutorials URL

When the user clicks Help > Training and Tutorials in the GroupWise Windows client, the GroupWise 8 
End-User Training Web page (http://www.brainstorminc.com/cbt/gw8/index.html) displays by 
default. If you purchase more in-depth training from BrainStorm, or you want to provide your own 
customized training materials for your GroupWise users, you can change the URL that Help > 
Training and Tutorials displays.

For instructions, see “Educating Your New Users” in “Users” in the GroupWise 8 Administration Guide.

14.4.6 Default MIME Encoding

You can now set the default MIME encoding (for example, UTF-8, Windows Default, ISO Default, 
and so on) that is used by the GroupWise clients.

For instructions, see “MIME Encoding” in “System” in the GroupWise 8 Administration Guide.

GroupWise users can override the default MIME encoding in the GroupWise clients, as described in:

 “Changing the MIME Encoding for E-Mail You Send” in “E-Mail” in the GroupWise 8 Windows 
Client User Guide
What’s New in GroupWise 8 251

http://www.brainstorminc.com/cbt/gw8/index.html
http://www.brainstorminc.com/cbt/gw8/index.html


 “Changing the MIME Encoding for E-Mail You Send” in “E-Mail” in the GroupWise 8 Mac/Linux 
Client User Guide

 “Changing the MIME Encoding of a Message” in “E-Mail” in the GroupWise 8 WebAccess Client 
User Guide

14.4.7 New Format for the GWCheck Options File

In the past, the GWCheck options file (gwcheck.opt, by default) was created in a different format on 
Linux than it was on NetWare and Windows. As a result, if you migrated from NetWare or Windows 
to Linux, you could not use any existing GWCheck options files on Linux.

In GroupWise 8, the GWCheck options file is created in XML format on all platforms. Therefore, you 
can create the GWCheck options file on any platform and use it on any platform interchangeably.

14.4.8 Updated Identity Manager Driver

The GroupWise Identity Manager driver has been updated with additional searches and more client 
options. It is available by selecting Identity Manager Drivers at Novell Downloads (http://
download.novell.com).

14.4.9 Access Control for Distribution Lists (v8.0.2)

In GroupWise 8 Support Pack 2, you can restrict the users who are allowed to send to a distribution 
list. For instructions, see “Controlling Access to a Distribution List” in “Distribution Lists, Groups, 
and Organizational Roles” in the GroupWise 8 Administration Guide.

14.4.10 Attachment Restrictions for Specified File Types (v8.0.2)

In GroupWise 8 Support Pack 2, you can restrict the types of files that users can attach to messages. 
For instructions, see “Restricted Attachment Extensions” in “Client” in the GroupWise 8 
Administration Guide,

14.4.11 Maximum Number of Recipients (v8.0.2)

In GroupWise 8 Support Pack 2, you can restrict the maximum number of recipients that users can 
send a message to. For instructions, see “Maximum Recipients Allowed” in “Client” in the GroupWise 
8 Administration Guide.

14.5 GroupWise Agents
 Section 14.5.1, “Post Office Agent and Message Transfer Agent,” on page 253
 Section 14.5.2, “GroupWise Internet Agent,” on page 253
 Section 14.5.3, “GroupWise WebAccess Agent,” on page 253
 Section 14.5.4, “GroupWise Monitor Agent,” on page 254
 Section 14.5.5, “GroupWise Calendar Publishing Host,” on page 254
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14.5.1 Post Office Agent and Message Transfer Agent

 The POA provides support for the calendar publishing and free/busy searching features in the 
Windows and WebAccess clients.

 The POA includes the new Document Conversion Agent to provide indexing of additional 
document formats such as PDF, OpenOffice, and Microsoft Office 2007.

 The POA also has enhanced performance when auto-archiving and emptying large numbers of 
items. 

 You can now display the agent startup files (domain.mta and post_office.poa) from the agent 
Web consoles.

14.5.2 GroupWise Internet Agent

 “Delayed Message Notification” on page 253
 “More Flexibility with Rule-Generated Messages” on page 253
 “More Complete Configuration Information in the Internet Agent Web Console” on page 253

Delayed Message Notification

Before GroupWise 8, users needed to check the Properties pages of messages sent to Internet users to 
see whether or not the messages had been transferred out of the GroupWise system. In GroupWise 8, 
the Internet Agent can be configured to provide a notification message to users whose e-mail 
messages cannot be immediately sent out across the Internet.

For more information, see “Configuring SMTP/MIME Services” in “Internet Agent” in the GroupWise 
8 Administration Guide.

More Flexibility with Rule-Generated Messages

Blocking of rule-generated messages has been enhanced to provide more options. Before GroupWise 
8, you could configure the Internet Agent to either block all rule-generated messages or allow all 
rule-generated messages. In GroupWise 8, you can differentiate between rule-generated replies to 
messages (such as vacation rule messages) and rule-generated forwards of messages (which can be a 
security issue).

For setup instructions, see “Creating a Class of Service” in “Internet Agent” in the GroupWise 8 
Administration Guide.

More Complete Configuration Information in the Internet Agent Web Console

The Internet Agent Web console now displays configuration settings for all settings that are available 
through ConsoleOne. In addition, you can view the Internet Agent startup file (gwia.cfg) at the 
Internet Agent Web console; however, you cannot edit it from the Web console.

For instructions, see “Using the Internet Agent Web Console” in “Internet Agent” in the GroupWise 8 
Administration Guide.

14.5.3 GroupWise WebAccess Agent

The GroupWise 8 WebAccess Agent includes no changes from the previous release. 
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14.5.4 GroupWise Monitor Agent

The GroupWise 8 Monitor Agent includes no changes from the previous release.

14.5.5 GroupWise Calendar Publishing Host

The Calendar Publishing Host is a new feature in GroupWise 8. It provides the following new 
capabilities:

 Publishes GroupWise users’ personal calendars to the Web, so that they are readily available to 
non-GroupWise users.

 Returns free/busy status to non-GroupWise users who want to set up appointments with 
GroupWise users.

For setup instructions, see Chapter 6, “Installing the GroupWise Calendar Publishing Host,” on 
page 135. See also “Calendar Publishing Host” in the GroupWise 8 Administration Guide.
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15 15Understanding the Update Process

You can update a Novell GroupWise 5.x, 6.x, or 7 system to GroupWise 8. 

NOTE: To update a GroupWise 4.x system to GroupWise 8, you must first update the system to 
GroupWise 5.x. The functionality to update from GroupWise 4.x is not part of the GroupWise 8 
Administrator snap-ins to ConsoleOne.

Before you begin updating your GroupWise system to GroupWise 8, you should review the 
following sections. These sections, which describe the process to follow when updating, help you 
plan and implement a successful update strategy:

 Section 15.1, “Understanding eDirectory Schema Extensions,” on page 255
 Section 15.2, “Understanding GroupWise Software Updates,” on page 256
 Section 15.3, “Understanding How the Agents Update Domain and Post Office Databases,” on 

page 256
 Section 15.4, “Understanding GroupWise Client Updates,” on page 257
 Section 15.5, “Understanding Internet Agent Updates,” on page 258
 Section 15.6, “Understanding WebAccess Updates,” on page 258
 Section 15.7, “Understanding Monitor Updates,” on page 259
 Section 15.8, “Understanding GroupWise Gateway Compatibility,” on page 259

For a list of enhancements and new features in GroupWise 8, see Chapter 14, “What’s New in 
GroupWise 8,” on page 249.

In some cases, you might need to maintain a mixed-version environment as you roll out GroupWise 
8. For a table showing which GroupWise 5.x, 6.x, and 7 components can be used with GroupWise 8, 
see Appendix A, “GroupWise Version Compatibility,” on page 281.

For additional advice and counsel on the update process, specifically for NetWare, see Consultant’s 
Corner: Upgrading to GroupWise 8 (http://www.novell.com/communities/node/6771/consultants-
corner-upgrading-gro).

15.1 Understanding eDirectory Schema Extensions
GroupWise 8 includes new functionality that requires you to extend the schema of any Novell 
eDirectory trees where you have GroupWise objects. The GroupWise Installation program does not 
currently extend the eDirectory for you. Before you run the Installation program, use ConsoleOne to 
extend the eDirectory schema for GroupWise 8.

1 In ConsoleOne, select an eDirectory tree that contains GroupWise objects.
2 Click Tools > GroupWise Utilities > Check eDirectory Schema.
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If the schema is current, a message notifies you. If the schema is not current, you can use this 
utility to update to the current schema.

3 Repeat this procedure for each eDirectory tree that contains GroupWise objects.

15.2 Understanding GroupWise Software Updates
The GroupWise 8 software requirements are different than previous GroupWise software 
requirements. To review the requirements, see Chapter 2, “GroupWise System Requirements,” on 
page 17.

 Section 15.2.1, “Software Distribution Directory,” on page 256
 Section 15.2.2, “ConsoleOne,” on page 256

15.2.1 Software Distribution Directory

The GroupWise Installation program helps you copy the GroupWise 8 software (administration, 
agents, client, and so forth) to a GroupWise software distribution directory. This can be an existing 
software distribution directory or a new software distribution directory.

NOTE: Starting with GroupWise 7, GroupWise Windows client users cannot run the client software 
from the software distribution directory. They must install the GroupWise Windows client locally on 
their workstations. Users running the GroupWise client from their local drives can continue to run 
the local GroupWise client until you prompt them to update to GroupWise 8.

15.2.2 ConsoleOne

GroupWise 8 is administered through ConsoleOne, using the version listed in Section 2.1, 
“GroupWise Administration Requirements,” on page 17. You can use the same version of 
ConsoleOne to administer earlier GroupWise components in your GroupWise system.

IMPORTANT: Earlier versions of ConsoleOne should not be used to administer GroupWise 8 
domains, post offices, users, or other GroupWise 8 objects.

The Windows and Linux versions of ConsoleOne are included on the GroupWise 8 DVD and 
downloaded GroupWise 8 software image. If necessary, you can install ConsoleOne at the same time 
as the other GroupWise software. For instructions, see “ConsoleOne” on page 27.

NOTE: Earlier versions of GroupWise required or allowed the use of NetWare Administrator to 
administer your GroupWise system. Currently, NetWare Administrator should only be used if you 
still run very early gateways that require it. Otherwise, do not use NetWare Administrator.

15.3 Understanding How the Agents Update Domain and Post 
Office Databases
Functionality enhancements in GroupWise 8 require the GroupWise domain and post office 
databases to be updated with new records and fields, similar to the schema extensions that are 
required for eDirectory. The following diagram illustrates the required update sequence.
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Figure 15-1   Required Software Update Sequence

1. Update the primary domain first, so that correct replication of GroupWise 8 information can 
take place as you update post offices and secondary domains. 

2. Update the post offices in the primary domain.
or
Update secondary domains

3. Update the post offices in the updated secondary domains.

To update a domain database, you run the GroupWise 8 Message Transfer Agent (MTA) against it. 
The first time the GroupWise 8 MTA runs against a domain, it rebuilds the domain database 
(wpdomain.db) so the database includes the records required for new GroupWise 8 information. The 
MTA uses a new domain dictionary file (gwdom.dc) to rebuild the database for use with GroupWise 
8.

Likewise, to update a post office database, you run the GroupWise 8 Post Office Agent (POA) against 
it. The first time the GroupWise 8 POA runs against the post office, it rebuilds the post office database 
(wphost.db) so the database includes the new records required for GroupWise 8 information. The 
POA uses a new post office dictionary file (gwpo.dc), which it requests from the MTA, to rebuild the 
database for use with GroupWise 8. A user cannot run a GroupWise 8 client until his or her post 
office has been updated.

IMPORTANT: Before you update a secondary domain, you must wait until the update to the 
primary domain has run to completion. Before you update a post office, you must wait until the 
update to its domain has run to completion. Updating a large domain database can take 20 minutes 
or more. If you do not wait until the update runs to completion, you might encounter database 
versioning discrepancies. If such discrepancies occur, see “MTA Fails to Update the Domain 
Database Version” and “POA Fails to Update the Post Office Database Version” in “Strategies for 
Agent Problems” in GroupWise 8 Troubleshooting 2: Solutions to Common Problems.

15.4 Understanding GroupWise Client Updates
After a post office is updated to version 8, users can run the GroupWise 8 Windows client or Mac/
Linux client on workstations listed in Section 2.2, “GroupWise Client Requirements,” on page 19. If 
necessary, they can also continue to run their older GroupWise clients, but they will not have 
GroupWise 8 functionality.

IMPORTANT: Users who need to proxy into other users’ mailboxes should not update to the 
GroupWise 8 clients until the proxy users’ post office has been updated to version 8. GroupWise 8 
client users cannot proxy into users’ mailboxes that have not been updated to GroupWise 8.
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For a list of new features in the GroupWise 8 client, see Chapter 14, “What’s New in GroupWise 8,” 
on page 249. 

For client update instructions, see Section 17.4, “Updating Users’ GroupWise Clients,” on page 271.

15.5 Understanding Internet Agent Updates
The GroupWise 5.x, 6.x, and 7 Internet Agent can run against a GroupWise 8 domain and post office, 
which means that you can continue to use it until all domains and post offices are updated to version 
8.

For a list of new features in the GroupWise 8 Internet Agent, see Chapter 14, “What’s New in 
GroupWise 8,” on page 249. 

NOTE: If you are updating from GroupWise 7 or earlier, see “Using Internet Agent Startup 
Switches” in “Internet Agent” in the GroupWise 8 Administration Guide for important changes to 
where Internet Agent configuration information is stored.

For Internet Agent update instructions, see Chapter 16, “Preparing Your GroupWise System for 
Update,” on page 261.

15.6 Understanding WebAccess Updates
As you plan how to update GroupWise WebAccess, you need to consider both the WebAccess Agent 
and the WebAccess Application on the Web server.

 Section 15.6.1, “WebAccess Agent,” on page 258
 Section 15.6.2, “WebAccess Application on the Web Server,” on page 259

For a list of new features in GroupWise 8 WebAccess, see Chapter 14, “What’s New in GroupWise 8,” 
on page 249.

For WebAccess update instructions, see Chapter 16, “Preparing Your GroupWise System for 
Update,” on page 261.

15.6.1 WebAccess Agent

The GroupWise 8 WebAccess Agent cannot access earlier (pre-GroupWise 8) domains and post 
offices. In addition, WebAccess Agents older than version GroupWise 5.5 Enhancement Pack SP3 
cannot access GroupWise 8 domains and post offices. 

Therefore, to continue to provide WebAccess service to users while you are updating your system, 
you need to: 

 Update the WebAccess Agent at the same time you update its domain and post offices. This 
keeps the WebAccess Agent version synchronized with the domain and post office version.

 If you have multiple domains or post offices that will be updated over a long period of time, 
install the GroupWise 8 WebAccess Agent in a GroupWise 8 domain to service users on 
GroupWise 8 post offices. Keep your current WebAccess Agent, installed in a GroupWise 
domain that supports it, to service users on post offices where earlier GroupWise versions are 
still running.
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15.6.2 WebAccess Application on the Web Server

Before GroupWise 8, you could successfully run different versions of the WebAccess Agent and the 
WebAccess Application together. For example, you could install a new version of the WebAccess 
Application on your Web server while still running the previous version of the WebAccess Agent for 
the domain. 

Starting in GroupWise 8, the recommended update procedure is to update all the WebAccess Agents 
in your GroupWise system first, then update all the WebAccess Applications. Long-term use of the 
mixed-version configuration is not supported and can result in time zone problems. You must update 
both the WebAccess Agent and the WebAccess Application to the same version in order to ensure 
proper functioning of the GroupWise 8 WebAccess client.

IMPORTANT: Running a new WebAccess Application with an older WebAccess Agent is no longer 
supported.

15.7 Understanding Monitor Updates
GroupWise Monitor is not dependent on any other GroupWise agents, so it can be updated at any 
time.

For a list of changes and new features in GroupWise 8 Monitor, see Chapter 14, “What’s New in 
GroupWise 8,” on page 249.

For Monitor update instructions, see Chapter 16, “Preparing Your GroupWise System for Update,” 
on page 261.

15.8 Understanding GroupWise Gateway Compatibility
There are no known issues with using GroupWise gateways with GroupWise 8.
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16 16Preparing Your GroupWise System for 
Update

To prepare your Novell GroupWise system to be updated to version 8, complete the following tasks:

 Update the eDirectory schema for all trees that contain GroupWise objects, as described in 
Section 15.1, “Understanding eDirectory Schema Extensions,” on page 255.

 Validate your domain and post office databases to make sure that there are no physical 
inconsistencies with the database. If problems exist, you should recover or rebuild the database. 
For information about validating, recovering, or rebuilding a database, see the documentation 
for your GroupWise version at the Novell Documentation Web site (http://www.novell.com/
documentation).

 Back up the domain or post office immediately before updating it. For information about 
backing up your GroupWise databases, see the documentation for your GroupWise version at 
the Novell Documentation Web site (http://www.novell.com/documentation).

 Collect the information about your GroupWise system that the GroupWise Installation program 
prompts you for as your update the GroupWise software. If you are not completely familiar with 
all aspects of your GroupWise system, you might find it helpful to record the information on the 
summary sheets provided for an initial installation:
 “Basic GroupWise System Summary Sheet” on page 68 (includes administration, domain, 

post office, and agent information)
 “GroupWise Internet Agent Installation Summary Sheet” on page 96
 “GroupWise WebAccess Installation Summary Sheets” on page 130
 “GroupWise Monitor Installation Summary Sheets” on page 177
 “GroupWise Agent Installation Summary Sheet” on page 225

 Ensure that all GroupWise client user workstations are running a supported version of the 
operating system. For current system requirements, see Section 2.2, “GroupWise Client 
Requirements,” on page 19.
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17 17Updating Your GroupWise 7 System to 
Version 8

The following sections provide step-by-step instructions for updating your Novell GroupWise 7 
system to GroupWise 8. Before beginning, make sure you have reviewed Chapter 15, 
“Understanding the Update Process,” on page 255 and Chapter 16, “Preparing Your GroupWise 
System for Update,” on page 261.

The update process described in this section is generalized to apply to all GroupWise platforms 
(NetWare, Linux, and Windows). Platform-specific cross-references are provided as needed.

 Section 17.1, “Installing the GroupWise 8 Software,” on page 263
 Section 17.2, “Updating the Primary Domain,” on page 268
 Section 17.3, “Updating Post Offices,” on page 269
 Section 17.4, “Updating Users’ GroupWise Clients,” on page 271
 Section 17.5, “Updating Secondary Domains,” on page 272
 Section 17.6, “Updating the GroupWise Internet Agent,” on page 273
 Section 17.7, “Updating GroupWise WebAccess,” on page 273
 Section 17.8, “Updating GroupWise Monitor,” on page 275

17.1 Installing the GroupWise 8 Software
 Section 17.1.1, “Installing the GroupWise 8 Software on NetWare or Windows,” on page 263
 Section 17.1.2, “Installing the GroupWise 8 Software on Linux,” on page 266

17.1.1 Installing the GroupWise 8 Software on NetWare or Windows

1 Make sure that you have updated the eDirectory schema for eDirectory trees that contain 
GroupWise objects, as described in Section 15.1, “Understanding eDirectory Schema 
Extensions,” on page 255.

2 Stop the MTA for the primary domain of your GroupWise system.
3 At a Windows workstation, log in as an Admin equivalent to the eDirectory tree in which you 

are updating GroupWise.
4 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.

or
Run setup.exe from the root of the downloaded GroupWise 8 software image.
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5 Click Install GroupWise System, then click Yes to accept the license agreement.
When you update your GroupWise system, you are performing a Standard installation.

6 Click Next to accept the default of Standard.

7 Select Update an Existing System, then click Next.
8 Follow the prompts to provide the following information from your Basic GroupWise System 

Summary Sheet.

Software Platform
ConsoleOne Path
Software Distribution Directory
Software Selection
Installation Path
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NetWare Agent Installation Options or Windows Agent Installation Options
Agent Language Selection
Client Language Selection
Domain Information

IMPORTANT: On the Domains / Post Offices page, add only the primary domain, even if the 
primary domain has one or more post offices. The MTA must update the primary domain 
database before any post offices are updated.

When you reach the Update an Existing System page, carefully review the steps that are 
involved in updating your GroupWise system from a previous version to GroupWise 8.

More detailed instructions are provided in the sections following the software update 
instructions.

9 Browse to and select the primary domain directory, then click Next.
By specifying the primary domain directory, you inform the GroupWise Installation program 
where to copy the GroupWise 8 data dictionary (.dc) files. Without the GroupWise 8 .dc files, 
the GroupWise MTA cannot rebuild the primary domain database into the structure required for 
GroupWise 8. Having the GroupWise 8 .dc files in the domain directory is critical to a successful 
GroupWise system update.

10 On the Summary and Modification page, review the information you have provided to the 
GroupWise Installation program for your update to GroupWise 8, modifying information if 
needed.

11 When you are satisfied with the information you have provided, click Install to update your 
primary domain to GroupWise 8.

12 When the installation completed, click Finish.
13 Skip to Section 17.2, “Updating the Primary Domain,” on page 268.
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17.1.2 Installing the GroupWise 8 Software on Linux

1 In a terminal window, become root by entering su - and the root password.
2 Make sure that you have updated the eDirectory schema for eDirectory trees that contain 

GroupWise objects, as described in Section 15.1, “Understanding eDirectory Schema 
Extensions,” on page 255.

3 Stop the MTA for the primary domain of your GroupWise system.
4 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.

or
Run install from the root of the downloaded GroupWise 8 software image.

5 Select the language in which you want to run the GroupWise Installation program, then click 
OK.

6 Click Create or Update a GroupWise System.

7 Follow the prompts to provide the following information from your Basic GroupWise System 
Summary Sheet.

Software Distribution Directory
Software Selection
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If the Installation program detects that multiple GroupWise components are installed on the 
server, a message lists the installed components and prompts you to update all of them. All 
components on the server must be updated to GroupWise 8 at the same time.

8 If you are prompted to update all GroupWise components on the server, click Yes.
This process updates the software but does not change the configuration of any of the 
components. Depending on the number of components to update, this process might take 
several minutes.

9 When the software copying is complete, click Next.

10 Retain the default of Updating an Existing GroupWise System, then click Next.
On the Update an Existing System page, carefully review the steps that are involved in updating 
your GroupWise system from a previous version to GroupWise 8.

More detailed instructions are provided in the sections following the software update 
instructions.

11 Browse to and select the primary domain directory, then click Update.
By specifying the primary domain directory, you inform the GroupWise Installation program 
where to copy the GroupWise 8 data dictionary (.dc) files. Without the GroupWise 8 .dc files, 
the GroupWise MTA cannot rebuild the primary domain database into the structure required for 
GroupWise 8. Having the GroupWise 8 .dc files in the domain directory is critical to a successful 
GroupWise system update.

12 Continue with Updating the Primary Domain.
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17.2 Updating the Primary Domain
By following the instructions in Section 17.1, “Installing the GroupWise 8 Software,” on page 263, 
you have installed the GroupWise 8 MTA for the primary domain. You have also installed the data 
dictionary (.dc) files to the primary domain. To finish updating the primary domain, you need to 
start the GroupWise 8 MTA. The MTA uses the new domain dictionary file (gwdom.dc) to update the 
domain database to version 8.

1 Make sure that the GroupWise 7 MTA is no longer running for the primary domain.
2 Follow the instructions for your platform to start the GroupWise 8 MTA for your primary 

domain.
 “Starting the NetWare GroupWise Agents” on page 197
 “Starting the Linux Agents with a User Interface” on page 202
 “Starting the Windows GroupWise Agents” on page 222

The MTA then updates the primary domain database (wpdomain.db) to GroupWise 8.
3 Before you update post offices in the primary domain or any secondary domains in your system, 

make sure that the domain database has been updated by checking the Database Version field on 
the Identification property page of the Domain object in ConsoleOne.

4 To update post offices in the primary domain, continue with the next section, Updating Post 
Offices.
or
To update other domains, skip to Section 17.5, “Updating Secondary Domains,” on page 272.
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17.3 Updating Post Offices
To update a post office, you need to install the GroupWise 8 POA and run it for the post office. The 
POA uses a new 8 version of the post office dictionary file (gwpo.dc) to update the post office 
database to version 8.

 Section 17.3.1, “Installing and Starting the POA,” on page 269
 Section 17.3.2, “Copying the GroupWise Views to the Post Office Directory,” on page 270

17.3.1 Installing and Starting the POA

The POA cannot be running while you update it. Users who connect to the post office via client/
server (TCP/IP) cannot access the post office while the POA is shut down. 

IMPORTANT: The MTA for the domain that the post office belongs to should be updated and 
running before you install and start the POA.

To install and start the POA:

1 Follow the instructions for your platform to install the GroupWise 8 POA for each post office in 
your GroupWise system.
 “Installing the NetWare Agent Software” on page 193
 “Installing the GroupWise Agents on Linux” on page 199
 “Installing the Windows Agent Software” on page 219

2 Follow the instructions for your platform to start the GroupWise 8 POA for each post office in 
your GroupWise system.
 “Starting the NetWare GroupWise Agents” on page 197
 “Starting the Linux Agents with a User Interface” on page 202
 “Starting the Windows GroupWise Agents” on page 222

This updates the post office database (wphost.db) in each post office to GroupWise 8.
3 Before you run GroupWise 8 clients against the post office, make sure that the post office 

database has been updated by checking the Database Version field on the Identification property 
page of the Post Office object in ConsoleOne.
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4 Continue with Copying the GroupWise Views to the Post Office Directory.

17.3.2 Copying the GroupWise Views to the Post Office Directory

GroupWise 8 includes new views for the GroupWise Windows client. When the POA starts, it 
updates the post office database and also attempts to update the client views in the post office 
directory. To do so, it requires access to the software distribution directory. If it doesn’t have access, 
you must manually copy the views.

You can check whether or not the POA was able to update the views by verifying the existence of the 
en02*.vew files in the drive:\post_office\ofviews\win directory, where post_office is the path to 
the post office directory.

If the en02*.vew files do not exist or have older dates, copy all files from

drive:\software\client\win32\ofviews\win

to

drive:\post_office\ofviews\win

where drive:\software is the path to the software distribution directory and drive:\post_office 
is the path to the post office directory.

You can also perform this task in ConsoleOne. See “Refreshing the Client View Files in the Post 
Office” in “Post Offices” in the GroupWise 8 Administration Guide.
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17.4 Updating Users’ GroupWise Clients
After a post office is updated to version 8, users who have accounts in that post office can start using 
the GroupWise 8 clients. Starting with GroupWise 7, uses cannot run the GroupWise client software 
from the software distribution directory, but the software is still installed to users’ workstations from 
software distribution directories. Users might access a software distribution directory and run the 
installations themselves, or you might configure automatic updates for them.

When you used the GroupWise Installation program as described in Section 17.1, “Installing the 
GroupWise 8 Software,” on page 263, you had the opportunity to update one software distribution 
directory. To fully implement GroupWise 8 throughout your GroupWise system, you must update all 
of your software distribution directories.

IMPORTANT: Before you update a software distribution directory, make sure all post offices that 
use the software distribution directory have been updated. The GroupWise 8 client cannot access a 
post office that still uses an earlier version of GroupWise. Users who update to the GroupWise 8 
client before their post office has been updated are locked out of the post office.

To update a GroupWise software distribution directory to GroupWise 8:

1 Make sure you have Read, Write, Create, Erase, Modify, and File Scan rights (or equivalent 
rights) in an existing GroupWise 8 software distribution directory and in the software 
distribution directory you are updating to version 8.
or
If you still have access to the GroupWise 8 DVD or downloaded GroupWise 8 software image, you 
can use it instead of an existing GroupWise 8 software distribution directory.

2 In ConsoleOne, click Tools > GroupWise System Operations > Software Directory Management.

3 Select the software distribution directory you want to update, then click Update to display the 
Update Software Distribution Directory dialog box.
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4 Click Update by Copying From.
5 Click Software Distribution Directory, then select the GroupWise 8 software distribution directory.

or
If the GroupWise 8 software distribution directory is not listed, click Path, then enter the path to 
the directory. You can use this option to update the software directly from the GroupWise 8 DVD 
or downloaded GroupWise 8 software image.

The Force Auto-Update Check by GroupWise Components option is deselected by default. 
6 Select Force Auto-Update Check by GroupWise Components to cause the GroupWise client to check 

for a new version; if a new version is found, the client then prompts users to update the next 
time they start the client.

IMPORTANT: If the software distribution directory is already updated to version 8 and you are 
now trying to force users to update to the GroupWise 8 client, you should select only the Force 
Auto-Update Check by GroupWise Components option. You do not need to modify the other fields 
in this case.

7 Click OK to copy the files or force the client update.

IMPORTANT: When you select Force Auto-Update Check by GroupWise Components, a flag is set in 
each post office database. This flag instructs the GroupWise client to check for updated software. 
GroupWise clients running in client/server mode do not access the post office database directly; 
instead, the Post Office Agent accesses the post office database for them. For the Post Office 
Agent to read the new auto-update setting, you need to restart the Post Office Agent. Only after 
the POA restarts will GroupWise clients running in client/server mode check for updated 
software. 

17.5 Updating Secondary Domains
After you have updated the primary domain, you can update any secondary domains in your system 
by installing updated MTA software in each secondary domain. For information about update issues 
you should consider, see Section 15.3, “Understanding How the Agents Update Domain and Post 
Office Databases,” on page 256.

IMPORTANT: The MTA for the domain that the secondary domain links to should be updated and 
running before you update the secondary domain.

For information about installing the GroupWise 8 MTA, see Chapter 8, “Installing GroupWise 
Agents,” on page 181.

If the secondary domain has additional agents, update those agents as described in:

 Section 17.6, “Updating the GroupWise Internet Agent,” on page 273
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 Section 17.7, “Updating GroupWise WebAccess,” on page 273
 Section 17.8, “Updating GroupWise Monitor,” on page 275

Update the post offices and users in the secondary domain as described in: 

 Section 17.3, “Updating Post Offices,” on page 269
 Section 17.4, “Updating Users’ GroupWise Clients,” on page 271

17.6 Updating the GroupWise Internet Agent
After you’ve updated your domains and post offices, you can update the Internet Agent. For 
information about update issues you should consider, see Section 15.5, “Understanding Internet 
Agent Updates,” on page 258.

For information about installing the GroupWise 8 Internet Agent, see Chapter 4, “Installing the 
GroupWise Internet Agent,” on page 73.

IMPORTANT: If you are updating from GroupWise 7 without Support Packs or from an earlier 
version of GroupWise, see “Using Internet Agent Startup Switches” in “Internet Agent”   in the 
GroupWise 8 Administration Guide for important changes to where Internet Agent configuration 
information is stored.

17.7 Updating GroupWise WebAccess
After you’ve updated your domains and post offices, you can update GroupWise WebAccess. For 
information about update issues you should consider, see Section 15.6, “Understanding WebAccess 
Updates,” on page 258.

For information about installing GroupWise 8 WebAccess, see Chapter 5, “Installing GroupWise 
WebAccess,” on page 101.

After installing GroupWise 8 WebAccess, complete the following tasks as needed for your system:

 Section 17.7.1, “Clearing Browser Caches,” on page 273
 Section 17.7.2, “Handling New URLs for WebAccess and Monitor,” on page 273
 Section 17.7.3, “Cleaning Up Obsolete Web Server Files,” on page 275
 Section 17.7.4, “Document Viewer Agent Cache Compatibility,” on page 275

17.7.1 Clearing Browser Caches

After you have updated the WebAccess software, notify your WebAccess client users that they 
should clear their browser caches before logging into their mailboxes with the updated WebAccess 
client. If old WebAccess files are pulled from users’ browser caches, they might not be compatible 
with the updated files pulled from the Web server. The results can be unpredictable and undesirable. 

17.7.2 Handling New URLs for WebAccess and Monitor

Prior to GroupWise 7, users of WebAccess accessed the following URLs on NetWare and Windows 
Web servers:
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Starting with GroupWise 7, the WebAccess URLs on NetWare and Windows Web servers are the 
same as the URLs used on Linux:

To keep users’ browser bookmarks from being broken when you update from a version of 
GroupWise earlier than GroupWise 7, you should redirect the old URLs to the new URLs. Follow the 
instructions below for your Web server.

 “Apache Web Server” on page 274
 “Internet Information Server (IIS)” on page 274

Apache Web Server

1 Change to the conf subdirectory of the Apache root directory (for example, \apache2\conf.
2 Edit the Apache configuration file (gwapache2.conf) for GroupWise.
3 Add the following line:

redirect permanent /servlet/webacc http://web_server_address/
                                                            gw/webacc 

4 If you use WebPublisher, add the following additional line:

redirect permanent /servlet/webpub http://web_server_address/
                                                            gw/webpub 

5 Save the file, then exit the editor.
6 Restart Apache to put the redirections into effect.

Internet Information Server (IIS)

1 Change to the inetpub\wwwroot subdirectory of the IIS root directory (for example, 
c:\inetpub\wwwroot)

2 Create a subdirectory named servlet.
3 Under the servlet subdirectory, create a subdirectory named webacc.
4 If you use WebPublisher, create a second subdirectory named webpub.
5 In IIS Manager, expand the tree in the left pane to display Default Web Site under Web Sites.

Under Default Web Sites, you should see the servlet subdirectory you created in Step 2.
6 Expand the servlet subdirectory to display the webacc subdirectory (and optionally, the 

webpub subdirectory) that you created in Step 3.
7 Right-click the webacc subdirectory, then click Properties.

Web Services page: Default index.html file of the Web server

WebAccess: http://web_server_address/servlet/webacc

WebPublisher: http://web_server_address/servlet/webpub

GroupWise-specific Web 
Services page: 

http://web_server_address/gw/index.html

WebAccess: http://web_server_address/gw/webacc

WebPublisher: http://web_server_address/gw/webpub
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8 Click Directory, select A Redirection to a URL, then type /gw/webacc in the associated field.
9 Select A Permanent Redirection for This Resource, then click OK to save your changes.

10 If you use WebPublisher, repeat Step 7 through Step 9, using webpub in place of webacc.
11 Restart the IIS Web server to put the redirections into effect.

17.7.3 Cleaning Up Obsolete Web Server Files

As part of the change from /servlet/webacc to /gw/webacc in GroupWise 7, the WebAccess 
Installation program installs the WebAccess Application files into the servlet container (gw) but it 
does not remove old servlet and htdoc files located under the ROOT container of the servlet and the 
Web server. Therefore, you might want to manually delete the following directories and files if you 
are updating from a version of GroupWise earlier than GroupWise 7:

sys:\apache2\htdocs\com
sys:\apache2\htdocs\index.html (if customized for GroupWise)
sys:\apache2\htdocs\novell.html (if index.html was not customized)
sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapfilt.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapjdk.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njgwap.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njweb.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\SpellServlet.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\web.xml

You should definitely delete web.xml, because it might cause the WebAccess, WebPublisher, and 
Monitor Applications to run in both the old and new locations. Also, if you have customized the 
GroupWise template files, you should copy the contents of the template subdirectories under:

sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com\novell

to the corresponding templates subdirectories under:

sys:\tomcat\4\webapps\gw\WEB-INF\classes\com\novell

17.7.4 Document Viewer Agent Cache Compatibility

The Document Viewer Agent was introduced in GroupWise 7. The cache created by the Document 
Viewer Agent is not compatible with the cache previously used with WebPublisher. If you are 
updating from a version earlier than GroupWise 7, old WebPublisher cache directories should be 
removed from servers where the Viewer Agent is installed.

17.8 Updating GroupWise Monitor
You can update GroupWise Monitor at any time. For information about installing GroupWise 8 
Monitor, see Chapter 7, “Installing GroupWise Monitor,” on page 159.
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18 18Updating Your GroupWise 5.x or 6.x 
System to Version 8

The process and procedures for updating a Novell GroupWise 5.x, or 6.x system to version 8 are the 
same as when updating a GroupWise 7 system to version 8. Refer to the following sections for 
instructions:

 Chapter 15, “Understanding the Update Process,” on page 255
 Chapter 16, “Preparing Your GroupWise System for Update,” on page 261
 Chapter 17, “Updating Your GroupWise 7 System to Version 8,” on page 263

What’s New Since Your GroupWise Version

The GroupWise features and functionality that are new to you depend on the version of GroupWise 
that you are updating from. For example, if you are updating from GroupWise 6, the new features 
and functionality added in versions 6, 6.5, 7, and 8 are all new. If you are updating from GroupWise 
6.5, only the version 7 and 8 features are new.

Chapter 14, “What’s New in GroupWise 8,” on page 249 includes only the changes made since 
version 7. For changes made in previous versions, refer to the following:

 Version 5.5 Enhancement Pack to 6: What’s New in GroupWise 6 (http://www.novell.com/
documentation/gw6/gw6_install/data/aady5l3.html)

 Version 6 to 6.5: What’s New in GroupWise 6.5 (http://www.novell.com/documentation/gw65/
gw65_install/data/aady5l3.html)

 Version 6.5 to 7: What’s New in GroupWise 7 (http://www.novell.com/documentation/gw7/
gw7_install/data/aady5l3.html)

GroupWise 5.2 Administration Agent 

WARNING: Beginning with GroupWise 5.5, the Administration Agent’s functionality was moved 
into the Message Transfer Agent (MTA) and the Post Office Agent (POA). If you are updating a 
GroupWise 5, 5.1, or 5.2 system, you need to make sure that you do not run the Administration Agent 
for the domain after you’ve started the GroupWise 8 MTA. Doing so can result in the loss of 
GroupWise 8 information.
Updating Your GroupWise 5.x or 6.x System to Version 8 277

http://www.novell.com/documentation/gw65/gw65_install/data/aady5l3.html
http://www.novell.com/documentation/gw6/gw6_install/data/aady5l3.html
http://www.novell.com/documentation/gw7/gw7_install/data/aady5l3.html


278 GroupWise 8 Installation Guide



IV IVAppendixes
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A AGroupWise Version Compatibility

Use the tables in this section to determine compatibility among the following Novell GroupWise 
versions:

 Section A.1, “GroupWise 8 on NetWare and Windows,” on page 281
 Section A.2, “GroupWise 8 on Linux,” on page 285

IMPORTANT: GroupWise 5.x and 6.x versions have entered the end-of-life phase and are no longer 
actively supported. For update instructions, see Chapter 18, “Updating Your GroupWise 5.x or 6.x 
System to Version 8,” on page 277.

For each GroupWise version, the tables indicate compatibility for:

 Administrative components: Domain and post office database platforms and versions, 
eDirectory platforms, and GroupWise snap-in to ConsoleOne platforms and versions

 Agents: Domain and post office database platforms and versions, agent platforms and versions
 Clients: Post office directory platforms and access, POA platforms and versions, client modes

In the compatibility tables, cells with combinations that are not applicable are marked N/A. For 
example, the POA never communicates with the Internet Agent, so that table cell is N/A.

For information about what operating system versions are supported for GroupWise 8 on NetWare, 
Linux, and Windows, refer to “GroupWise System Requirements” on page 17. For information about 
earlier versions of GroupWise, refer to:

 GroupWise 7 Installation Guide (http://www.novell.com/documentation/gw7)
 GroupWise 6.5 Installation Guide (http://www.novell.com/documentation/gw65)

For information about the features that each GroupWise version includes, see Novell GroupWise 
Feature Comparison (http://www.novell.com/products/groupwise/compare.html).

A.1 GroupWise 8 on NetWare and Windows
Select the GroupWise version that you want to determine GroupWise 8 compatibility with:

 Section A.1.1, “Compatibility with GroupWise 7 on NetWare and Windows,” on page 281
 Section A.1.2, “Compatibility with GroupWise 6.5 on NetWare and Windows,” on page 283

A.1.1 Compatibility with GroupWise 7 on NetWare and Windows

 “GroupWise 7 Administrative Components with GroupWise 8” on page 282
 “GroupWise 7 Agents with GroupWise 8” on page 282
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 “GroupWise 7 Windows Client with GroupWise 8” on page 283
 “GroupWise 8 Windows Client with GroupWise 7” on page 283

GroupWise 7 Administrative Components with GroupWise 8

Table Summary: ConsoleOne with the GroupWise 8 snap-ins can be used to access GroupWise 7 
databases for domains and post office and GroupWise 7 eDirectory objects. However, ConsoleOne 
with the GroupWise 7 snap-ins cannot be used to access GroupWise 8 databases and GroupWise 8 
eDirectory objects. The general rule is that later GroupWise snap-ins can administer earlier 
GroupWise system components, but earlier GroupWise snap-ins cannot administer later GroupWise 
system components.

NOTE: If your GroupWise administration includes Novell Identity Manager, see “Identity Manager 
Version Compatibility” in the GroupWise 8 Readme on the GroupWise 8 Documentation Web site 
(http://www.novell.com/documentation/gw8).

GroupWise 7 Agents with GroupWise 8

GroupWise 8
Components

GroupWise 7 
Domain and Post 
Office Databases

GW 7 Objects in 
eDirectory

ConsoleOne + 
GW 7 Snap-Ins

GW 8 Domain and Post 
Office Databases

N/A N/A Not Supported

GW 8 Objects in 
eDirectory

N/A N/A Not Supported

ConsoleOne + 
GW 8 snap-ins

Supported Supported N/A

GroupWise 8
Agents

GroupWise 7 
Domain and 
Post Office 
Databases

GW 7 MTA
 

GW 7 POA GW 7 GWIA
GW 7 
WebAcces
s

GW 7 
Monitor

GW 8 Domain
and Post Office 
Databases

N/A Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

GW 8 MTA Supported Supported Supported Supported N/A Supported

GW 8 POA Supported Supported N/A N/A Supported Supported

GW 8 GWIA Supported Supported N/A Not 
Supported

N/A Supported

GW 8 
WebAccess

Not Supported N/A Not 
Supported

N/A N/A Supported

GW 8 Monitor Supported Supported Supported Supported Supported N/A
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Table Summary: GroupWise 7 agents cannot access domain and post office databases that have been 
updated to GroupWise 8. When a GroupWise 8 MTA or POA accesses a GroupWise 7 database, it 
automatically updates the database to GroupWise 8. Although most GroupWise 8/GroupWise 7 
agent combinations are supported, two combinations are not supported.

GroupWise 7 Windows Client with GroupWise 8

Table Summary: The GroupWise 7 Windows client can communicate with the GroupWise 8 POA, 
but it cannot access a GroupWise 8 post office directly. The general rule is that later POAs can always 
communicate with earlier GroupWise clients, but earlier POAs cannot communicate with later 
GroupWise clients.

GroupWise 8 Windows Client with GroupWise 7

Table Summary: The GroupWise 8 Windows client cannot communicate with the GroupWise 7 POA, 
nor can it access a GroupWise 7 post office directly. The general rule is that earlier POAs cannot 
communicate with later GroupWise clients, but later POAs can always communicate with earlier 
GroupWise clients.

A.1.2 Compatibility with GroupWise 6.5 on NetWare and Windows

 “GroupWise 6.5 Administrative Components with GroupWise 8” on page 283
 “GroupWise 6.5 Agents with GroupWise 8” on page 284
 “GroupWise 6.5 Windows Client with GroupWise 8” on page 284
 “GroupWise 8 Windows Client with GroupWise 6.5” on page 285

GroupWise 6.5 Administrative Components with GroupWise 8

GroupWise 7
Windows 
Client

GroupWise 8
Post Office
Direct Access

GW 8 POA
Client/Server 
Access 
Online Mode

GW 8 POA
Client/Server 
Access 
Caching Mode

GW 8 POA
Dial-Up Access
Remote Mode

Windows 
client

Not Supported Supported Supported Supported

GroupWise 8
Windows 
Client

GroupWise 7
Post Office
Direct Access

GW 7 POA
Client/Server 
Access 
Online Mode

GW 7 POA
Client/Server 
Access 
Caching Mode

GW 7 POA
Dial-Up Access
Remote Mode

Windows 
client

Not Supported Not Supported Not Supported Not Supported

GroupWise 8
Components

GroupWise 6.5 
Domain and Post 
Office Databases

GW 6.5 Objects in 
eDirectory

ConsoleOne + 
GW 6.5 Snap-Ins

GW 8 Domain and Post 
Office Databases

N/A N/A Not Supported
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Table Summary: ConsoleOne with the GroupWise 8 snap-ins can be used to access GroupWise 6.5 
databases for domains and post office and GroupWise 6.5 eDirectory objects. However, ConsoleOne 
with the GroupWise 6.5 snap-ins cannot be used to access GroupWise 8 databases and GroupWise 8 
eDirectory objects. The general rule is that later GroupWise snap-ins can administer earlier 
GroupWise system components, but earlier GroupWise snap-ins cannot administer later GroupWise 
system components.

GroupWise 6.5 Agents with GroupWise 8

Table Summary: GroupWise 6.5 agents cannot access domain and post office databases that have 
been updated to GroupWise 8. When a GroupWise 8 MTA or POA accesses a GroupWise 6.5 
database, it automatically updates the database to GroupWise 8. Although most GroupWise 8/
GroupWise 6.5 agent combinations are supported, two combinations are not supported.

GroupWise 6.5 Windows Client with GroupWise 8

GW 8 Objects in 
eDirectory

N/A N/A Not Supported

ConsoleOne + 
GW 8 snap-ins

Supported Supported N/A

GroupWise 8
Agents

GroupWise 
6.5 Domain 
and Post 
Office 
Databases

GW 6.5 
MTA
 

GW 6.5 
POA

GW 6.5 
GWIA

GW 6.5 
WebAcces
s

GW 6.5 
Monitor

GW 8 Domain
and Post Office 
Databases

N/A Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

GW 8 MTA Supported Supported Supported Supported N/A Supported

GW 8 POA Supported Supported N/A N/A Supported Supported

GW 8 GWIA Supported Supported N/A Not 
Supported

N/A Supported

GW 8 
WebAccess

Not Supported N/A Not 
Supported

N/A N/A Supported

GW 8 Monitor Supported Supported Supported Supported Supported N/A

GroupWise 
6.5
Windows 
Client

GroupWise 8
Post Office
Direct Access

GW 8 POA
Client/Server 
Access 
Online Mode

GW 8 POA
Client/Server 
Access 
Caching Mode

GW 8 POA
Dial-Up Access
Remote Mode

Windows 
client

Not Supported Supported Supported Supported

GroupWise 8
Components

GroupWise 6.5 
Domain and Post 
Office Databases

GW 6.5 Objects in 
eDirectory

ConsoleOne + 
GW 6.5 Snap-Ins
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Table Summary: The GroupWise 6.5 Windows client can communicate with the GroupWise 8 POA, 
but it cannot access a GroupWise 8 post office directly. The general rule is that later POAs can always 
communicate with earlier GroupWise clients, but earlier POAs cannot communicate with later 
GroupWise clients.

GroupWise 8 Windows Client with GroupWise 6.5

Table Summary: The GroupWise 8 Windows client cannot communicate with the GroupWise 6.5 
POA, nor can it access a GroupWise 6.5 post office directly. The general rule is that earlier POAs 
cannot communicate with later GroupWise clients, but later POAs can always communicate with 
earlier GroupWise clients.

A.2 GroupWise 8 on Linux
Select the GroupWise version that you want to determine GroupWise 8 compatibility with:

 Section A.2.1, “Compatibility with GroupWise 8 on NetWare and Windows,” on page 285
 Section A.2.2, “Compatibility with GroupWise 7 on NetWare and Windows,” on page 287
 Section A.2.3, “Compatibility with GroupWise 6.5 on NetWare or Windows,” on page 289

A.2.1 Compatibility with GroupWise 8 on NetWare and Windows

 “GroupWise 8 Linux Administrative Components with GroupWise 8 on NetWare or Windows” 
on page 285

 “GroupWise 8 Linux Agents with GroupWise 8 on NetWare or Windows” on page 286
 “GroupWise 8 Mac/Linux Client with GroupWise 8 on NetWare or Windows” on page 287
 “GroupWise 8 Windows Client with GroupWise 8 on Linux” on page 287

GroupWise 8 Linux Administrative Components with GroupWise 8 on NetWare or 
Windows

GroupWise 8
Windows 
Client

GroupWise 6.5
Post Office
Direct Access

GW 6.5 POA
Client/Server 
Access 
Online Mode

GW 6.5 POA
Client/Server 
Access 
Caching Mode

GW 6.5 POA
Dial-Up Access
Remote Mode

Windows 
client

Not Supported Not Supported Not Supported Not Supported

GroupWise 8 on Linux 
Administrative 
Components

GroupWise 8
Domain and Post 
Office Databases on 
NetWare 
or Windows

GW 8 Objects in 
eDirectory on 
NetWare 
or Windows

Windows ConsoleOne 
+ GW 8 Snap-Ins

GW 8 Domain and Post 
Office Databases 
on Linux

N/A N/A Supported
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Table Summary: On both Linux and Windows, ConsoleOne with the GroupWise snap-ins can be 
used to access GroupWise databases for domains and post offices and GroupWise objects in 
eDirectory located on NetWare, Linux, or Windows. When using Linux ConsoleOne to administer 
domains and post offices on NetWare or Windows, you must mount the NetWare or Windows server 
to your Linux machine. When using Windows ConsoleOne to administer domains and post offices 
on Linux, you can use a Samba share to access the Linux server from your Windows machine.

GroupWise 8 Linux Agents with GroupWise 8 on NetWare or Windows

Table Summary: Domains and post offices can be located on NetWare, Linux, or Windows. We do 
not recommend that you run the Linux agents for domains and post offices located on NetWare and 
Windows. However, existing GroupWise 6.5 or 7 domains and post offices can be moved onto Linux 
servers so that the Linux agents can update them to GroupWise 8 on Linux. All the Linux agents can 
communicate as usual with the NetWare and Windows agents.

GW 8 Objects in 
eDirectory on Linux

N/A N/A Supported

Linux ConsoleOne + 
GW 8 snap-ins on Linux

Supported Supported N/A

GroupWise 8 on 
Linux Agents

GroupWise 8
Domain or 
Post Office 
Databases 
on NetWare 
or Windows

GW 8 MTA 
on 
NetWare or 
Windows 

GW 8 POA 
on 
NetWare or 
Windows

GW 8 GWIA 
on NetWare 
or Windows 

GW 8
WebAcces
s
on NetWare 
or 
Windows 

GW 8
Monitor 
on
Windows 

GW 8 Domain 
and Post Office 
Databases
on Linux

N/A Supported Supported Supported Supported Supported

GW 8 MTA
on Linux

Supported Supported Supported Supported N/A Supported

GW 8 POA
on Linux

Supported Supported N/A N/A Supported Supported

GW 8 GWIA
on Linux

Supported Supported N/A Supported N/A Supported

GW 8 
WebAccess
on Linux

Supported N/A Supported N/A N/A Supported

GW 8 Monitor
on Linux

Supported Supported Supported Supported Supported N/A

GroupWise 8 on Linux 
Administrative 
Components

GroupWise 8
Domain and Post 
Office Databases on 
NetWare 
or Windows

GW 8 Objects in 
eDirectory on 
NetWare 
or Windows

Windows ConsoleOne 
+ GW 8 Snap-Ins
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GroupWise 8 Mac/Linux Client with GroupWise 8 on NetWare or Windows

Table Summary: The GroupWise 8 Mac/Linux client can communicate in client/server mode with the 
GroupWise 8 POA on NetWare or Windows. The Mac/Linux client cannot access the post office 
directly, nor can it communicate with the GroupWise 8 POA across a dial-up connection over a 
modem. Remote mode is not supported in the Mac/Linux client.

GroupWise 8 Windows Client with GroupWise 8 on Linux

Table Summary: The GroupWise 8 Windows client can communicate in client/server mode with the 
GroupWise 8 POA on Linux. The Windows client cannot access the post office directly.

A.2.2 Compatibility with GroupWise 7 on NetWare and Windows

 “GroupWise 8 Linux Administrative Components with GroupWise 7 on NetWare or Windows” 
on page 287

 “GroupWise 8 Linux Agents with GroupWise 7 on NetWare or Windows” on page 288
 “GroupWise 8 Mac/Linux Client with GroupWise 7 on NetWare or Windows” on page 289
 “GroupWise 7 Windows Client with GroupWise 8 on Linux” on page 289

GroupWise 8 Linux Administrative Components with GroupWise 7 on NetWare or 
Windows

GroupWise 8 
Linux Client

GroupWise 8
Post Office 
Direct Access on 
NetWare or 
Windows

GW 8 POA 
Client/Server 
Access
Online Mode on 
NetWare or 
WIndows

GW 8 POA
Client/Server 
Access
Caching Mode on 
NetWare or 
Windows

GW 8 POA
Dial-Up Access
Remote Mode 
on NetWare or 
Windows

Mac/Linux 
client on Linux

Not Supported Supported Supported Not Supported

GroupWise 8 
Windows Client

GroupWise 8
Post Office 
Direct Access on 
Linux

GW 8 POA 
Client/Server 
Access
Online Mode on 
Linux

GW 8 POA
Client/Server 
Access
Caching Mode on 
Linux

GW 8 POA
Dial-Up Access
Remote Mode 
on Linux

Windows Client Not Supported Supported Supported Supported

GroupWise 8 on Linux 
Administrative 
Components

GroupWise 7
Domain and Post 
Office Databases on 
NetWare 
or Windows

GW 7 Objects in 
eDirectory on 
NetWare 
or Windows

Windows ConsoleOne 
+ GW 7 Snap-Ins

GW 8 Domain and Post 
Office Databases 
on Linux

N/A N/A Supported
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Table Summary: On both Linux and Windows, ConsoleOne with the GroupWise snap-ins can be 
used to access GroupWise databases for domains and post offices and GroupWise objects in 
eDirectory located on NetWare, Linux, or Windows. When using Linux ConsoleOne to administer 
domains and post offices on NetWare or Windows, you must mount the NetWare or Windows server 
to your Linux machine. When using Windows ConsoleOne to administer domains and post offices 
on Linux, you can use a Samba share to access the Linux server from your Windows machine.

GroupWise 8 Linux Agents with GroupWise 7 on NetWare or Windows

Table Summary: Domains and post offices can be located on NetWare, Linux, or Windows. We do 
not recommend that you run the Linux agents for domains and post offices located on NetWare and 
Windows. However, existing GroupWise 7 domains and post offices can be moved onto Linux 
servers so that the Linux agents can update them to GroupWise 8 on Linux. All the Linux agents can 
communicate as usual with the NetWare and Windows agents. Although most GroupWise 8/
GroupWise 7 agent combination are supported, two combinations are not supported.

GW 8 Objects in 
eDirectory on Linux

N/A N/A Supported

Linux ConsoleOne + 
GW 8 snap-ins on Linux

Supported Supported N/A

GroupWise 8 on 
Linux Agents

GroupWise 7
Domain or 
Post Office 
Databases 
on NetWare 
or Windows

GW 7 MTA 
on 
NetWare or 
Windows 

GW 7 POA 
on 
NetWare 
or 
Windows

GW 7 GWIA 
on NetWare 
or Windows 

GW 7
WebAcces
s
on NetWare 
or 
Windows 

GW 7
Monitor 
on
Windows 

GW 8 Domain 
and Post Office 
Databases
on Linux

N/A Supported Supported Supported Supported Supported

GW 8 MTA
on Linux

Supported Supported Supported Supported N/A Supported

GW 8 POA
on Linux

Supported Supported N/A N/A Supported Supported

GW 8 GWIA
on Linux

Supported Supported N/A Supported N/A Supported

GW 8 
WebAccess
on Linux

Not Supported N/A Not 
Supported

N/A N/A Supported

GW 8 Monitor
on Linux

Supported Supported Supported Supported Supported N/A

GroupWise 8 on Linux 
Administrative 
Components

GroupWise 7
Domain and Post 
Office Databases on 
NetWare 
or Windows

GW 7 Objects in 
eDirectory on 
NetWare 
or Windows

Windows ConsoleOne 
+ GW 7 Snap-Ins
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GroupWise 8 Mac/Linux Client with GroupWise 7 on NetWare or Windows

Table Summary: The GroupWise 8 Mac/Linux client cannot communicate in client/server mode with 
the GroupWise 7 POA on NetWare or Windows, nor can it access the post office directly. The general 
rule is that earlier POAs cannot communicate with later GroupWise clients, but later POAs can 
always communicate with earlier GroupWise clients. Remote mode is not supported in the Mac/
Linux client.

GroupWise 7 Windows Client with GroupWise 8 on Linux

Table Summary: The GroupWise 7 Mac/Linux client can communicate in client/server mode with the 
GroupWise 8 POA on NetWare or Windows. The Mac/Linux client cannot access the post office 
directly, nor can it communicate with the GroupWise 8 POA across a dial-up connection over a 
modem. Remote mode is not supported in the Mac/Linux client.

A.2.3 Compatibility with GroupWise 6.5 on NetWare or Windows

 “GroupWise 8 Linux Administrative Components with GroupWise 6.5 on NetWare or 
Windows” on page 290

 “GroupWise 8 Linux Agents with GroupWise 6.5 on NetWare or Windows” on page 290
 “GroupWise 8 Mac/Linux Client with GroupWise 6.5 on NetWare or Windows” on page 291
 “GroupWise 6.5 Mac/Linux Client with GroupWise 8 on NetWare or Windows” on page 291

GroupWise 8 
Linux Client

GroupWise 7
Post Office 
Direct Access on 
NetWare or 
Windows

GW 7 POA 
Client/Server 
Access
Online Mode on 
NetWare or 
WIndows

GW 7 POA
Client/Server 
Access
Caching Mode on 
NetWare or 
Windows

GW 7 POA
Dial-Up Access
Remote Mode 
on NetWare or 
Windows

Mac/Linux 
client on Linux

Not Supported Not Supported Not Supported Not Supported

GroupWise 7 
Windows Client

GroupWise 8
Post Office 
Direct Access on 
Linux

GW 8 POA 
Client/Server 
Access
Online Mode on 
Linux

GW 8 POA
Client/Server 
Access
Caching Mode on 
Linux

GW 8 POA
Dial-Up Access
Remote Mode 
on Linux

Windows Client Not Supported Supported Supported Supported
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GroupWise 8 Linux Administrative Components with GroupWise 6.5 on NetWare 
or Windows

Table Summary: On Linux, ConsoleOne with the GroupWise snap-ins can be used to access 
GroupWise databases for domains and post offices and GroupWise objects in eDirectory on NetWare, 
Linux, and Windows. On Windows, ConsoleOne with the GroupWise 6.5 snap-ins cannot be used to 
access GroupWise 8 domains and post offices on Linux. The general rule is that later GroupWise 
snap-ins can administer earlier GroupWise system components, but earlier GroupWise snap-ins 
cannot administer later GroupWise system components.

GroupWise 8 Linux Agents with GroupWise 6.5 on NetWare or Windows

GroupWise 8 on Linux 
Administrative 
Components

GroupWise 6.5
Domain and Post 
Office Databases on 
NetWare or 
Windows 

GW 6.5 Objects in 
eDirectory on 
NetWare or 
Windows

Windows ConsoleOne 
+ GW 6.5 snap-ins

GW 8 Domain and Post 
Office Databases on Linux

N/A N/A Not Supported

GW 8 Objects in 
eDirectory on Linux

N/A N/A Not Supported

Linux ConsoleOne + 
GW 8 snap-ins on Linux

Supported Supported N/A

GroupWise 8 
Linux Agents

GroupWise 
6.5
Domain and 
Post Office 
Databases 
on NetWare 
or Windows

GW 6.5 
MTA 
on 
NetWare or 
Windows 

GW 6.5 
POA 
on 
NetWare or 
Windows 

GW 6.5 
GWIA
on NetWare 
or Windows 

GW 6.5 
WebAcces
s
on NetWare 
or 
Windows 

GW 6.5 
Monitor
on 
Windows 

GW Domain 
and Post Office 
Databases
on Linux

N/A Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

GW 8 MTA
on Linux

Supported Supported Supported Supported N/A Supported

GW 8 POA
on Linux

Supported Supported N/A N/A Supported Supported

GW 8 GWIA 
on Linux

Supported Supported N/A Not 
Supported

N/A Supported

GW 8 
WebAccess
on Linux

Supported N/A Not 
Supported

N/A N/A Supported

GW 8 Monitor
on Linux

Supported Supported Supported Supported Supported N/A
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Table Summary: Domains and post offices can be located on NetWare, Linux, or Windows. We do 
not recommend that you run the Linux agents for domains and post offices located on NetWare and 
Windows. However, existing GroupWise 6.5 domains and post offices can be moved onto Linux 
servers so that the Linux agents can update them to GroupWise 8 on Linux. Although most GW 8 on 
Linux/GW 6.5 agent combinations are supported, two combinations are not supported.

GroupWise 8 Mac/Linux Client with GroupWise 6.5 on NetWare or Windows

Table Summary: The GroupWise 8 Mac/Linux client cannot communicate in client/server mode with 
the GroupWise 6.5 POA on NetWare or Windows, nor can it access the post office directly. The 
general rule is that earlier POAs cannot communicate with later GroupWise clients, but later POAs 
can always communicate with earlier GroupWise clients. Remote mode is not supported in the Mac/
Linux client.

GroupWise 6.5 Mac/Linux Client with GroupWise 8 on NetWare or Windows

Table Summary: The GroupWise 6.5 Mac/Linux client can communicate in client/server mode with 
the GroupWise 8 POA on NetWare or Windows, but it cannot access the post office directly. The 
general rule is that later POAs can always communicate with earlier GroupWise clients, but earlier 
POAs cannot communicate with later GroupWise clients. Remote mode is not supported in the Mac/
Linux client.

GroupWise 8
Client
on Linux 

GroupWise 6.5
Post Office 
Direct Access on 
NetWare or 
WIndows

GW 6.5 POA 
Client/Server 
Access
Online Mode on 
NetWare or 
Windows

GW 6.5 POA
Client/Server 
Access
Caching Mode on 
NetWare or 
Windows

GW 6.5 POA
Dial-Up Access
Remote Mode on 
NetWare or 
Windows

Mac/Linux 
client on Linux

Not Supported Not Supported Not Supported Not Supported

GroupWise 6.5
Client
on Linux 

GroupWise 8
Post Office 
Direct Access on 
NetWare or 
WIndows

GW 8 POA 
Client/Server 
Access
Online Mode on 
NetWare or 
Windows

GW 8 POA
Client/Server 
Access
Caching Mode on 
NetWare or 
Windows

GW 8 POA
Dial-Up Access
Remote Mode on 
NetWare or 
Windows

Mac/Linux 
client on Linux

Supported Supported Supported Not Supported
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B BGroupWise Linux Executables

This section provides the information in the GroupWise man pages that are available on your Linux 
server.

 “grpwise(1)” on page 294
 “grpwise-ma(1)” on page 297
 “gwpoa(1)” on page 299
 “gwmta(1)” on page 301
 “gwia(1)” on page 303
 “gwinter(1)” on page 305
 “gwmon(1)” on page 307
 “gwcheck(1)” on page 309
 “gwcheckt(1)” on page 312
 “dbcopy(1)” on page 314
 “gwtmstmp(1)” on page 317
 “gwcsrgen(1)” on page 320
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grpwise(1)

Name

grpwise - GroupWise Script

Syntax

grpwise start [agent_location_name] 
grpwise status [agent_location_name] 
grpwise stop [agent_location_name]
grpwise restart [agent_location_name]
grpwise print [agent_location_name]

The agent location names are:

POA: post_office_name.domain_name
MTA: domain_name
Internet Agent: gwia.domain_name
WebAccess Agent: webac80a.domain
Document Viewer Agent: gwdva.hostname

NOTE: The Monitor Agent is not controlled by the grpwise script. It has its own script named 
grpwise-ma, which works essentially the same as the grpwise script.

Description

The grpwise script is created during installation and can control any agents installed on the local 
server. It is created in the /etc/init.d directory. It works in conjunction with the gwha.conf file, 
which is created in the /etc/opt/novell/groupwise directory. The gwha.conf file lists the agents 
installed on the local server so that the grpwise script know what agents to start.

The GroupWise agents are Run Control compliant. During installation, a symbolic link is created 
from /etc/init.d/grpwise to /usr/sbin/rcgrpwise. Typically, /usr/sbin is already on your 
path, so you can run rcgrpwise from any directory, rather than changing to /etc/init.d in order to 
run the grpwise script. A /usr/sbin/grpwise-ma link is also created.

Options

Usage Options:

start 
Starts all GroupWise agents on the local server or the GroupWise agent specified in the grpwise 
command. A green “done” indicates that an agent is running. If a green “done” does not appear, 
then agent was unable to start.

status 
Displays status for all GroupWise agents on the local server or for the GroupWise agent 
specified in the grpwise command. A green “done” indicates that an agent is running. A black 
“unused” indicates than an agent is not running.
294 GroupWise 8 Installation Guide



stop 
Stops all GroupWise agents on the local server or the GroupWise agent specified in the grpwise 
command. A green “done” indicates that an agent is stopped. A black “unused” indicates than 
an agent is not running and, therefore, cannot be stopped.

restart 
Stops all GroupWise agents on the local server or the GroupWise agent specified in the grpwise 
command. A green “done” indicates that an agent is stopped. A black “unused” indicates than 
an agent is not running and, therefore, cannot be stopped. Then starts the agents again with the 
standard start status indicators.

print 
Lists settings for all GroupWise agents in the gwha.conf file or for the GroupWise agent 
specified in the grpwise command. 

post_office_name.domain_name 
Specifies the POA to stop. The syntax allows for multiple POAs running on the same server and 
specifies which POA to stop.

domain_name 
Specifies the MTA to stop. The syntax allows for multiple MTAs running on the same server and 
specifies which MTA to stop.

gwia.domain_name 
Specifies the Internet Agent to stop. The syntax allows for multiple Internet Agents running on 
the same server and specifies which Internet Agent to stop.

webac80a.domain 
Specifies the eDirectory object name of the WebAccess Agent to stop. The syntax allows for 
multiple WebAccess Agents running on the same server and specifies which WebAccess Agent 
to stop.

gwdva.hostname 
Stops the Document Viewer Agent. The syntax stops all Document View Agents on the server.

Help Options:

--help, -? 
Displays the help information and exits.

Files

/etc/opt/novell/groupwise/gwha.conf 
GroupWise High Availability service configuration file. This configuration file lists all 
information necessary to start and stop each GroupWise agent that is installed on the server. For 
example, an entry for an MTA might look similar to this example:

server    = /opt/novell/groupwise/agents/bin/gwmta
command   = /etc/init.d/grpwise
startup   = provo1.mta
delay     = 2
wait      = 10

The server = setting specifies the full path to the agent executable.
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The command = setting specifies the full path to the grpwise script.
The startup = setting specifies the name of the agent startup file. All agent startup files are 
located in the /opt/novell/groupwise/agents/share directory.
The delay = setting controls the length of time between when the script issues the command to 
start an agent and when the script displays a message indicating that the agent has started. The 
default delay time is 2 seconds. 
The wait = setting controls the length of time between when the script issues the command to 
stop an agent and when the script kills the agent if the agent has not yet stopped. The default 
wait time is 10 seconds.
By default, the grpwise script starts the agents as daemons with no user interface. If you want a 
user interface, you can add a show = yes line for each agent that you want to have a user 
interface.

Examples

This program must be run as root. If you have configured the GroupWise agents to run as a non-
root user, they switch over to that user after they have started.

/etc/init.d/grpwise start 
Start all GroupWise agents that are installed on the server

/etc/init.d/grpwise status development.provo1 
Show the status of the Development post office POA. The Development post office belongs to 
the Provo1 domain.

/etc/init.d/grpwise stop provo1.gwia 
Stop the Internet Agent that belongs to the Provo1 domain.

Diagnostics

If a GroupWise agent fails to start when using the grpwise script, try starting the agent manually, as 
described in the man page for each agent. You might receive an error message indicating why the 
agent is failing to start.

If you have changed the non-root user that you want the agent to run by modifying the /etc/opt/
novell/groupwise/agents/uid.conf file, you might have forgotten to delete the corresponding 
uid.run file in the domain or post office directory that the agent services. Delete the uid.run file, 
then use the grpwise script to try to start the agent again.

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

gwpoa(1), gwmta(1), gwia(1), gwinter(1).

To report problems with this software or its documentation, visit Novell Bugzilla. (http://
bugzilla.novell.com).
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grpwise-ma(1)

Name

grpwise-ma - GroupWise Monitor Script.

Syntax

grpwise-ma [start] [stop] [status] [restart]

Description

The grpwise-ma script is created during installation and controls the Monitor Agent. (The grpwise 
script controls the other four GroupWise agents.) The grpwise-ma script is created in the /etc/
init.d directory. It works in conjunction with the monitor.xml file, which is created in the /etc/
opt/novell/groupwise/agents/share directory. The monitor.xml file points the Monitor Agent to 
a domain database (wpdomain.db) where it can access a list of agent to monitor in your GroupWise 
system.

The grpwise-ma script includes an MA_OPTIONS variable where you can specify Monitor Agent 
startup switches. This is convenient because the Monitor Agent does not use a startup file as the other 
GroupWise agents do.

The Monitor Agent is Run Control compliant. During installation, a symbolic link is created from /
etc/init.d/grpwise-ma to /usr/sbin/rcgrpwise-ma. Typically, /usr/sbin is already on your 
path, so you can run rcgrpwise-ma from any directory, rather than changing to /etc/init.d in 
order to run the grpwise-ma script. 

Options

Usage Options:

start 
Starts the Monitor Agent as a daemon on the local server. A green “done” indicates that the 
agent is running. If a green “done” does not appear, then the agent was unable to start.

status 
Displays status for the Monitor Agent. A green “running” indicates that the agent is running. A 
black “unused” indicates that the agent is not running.

stop 
Stops the Monitor Agent. A green “done” indicates that the agent is stopped. A black “unused” 
indicates than the agent is not running and, therefore, cannot be stopped.

restart 
Stops the Monitor Agent. A green “done” indicates that the agent is stopped. A black “unused” 
indicates than the agent is not running and, therefore, cannot be stopped. The Monitor Agent 
then starts again with the standard start status indicators.
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Help Options:

--help, -? 
Displays the help information and exits.

Files

/opt/novell/groupwise/agents/share/monitor.xml 
Configuration file. Provides a domain directory where the Monitor Agent can determine what 
GroupWise and Messenger agents to monitor. The monitor.xml file is created during 
installation.

Examples

This program does not run as root.

/etc/init.d/grpwise-ma start 
Starts the Monitor Agent. You can view the Monitor Agent Web console at the following URL: 
http://localhost:8200

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

gwmon(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com). 
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gwpoa(1)

Name

gwpoa - GroupWise Post Office Agent.

Syntax

gwpoa [--show] --home post_office_directory
gwpoa [--show] @startup_file

Description

A post office is a collection of user mailboxes and GroupWise objects. Messages are delivered to 
mailboxes by the Post Office Agent (POA).

You can provide POA startup switches on the command line or in a startup file. By default, the 
startup file is named after the post office and has a .poa extension. It is located in the /opt/novell/
groupwise/agents/share directory.

Options

Usage Options:

--home post_office_directory 
Specifies the post office directory, where the POA can access message and user databases. There 
is no default location. You must use this switch in order to start the POA. The Agent Installation 
program automatically sets the --home switch to the post office directory in the POA startup file.

@startup_file 
Specifies the location of the POA startup file. By default, the POA startup file is created in the /
opt/novell/groupwise/agents/share directory and is named after the post office, with a 
.poa extension. The startup file must reside on the same server where the POA is installed.

--show 
Starts the POA with a user interface similar to that provided for the NetWare and Windows 
POA. By default, no user interface is provided for the POA on Linux. The --show startup switch 
can only be used on the command line; it cannot be placed in the startup file.

Help Options:

--help, -? 
Displays the help information and exits.

Files

/opt/novell/groupwise/agents/share/post_office_name.poa 
Startup file where startup switches are specified.
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/var/log/novell/groupwise/post_office.poa/mmddpoa.nnn 
Log file where error messages are written.

Examples

By default, this program runs as root, but it is preferable to run it as a non-root user. See the 
GroupWise Installation Guide  (http://www.novell.com/documentation/gw8) to set up the POA to run 
as a non-root user.

/opt/novell/groupwise/agents/bin/gwpoa --home /gwsystem/acct 
Starts the POA by specifying the post office directory.

/opt/novell/groupwise/agents/bin/gwpoa @acct.poa 
Starts the POA by specifying the POA startup file.

/opt/novell/groupwise/agents/bin/gwpoa --show @acct.poa 
Starts the POA with a user interface.

Diagnostics

If you use the --show startup switch, error messages are displayed in the Log Message box of the 
POA server console where the POA is running. By default, error messages are also written to the 
POA log file located in the /var/log/novell/groupwise/post_office.poa directory.

Typically you find multiple log files in this directory. The first four characters of each filename 
represent the date. The next three identify the agent. A three-digit extension allows for multiple log 
files created on the same day. For example, a log file named 0518poa.001 indicates that it is a POA 
log file created on May 18. If you restart the POA on the same day, a new log file is created, named 
0518poa.002.

For information about POA error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/gw8).

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also

grpwise(1)

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwmta(1)

Name

gwmta - GroupWise Message Transfer Agent

Syntax

gwmta [--show] --home domain_directory
gwmta [--show] @startup_file

Description

A domain organizes post offices into a logical grouping for addressing, routing, and administration 
purposes in your GroupWise system. Messages are transferred between post offices and domains by 
the Message Transfer Agent (MTA).

You can provide MTA startup switches on the command line or in a startup file. By default, the 
startup file is named after the domain and has a .mta extension. It is located in the /opt/novell/
groupwise/agents/share directory.

Options

Usage Options:

--home domain_directory 
Specifies the domain directory, where the MTA can access the domain database (wpdomain.db). 
There is no default location. You must use this switch in order to start the MTA. The Agent 
Installation program automatically sets the --home switch to the domain directory in the MTA 
startup file.

@startup_file 
Specifies the location of the MTA startup file. By default, the MTA startup file is created in the /
opt/novell/groupwise/agents/share directory and is named after the domain, with a .mta 
extension. The startup file must reside on the same server where the MTA is installed.

--show 
Starts the MTA with a user interface similar to that provided for the NetWare and Windows 
MTA. By default, no user interface is provided for the MTA on Linux. The --show startup switch 
can only be used on the command line; it cannot be placed in the startup file.

Help Options:

--help, -? 
Displays the help information and exits.

Files

/opt/novell/groupwise/agents/share/domain_name.mta 
Startup file where startup switches are specified.
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/var/log/novell/groupwise/domain.mta/mmddmat.nnn 
Log file where error messages are written.

Examples

By default, this program runs as root, but it is preferable to run it as a non-root user. See the 
GroupWise Installation Guide (http://www.novell.com/documentation/gw8) to set up the MTA to run 
as a non-root user.

/opt/novell/groupwise/agents/bin/gwmta --home /gwsystem/provo1 
Starts the MTA by specifying the domain directory.

/opt/novell/groupwise/agents/bin/gwmta @provo1.mta 
Starts the MTA by specifying the MTA startup file.

/opt/novell/groupwise/agents/bin/gwmta --show @provo1.mta 
Starts the MTA with a user interface.

Diagnostics

If you use the --show startup switch, error messages are displayed in the Alert box of the MTA server 
console where the MTA is running. By default, error messages are also written to the MTA log file 
located in the /var/log/novell/groupwise/domain_name.mta directory.

Typically you find multiple log files in this directory. The first four characters of each filename 
represent the date. The next three identify the agent. A three-digit extension allows for multiple log 
files created on the same day. For example, a log file named 0518mta.001 indicates that it is an MTA 
log file created on May 18. If you restart the MTA on the same day, a new log file is created, named 
0518mta.002.

For information about MTA error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/gw8).

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

grpwise(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwia(1)

Name

gwia - GroupWise Internet Agent

Syntax

gwia [--show] --home gateway_directory
gwia [--show] @startup_file
gwia [--show] --dhome SMTP_directory
gwia [--show] --hn hostname

Description

The GroupWise Internet Agent enables you to send and receive messages over the Internet.

You can provide Internet Agent startup switches on the command line or in a startup file. At startup, 
the Internet Agent reads its startup file, gwia.cfg. It is located in the /opt/novell/groupwise/
agents/share directory.

Options

Usage Options:

--home gateway_directory 
Points the Internet Agent to the Internet Agent’s gateway directory. Normally, this is the 
domain_directory/wpgate/gwia directory.

@startup_file 
Specifies the location of the Internet Agent startup file, which is gwia.cfg by default. The 
Internet Agent looks for gwia.cfg in the /opt/novell/groupwise/agents/share directory.

--dhome SMTP_directory 
Points to the SMTP service work area. This is normally the same as the Internet Agent’s gateway 
directory (domain_directory/wpgate/gwia).

--hn hostname 
Provides the hostname that is displayed when someone connects to your Internet Agent via a 
Telnet session. You should enter the hostname assigned to you by your Internet service provider. 
Normally, the Internet Agent can get the information from another source and does not need this 
switch. If you receive a message that the --hn switch is required, you must use the switch.

--show 
Starts the Internet Agent with a user interface similar to that provided for the NetWare and 
Windows Internet Agent. By default, no user interface is provided for the Internet Agent on 
Linux. The --show startup switch can only be used on the command line; it cannot be placed in 
the startup file.
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Help Options:

--help, -? 
Displays the help information and exits.

Files

/opt/novell/groupwise/agents/share/gwia.cfg 
Startup file where startup switches are specified.

/var/log/novell/groupwise/domain_name.gwia/mmddgwia.nnn 
Log file where error messages are written.

Examples

By default, this program runs as root, but it is preferable to run it as a non-root user. See the 
GroupWise Installation Guide  (http://www.novell.com/documentation/gw8) to set up the Internet 
Agent to run as a non-root user.

/opt/novell/groupwise/agents/bin/gwia --home /gwsystem/provo1/wpgate/gwia 
Start the Internet Agent by specifying its gateway directory in the domain.

/opt/novell/groupwise/agents/bin/gwia @gwia.cfg 
Start the Internet Agent by specifying its startup file.

/opt/novell/groupwise/agents/bin/gwia --show @gwia.cfg 
Run the Internet Agent with a user interface.

Diagnostics

If you have used the --show startup switch, error messages are displayed in the Log Message box of 
the Internet Agent server console where it is running. By default, error messages are also written to 
the Internet Agent log file located in the /var/log/novell/groupwise/domain_name.gwia 
directory.

Log files are named according to the date they are created. If the Internet Agent restarts during the 
day, the file extension indicates which session is logged (for example 0518gwia.003 indicates the 
third session logged for May 18).

For information about Internet Agent error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/gw8).

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

grpwise(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com). 
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gwinter(1)

Name

gwinter - GroupWise WebAccess Agent.

Syntax

gwinter [--show] --home gateway_directory
gwinter [--show] @startup_file

Description

The WebAccess Agent receives user requests to view messages and documents from the WebAccess 
Application and WebPublisher Application, accesses post offices and libraries to process the requests, 
and then passes information back to the applications for display in your Web browser. The 
WebAccess Agent is required for both WebAccess and WebPublisher. 

You can provide WebAccess Agent startup switches on the command line or in a startup file. By 
default, the startup file is named after the agent’s object name and has a .waa extension, for example, 
webac80a.waa.

Options

Usage Options:

--home gateway_directory 
Specifies the path to the WebAccess Agent’s gateway directory under the domain directory 
(domain_name/wpgate/webac80a). 

@startup_file 
Specifies a startup file to use, for example, webac80a.waa. You can add any of the WebAccess 
Agent startup switches to the startup file and then reference the file when starting the 
WebAccess Agent. The default startup file, webac80a.waa, automatically includes the --home 
switch set to the WebAccess gateway directory.

--show 
Displays log information about the WebAccess Agent in the terminal window where you start 
the WebAccess Agent. By default, no user interface is provided for the WebAccess Agent on 
Linux. The --show startup switch can only be used on the command line; it cannot be placed in 
the startup file.

Help Options:

--help, -? 
Displays the help information and exits.
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Files

/opt/novell/groupwise/share/webac80a.waa 
Startup file where startup switches are specified.

/var/log/novell/groupwise/domain_name.gateway_name/000.prc/mmddweb.nnn 
Log file where error messages are written.

Examples

By default, this program runs as root, but it is preferable to run it as a non-root user. See the 
GroupWise Installation Guide (http://www.novell.com/documentation/gw8) to set up the WebAccess 
Agent to run as a non-root user.

/opt/novell/groupwise/agents/bin/gwinter --home /gwsystem/provo1/wpgate/webac80a 
Starts the WebAccess Agent by specifying its gateway directory in the domain.

/opt/novell/groupwise/agents/bin/gwia @webac80a.waa 
Starts the WebAccess Agent by specifying its startup file.

/opt/novell/groupwise/agents/bin/gwia --show @webac80a.waa 
Runs the WebAccess Agent with a user interface.

Diagnostics

The WebAccess Agent creates a new log file each day and each time it is started. The log file is named 
mmddweb.nnn, where mm is the month, dd is the day, and nnn is a sequenced number (001 for the first 
log file of the day, 002 for the second, and so forth). The default location for the log files is the /var/
log/novell/groupwise/domain_name.gateway_name/000.prc directory.

For information about WebAccess Agent error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/gw8).

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

grpwise(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwmon(1)

Name

gwmon - GroupWise Monitor Agent.

Syntax

gwmon --home domain_directory

Description

The Monitor Agent is a monitoring and management tool that allows you to monitor GroupWise 
agents and gateways, along with Messenger agents, from any location where you are connected to 
the Internet and have access to a Web browser. Some agent administration can also be performed 
from your Web browser.

Monitor agent configuration information is stored in the gwmonitor.cfg file in the /opt/novell/
groupwise/gwmonitor directory.

Options

NOTE: The --show switch that is available for the other GroupWise agents to provide a user interface 
is not available for the Linux Monitor Agent.

Usage Options:

--home domain_directory 
Specifies a domain directory where the Monitor Agent can access a domain database 
(wpdomain.db). From the domain database, the Monitor Agent can determine which agents to 
monitor, what user names and passwords are necessary to access them, and so on.

Help Options:

--help, -? 
Displays the help information and exits.

Files

/opt/novell/groupwise/gwmonitor/gwmonitor.cfg 
Configuration file with Monitor Agent properties. The Monitor Agent does not have a startup 
file like the other agents. Its startup switches can be used only on the command line.

/var/log/novell/groupwise/gwmon/mmddmon.nnn 
Log file for Monitor Agent events.

/var/log/novell/groupwise/gwmon/mmddhist.nnn 
Log file for dumps of monitored agent MIB values.
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Examples

This program can run as any user.

/opt/novell/groupwise/agents/bin/gwmon --home /gwsystem/provo1 
Starts the Monitor Agent by accessing the domain database in the specified domain directory.

Diagnostics

The Monitor Agent writes to two different types of log files. Event log files record error messages, 
status messages, and other types of event-related messages. History log files record dumps of all MIB 
values gathered during each poll cycle of monitored agents. By default, both types of log files are 
created in the /var/log/novell/groupwise/gwmon directory.

Typically you find multiple log files in this directory. The first four characters of each filename 
represent the date. The following characters are mon for event log files and hist for history log files. 
A three-digit extension allows for multiple log files created on the same day. For example, a log file 
named 0518mon.001 indicates that it is a Monitor Agent event log file created on May 18. If you 
restart the Monitor Agent on the same day, a new event log file is created, named 0518mon.002.

For information about Monitor Agent error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/gw8).

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

grpwise(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwcheck(1)

Name

gwcheck - GroupWise Check utility.

Syntax

gwcheck [--opt [/pathname/]options_file [--batch] ] [--po post_office_directory][-
-pa archive_directory][--pr remote_mailbox_directory]

Description

GroupWise Check (GWCheck) is a tool provided for GroupWise to check and repair GroupWise user, 
message, library, and resource databases without needing ConsoleOne. In addition to checking 
databases in the post office, it also checks users’ remote, caching, and archive databases on user 
workstations or other personal locations.

GWCheck provides a user interface similar to the Mailbox/Library Maintenance feature in 
ConsoleOne. The list below illustrates the types of database repair that you can perform using 
GWCheck. Click Help in GWCheck for more information about the database repair options that are 
available.

Analyze/Fix Databases

Structure
Index Check

Contents
Collect Statistics
Attachment File Check

Fix Problems
Update User Disk Space Totals

Expire/Reduce Messages

Reduce Only
Expire and Reduce

Items Older Than
Downloaded Items Older Than
Items Larger Than
Trash Older Than
Reduce Mailbox To
Reduce Mailbox to Limited Size

Include
Received Items
Sent Items
Calendar Items
Only Backed-Up Items
Only Retained Items

Mailbox Statistics

Mailbox Statistics
Box Limit

Expire Statistics
(same as the Expire and Reduce options)
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Archive/Delete Documents

(no options)

Delete Activity Logs

Delete Logs Older Than nn Days

Analyze/Fix Library

Verify Library
Fix Document/Version/Element
Verify Document Files
Validate All Document Security
Synchronize User Name
Remove Deleted Storage Areas

Move Documents First
Reassign Orphaned Documents

New Author
Reset Word Lists

Audit Report

Show Accounts without Activity for Previous nn Days

GWCheck Options File

If you repeatedly use the same set of database repair options, you can save them in an options file. To 
create an options file, start GWCheck, select database repair options as needed, then click Save. By 
default, the options file is named gwcheck.opt and is saved in your home directory. You can change 
the filename and location as needed. You can retrieve the options file from the user interface or you 
can specify the options file on the command line. The options file is created in XML format on all 
platforms. Therefore, you can create the options file on any platform and use it on any platform 
interchangeably.

After you have created one or more options files, you can run GWCheck as a script, rather than using 
the user interface.

Options

Usage Options:

--opt options_file 
Specifies the name of the options file. By default, this file is saved in your home directory. If you 
want to save it to another directory, specify a path relative to your home directory or specify an 
absolute path.

--batch 
Runs GWCheck in the background, without a user interface. Use an options file to specify the 
database repair options.

--po post_office_directory 
Specifies the path to the post office directory.
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--pa archive_directory 
Specifies the path to the archive directory.

--pr remote_mailbox_directory 
Specifies the path to the remote mailbox database.

Help Options:

--help, -? 
Displays the help information and exits.

Files

[/pathname/]gwcheck.opt 
Options file. Create this file by setting database repair options in GWCheck, then click Save. The 
options file is created in XML format on all platforms. Therefore, you can create the options file 
on any platform and use it on any platform interchangeably.

Examples

This program normally runs as root.

/opt/novell/groupwise/gwcheck/bin/gwcheck 
Starts the GUI GWCheck.

/opt/novell/groupwise/gwcheck/bin/gwcheck --opt gwcheck.opt --batch 
Starts GWCheck with an options file that provides default database repair options and runs it in 
batch mode so that there is no user interface.

/opt/novell/groupwise/gwcheck/bin/gwcheck --opt gwcheck.opt --pa /home/gsmith/
gwarchive 

Runs GWCheck for an archive mailbox.

Diagnostics

For information about GWCheck error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/gw8).

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

gwcheckt(1).

To report problems with this software or its documentation, visit Novell Bugzilla. (http://
bugzilla.novell.com).
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gwcheckt(1)

Name

gwcheckt - Text-Based GroupWise Check

Syntax

gwcheckt options_file [--dump]

Description

Text-Based GroupWise Check (GWCheckT) is a tool provided for GroupWise to check and repair 
GroupWise user, message, library, and resource databases without needing ConsoleOne or any GUI 
environment.

Text-Based GWCheckT has no user interface. You must create the required options file by using the 
GUI GroupWise Check (GWCheck) or the Mailbox/Library Maintenance feature in ConsoleOne. 
Text-Based GWCheckT can perform all of the same types of database repair as the GUI GWCheck, 
but in a text-only environment.

To create the required options file, start the GUI GWCheck in an environment where the X Window 
System is available, select database repair options as needed, then click Save. By default, the options 
file is named gwcheck.opt and is saved in your home directory. You can change the filename and 
location as needed.

Options

Usage Options:

[/pathname/]options_file 
Specifies the name of the options file. By default, this file is saved by the GUI GWCheck in your 
home directory. If you saved it to another directory, specify a path relative to your home 
directory or specify an absolute path.

--dump 
Displays the contents of the options file so that you can see what database repair options have 
been selected.

Help Options:

--help, -? 
Displays the help information and exits.

Files

options_file 
(Required) Use the GUI GWCheck to select and save database repair options in the gwcheck.opt 
file, then run the Text-Based GWCheckT with the options file to execute the database repair 
options.
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Examples

This program normally runs as root.

/opt/novell/groupwise/gwcheck/bin/gwcheckt gwcheck.opt 
Runs GWCheckT in a text only environment, based on the database repair options provided in 
the options file created in the GUI GWCheck.

/opt/novell/groupwise/gwcheck/bin/gwcheckt gwcheck.opt --dump 
Lists the settings of the database repair options in the specified options file.

Diagnostics

For information about GWCheck error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/gw8).

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

gwcheck(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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dbcopy(1)

Name

dbcopy - GroupWise Database Copy utility

Syntax

dbcopy /source_directory /destination_directory
dbcopy [-b] [-i] [-t] [-v] [-w] /source_directory /destination_directory
dbcopy -m [-d] [-p] [-f] [-s] [-a] [-u] [-k] [-o] [-l]

/source_directory /destination_directory

Description

The GroupWise Database Copy utility (DBCopy) copies files from a live GroupWise domain, post 
office, or remote document storage area to a static location for backup. During the copy process, it 
prevents the files from being modified, using the same locking mechanism used by other GroupWise 
programs that access databases. This ensures that the backed-up versions are consistent with the 
originals even when large databases take a substantial amount of time to copy.

The DBCopy utility is not installed automatically with the rest of the GroupWise software. The 
DBCopy RPM is located in the /admin subdirectory of your software distribution directory (/opt/
novell/groupwise/software). When you install the RPM, the dbcopy executable is placed in the /
opt/novell/groupwise/agents/bin directory.

In addition to backups, the DBCopy utility is used in conjunction with the GroupWise Server 
Migration Utility (http://www.novell.com/documentation/gwutilities/gw8_svrmig11/data/
ab32nt1.html), which helps you migrate GroupWise data from NetWare or Windows to Linux. Some 
startup switches can be used for both backups and migration. Other startup switches are used only 
for migration.

Options

Usage Options:

source_directory 
Specifies the full path to the domain directory, post office directory, or remote document storage 
area directory.

destination_directory 
Specifies the full path to the directory where you want to copy the domain, post office, or remote 
document storage area.

-b 
Copies a remote document storage area associated with a library, including all subdirectories 
and compressed BLOB (binary large object) files in which library documents are stored.

-i mm-dd-yyyy 
Indicates that you are performing an incremental copy of only those files with the specified date 
or newer.
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-t 
Specifies the number of copy threads. The default is 5. Valid values range from 1 to 10.

-v 
Turns on verbose logging. The DBCopy log file is named mmddgwbk.nnn. The first four 
characters represent the date. A three-digit extension allows for multiple log files created on the 
same day. The log file is created at the root of the destination domain, post office, or document 
storage area directory. In addition to status and error messages, it lists any remote document 
storage areas associated with a post office.

-w 
Turns on continuous logging to the screen.

-m 
Copies all directories and files associated with a domain, post office, or document storage area 
as part of a migration.

-d 
Indicates migration of a domain.

-p 
Indicates migration of a post office.

-f 
Indicates that this is the first pass of the migration process. 

-s 
Indicates that this is the second pass of the migration process. 

-a 
Specifies the IP address to bind to for the migration process. The default is all available IP 
addresses.

-u 
Specifies the TCP port number for status requests during the migration.

-k 
Skips collecting database size information during the migration.

-o 
Skips the second copy of the post office offiles directory during the migration

-l 
Performs the GroupWise Check function of storelowercase on the migrated GroupWise 
databases. Its purpose is to do an “in-place” conversion of files and directories to lowercase, 
rather than as part of a copy operation. For a post office, it also updates the guardian database 
with the new, lowercase names.
For example, you could use this functionality if you have a domain or post office located on a 
SAN that was mounted for access by the GroupWise NetWare agents, but you now want to run 
the GroupWise Linux agents for the domain or post office.
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Help Options:

-h, --help, -? 
Displays the help information and exits.

Files

/pathname/mmddgwbk.nnn 
Log file created at the root of the destination directory.

Examples

This program normally runs as root.

/opt/novell/groupwise/agents/bin/dbcopy /gwsystem/acct /backups/acct 
Copies a post office to a backup location.

/opt/novell/groupwise/agents/bin/dbcopy --b /gwsystem/acct_library /backups/
acct_library 

Copies a library to a backup location.

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

gwtmstmp(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com). 
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gwtmstmp(1)

Name

gwtmstmp - GroupWise Time Stamp utility.

Syntax

gwtmstmp --postpath post_office_directory [--set] [--get] [--clear] [--backup] [--
restore] [--retention] [--date mm/dd/yyyy] [--time hh:mm[am|pm]] [--gmttime 
seconds] [--userid GroupWise_userID] [--userdb user_database] 

Description

The GroupWise Time Stamp utility (GWTMSTMP) places a time stamp on a GroupWise user 
database to indicate the last time the database was backed up. If a user deletes an item from his or her 
mailbox and purges it from the Trash, the item is removed from the user’s database only if the time 
stamp shows that the item has already been backed up. Otherwise, the item remains in the user’s 
database until the database is backed up, at which time it is purged from the database.

The GroupWise Time Stamp utility places date and time information on user databases (userxxx.db) 
in order to support message backup, restore, and retention. No other databases are affected. You can 
run the GroupWise Time Stamp utility on all user databases in a post office or on a single user 
database.

Backup

To ensure thorough user database backups, you can make sure that deleted items are not purged 
from users’ databases until they have been backed up. Two conditions must be met in order to 
provide this level of protection against loss of deleted items:

 The Do Not Purge Items Until They Are Backed Up option must be selected for the post office in 
ConsoleOne (Tools > GroupWise Utilities > Client Options > Environment > Cleanup).

 User databases (userxxx.db) must be time-stamped every time a backup is performed so that 
items can be purged only after they are backed up.

Restore

You can use the GroupWise Time Stamp utility to manually add the restore time stamp to the 
database. The restore time stamp is not required for any GroupWise feature to work properly. Its 
primary purpose is informational.

Retention

If you use a message retention application, the application should automatically add the retention 
time stamp after retaining the database’s messages. Any messages with dates that are newer than the 
retention time stamp cannot be purged from the database. You can use the GroupWise Time Stamp 
utility to manually add a retention time stamp.
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Options

Usage Options:

--postpath /post_office_directory, -p /post_office_directory 
(Required) Specifies the full path to the post office directory where the user databases to time-
stamp are located.

--set, -s 
Sets the current date and time (of backup, restore, or retention) on user databases.

--get, -g 
Lists existing backup, restore, and retention time stamp information for user databases. If no 
time stamps are set, “unknown” is displayed. If no other operational switch is used, --get is 
assumed.

--clear, -c 
Removes time stamps (of backup, restore, or retention) from user databases.

--backup, --restore, --retention, -b, -r, -n 
Specifies the type of time stamp (backup, restore, or retention) on which to perform the get or set 
operation. If no time stamp type is specified, the operation is performed on the backup time 
stamp. Multiple time stamp types can be specified together.

--date mm/dd/yyyy, -d mm/dd/yyyy 
Specifies the date that you want placed on user databases. Use the format mm/dd/yyyy; for 
example, 05/18/2010 for May 18, 2010. If no date is specified, the current date is used. If your 
locale does not use the mm/dd/yyyy format, use gwtmstmp --help to determine the format for 
your locale.

--time hh:mm[am|pm], -t hh:mm[am|pm] 
Specifies the time that you want placed on user databases. Use the format hh:mm, expressed in a 
24-hour format (for example, 20:45) or expressed with the am or pm option (for example, 
8:45pm. If no time is specified, 00:00 is used.

--gmttime seconds, -m seconds 
Specifies the number of seconds since midnight on January 1, 1970 GMT that you want placed 
on the user databases.

--userid username, -u username 
Provides a specific GroupWise user ID so that an individual user database can be time-stamped.

--userdb user_database, -e user_database 
Provides a specific database name so that an individual user database can be time-stamped.

Help Options:

--help, -? 
Displays the help information and exits.
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Examples

This program normally runs as root.

/opt/novell/groupwise/agents/bin/gwtmstmp -p /gwsystem/acct 
Checks the existing time stamp on all GroupWise user databases in a post office.

/opt/novell/groupwise/agents/bin/gwtmstmp -p /gwsystem/acct --set 
Set a current time stamp on all user databases in a post office.

Diagnostics

For information about GroupWise Time Stamp utility error messages, see Troubleshooting 1: Error 
Messages (http://www.novell.com/documentation/gw8).

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

dbcopy(1).

To report problems with this software or its documentation, visit Novell Bugzilla. (http://
bugzilla.novell.com).
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gwcsrgen(1)

Name

gwcsrgen - GroupWise Generate CSR utility

Syntax

gwcsrgen

Description

The GroupWise Generate CSR utility (GWCSRGEN) generates a certificate signing request (CSR) file 
and a private key file. These files are needed to provide secure communication through SSL (Secure 
Socket Layer) connections between GroupWise agents and clients.

When you run the Generate CSR utility, you must fill in the following fields in the interface provided:

Key Filename

The name for the private key file (for example, server1.key). If you don’t want the file stored in the 
same directory as the gwcsrgen executable, specify a full path with the filename (for example, /
certs/server1.key).

Key Password

The password for the private key. The password can be up to 256 characters (single-byte 
environments).

CSR Filename

The name for the certificate signing request file (for example, server1.csr). If you don’t want the file 
stored in the same directory as the gwcsrgen executable, specify a full path with the filename (for 
example, /certs/server1.csr).

Country

The two-letter abbreviation for your country (for example, US).

State/Province

The name of your state or province (for example, Utah). Use the full name. Do not abbreviate it.

City

The name of your city (for example, Provo).

Organization

The name of your organization (for example, Novell, Inc.).
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Division

The division of your organization that this certificate is being issued to (for example, Product 
Development).

Hostname of Server

Enter the DNS hostname of the server where the server certificate will be used (for example, 
dev.provo.novell.com).

Configuration File

For convenience, you can record the information for the above fields in a configuration file so that it is 
automatically provided whenever you run the Generate CSR utility. The configuration file must have 
the following format:

[Private Key]
Location = 
Extension = key

[CSR]
Location = 
Extension = csr

[Required Information]
Country =
State = 
City = 
Organization =
Division =
Hostname =

If you do not want to provide a default for a certain field, insert a comment character (#) in front of 
that line. Name the file gwcsrgen.cnf. You can save the file in your current directory (for example, /
opt/novell/groupwise/agents/bin if you run the gwcsrgen executable from that default location) 
or in /etc/opt/novell/groupwise/agents.

What’s Next

After the CSR and private key files are created, you need to submit the CSR to a Certificate Authority 
in order to receive a server certificate. If you haven’t previously used a Certificate Authority, you can 
use the keywords “Certificate Authority” to search the Web for Certificate Authority companies. The 
process of submitting the CSR varies from company to company. Most provide online submission of 
the request. Follow their instructions for submitting the request.

When you receive the server certificate, you can store it, along with the private key file, anywhere on 
the server where they will be used. Any GroupWise agent (MTA, POA, Internet Agent, or WebAccess 
Agent) that is running on the server can use the certificate and private key when using SSL for secure 
connections.

Files

/etc/opt/novell/groupwise/agents/bin/gwcsrgen.cnf 
Configuration file. By providing a configuration file, you do not need to fill in the fields 
manually every time you run the Generate CSR utility.
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Examples

This program normally runs as root.

/opt/novell/groupwise/agents/bin/gwcsrgen 
Starts the Generate CSR utility. If you have supplied a configuration file, the fields are filled in 
based on the data in the configuration file.

Authors

Copyright 2004-2010, Novell, Inc. (http://www.novell.com). All rights reserved. 

See Also

To report problems with this software or its documentation, visit Novell Bugzilla. (http://
bugzilla.novell.com).
322 GroupWise 8 Installation Guide

http://www.novell.com
http://bugzilla.novell.com


C CThird-Party Materials

The following third-party software is included in Novell GroupWise 8:

 Section C.1, “Apache,” on page 323
 Section C.2, “BLT,” on page 324
 Section C.3, “GD Graphics Library,” on page 324
 Section C.4, “getopt.h,” on page 325
 Section C.5, “ICU License - ICU 1.8.1 and Later,” on page 326
 Section C.6, “JRE,” on page 326
 Section C.7, “NET-SNMP Open Source Package,” on page 326
 Section C.8, “ODMA 2.0,” on page 329
 Section C.9, “OpenLDAP,” on page 330
 Section C.10, “OpenSSL,” on page 330
 Section C.11, “Python 2.2,” on page 332
 Section C.12, “Yahoo! UI Library,” on page 332

C.1 Apache
The Apache Software License, Version 1.1
Copyright (c) 2000 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment:
“This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).”
Alternately, this acknowledgment may appear in the software itself, if and wherever such third-
party acknowledgments normally appear.
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4. The names “Apache” and “Apache Software Foundation” must not be used to endorse or 
promote products derived from this software without prior written permission. For written 
permission, please contact apache@apache.org.

5. Products derived from this software may not be called “Apache”, nor may “Apache” appear in 
their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS’’ AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache 
Software Foundation. For more information on the Apache Software Foundation, please see <http://
www.apache.org/>.

Portions of this software are based upon public domain software originally written at the National 
Center for Supercomputing Applications, University of Illinois, Urbana-Champaign.

C.2 BLT
Copyright 1993-1998 Lucent Technologies, Inc.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose 
and without fee is hereby granted, provided that the above copyright notice appear in all copies and 
that both that the copyright notice and warranty disclaimer appear in supporting documentation, 
and that the names of Lucent Technologies any of their entities not be used in advertising or publicity 
pertaining to distribution of the software without specific, written prior permission.

Lucent Technologies disclaims all warranties with regard to this software, including all implied 
warranties of merchantability and fitness. In no event shall Lucent Technologies be liable for any 
special, indirect or consequential damages or any damages whatsoever resulting from loss of use, 
data or profits, whether in an action of contract, negligence or other tortuous action, arising out of or 
in connection with the use or performance of this software.

C.3 GD Graphics Library
Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Cold Spring 
Harbor Laboratory. Funded under Grant P41-RR02188 by the National Institutes of Health. 

Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Boutell.Com, Inc. 

Portions relating to GD2 format copyright 1999, 2000, 2001, 2002, 2003, 2004 Philip Warner. 

Portions relating to PNG copyright 1999, 2000, 2001, 2002, 2003, 2004 Greg Roelofs. 

Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002, 2003, 2004 John Ellson 
(ellson@graphviz.org). 

Portions relating to gdft.c copyright 2001, 2002, 2003, 2004 John Ellson (ellson@graphviz.org). 
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Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, 2003, 2004, Doug 
Becker and copyright (C) 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 Thomas G. 
Lane. This software is based in part on the work of the Independent JPEG Group. See the file 
README-JPEG.TXT for more information. 

Portions relating to GIF compression copyright 1989 by Jef Poskanzer and David Rowley, with 
modifications for thread safety by Thomas Boutell. 

Portions relating to GIF decompression copyright 1990, 1991, 1993 by David Koblas, with 
modifications for thread safety by Thomas Boutell. 

Portions relating to WBMP copyright 2000, 2001, 2002, 2003, 2004 Maurice Szmurlo and Johan Van 
den Brande. 

Permission has been granted to copy, distribute and modify gd in any context without fee, including 
a commercial application, provided that this notice is present in user-accessible supporting 
documentation. 

This does not affect your ownership of the derived work itself, and the intent is to assure proper 
credit for the authors of gd, not to interfere with your productive use of gd. If you have questions, 
ask. “Derived works” includes all programs that utilize the library. Credit must be given in user-
accessible documentation. 

This software is provided “AS IS.” The copyright holders disclaim all warranties, either express or 
implied, including but not limited to implied warranties of merchantability and fitness for a 
particular purpose, with respect to this code and accompanying documentation. 

Although their code does not appear in the current release, the authors also wish to thank Hutchison 
Avenue Software Corporation for their prior contributions. 

C.4 getopt.h
Copyright (c) 2000 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation by Dieter Baron and 
Thomas Klausner.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgement:
This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
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PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS 
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

C.5 ICU License - ICU 1.8.1 and Later
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995-2006 International Business Machines Corporation and others

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the 
Software, and to permit persons to whom the Software is furnished to do so, provided that the above 
copyright notice(s) and this permission notice appear in all copies of the Software and that both the 
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY 
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS 
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL 
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization of the copyright holder. 

C.6 JRE
JRE Note

This product includes code licensed from RSA Security, Inc. Some portions licensed from IBM are 
available at http://oss.software.ibm.com/icu4j/.

C.7 NET-SNMP Open Source Package
 Section C.7.1, “---- Part 1: CMU/UCD copyright notice: (BSD like) -----,” on page 327
 Section C.7.2, “---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----,” on 

page 327
 Section C.7.3, “---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----,” on page 328
 Section C.7.4, “---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----,” on page 328
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C.7.1 ---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University
Derivative Work - 1996, 1998-2000
Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose 
and without fee is hereby granted, provided that the above copyright notice appears in all copies and 
that both that copyright notice and this permission notice appear in supporting documentation, and 
that the name of CMU and The Regents of the University of California not be used in advertising or 
publicity pertaining to distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL 
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE 
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE 
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE 
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR 
PERFORMANCE OF THIS SOFTWARE.

C.7.2 ---- Part 2: Networks Associates Technology, Inc copyright notice 
(BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 Neither the name of the Networks Associates Technology, Inc nor the names of its contributors 
may be used to endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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C.7.3 ---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 The name of Cambridge Broadband Ltd. may not be used to endorse or promote products 
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

C.7.4 ---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright © 2003 Sun Microsystems, Inc., 
4150 Network Circle, Santa Clara, California 95054, U.S.A. 
All rights reserved.

Use is subject to license terms below.

This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE 
328 GroupWise 8 Installation Guide



LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

C.8 ODMA 2.0
OPEN DOCUMENT MANAGEMENT API LICENSE 1.0
ODMA 2.0 SPECIFICATIONS AND SOFTWARE 
Copyright © 1994-1998 AIIM International

LICENSE:

Redistribution and use in source and binary forms, with or without modifications, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of AIIM International nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.

DISCLAIMER:

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

ADDITIONAL INFORMATION:

 ODMA reference materials, software, and status: 
<http://ODMA.info>

 Information about this ODMA License and its application: 
<http://DMare.info/license/>

 Open Source Definition 1.9 and the BSD License 
(the model for this ODMA license): 
<http://opensource.org>

 HTML (ISO 8859-1) version of this license: 
<http://Dmware.info/license/P040801F.htm>
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C.9 OpenLDAP
The OpenLDAP Public License
Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation (“Software”), with or without 
modification, are permitted provided that the following conditions are met:

1 Redistributions in source form must retain copyright statements and notices,
2 Redistributions in binary form must reproduce applicable copyright statements and notices, this 

list of conditions, and the following disclaimer in the documentation and/or other materials 
provided with the distribution, and

3 Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished 
by a version number. You may use this Software under terms of this license revision or under the 
terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS 
``AS IS’’ AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS 
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to 
promote the sale, use or other dealing in this Software without specific, written prior permission. 
Title to copyright in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights 
Reserved. Permission to copy and distribute verbatim copies of this document is granted.

C.10 OpenSSL
OpenSSL License
Copyright (c) 1998-2002 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

3 All advertising materials mentioning features or use of this software must display the following 
acknowledgment:
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“This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit. (http://www.openssl.org/)”

4 The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, 
please contact openssl-core@openssl.org.

5 Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear 
in their names without prior written permission of the OpenSSL Project.

6 Redistributions of any form whatsoever must retain the following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS’’ AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This 
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The 
implementation was written so as to conform with Netscape's SSL.

This library is free for commercial and non-commercial use as long as the following conditions are 
adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, 
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is 
covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be 
removed. If this package is used in a product, Eric Young should be given attribution as the author of 
the parts of the library used. This can be in the form of a textual message at program startup or in 
documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1 Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

3 All advertising materials mentioning features or use of this software must display the following 
acknowledgement: 
“This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)”
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The word “cryptographic” can be left out if the routines from the library being used are not 
cryptographic related :-).

4 If you include any Windows specific code (or a derivative thereof) from the apps directory 
(application code) you must include an acknowledgement: 
“This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS’’ AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or derivative of this code cannot 
be changed; i.e. this code cannot simply be copied and put under another distribution licence 
[including the GNU Public Licence.]

C.11 Python 2.2
Copyright (c) 1991 - 1995, Stichting Mathematisch Centrum Amsterdam, The Netherlands. All rights 
reserved.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose 
and without fee is hereby granted, provided that the above copyright notice appear in all copies and 
that both that copyright notice and this permission notice appear in supporting documentation, and 
that the name of Stichting Mathematisch Centrum or CWI not be used in advertising or publicity 
pertaining to distribution of the software without specific, written prior permission.

STICHTING MATHEMATISCH CENTRUM DISCLAIMS ALL WARRANTIES WITH REGARD TO 
THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS, IN NO EVENT SHALL STICHTING MATHEMATISCH CENTRUM BE LIABLE FOR ANY 
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

C.12 Yahoo! UI Library
Yahoo! UI Library uses the BSD License which states:

Software License Agreement (BSD License)

Copyright (c) 2006, Yahoo! Inc.

All rights reserved.
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Redistribution and use of this software in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

 Redistributions of source code must retain the above   copyright notice, this list of conditions 
and the following disclaimer.

 Redistributions in binary form must reproduce the above   copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

 Neither the name of Yahoo! Inc. nor the names of its   contributors may be used to endorse or 
promote products derived from this software without specific prior written permission of 
Yahoo! Inc.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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D DDocumentation Updates

This section lists updates to the Installation Guide that have been made since the initial release of 
Novell GroupWise 8. The information helps you to keep current on documentation updates and, in 
some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the Installation Guide was republished. Within 
each dated section, the updates are listed by the section title.

The GroupWise 8 Installation Guide has been updated on the following dates:

 Section D.1, “September 12, 2012 (GroupWise 8 SP2 HP4 Mac Client Update),” on page 335
 Section D.2, “June 26, 2012 (GroupWise 8 SP3),” on page 335
 Section D.3, “December 9, 2010 (Compatibility with Vibe 3),” on page 336
 Section D.4, “July 14, 2010 (GroupWise 8 SP2),” on page 336
 Section D.5, “August 31, 2009 (GroupWise 8 SP1),” on page 337

D.1 September 12, 2012 (GroupWise 8 SP2 HP4 Mac Client 
Update)

D.2 June 26, 2012 (GroupWise 8 SP3)

Location Change

Product Overview 

Section 2.2.2, “Mac Client 
Requirements,” on page 19

Added support for Mac OS 10.8 (Mountain Lion).

Location Change

Product Overview 

Section 2.1, “GroupWise 
Administration Requirements,” on 
page 17

Added OES 11 as a supported operating system; updated the Tomcat 
requirement to Tomcat 6 for OES 11 and SLES 11; added a link for 
obtaining the LDAP snap-in to ConsoleOne.

Section 2.2.2, “Mac Client 
Requirements,” on page 19

Noted that GroupWise 8 Support Pack 3 does not include the Mac 
client or the Linux client, but earlier versions can still be used; updated 
the supported versions of Mac OS.

Installation 
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D.3 December 9, 2010 (Compatibility with Vibe 3)

D.4 July 14, 2010 (GroupWise 8 SP2)

Section 6.4.2, “Configuring the 
Calendar Publishing Host in 
ConsoleOne,” on page 148

Corrected the port number on which the Calendar Publishing Host 
communicates with the POA.

“Enabling the Groupwise High 
Availability Service for the Linux 
GroupWise Agents” on page 209

Improved the instructions for enabling the GroupWise High Availability 
service (gwha).

Chapter 12, “Installing Novell Vibe,” 
on page 243

Updated for the product name change from Novell Vibe OnPrem to 
Novell Vibe.

Location Change

Location Change

Installation 

Chapter 12, “Installing Novell Vibe,” 
on page 243

Updated for the product name change from Novell Teaming to Novell 
Vibe OnPrem.

Location Change

Installation 

Section 2.2, “GroupWise Client 
Requirements,” on page 19

Updated the supported operating systems for the GroupWise Windows 
client.

Part II, “Installation,” on page 23 Added links to the “GroupWise 8 Good and Bad Habits” wiki throughout 
the Installation Guide.

“Enabling the Groupwise High 
Availability Service for the Linux 
GroupWise Agents” on page 209

Introduced the High Availability service configuration file.

“Configuring the Groupwise High 
Availability Service in the gwha.conf 
File” on page 210

Noted that the user that the High Availability service runs as cannot be 
a LUM-enabled user.

Section 9.5.2, “Prerequisites on 
SUSE Linux Enterprise Desktop 11,” 
on page 236

Added platform-specific client installation instructions.

Chapter 10, “Installing Novell 
Messenger,” on page 239

Updated the documentation links to the latest version of Novell 
Messenger.

Chapter 11, “Installing the Novell Data 
Synchronizer Mobility Pack,” on 
page 241

Replaced the documentation links to GroupWise Mobile Server 
documentation with links to the Novell Data Synchronizer Mobility Pack 
documentation. Synchronizer is the next generation of mobile device 
support for GroupWise users.
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D.5 August 31, 2009 (GroupWise 8 SP1)

Chapter 12, “Installing Novell Vibe,” 
on page 243

Updated the documentation links to the latest version of Novell 
Teaming.

Chapter 13, “Installing Novell 
Conferencing,” on page 245

Updated the documentation links to the new version of Novell 
Conferencing.

Update 

Section 17.5, “Updating Secondary 
Domains,” on page 272

Clarified the process of updating secondary domains.

Appendixes 

dbcopy(1) (page 314) Clarified the functionality of the -l switch.

Location Change

Location Change

Installation 

Chapter 2, “GroupWise System 
Requirements,” on page 17

Updated the supported operating environments for GroupWise 8 
Support Pack 1.

Section 2.3.5, “Citrix Support,” on 
page 22

Added Citrix XenServer as a supported environment.

Section 2.3.6, “Domain Services for 
Windows Support,” on page 22

Added Domain Services for Windows as a supported environment.

Section 4.3.9, “NetWare Installation 
Options: Automatic Startup, Protected 
Mode, and Clustering,” on page 82

Added Protected Mode as an Internet Agent installation option.

Section 7.1, “GroupWise Monitor 
Overview,” on page 159

Clarified that the Monitor web-based consoles are available on both 
Windows and Linux.

“Monitor Server” on page 163 Stated that the Monitor Agent cannot run as a Windows service; 
recommended installing the Monitor Agent on the same server with a 
domain and its MTA.

Section 6.3.3, “Determining the 
Configuration of the Calendar 
Publishing Host,” on page 139 and 
Section 6.4.1, “Installing the Calendar 
Publishing Host,” on page 143

Added the new Calendar Publishing Host Name dialog box in the 
Calendar Publishing Host Installation program.

Update 

Section 14.4.3, “Simplified Addressing 
for External GroupWise Systems,” on 
page 251

Removed user synchronization as an aspect of simplified addressing. 
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Section 15.1, “Understanding 
eDirectory Schema Extensions,” on 
page 255, Chapter 16, “Preparing 
Your GroupWise System for Update,” 
on page 261, and Section 17.1, 
“Installing the GroupWise 8 Software,” 
on page 263

Clarified that, during an update from GroupWise 7 to GroupWise 8, the 
GroupWise Installation program does not automatically extend the 
eDirectory schema. You must do it manually in ConsoleOne.

Chapter 16, “Preparing Your 
GroupWise System for Update,” on 
page 261

Emphasized that GroupWise client user workstations must be running 
a supported version of the operating system.

Location Change
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